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BillQuick Overview 
 
Welcome to BillQuick® from BQE Software, Inc. Thank you for making BillQuick your time, billing and 
business management solution. Virtually any company that tracks hours for job costing (and payroll) or 
bills by fixed fee, recurring amount, hourly, cost plus and variations will find strong value in BillQuick. It 
adapts and scales to various types and sizes of professional services firms – handling a two-person firm as 
efficiently as a large multi-office firm. 
 

 
 
Benefits: BillQuick offers an easy and efficient way to reduce the overhead of your business and increase 
your revenue by accurately tracking professional hours, recording expenses and job costs, managing 
projects, billing your clients and reporting. Companies report saving 10, 25 and more hours monthly 
because of shortcuts, automatic features and simplified tasks in BillQuick. You can reduce your billing 
time from days to hours, accessing BillQuick on the desktop, web and Smartphone. In addition, you get 
to integrate BillQuick data with your accounting package. 
 
It is all about time: Everything in BillQuick is designed with ‘time’ in mind. For example:  
 

 How to capture hours (time) and expenses with the minimum of effort and time  
 How to bill clients with minimum user involvement 
 How to generate reports easily and quickly 

 
When you buy a software program, you want to know what the application offers, how it benefits you 
and how to use it in the simplest and fastest way possible. This User Guide meets this expectation by 
covering all the features and functionality of BillQuick at the basic level (for the first-time users) as well as 
at the advanced level (for existing users). It explains your most important questions – ‘What does it do?’ 
and ‘How do I do it?’  
 

 For a guided learning of BillQuick, please check our Training and Consulting 
Services at www.bqe.com/Services.asp. 

 
This BillQuick User Guide is organized into chapters – starting with an executive summary of major 
solutions offered by BillQuick. This is followed by some basic concepts and initial procedures for getting 
BillQuick up and running. There are sections focusing on specific role-based information and procedures. 
Often these role-based functions correspond to a person’s position or title, although different companies 
organize roles and responsibilities in different ways. Typically, a company consists of a Principal/Partner 

http://www.bqe.com/Services.asp?pageId=Home&link_src=header
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(owner or official head), Supervisor (company administrator or manager), Timekeepers (employees and 
vendors), Project Manager, Billing Manager, Staff (accountant, admin assistants, support staff, clerks) and 
so on. 
 
Executive Summary briefly presents the major functions and features of BillQuick that are useful for 
managing your projects, billing and overall business. It summarizes the major solutions offered by 
BillQuick from the managerial perspective. In a typical company, a System/IT Administrator installs any 
software. Installation  covers the start-up issues related to installing BillQuick such as system 
requirements, different installation scenarios, setting up a company database, activating the software and 
so on. General Features chapter contains information and procedures related to features commonly used 
by all. After understanding the basics of BillQuick, the first thing you need to do is add data to your 
company database. Setting up master profiles (such as employees, clients, projects, etc.) and related 
information (schedules, budgets, etc.) is covered in Master Information Setup.  
 
After the setup issues, you will deal with the managerial aspect of BillQuick. Company Management 
covers important issues such as security, templates, database maintenance, company-wide settings and 
preferences. Being project-centric, BillQuick offers a complete Project Management solution. Essentially, 
for project managers, this chapter explains all the features of BillQuick useful for tracking and managing 
projects. Here, you find out about contract types, budgets, fee schedules, journals, project rules, 
dashboard, document management, and so on.  
 
Time Tracking and Expense Tracking revolve around typical timekeepers (employees and vendors) and 
their managers. These explain various time and expense entry options, submission-approval procedures 
and other settings. 
 
Accounting  covers the accounting-related features in BillQuick, focusing on accounts payable. Typically, 
this chapter is for accountants or billing managers and covers issues related to purchase orders, vendor 
bills, data integration with accounting software, etc. Next, you can explore the billing chapters, focusing 
on useful information for billing managers or accountants. Billing Basics includes pre-billing tasks, billing 
methods and invoice settings; Billing explains the billing decisions and processes for creating various 
invoices; Accounts Receivable lays out procedures related to invoices, late fees and payments, followed 
by Retainer Management that covers everything about pre-paid amounts and retainers.  
 
Finally, BillQuick provides a variety of reports for executives, managers and supervisors. Report 
Management talks about the excellent reporting capabilities of BillQuick including report filters, report 
customization and automation, statements and so on. The User Guide concludes with an Appendix 
displaying common report and invoice samples, glossary definitions and a useful index. 
 

 This Guide covers all the features of BillQuick, available in the Enterprise 
edition but may not be in the Basic and Pro editions. 
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BillQuick Editions 
 
BillQuick is available in four editions—Lite, Basic, Pro and Enterprise. Depending upon your 
requirements, you can choose the edition that fits you the best: 
 

Edition Description Database Type 

BillQuick Lite Free, limited edition of BillQuick. It is for a 
one-man company that requires only capture 
of time and expenses and basic billing. 

Microsoft Access 
(Standard) 

BillQuick Basic Low-end, paid edition of BillQuick. It is for 
small companies with 2 to 4 users. Offers time 
and expense tracking, invoicing, billing, and 
reporting features.  

Microsoft Access 
(Standard) 

BillQuick Pro Professional edition of BillQuick for companies 
with 5 to 20 users. Offers advanced features 
than Basic but less than the Enterprise. 

Microsoft Access 
(Standard) 
Microsoft SQL Express 

BillQuick Enterprise Top-of-the-line edition for companies with 
more than 20 users or those who need very 
robust features. Offers all the advanced and 
new features. 

Microsoft Access 
(Standard) 
Microsoft SQL Express 
Microsoft SQL Server 

 

 For details, check all the BillQuick editions at www.bqe.com/BQFlavor.asp 
and the BillQuick Editions Comparison Chart.  

 
BillQuick comes in three different versions. Depending upon what suits your company and situation, you 
can use one or more of these options: 
 

 BillQuick – flagship product, installed and accessed on desktop computers and laptops 
 Web Suite – web version of BillQuick, accessed from web browsers using Internet/ 

Intranet/ local network 
 BillQuick Online – online hybrid SaaS version of BillQuick, hosted by us and accessed by 

subscribers from web browsers using Internet 
 
 

http://www.bqe.com/BQFlavor.asp
http://bqesoftware.net/media/PDF/BQ/2011/BillQuick2011EditionComparison.pdf
http://www.billquickonline.com/Default.asp
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User Guide Conventions 
 
The BillQuick 2011 User Guide follows standard presentation conventions, making it easier and faster to 
scan and review information. Conventions employed include: 
 

Item Presentation 

Field Name, Field Group Name Initial capital for each word 

Section Title Initial capital for each word 

Chapter Title Initial capital for each word 

Minor emphasis No initial capital 

Significant emphasis No initial capital 

Special information or notes 
 within the text 

Help Information 
 within text 

Warnings and caution 
 within text 

Buttons and icons Initial capital for each word,  within the text 

Reference selection from a menu Each menu item is separated with a comma. E.g., 
‘Project menu, Document Management’ means to 
select the Project menu and then choose Document 
Management from it 

Keys on the keyboard Key begins with a capital letter. E.g., Shift, Ctrl, Tab 

Reference to selecting an icon or 
button 

‘Click’ means to mouse over the item and press the 
left mouse button. Click and another action or 
keystroke uses a plus sign. E.g., Ctrl+Click 

Header on the page Name of the chapter you are in 

Footer on the page Name and page number of the User Guide document  

Hyperlinks Click hyperlink to jump to the topic 

Index List of major chapters, sections and topics with page 
numbers 

 

 Please store the License and Registration Keys for BillQuick and its 
add-on modules in a secure location.  

 

 Your feedback helps us plan and improve BillQuick releases and associated 
documentation. Please email your comments, suggestions and ideas about 
BillQuick and this User Guide to BQ-Ideas@bqe.com. 

mailto:BQ-Ideas@bqe.com
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Executive Summary 
 
Implementation of BillQuick for time tracking, billing and project management is the right step towards 
increasing business productivity and investing in technology that helps you manage your business. This 
executive summary highlights those functions and features of BillQuick that are useful for decision-makers 
and executives in a company. It focuses on important information needed by owners, principals, partners, 
executives, project managers, billing managers, company managers and such other people for effective 
and efficient management of projects, company and business as a whole. In other words, it answers your 
question “What does BillQuick do for me?”  
 
Depending upon your business type, BillQuick adjusts its terminology and activity codes to your industry: 
 

Industry-Specific Terminology 

Architects & 
Engineers 

IT & Computer 
Consultants 

Accountants & 
CPAs 

Attorneys & 
Paralegals 

Employee Employee Timekeeper Employee 

Client Customer Client Client 

Project Job Engagement Matter 

Activity Activity Task/Service Activity 

Company Company Company Firm 

Vendor Vendor Consultant Consultant 

Budget Budget Budget Estimate 

 
 BillQuick for Architects and Engineers 
 BillQuick for IT/Computer Consultants 
 BillQuick for Accountants/CPAs 
 BillQuick for Attorneys 

 
 

BillQuick for Architects and Engineers 
 
Architects and engineers are project-oriented. They generally encounter accounting issues, and project 
management and reporting is important to them. BillQuick is project-centric software that meets or 
exceeds all their expectations. 
 
To manage and complete projects profitably, project managers need timely, complete, and accurate 
information about hours worked and expenses incurred on their projects. Thus, easy capture of time and 
expenses is required, whether you are in an office, at a client’s location or working from home. The bill 
and cost rates applied to hours worked may be standard or special for employees or groups of employees. 
You can negotiate special rates with the client on a project-by-project basis or your firm may assign 
special rates based on the type of project and other factors. 
 
Projects typically have budgets, which you need to develop and approve before starting a project. It is 
essential that a project manager knows exactly how much budget and, overall, how much of the contract 
amount has been ‘burned’. While budget totals and contract amounts may be the same in some firms, in 
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others they are different to allow for unknown contingencies.  
 
Throughout the project, a manager may update the percent complete value. Typically, the project fee 
will be a lump sum, hour rate, cost + percentage (profit margin) or cost + fixed fee (management fee). 
During a billing cycle, the net bill amount for a project may be based on: 
 

 Total value of the hours worked (Hourly Billing, Time & Materials Billing) 
 A percentage of the lump sum agreed to (Fixed Fee, Percent Complete Billing)  
 Achieving a milestone in the project (Fixed Fee, Milestone Billing) 
 The cost of work done plus a percent of cost or a portion of fixed fee (Cost Plus Billing) 
 A predefined billing schedule with amount and billing dates (Fixed Fee using a Billing 

Schedule) 
 
Depending on the situation, billing may be straightforward or may involve judgment: 
 

 Project percent complete: how much of the contract has been earned 
 Hourly contracts: quality and justifiability of time and expenses 

 
An invoice must project the desired image of the company. It must represent the professionalism and 
brand of the company, and clearly communicate the work done, amount charged and the total due. Thus, 
firms pay special attention to the look and feel of their invoices, including logos, layout of information and 
the information itself.  
 
Project managers and senior executives focus on satisfying clients and maximizing company profits. 
Scheduled reports and alerts ensure managers have the right information at the right time. If none of the 
150 plus invoice formats and 400 plus reports included with BillQuick meets your requirements, you may 
customize them yourself or outsource the job to BQE Report Services.  
 
 

BillQuick for IT Consultants 
 
Like architects and engineers, IT or computer consultants are also project-oriented. They share many of 
the same characteristics and pain points. Again, BillQuick is a project-centric software that meets or 
exceeds all their expectations. 
 
A unique characteristic among IT companies is prepaid services. They may discount standard bill rates 
because they get payment upfront. This is justified as revenue in-hand, instead of waiting for a client to 
pay an invoice. Thus, bill rates for prepaid services are usually lower than for post-paid services.  
 
Prepaid services involve keeping track of every minute with exact details, because clients will demand 
accounting for their up-front payment. Exact time is required, whether you are in your company office, at 
the client’s office or traveling. 
 
To improve productivity and profitability, IT consultants often multi-task when providing Help Desk and 
other services. They usually work with two or more clients at the same time through chat logs, online 
sessions or on the phone. 
 
Management must know how much of the prepaid amount or retainer remains so that it can contact the 

http://www.bqe.com/Services.asp?pageId=Reports
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clients to replenish the funds and discuss increasing the total amount because of higher than estimated 
service activity.  
 
These companies share many of the same billing and collections issues as architects, engineers, 
accountants and attorneys. 
 
 

BillQuick for Accountants 
 
Accounting professionals and CPAs (certified public accountants) are engagement-oriented. They refer to 
‘projects’ as ‘engagements’ and manage them just like the engineers or IT consultants. Again, BillQuick is 
engagement-centric software that meets or exceeds all their expectations. 
 
Engagements may involve budgets, fixed fee contracts and milestone billing. Accountants closely monitor 
budget spent and contract burned. Often, they schedule this information for automatic delivery or print it 
on-demand, as needed.  
 
Other engagements are less complex but even then, you should manage them well for profitability. Such 
engagements include: 
 

 Tax preparation (Fixed Fee) 
 Monthly, quarterly and annual accounting services (Recurring) 
 Payroll forms services (compliance) (Hourly) 
 Payroll processing (Fixed Fee) 
 Software consulting services (Hourly) 
 Specialized consulting services (Hourly) 
 Special financial analysis (Hourly) 
 Loan application assistance (Hourly) 

 
Traditional billing arrangements (contract types) with clients are hourly or recurring for accounting and 
consulting services. For tax services, they bill clients on a fixed fee or hourly basis. Some engagements 
contain a maximum fee, resulting in Hourly Not to Exceed contract. In less formal situations, accountants 
communicate a maximum fee verbally or associate a ‘shadow’ contract amount with an engagement.  
 
Typically, managers review hours worked and expenses incurred before billing. Accounting companies 
refer to this as ‘pre-billing’ or ‘reviewing the WIP worksheet’. Depending on the value of the work done, 
client, and formality of billing procedures followed by the partner, this stage could take an hour or days. 
Work-in-progress represents potential revenue to the company (some accounting companies treat WIP 
as revenue). Hence, time and expense entries must be accurate and complete with the right bill rates 
applied to hours. Bill rates may be standard or special, depending upon the type of engagement or person 
doing the work. 
 
A key pain point is asking questions about work done. The distance between the time when you worked 
and when you reviewed it for billing can be a few days or months. The more distant in time or the busier 
an employee has been, the harder it is to remember the details. This ‘fuzziness’ affects billing decisions. 
Thus, companies prefer that timekeepers add notes (memos) to their entries. 
 
When reviewing WIP and deciding what to include on an invoice, the billing person must balance various 
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factors such as the revenue earned for the work, reaction of the client and the likelihood of timely 
payment.  
 
When billing, a partner or a billing manager may exclude specific time and expenses (put them back into 
WIP), write-off specific items (the bill value is reduced to zero), make items ‘no-charge’ (include on the 
invoice as a zero-charge item), or adjust the bill value (write-up or down) of individual items or the entire 
invoice. You need to monitor all these decisions to gauge the impact on the company and client 
relationship. 
 
Accounting companies closely watch the ‘realization rate’ metric. This is the average bill rate achieved by 
a person on an engagement (billed) for a specific period. E.g., ideally, it should be 100% but realistically it 
should be 70-85%. Some companies use this rate to measure the effectiveness of staff and managers. 
Realization rate is often a substitute value for profitability. Increasingly, companies look at profitability 
reports for clients, engagements, employees and task codes. 
 
 

BillQuick for Attorneys 
 
Law firms are matter-oriented. They share many of the same issues as an accounting company. Again, 
BillQuick is matter-centric software that meets or exceeds all their expectations. 
 
A ‘matter’ is a project typically billed on an hourly basis plus expenses. You may do some type of work on 
a contingency basis (paid when you win a case) plus expenses.  
 
Usually, you review work-in-progress before billing. The fuzzy factor is an issue here as well. Exclusions, 
write-offs, no-charge and write-up/downs are common billing decisions, along with discounts and 
retainers.  
 
Many law firms require a retainer up-front. The retainer may be for any work done for a client or may be 
specific to a matter. You may apply retainers to bills while generating invoice to reduce the amount due, 
or apply as a payment to an outstanding invoice. After a matter is completed, typically you refund any 
retainer balance to the client. Depending on the nature of the matter and the state laws, you may 
combine the retainer with other retainers in a general bank account (co-mingled funds) or may require a 
separate account. In some situations, the separate account may be a special ‘trust’ account, with legal and 
regulatory requirements and liabilities.  
 
Like CPAs, partners and managers in a law firm watch the ‘realization rate’ metric very closely. 
Depending on the firm, you may measure it for WIP, after billing (billed revenue) or after collection (after 
write-off of invoiced amounts). Another metric they watch closely is ‘production’ or ‘billable time’ per 
attorney. You may review it as hours or bill value against a goal (hours x bill rate). Typically, you measure 
production against formal or informal goals. Increasingly, you monitor profitability by client, matter, 
manager and staff. Comparison of realization rate, production and profitability among attorneys and law 
firms is common.  
 
As a law firm grows, compensation reporting becomes more important. Compensation (direct, bonus) 
may be based on pre-billed revenues (production), billed revenues (what was invoiced) and/or collections 
(invoice amounts paid by the client). You may compute amounts for one or more of the following:  
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 Client rainmaker (who brought a client into the firm) 
 Matter rainmaker (who brought immediate work into the firm) 
 Attorney(s) performing the work  
 Paralegals and others involved in a matter 

 
Compensation formulas can be highly specific to a firm’s management structure, negotiated partnership 
agreement, and general management style. 
 
Keeping all these concerns as the driving force behind the success and popularity of BillQuick, it provides 
various solutions and features that enhance the overall productivity and profitability of your business 
concern—whether you are an architectural, engineering, IT, accounting or any other professional 
services firm.   
 
Some critical aspects of a business are a major concern of all executives in any industry. BillQuick 
addresses all those concerns: 
 

 project management  
 billing management 
 overall company and business management 

 
 

How Does BillQuick Manage My Projects? 
 
BillQuick is a project-centric system that supports an unlimited number of projects. After winning a 
project, you need to plan and set up the scope of work to do, which can be as broad or as narrow as you 
wish. BillQuick lets you charge time and expenses to it and accordingly bill your client. All the billable and 
non-billable charges, issues and events occurring over the life of a project affects its budget, job costs, 
billing, profitability and utilization. The quality of project management depends on timely, complete and 
accurate capture and processing of time and expenses, which is why BillQuick is the best solution for 
your project management needs. 
 
BillQuick provides the following solutions and benefits, enabling you to manage your projects in the most 
efficient way. 
 
ID Structures 
 
Descriptive IDs can communicate useful information, especially if you plan their structure well. You can 
sort all grids and dropdown lists by activity, project, client, employee and other IDs, making it easier and 
faster to work. For companies offering a single category of services, BillQuick provides the option to 
auto-create project codes, saving time during initial setup. 
 

 See the Master Information Setup chapter for more information and 
detailed procedures. 

 
Project Structure 
 
BillQuick records each project with a unique ID linked to a client, who authorizes and pays for the work. 
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A project’s scope can be broken down into parts called phases, segments and sub-segments. In essence, 
BillQuick supports up to four levels in a project hierarchy. Each project record can have agreed-on 
contract provisions like fee, contract amount and type, manager, budget, estimate, fee schedule, 
employees, activities and expenses assigned to it. 
 
Contract Types 
 
In BillQuick, project contract types trigger business-processing rules. BillQuick provides different contract 
types or billing arrangements to track information for any of these purposes: 
 

 Billing and revenue 
 Marketing 
 Overhead 

 
For instance, revenue-generating projects can be assigned Fixed Fee (lump sum), Hourly (time and 
materials), Hourly Not to Exceed, Recurring or Cost Plus contracts.  
 
For projects that your company is trying to win, you can use ‘Marketing’ contract. Tracking of marketing 
time and expense can begin when a new or existing client calls. Conversations, budget and estimate 
preparations, meetings, planning and bid proposals- all affect a project’s profitability. After winning a 
project, you can carry out your plan through to the final close of the project.  

 
Finally, you can use ‘Overhead’ contract to track internal activities and expenses like education, staff 
meetings and research. In any case, time and expenses flow to the project, giving you accurate billing, 
profitability and management information. You can set up one or more research project(s) for the 
company with the objective of improving your services and expanding your professional offerings to 
customers. An overhead project will require you to set up your company as a ‘client’ and then assign the 
overhead project to it.  

 
Project Manager 
 
BillQuick lets you assign a project manager who is responsible for that project. This is essential for proper 
tracking and managing of projects. Project managers can be assigned ‘manager level’ security permissions 
and ‘role’ to handle their projects in BillQuick. You can give them exclusive access to managerial reports 
for tracking and reporting of project issues. 
 
Project Journals 
 
Having access to right information at the right time is the key to effective management and a successful 
business. BillQuick lets your project managers maintain a centralized record of project issues, events, 
billing decisions, change orders and other qualitative information over its life. These journals link to bills, 
invoices and payments, quite useful for later reference and analysis in the following situations: 
 

 making billing decisions 
 post-project analysis as part of the company’s continuous improvement and client 

evaluation process 
 recording collections conversations 
 trying to get in touch with the project manager to get some answers 
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BillQuick also lets you record unlimited information about projects in a memo. If you prefer, these memos 
can display on invoices and journals. 
 
You can find important project information in various BillQuick screens besides project reports and the 
dashboard. For quick ‘at-a-glance’ information, project managers can see summarized activity and 
account information of an existing project on the Project-Account and Project-History tabs.  
 
To Do List 
 
The To Do List feature allows you to create a list of tasks to do. It allows you to assign tasks to any 
employee, set priority on them, track the status of each item and get reminders, thus making project 
execution and management an efficient yet simple process. It supports various types of tasks and 
categorization with specific start-end dates.  
 
Project Rules and Settings 
 
BillQuick lets you specify rules and preferences that affect the management of your projects. These 
settings can be set at the project level or global level to let you control the progress of projects, their 
billing and related aspects. 
 
Budgets and Estimates 
 
As you would already know, budgets are a good way to track the expected revenue or cost of a project 
against the actual. On the other hand, estimates can support later-stage marketing efforts with a bid to 
provide specified services. For many professional services firms – architects, engineers, IT consultants, 
surveyors, computer consultants, etc. – it is the ‘estimate’ that is sent to the clients as part of their bid 
proposal. When accepted, it usually becomes the foundation for the project contract or engagement 
letter. Some companies start with a preliminary budget and then convert it to an estimate, and may go 
through multiple iterations until the client signs off. Once signed off and project begins, project managers 
keep track of the budgeted project.  
 
BillQuick lets you use budgets and estimates for many purposes, including: 
 

 Compare the actual vs. budgeted items on a daily or weekly routine. This helps project 
managers gauge progress of a project and identify issues that need immediate 
management attention.  

 Analyze actual-to-budget results to improve operations, employee skill sets, fee 
structures and other aspects of profitable delivery of services to clients.  

 Use the total budget amount as the contract amount. 
 Restrict employees, expenses and activities to the budgeted ones while making time and 

expense entry. 
 Use budgets to assign employees and consultants to a project with specific tasks, hours 

and expenses, then use the ‘Budget by Employee’ report to track whether those 
employees are over or under budget for the assigned task.  

 Track budget line items by percentage done, provided you have assigned a budget to a 
project.  

 Create purchase orders, manual invoices and project controls from a budget.  
 

BillQuick budgets and estimates include separate services and expense portions and can draw bill rates 
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from fee schedules. You can use the same budget for several projects and include useful reports that 
compare budgeted hours and amounts to what you spent, how much remains, and whether you are over 
or under budget for a project.  
 
Fee Schedules 
 
BillQuick allows project or billing managers to set up service fee schedules and expense fee schedules 
containing special bill and cost rates for projects. With fee schedules, BillQuick eliminates manual entry 
and changing of alternative rates or setting up extra codes for special situations. After assigning a fee 
schedule, you can relax and watch how BillQuick determines automatically whether to apply the default 
or special rates to time or expense entries. 
 
BillQuick also lets you assign a Delayed SFS to projects to handle specific situations in which the bill rate 
changes based on a trigger event (e.g., project retainer balance, recurring amount, unbilled hours or 
unbilled amount). A company can use a Delayed SFS when offering prepaid services that are used up over 
a period. E.g., an IT company can offer a discounted bill rate for purchasing a certain number of hours or 
dollar value of help desk, remote assistance or on-demand consulting services. Employees or vendors 
charge their hours to these prepaid service projects until it exceeds the trigger value. Then onwards, 
BillQuick automatically replaces the regular SFS with the Delayed SFS.  
 
Project and Employee Control 
 
BillQuick’s project control feature lets managers limit who can charge time and expenses to a project. 
The net effect is that drop-down lists are significantly shorter, resulting in faster time and expense entry. 
It also increases data accuracy because there is less chance for error. For example, if you assign three 
employees to work on a construction project, only those employees will see that project in their time 
and expense entry drop-down lists (in BillQuick and in add-on modules). 

 
BillQuick also provides employee control that works with security settings to manage what information 
an employee can view and use throughout BillQuick. It results in faster interaction with BillQuick because 
data is limited to assigned projects, activities and expenses. For example, if you assign John to work on six 
projects, he will see only those projects in all drop-down lists. Employee control ensures that all relevant 
data is available to project managers but confidential data is not accessible to all employees.  
 
Allocation 
 
BillQuick lets you set expectations for how long it should take to complete tasks (allocated hours) or how 
much expenses to incur (allocated units) on each project. This establishes a self-policing process where 
project managers do not need to micro-manage timekeepers and their tasks. Your staff knows what you 
expect from them.  
 
Job Costing 
 
Knowing your project or job costs is very important for the business. It is an important part of project 
management. While calculating the job costs, you must include both the billable and non-billable hours 
worked by your employees on a project. In addition, your project is profitable only if your costs are 
lesser than the amount paid by your client. BillQuick provides you with all the relevant information 
(billable hours, bill rate, non-billable hours and expenses) to calculate and track your job costs, including 
job-costing reports. 
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Cost = Total Hours x Bill Rate (+ Expenses) 
 

Project Reports 
 
Many companies conduct a post-project analysis as part of their continuous improvement strategy. 
Project managers need reports for many reasons and situations, including: 
 

 Tracking work-in-progress for projects 
 Determining whether projects are under or over-budget 
 Comparing the budgeted amount to the actual amount spent 
 Tracking the qualitative information about project progress 
 Reviewing time and expense entries against projects 
 Determining due dates of projects 
 Analyzing billing details of projects 
 Checking staff performance on projects 

 
BillQuick allows project managers and executives to produce project reports on a daily, weekly or 
monthly basis, or simple schedule it for automatic generation and delivery using BillQuick Agent. Using 
these reports combined with qualitative information captured in the project journal and memos, 
managers know what went well and what did not. This helps in making your future clients more satisfied 
and projects more profitable. 
 
Workflow Event Tracking 
 
BillQuick’s built-in workflow event tracking feature enables managers and reviewers track the entire 
submittal-approval process and take the desired action on events. The Workflow screen lets you view 
the status of all submitted, approved or rejected time and expenses, invoices, vendor bills, etc. – all in 
one screen. From here, reviewers and managers can check the details of the event, action taken and 
status.  
 

 See the Project Management chapter for more information and detailed 
procedures. 

 
 

How Does BillQuick Manage My Billing? 
 
Using BillQuick, you can track billable as well as non-billable hours to measure performance, utilization 
and profitability effectively. Non-billable hours may indicate how much time was lost or given away to 
gain or keep the business. Depending upon your preferences, you can choose the frequency and method 
of capturing time and expenses for accurate billing and reporting.  
 
BillQuick provides an accurate and flexible billing system for billing managers, though in some cases you 
may delegate these tasks to accountants or project managers. Billing decisions can be made in real-time 
(on-screen) or through a printed billing report (off-screen). When creating invoices, billing decisions can 
range from ‘no-decisions-needed’ to application of retainers, adjustments, write-ups/downs, discounts, 
etc. After executing billing decisions, you can review and sign off on draft invoices, generate final invoices, 
send them to clients and receive payments. You may produce billing reports on-demand to keep yourself 
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updated on all projects.  
 
BillQuick provides the following solutions and benefits, enabling you to manage your billing: 
 
Time and Expense Tracking 
 
BillQuick allows recording of time and expenses in any screen that suits your timekeepers- Sheet View, 
Simple Time Card, Timer, Expense Log, etc. In addition, several add-on modules (Web Suite, Outlook 
Add-In, etc.) allow them to capture hours worked and expenses incurred from any remote location using 
laptops and smart phones. 
 
Many companies outsource tasks to vendors or consultants. Whether paid an hourly rate or a flat project 
fee, it is beneficial to track their hours for reporting and analysis. This information can help improve 
future estimates, budgets and other decisions. That is why BillQuick allows your vendors to record time 
and expenses with appropriate security permissions. 
 
Submit-Approve 
 
BillQuick’s built-in submit and approve feature enables timekeepers to follow company policy and submit 
time and expenses, invoices, vendor bills, etc. to a designated reviewer or manager. Once submitted, 
BillQuick notifies the managers to review the submitted entries for approval and billing. BillQuick allows a 
chain of reviewers to check entries before a final reviewer approves them. For convenience, you can 
review both time and expense entries in a single Reviewer screen. 
 
The Workflow tracking system gives you the status of all submitted timesheets, expenses, invoices, etc. –
all in one screen. From here, reviewers and managers can check the details of the event, action taken and 
status.  
 
BillQuick Agent includes a tracking feature wherein it monitors time cards and sends reminders to 
delinquent timekeepers. It also alerts the designated manager regarding the same. 
 
Automatic Evaluation 
 
BillQuick does not prevent you from accumulating time and expenses above the contract amount. Nor 
are you prevented from billing more than the contract amount for a fixed-type contract. However, 
BillQuick applies a Red Flag Rule to all time and expense entries charged to fixed-type contracts (except 
Percentage) to determine if it goes beyond the contract amount. If it does, BillQuick changes the status of 
the entry to ‘non-billable’, drawing the attention of employees and project managers.  
 
BillQuick is smart enough to recognize that managers are busy and at times may miss things. Rather than 
inadvertently over-bill clients and likely lose them, the red flag prompts you to check the non-billable 
item. 
 

 See the Time Tracking and Expenses Tracking chapters for more 
information and detailed procedures. 

 
Accounting 
 
To provide your company with day-to-day accounting capabilities, BillQuick provides some core 
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accounting features that make it easier to keep track of financial information. With these capabilities, you 
can create purchase orders, receive items, create and pay vendor bills, write checks, and manage your 
chart of accounts and accounts payable in BillQuick.  
 
BillQuick provides flexible options to billing managers by letting them create purchase orders based on 
budgets, vendor bills based on purchase orders and manual invoices based on budgets and estimates. This 
saves a lot of time and effort when you need to work with the same information. 

 
You gain a major advantage of recording vendor bills in BillQuick because of the ‘Pay When Paid’ feature. 
When your client pays for an invoice, BillQuick includes a link to a vendor bill, prompting you to schedule 
payments to your vendors. In essence, you pay your vendors when your clients pay you. 
 

 See the Accounting chapter for more information and detailed procedures. 
 
Payment Terms 
 
BillQuick lets you specify payment terms to indicate when you expect to receive payments from 
customers. In case of forgetful clients or late payments, you can charge specified interest rates or late 
fees. These user-defined terms are available at the project, client and billing level. 
 
Invoice Formats 
 
An invoice is a marketing document that nurtures client relationships. It must communicate positive 
images to both new and long-term clients: Quality, Capability, Professionalism and Confidence. BillQuick 
offers more than 150 invoice formats for you to choose. These templates support detail or summary 
information, time and expense descriptions, retainers, memos, employee titles, value-added taxes (e.g. 
GST) and so on. BillQuick can even customize these templates for you.  
 
All invoices associated with a specific contract type have their own default invoice format. However, for 
demanding clients, you can assign an invoice template per project. For example, most of your clients may 
like a particular invoice template because it displays detailed memos for each time and expense entry. 
Nevertheless, a certain client wants his invoices to display time entries by activity and without memos. 
BillQuick accommodates all such preferences.  

 
Invoice Numbers 
 
When setting up BillQuick for the first time, managers need to consider whether to start with a new 
invoice format or use the last invoice number from an old time and billing system. BillQuick lets you 
define invoice numbering on a global level or customize it at the project level. You even have the 
flexibility to structure the invoice number so that it has a static and variable portion (automatically 
incremented). For example, you can include the fiscal year in the invoice number as static information 
while the variable will be the incremental part in curly brackets.  

 
Retainage 
 
With BillQuick, you can set a retainage percentage and a maximum retainage amount that a client can 
hold back while making payments on invoices. This is most common in the construction industry, but you 
can find it in any project-centric company. The client pays the accumulated retainage amount later — 
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when the project is over or until the client verifies the quality and completeness of a project. 
 
Rates 
 
One of the best features in BillQuick is the ability to assign an unlimited number of bill and cost rates to 
employees, activities and projects. It supports default bill rates (employee rates), special bill rates (fee 
schedule rates) and activity rates. BillQuick also lets you specify classification or title of employees for 
these rates. After negotiating with clients, project manager or billing manager decides which rate to 
charge. By defining the rates up front, you eliminate non-billable administrative hours otherwise spent 
checking and correcting rate information. In addition, you can allow your timekeepers to record their 
time without any knowledge of the rates.  
 
BillQuick lets you determine the ideal bill rate for producing the target profit per hour, the utilization rate 
of your employees and day rates. Such information is extremely useful in making business decisions. 
 
Taxes 
 
BillQuick handles most of the tax rules in various countries – taxes on time and expense line items, taxes 
on invoiced labor and expense, and taxes on taxes. BillQuick supports taxes at two levels. At the first 
level, there are three item taxes, summed and applied to the pre-tax bill amount. You can modify these 
tax rates during time and expense entry.  
 
At the second level, there are two main taxes on the total invoiced services and invoiced expenses. A 
common example is GST in Canada and VAT or MST in other countries. Item taxes are in addition to 
these main taxes and both taxes carry to the invoice.  
 
BillQuick also lets you specify the taxes paid on purchases and expenses. This is useful in tracking taxes 
paid, taxes collected and the net amount owed to the tax authorities. 
 
Currency Manager 
 
Your business may be located in United States with clients in Canada, Mexico, China, and so on. With 
different countries and foreign currencies, billing can get confusing. However, BillQuick lets you convert 
bill and expense amounts of your home currency to the local currency of the client (or project) when 
generating an invoice. The only time you will see a foreign currency is on the invoices and when 
recording payments. BillQuick reports will always appear in your home currency.  
 
Billing Schedules 
 
BillQuick lets you set up billing schedules to bill clients on a scheduled date for a scheduled amount. 
Depending on your needs, you can define billing records for the entire life of a project or only for the 
initial period of work. While you can define a billing schedule for any contract type, you would most likely 
use it for fixed-type contracts.  

 

 See the Billing Basics chapter for more information and detailed 
procedures. 

 
Billing 
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BillQuick offers multiple and flexible options for billing managers. For initial billing or if in a hurry, you 
may use the wizards; for detailed or advanced billing, Billing Review is the best screen to use. Manual 
Invoice allows you to create quick invoices, with or without time and expense entries.  BillQuick lets you 
determine the net bill amount based on project contract types, billing schedules, write-ups, discounts, 
retainers, fixed fees, retainage, taxes, etc.  

 
You can opt for batch billing when you want to bill records as-is. BillQuick lets you generate percent 
complete invoice using the ‘% Complete’ value of the project. Percent complete billing supports both 
single project per invoice and joint invoicing. You can set BillQuick for automatic billing at the project 
level and memorize invoices for future billing. 
 
You can process and print (or email) invoices in one simple step. Billing can never get so simple and fast! 

 
Writing-Up/Down 
 
When billing a client, a billing manager may recognize that the company was more efficient than normal 
because of investment in new technology and staff training. Conversely, you may recognize that an 
employee or a team was less efficient because of some issues. Alternatively, you may look at the service 
delivered and decide its value is greater for the client than the calculated bill amount. Whatever the 
reason, you can adjust the bill amount of the invoices by writing up or writing down the value of time 
entries. This is especially common in the accounting industry. 

 
Manual Invoices 
 
BillQuick provides options as to where and how billing managers want to generate invoices. While you 
create most invoices using Billing Review, there are situations when Manual Invoice is a better option. For 
example, when you want to: 

 
 Create a quick invoice from an estimate, budget, billing schedule or % Done value for 

activity/expense items 
 Resell software, hardware or other products having no significant services associated 

with them 
 Enter invoices (summary or detail) manually from a previous time and billing system, 

including your old invoice numbers 
 Create an invoice with no time or expenses charged to a project. 

 
Whatever the reason or situation, you can make use of any billing screen in BillQuick and do your billing 
in no time! You can also memorize your manual invoices for future billing. 

 
Billing Reports 
 
BillQuick has a huge collection of useful billing reports. Some billing managers use pre-billing reports to 
speed-up the billing process. Others record billing decisions on the report and hand it off to the 
administrative staff to complete billing. You can use the post-billing reports for analysis and decision-
making. 

 

 See the Billing chapter for more information and detailed procedures. 
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Invoices 
 
BillQuick lets you create, print, email, reverse, edit and finalize invoices in a single Invoice Review screen. 
You can even generate your invoices as PDFs, edit their memos and apply late fees to them. It contains 
everything you need to manage current, historical and draft invoices. BillQuick also support electronic 
invoices, popularly used in European nations. 

 
At times, clients request another copy of an invoice or ask for more or less detail in a different format. 
Using BillQuick, your billing staff can easily reprint or resend invoices directly from Invoice Review, 
without reversing them or changing their settings. You can specify default settings for emailing invoices to 
clients, at the client as well as project level.  
 
Interest and Late Fees 
 
BillQuick lets you define and calculate late fees or finance charges on outstanding invoices based on a 
preferred date. You can define these settings at various levels. If you want a common interest rate for all 
your clients, that can be specified at the global level. For selective interest rates, you can set them up at 
the client or project level. BillQuick generates late fee invoices separately and can transfer them to your 
accounting package such as QuickBooks. 
 
You can record late fee payments in the Payment screen and view them on several reports, such as 
Account Transaction and Cash Receipts Journal. 
 
Payments 
 
Tracking invoices to full payment is a critical task, well handled by BillQuick. Prompt receipt and 
recording of payment results in the most up-to-date information, drives cash flow and other management 
decisions as well as affects future billing decisions. BillQuick lets you record payments in many ways, to 
one invoice or multiple invoices, manually or automatically.  
 
To top this, BillQuick allows secure processing of credit card payments from within the program. You 
can transfer credit card payments into BillQuick or embed an email link into invoices that lets your clients 
make online payments. When you email such invoices to clients, they can simply click on the link and 
make a payment. This saves time and is very convenient. 
 
Credit Memos 
 
You may want to inform your clients that you have reduced their outstanding balance. For such 
situations, BillQuick supports recording of credit memos against client invoices.  
 
Accounts Receivable 
 
To ensure proper cash flow and to lower the risk of reduced profits, it is important to manage 
receivables and track individual invoices for timely collections. You need to set a benchmark and payment 
terms for your clients. To help you, BillQuick displays significant aging information on the dashboard and 
includes various accounts receivable e and aging reports for managers.  
 
The aging reports have client sections that list aged project invoices along with client contact details and 
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project managers. In addition, you can identify payment deficiencies and other issues from reports such as 
Monthly Billing, Cash Receipts, Statements, Collections, etc.  
 

 See the Accounts Receivable chapter for more information and detailed 
procedures. 

 
Retainers 
 
In BillQuick, you can have two types of retainers— client retainers (advance received from client for all 
projects) and project retainers (amount received from client for a specific project). Retainer Management 
maintains a complete history of all retainer activity, including retainer invoices, receipts and application to 
invoices. This information is also available in-context throughout BillQuick from client, project, billing and 
payment records, and reports. You can also memorize your retainer invoices for future billing. 

 

 See the Retainer Management chapter for more information and detailed 
procedures. 

 
 

How Does BillQuick Manage My Business? 
  
It is recommended that everyone in your company who draws a paycheck (including principals and 
executives) should enter time in BillQuick so that you have an accurate accounting of the hours (and thus, 
dollars) invested in your business. This way, BillQuick will be able to send accurate time and other data to 
the appropriate general ledger account in your accounting software.   
 
BillQuick provides the following solutions and benefits, enabling you to manage your overall company and 
business: 
 
Industry Codes 
 
BillQuick lets you select a standard list of activities or tasks based on your industry or business type, 
saving you a lot of effort and time. For examples, if you select ‘Architect’, you will have all the 
architecture related activity codes pre-filled in your company database. 
 
DCAA Compliance 
 
You can set up and operate BillQuick to allow contractors and government agencies to comply with the 
Defense Contract Audit Agency (DCAA) audit requirements. Feature such as password security, audit 
trail, task assignment and monitoring, time tracking, submittal and multi-level approval, reporting, etc. 
meet the DCAA compliance requirements. You can implement standard DCAA Compliant settings 
throughout BillQuick with a single click and set its password (using Global Settings). See the DCAA 
Compliance Guide 2011 for more information. 
 
BillQuick Messages 
 
Using BillQuick, you can send contextual messages to other users based on trigger events. For example, 
project managers can send time card rejection messages to timekeepers when they log in or open a time 

http://bqesoftware.net/media/PDF/BQ/2011/DCAA-Compliance-Guide-2011.pdf
http://bqesoftware.net/media/PDF/BQ/2011/DCAA-Compliance-Guide-2011.pdf


Executive Summary 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 22 

entry screen. Similarly, you can send billing-related messages to billing managers when they open the 
Billing Review screen. This improves communication by notifying, reminding or advising others within the 
context of a task.  
 
Customization 
 
It is a good management practice to determine what information you want on your screens, especially 
when making billing decisions. BillQuick lets you customize the fields displayed in the grids—keep the 
fields you want to view and hide those you do not deal with. For example, do you collect taxes on labor 
or expenses? If yes, turn on the tax fields. Do you want the client ID, project name and activity 
description in the grid as reference information? If no, turn off those fields in the grid. 
 
Besides this, BillQuick allows you to customize the screen labels and fields. You can also choose any 
other UI theme.  
 
File Linking 
 
You can link scanned documents and graphics to BillQuick records like employees, clients, projects, time, 
expenses, purchase orders, vendor bills, etc. For instance, you may want to attach letters, employee 
performance reports, contracts, receipts, consultant invoices,  bills or anything that is digital to records 
for quick reference. Files can be located anywhere on your computer or your company network. The 
benefit is that project managers, principals and others do not have to waste time in looking at different 
places to find important documents related to your current task or project. 
 
Memos 
 
BillQuick lets you record important qualitative or quantitative information about clients, projects, time, 
invoices, payments and so on. For example, a descriptive memo for a time entry can eliminate non-
billable time spent by a billing manager asking or waiting for clarification about an item. That time memo, 
when included on an invoice, would reduce a client’s need to ask for more details. If your company or 
client prefers, you may add memos to invoices that explain the scope of the work and change orders. As 
the invoices change hands in your client’s company, the memos reduce questions by providing useful 
insight into the project’s progress and billing decisions. 
 
Filters 
 
Data analysis and reporting are important aspects of business management. Executives and managers 
have to view many reports to keep themselves updated about their company affairs. They can use filter 
options in BillQuick to perform this task easily and efficiently. 
 
BillQuick lets you limit the number of records displayed in the grids, drop-down lists and reports using 
filters. Filters are very useful data management tools that lessen the task of managing a large BillQuick 
database. You can use advanced filters to view and analyze selective data as per the criteria specified. 
 
For example, your project manager who is responsible for 20 projects out of 700 active ones would 
prefer not to waste time scrolling and scanning hundreds of items in a list. Similarly, you may like to view 
clients with IDs that range from A through N, or only the employees belonging to the Marketing 
department. 
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Finding Information 
 
At times, you need to find records that contain important information, say, a conversation with an 
important client recorded within an invoice memo. You remember typing it into Billing Review memo as 
you talked to a client, but cannot remember the exact date or which client it was. All you do remember 
is a reference to ‘extension’. In BillQuick, searching for information is easy and fast because of the global 
find and quick find features. 
 
Global Find searches all fields for a keyword and displays a list of records that match your criteria, 
whether simple or advanced. Quick Find simply searches records as you type initials or letters in the 
search box. 
 

 See the General Features chapter for more information and detailed 
procedures. 

 
Security 
 
In BillQuick, you can control who should accesses its features, functions and reports. When you turn on 
security, only authorized employees and vendors, having full or selective access, can log into BillQuick 
and its add-on modules. For example, you may grant your staff permission to enter time while managers 
receive more extensive security permissions. This prevents any unauthorized access to your company 
database. 
 
To avoid any hassle and save time, you can use the standard security profiles shipped with BillQuick, such 
as Billing Only, Manager Level Access, Time Entry Only and so on. You can customize these built-in 
security templates to your preference. 
 
To top all these advantages, you can assign security permissions for BillQuick modules and features as 
well as for individual reports. Security is simply built into our BillQuick design!  

 
Roles 
 
BillQuick lets you select organizational roles for your staff members. Based on that, a special role-based 
navigator displays when they log in. This provides easy and authorized access to the frequent tasks 
associated with a role. For example, you may assign a ‘Billing’ role to a billing manager while a ‘Time & 
Expense’ role to a timekeeper.  
  
Log Viewer 
 
BillQuick lets you track all key actions taken by users in the program. Using the Log Viewer, you can view 
actions taken, know who performed them and when they were performed. You can even read the log 
records with a text editor or word processor. BillQuick maintains separate audit log files for each month 
in the same folder as your company database. This feature monitors and encourages user accountability 
by tracking actions over time. 
 
Reminders 
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BillQuick displays system-generated and user-defined messages on the Reminders screen. It informs your 
employees about the actions to take, such as print invoices, approve time entries, process recurring 
invoices, and so on. You can set reminders on Employee and Vendor screens for specific dates and view 
them if security permits you to. As an example, it can remind a manager or supervisor few days prior to 
an employee’s birthday or annual performance review. Alternatively, it can remind you about arranging 
for your next out-of-town meeting and so on. 
 
Groups 
 
BillQuick lets you group employees, vendors, clients, codes and projects based on shared or common 
attributes. This is useful in filtering records included in the grid lists and reports. In addition, groups save 
time and effort when setting up fee schedules, controls and budgets. Some of the common groupings you 
could use include: 
 

 Employees: hired date, department, title, annual review, skills, etc. 
 Vendors: skills, location, ability to travel, etc. 
 Clients: Architects/Engineers – commercial, residential and government 

Accounting Firms – 1040 tax, consulting, litigation support 
Law Firms – contracts, bankruptcy, divorces, real estate 
Computer Consulting – networks, remote maintenance services, solutions 

 Activity Codes: tax services, administrative, marketing, technical, etc. 
 Expense Codes: overheads, taxes, costs, reimbursable, administrative, etc. 
 Projects: type, industry, location, etc. 

 
Archive and Restore Data 
 
Many companies adopt archiving policies. For example, you might archive inactive clients and projects 
every 36 months because its management information value decreases. Reasons companies archive 
clients and projects include: 
 

 To reduce database size by archiving data to another location 
 To speed up database retrieval in Microsoft Access 
 To have faster information for management  
 To manage and report more recent information 

 
BillQuick lets you archive (and restore) client and project data, and run reports on the archive database.  
 
Backup, Restore and Repair 
 
In this age of information technology, where right information is the most important tool for any business, 
you would not want to lose it at any cost. BillQuick provides a built-in backup utility for Standard/Access 
databases. This is required to safeguard your data against a damaged company database (e.g. after a 
power loss or computer failure) or before making significant changes to your data. Backup copies allow 
you to restore data in case you change your mind about the changes or if your data is lost or damaged.  
 
In addition, BillQuick provides built-in tools that attempt to repair a damaged database (MS Access and 
SQL) and protect the information stored in it. To guard against time delays resulting from database 
corruption, Repair Database utilities are valuable.  
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Settings and Preferences 
 
To optimize BillQuick based on your company size, business goals, management styles and policies, you 
can choose various global settings, business rules and user preferences. For instance, you can specify your 
preferences regarding time and expense tracking, billing and invoices, taxes, emailing, UI and so on. Thus, 
you can control how BillQuick works for your company and employees.  
 
Data Exchange 
 
BillQuick lets you enter, import or convert data into your company database using its import-export, data 
conversion and data integration utilities. You can also export data to other supported programs. 

 
In BillQuick, you can export documents such as invoices, reports and statements to Microsoft Excel, 
Microsoft Word, PDF and other formats. You can also exchange data with another program using 
Import-Export utility. For instance, you may want to export time data to an external payroll service or 
program. Additionally, if you work with two different BillQuick companies, you can export the client list 
from one company and import it into the other.  

 
BillQuick includes built-in data conversion utilities that convert important data from your old system 
(Wind2/Deltek FMS and Timeslips) into BillQuick company database. This allows you to get up and 
running in no time if you have shifted from an old time billing or accounting system to BillQuick. If you 
need to convert or transfer data from another application to BillQuick but do not have the time or 
technical expertise to do so, you can use our exclusive and customized Data Conversion Services.  

 
If you have not been using any accounting package nor have any electronic data to convert into BillQuick 
data, you can manually enter and set up historical invoices, payments and opening balances using Manual 
Invoice feature.  
 
BillQuick Family of Products and Add-Ons 
 
BQE Software offers other stand-alone products and add-on modules that can help you manage your 
company better by expanding BillQuick’s core capabilities. According to your requirements and 
situations, you can decide to use these smart tools and modules, increasing your productivity and overall 
profitability. 

 
 BillQuick Online is a subscription-based, hybrid Software-as-a-Service (SaaS) model of 

BillQuick desktop that is hosted by us. It provides you with a secure, hassle-free, 
investment-free time tracking, billing and business management software. 
 

 Web Suite is a browser-based version of BillQuick ideal for companies with satellite offices or 
staff, managers and consultants working remotely. Some companies deploy Web Suite inside 
their company to cut the total cost of ownership.  
 

 If you and your employees are using Microsoft Outlook and tend to keep very busy, you can 
deploy BillQuick Outlook Add-In in your company. These smart programs convert your Outlook 
appointments, emails and tasks to time entries in BillQuick with as little as a few mouse clicks.  

 
 You can utilize BillQuick Agent for scheduling BillQuick reports for automatic generation and 

http://www.bqe.com/Services.asp?pageId=Convert
http://www.billquickonline.com/Default.asp
http://www.bqe.com/ProductOverview.asp?prodId=WS
http://www.bqe.com/ProductOverview.asp?prodId=OL
http://www.bqe.com/ProductOverview.asp?prodId=AG
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delivery to anyone inside or outside your company via email or onscreen. Besides this major 
advantage, Agent is useful for monitoring time cards and generating business alerts. It 
automatically tracks the changes in the database that signal a special situation or an event that 
requires your immediate attention and sends relevant alerts.  

 
 Human resources are the most important resource in any organization and hence need special 

attention. Our BillQuick HR product enables you to manage your employees and fulfill the 
associated human and legal obligations. 
 

 If you are using QuickBooks and want a reporting tool that automates tasks, then AutoReporter 
is just right for you. With it, you can generate QuickBooks reports, memorize filters and formats 
to standard reports and schedule them for automatic processing. 
 

 To learn more about other BQE products, please visit 
www.BQE.com/Products.asp. 30-day trial versions of add-on modules and 
stand-alone applications are available here. To purchase, contact Sales at (310) 
602-4020. 

 

 See the Company Management chapter for more information and detailed 
procedures. 

 
Document Management 
 
BillQuick provides a desktop solution to managing and storing your entire client and project-related 
documents, such as contracts, engagement letters, spreadsheets, tax returns, financial statements, CAD 
files, etc. Using Document Management feature, your company can handle client and project documents, 
folders and emails within BillQuick. It lets you define any desired folder structure that makes sense to 
everyone in your company.  

 
Email 
 
BillQuick’s Document Management screen lists your client emails. In addition, you can link email folders 
from Microsoft Outlook (2000 or later) or Outlook Express (6.0 or later) to a client or project and then 
view them directly from BillQuick. This is a time saving feature as it lets you work in one smart system. 

 
BillQuick also lets you send purchase orders, vendor bills and invoices via email directly from BillQuick. 
You can customize the default message as well as other email settings according to your preferences in 
the Global Settings and Preferences screens. 
 
Dashboard 
 
The Dashboard is the most valuable and useful feature in BillQuick for decision-makers and executives. 
Rather than run through menu commands, set filters, run reports and then read them one after another 
to find exceptions and visualize trends, the dashboard lets you view important business metrics at-a-
glance. 

 
Using the dashboard, you can: 
 

 

http://www.bqe.com/ProductOverview.asp?prodId=HR
http://www.bqe.com/ProductOverview.asp?prodId=AR
http://www.bqe.com/Products.asp
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 view rankings of top performers – clients, projects, employees, etc. 
 view account balances, aging, money owed, aged receivables and other summary 

information for your projects 
 view oddities in annual trends, presented as simple bar charts 
 use funnel filters to specify conditions and display selective data 
 use advanced Boolean conditions through the custom funnel filters to fine-tune the lists 

to exactly what you need and want to view 
 drill-down to reports that support the summary information in charts or lists 
 find out your staff’s effective rate and utilization rate 

 

 See the Project Management chapter for more information and detailed 
procedures. 

 
Accounting Integration 
 
You may be using a software application for accounting and other financial functions such as general 
ledger, accounts payable, banking and financial reports. However, BillQuick provides you with excellent 
project and business management solutions such as time and expense tracking; management of projects, 
job costs and receivables; generation of invoices and reports; and so on. To offer you the best of both 
worlds, BillQuick lets you integrate your BillQuick data with a supported accounting package such as 
QuickBooks, Peachtree Accounting and MYOB. 
 
With this feature, your day-to-day accounting and financial management tasks become easier. Integrating 
the two applications provides benefits such as elimination of duplicate data entry, transfer of QuickBooks 
classes into BillQuick prior to synchronization, assignment of G/L accounts to BillQuick items, etc. 
 

 See the Accounting chapter for more information and detailed procedures. 
 
Reports 
 
Reports contain information that is important and useful to a company, especially its executives and 
decision-makers. Typically, managers follow a standard pattern when it comes to reviewing information. 
Contract spent and budget comparisons may be daily or weekly reports. Job costs, work-in-progress and 
unpaid invoices may be biweekly. After monthly billing, managers may check profitability, work-in-hand 
and analysis reports.  

 
BillQuick offers more than 400 standard reports that can be printed, previewed, emailed and exported. 
There are reports corresponding to the charts and graphs that display on the navigators and the 
Dashboard, besides the statements and collection letters. For your convenience, BillQuick lets you access 
in-context reports from almost all screens.  
 
You can use report filters to limit the number of records or data displayed on the reports. For example, if 
you make activities or expenses billable to a project, the Project Time and Expense Report initially shows 
unbilled costs for all projects and for all dates. This is too much information if all you want to see is last 
year’s unbilled costs to one of the projects. You can use the Date and Projects Filters to print last year’s 
Project Time and Expense report for a particular project.  
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You can tag reports as favorites or memorize any regularly viewed or printed report to save time and 
effort. For example, you may memorize a profit or a staff utilization report that shows the previous 
month’s information. Better than that, BillQuick Agent can be used to schedule BillQuick reports (or 
others created with Crystal Reports) to be generated and delivered on any frequency to any email or postal 
address. 

 
You can customize our editable collection letters (Word templates) to your company preference. 
BillQuick also allows limited report customization such as sorting data, suppressing items, changing font 
and style of the report. It lets you customize or create BillQuick reports using Crystal Reports 9.0 or 
later. Alternatively, you can have them customized by our Custom Reports Team.  
 

 See the Report Management chapter for more information and detailed 
procedures. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 
 

http://www.bqe.com/Services.asp?pageId=Reports
mailto:BQ-Ideas@bqe.com
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Overview 
 
A ‘BillQuick Supervisor’ is responsible for planning and implementing the initial setup and deployment of 
BillQuick. After installing the software, follow it by setting up a company database and activating the 
program. You should follow a plan, ideally a written plan, to ensure all preliminary and necessary tasks 
are completed and checked off. 
 

Implementation Checklist 
 
This Implementation Checklist outlines the steps to follow in order to deploy BillQuick in your company. 
Typically, a BillQuick Supervisor will use it when setting up BillQuick. 
 

Check  Stage Task Details 

 Pre-Installation Assign BillQuick 
Supervisor (s). 

Person responsible for the setup and management of 
BillQuick in the company 

 Installation  
BillQuick Supervisor  
BillQuick User 

Check system 
requirements. 

Software and hardware system requirements 

Install BillQuick. Installation on a single PC 
Installation on multiple PCs (would depend on the 
number of licenses purchased) 

License and register 
BillQuick. 

Activate, license and register the software for 
unlimited use. 

Create a company 
database.  

Place the company database in a folder on a shared 
drive.  

Get started with 
BillQuick Start-Up 
Interview.  

Provide information such as Company Name and the 
license and registration keys. Do not import from 
Timeslips or integrate with QuickBooks at this time. 
Skip the BillQuick Initial Setup Checklist wizard. 

 Pre-Implementation Define ID structures. Develop standard ID structure for employees, 
projects, clients, activity and expense codes.  

Determine source of 
data. 

Sources include: (a) QuickBooks or another 
accounting package with which BillQuick integrates, 
(b) Timeslips or Wind2/FMS for which BillQuick 
includes conversion utilities, (c) Any application from 
which BillQuick imports 

 Master and Other 
Information Setup 

Add data into BillQuick. Based on the source, transfer or enter data. If a 
BillQuick Consultant converts your data, you will 
receive a BillQuick database (see Master Information 
Setup for more). 

Verify key information.  Check receivables and WIP reports to ensure data 
accuracy and completeness. 

Set up company. Enter Company data.  
Set Custom Labels and terminology. 

Set up master records Enter Employee, Client, Project, Activity and 
Expense Codes data. 
Specify Manager for clients, projects and employees.  
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Check  Stage Task Details 

Set up groups for clients, projects, employees, 
activity, and expense codes. 
Set bill and cost rates for employees and vendors. 
Enter Contract Type and Amount for each project.  

Assign Security 
permissions to users. 

Supervisor to set up security profiles and assign 
access permissions to employees and vendors 

Specify roles. Supervisor or Manager to specify employee roles 

 Installation and 
Setup of Add-On 
Modules (optional) 

Check system 
requirements. 

Check that PCs/server meets software and 
hardware requirements. 

Install add-ons products.  Follow order of installation: Web Suite, Outlook 
Add-In and Agent.  

 Pre-Deployment Specify settings and user 
preferences 

Assign Global Settings, Preferences and other 
settings.  
Set BillQuick to be DCAA Compliant. 

Specify time and expense 
review and approval 
procedure. 

Whether submit and approve or auto-approve 
setup? If submit and approve, then decide who 
reviews administrative time and billable time 
submitted by employees and vendors. 

Review invoices.  Review your current invoices and BillQuick invoices 
to identify which ones to use or customize.  

Review reports. Review BillQuick reports and determine which ones 
to use for executives, project managers, billing 
managers and staff.  

 Staff Training Identify training needs of 
each group. 

BillQuick Supervisors, Administrators, Principals, 
Partners, Project Managers, Billing Managers  
Staff, Timekeepers, Employees, Vendors 

Train employees. Develop internal self-training or utilize BQE’s 
Training and Consulting Services. 

 Deploy BillQuick Manage projects. Assign Project Control, Budgets, Fee Schedules, etc. 
Maintain folders, journals, memos, etc. 

Enter time and expenses. Record time and expense entries in BillQuick 

Manage billing functions. Process bills and send invoices to clients. 
Track payments and accounts receivable. 

Generate and view 
reports. 

Get the required information from standard and 
custom reports. 

 
 
 
 
 
 
 
 

 

http://www.bqe.com/Services.asp?pageId=Training
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BillQuick Installation 
 
The BillQuick Supervisor may install BillQuick in a company or allocate an IT/System Administrator to do 
so. According to your situation, you need to follow a procedure for installing BillQuick software. Choose 
the relevant procedure: 
 

 System Requirements for Installing BillQuick 
 Installing BillQuick for the First Time 
 Installing BillQuick in a Network Environment 
 Installing BillQuick with Microsoft SQL Server/ SQL Express 
 Upgrading BillQuick from a Previous Version 
 Upgrading from Time and Bill Professional 
 Updating BillQuick 
 Upsizing to BillQuick Enterprise 

 
 

System Requirements for Installing BillQuick 
 
For successful installation and implementation of your BillQuick software, be sure your computer systems 
meet or exceed the requirements mentioned below.  
 
Hardware Requirements 
 

 2.0 GHZ Intel Pentium IV-class processor or faster 
 1024 MB RAM  
 300 MB or more of hard disk space, plus 130 MB additional hard disk space for 

installation 
 1024 x 768 screen resolution or more 

 
Software Requirements 
 

 Microsoft Windows XP/2003/2008/Vista/Windows 7 
 Microsoft Windows 2003 Server/2008 Server 
 Compatible with 32 bit or 64 bit operating system (dual compatibility) 
 Microsoft .NET Framework 2.0 or later (automatically installed with BillQuick)  
 Microsoft SQL Server 2005 or later (for BillQuick Enterprise edition)  
 Microsoft Data Access Components 2.8 or later (automatically installed with BillQuick) 
 Microsoft Windows Installer 3.0 or later (typically installed or updated with Windows) 
 Microsoft Internet Explorer 6 or later (for accessing BillQuick website) 
 An Internet connection with a 256 KBPS or faster modem, DSL, cable modem or other 

broadband connection (for accessing BillQuick website and for Automatic Updates) 
 

 For more, please check the BillQuick Help and BillQuick Getting Started 
Guide. 

 
 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Getting-Started-Guide-2011.pdf
http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Getting-Started-Guide-2011.pdf


Installation 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 33 

Installing BillQuick for the First Time 
 
Please follow the steps below to install BillQuick on a single computer. 
 

1. If you received a BillQuick 2011 CD, insert it in your drive. If the installation program does not 
start automatically, click Start on the Windows task bar. Choose Run from the Start menu, and 
type: ‘x:\BillQuick2011Setup.exe’ without quotes (where x is the CD drive letter). 

 
2. If you downloaded BillQuick from the website as a compressed archive file, use a Zip program to 

extract the file into a work folder or desktop.  
 

 
 
 

3. Right-click on the setup icon on your desktop and 
click Open.  
 

4. When the first BillQuick installation screen appears, 
read the information and follow the instructions on 

each screen by clicking . 
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5. Accept or modify the User Name and Organization. Click . 
 

6. The Destination Folder screen allows you to accept the default directory path for BillQuick or 

enter a new path. To accept the default, click . To change the path, click . 
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7. On the Change Current Destination Folder dialog, enter the desired path or navigate to the 

folder where you wish to install BillQuick. Click , then click . 
 

8. Installation begins and you can see the progress bar. When the Finished screen appears, click 

. Restart your computer to complete the installation. 
 
 

Installing BillQuick in a Network Environment 
 
In a network environment, you must install BillQuick software on the computer of each person who 
needs to access it.  
 

1. On the computer used by your primary BillQuick user (BillQuick Supervisor), install BillQuick (as 
explained above). 
 

2. Create a BillQuick database and activate it (see below for details). Make sure the BillQuick 
database is in a shared folder. 

 
3. Install BillQuick on the other computer from which you want a user to access it (follow the steps 

above). Start BillQuick.  
 

4. Select File menu, Open Company and navigate to the shared folder.  
 

5. Select your BillQuick database. BillQuick remembers the location each time you open it.  
 

6. With the database open, select 
File menu, Registration. Enter the 
registration key from the email 

you received. Click .  
 

7. Repeat the above steps on each 
computer from which users will 
access BillQuick. 

 
 

 BillQuick also works in other network scenarios. Contact BillQuick Support 
for more information (310-602-4030). 

 
 

Installing BillQuick with Microsoft SQL Express/SQL Server 
 
BillQuick installation does not require SQL Scripts or special items to create a SQL Server/SQL Express 
database for your company. All logic is built into BillQuick. 
 

 Support for full SQL Server as backend is available in the BillQuick 
Enterprise edition only. 
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1. Install and configure Microsoft SQL Express/ SQL Server before installing BillQuick. Specifically: 
 

 Make sure to enable TCP/IP and Named Pipes for the SQL instance to which you are 
connecting. 

 Make sure SQL browser is running. 
 If you receive Error 5, it is possibly a network or firewall issue. Please check all firewalls 

(including Windows) and make sure to add either port 1433 or BillQuick as an exception. 
 

2. Install BillQuick on the primary computer that is accessed by the Supervisor. (See above.) 
 

3. Start BillQuick and go to File menu, New Company, SQL Server Database. 
 

4. Enter the Server Name, User ID, Password and Database Name. Typically, the database 
name is similar to the company name.  
 

 
 

5. Click OK to create the database. 
 

 If you receive error messages or have any other trouble connecting to the 
SQL Server during BillQuick installation, please look up our Knowledgebase for 
related issues. Else, contact our Technical Support at (310)602-4030.  

 
 
 
 
 
 

http://www.bqe.com/BillQuickKB/kb.aspx
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Upgrading BillQuick from a Previous Version 
 
BillQuick 2011 installs as a separate application from your current version of BillQuick. However, you can 
upgrade your current version or simply uninstall it. If you wish to uninstall it, do so from Control Panel, 
Add/Remove Programs. When upgrading from one version of BillQuick to another, it does not retain 
your personal settings and report mappings. 
 
If you had been using a MSDE or SQL Server database, BillQuick will create a newly converted database, 
with the same name as the existing one but with ‘2011' concatenated at the end. It will leave the previous 
database as a backup in the pre-2011 format. In the case of MS Access database, BillQuick will 
automatically make a copy of your database that is compatible with your current version. In addition to 
your main database, BillQuick will upgrade your archive file.  
 

 Please make sure that other users have logged off from BillQuick prior to 
converting your database and they stop using the previous version to prevent 
having to re-enter any data. 

 
Please follow the steps below to upgrade to BillQuick 2011:  
 

1. Install the new version of BillQuick (see Installation above). 
 

2. On the Destination Folder screen, double-check the default directory to make sure it is not the 
same one as your old version of BillQuick. You must install BillQuick 2011 in a separate folder 
on your hard drive. 

3. Double-click  on your desktop to start the application. 
 

4. As you have already been using a previous version of BillQuick, it will prompt you to upgrade 

your database. Click .  
 

5. BillQuick will now make a backup of your previous database and then convert it to BillQuick 
2011.  
 

6. When conversion is complete, you are prompted to copy any custom reports or invoice 
templates created in the previous version to the new location. In addition, if Global Settings is 
pointing to a common folder other than the install folder, BillQuick will reset it to the install 
folder. 
 

7. Next, BillQuick will prompt you to license and register your application. Choose ‘Already 
Purchased’ option on the Product Activation screen.  

 

 For more, please see the Upgrade to BillQuick 2011 whitepaper. 
 
 

Upgrading from Time and Bill Professional 
 
If you have been using Time and Bill Professional, you can easily upgrade to BillQuick. To do so: 

http://bqesoftware.net/media/PDF/BQ/2011/Upgrade-to-BillQuick-2011.pdf
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1. Open your Time and Bill Professional application and look at its status bar at the bottom. It 
displays your current database location and name (say, C:\ Program 
Files\TimeandBill\mycompany.mdb). Please make a note of your database location. 
 

2. Install BillQuick (see above sections for details). 
 

3. Copy your Time and Bill Professional database (with .mdb extension) from its current location to 
the folder where you installed BillQuick. Typically, you install BillQuick in C:\Program 
File\BillQuick2011 folder. 
 

4. Run BillQuick and when prompted, select ‘Open an Existing File’ option. 
 

5. Point it to the BillQuick installation folder and open the database that you just copied. 
 

6. After you have successfully opened your database in BillQuick, you can uninstall the Time and Bill 
Professional application from your computer. 

 
 

Updating BillQuick 
 
When you purchase BillQuick, periodic updates containing bug fixes, minor improvements and new 
features are available free. You can see which version you have installed by selecting Help menu, About 
BillQuick.  
 
To receive updates:  
 

1. If you have an Internet connection on your computer, BillQuick automatically checks for an 
update each time you start it up. If a new update is available, it prompts you to download the 
update.  
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2. You can disable automatic updates on the Preferences-Options screen (Settings menu). When 
disabled, you must manually check for updates using Help menu, Get Updates. 
 

3. You can view the download size and the detailed list of changes made in the update. Click on the 
link provided to read the associated log file. Else, click the Download button to start the 
download.  
 

4. Once BillQuick downloads an update, it prompts you to install it. Click  to do so. 
 

 A System or Network Administrator should install the update by running 
the BQUpdate.exe program on each workstation. 

 
 

Upsizing to BillQuick Enterprise 
 
Over time, most databases become more complex and need to support more users. Microsoft has 
designed the Access database for 1 to 4 users to log in consecutively. Beyond that threshold, Access 
databases can become unstable and the file can become corrupt. BillQuick utilizes the Microsoft 
Access/Standard database, which can support a growing organization, but at some point, speed may 
become an issue. Hence, you should consider upsizing to SQL Express or SQL Server database that uses 
BillQuick Pro or Enterprise editions.  
 
General guidelines for database selection are: 
 

Users Recommended Database BillQuick Edition 

2 to 4 Microsoft Access/ 
Standard 

BillQuick Basic 
BillQuick Pro 
BillQuick Enterprise 

5 to 50 Microsoft SQL Express BillQuick Pro 
BillQuick Enterprise 

50 or more Microsoft SQL Server BillQuick Enterprise 

 

 If you are not comfortable installing and configuring SQL on the server or 
PC, a BQE Consultant can help you for a nominal fee. Please contact BQE sales 
at (888) 245-5669 (outside USA +1 (310) 602-4020) or check our Consulting 
Services for more information. 

 
BillQuick includes a utility to convert your Microsoft Access database to Microsoft SQL. However, this 
requires a new license key. The Upsize feature also up-sizes your accounts payable data, if any.  
 
To upsize to BillQuick Enterprise: 
 

1. After installing Microsoft SQL and BillQuick Enterprise, open your existing BillQuick 2011 
database. 
 

2. From the File menu, select ‘Upsize to SQL Server’. 
 

http://www.bqe.com/Services.asp?pageId=Consulting
http://www.bqe.com/Services.asp?pageId=Consulting
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3. In the ‘BillQuick SQL Database’ screen, enter the SQL Server Name, User ID, Password and 
Database Name of the new BillQuick Enterprise database. The User ID must have system 
administrative (SA) rights on the SQL Server.  
 

 
 

4. Enter or click  to browse for the location where these SQL database settings will be saved. 
Click OK. 
 

5. A progress bar and message indicates the upsizing activity. You will receive error messages if the 
connection is not established. Sometimes, due to slow network speed or server, the upsizing 
may not be successful. If so, use SQL Server Enterprise Manager to delete the database and try 
again.  
 

Upon completion, BillQuick creates a log file (bqsqlerr.txt) containing the details of the success events and 
errors encountered during the upsizing process. Please review the file to determine the severity of the 
errors.  
 
 

Company Database 
 
The BillQuick Supervisor is responsible for setting up the BillQuick company database and master 
information. You can also assign this responsibility to an IT/System Administrator. 
 
This section teaches you the following initial setup tasks: 
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 Creating a New Company Database 
 Setting-Up a Company Database 
 Activating BillQuick 

 
 

Creating a New Company Database 
 
To start up BillQuick, do one of the following: 
 

 In Windows, click Start and select Programs from the menu. From the program list, 
choose BillQuick 2011.  

 On your desktop, double click . 
 
The first time you start BillQuick, it will prompt you to select a company file and database type. Creation 
of BillQuick database requires system administrative privileges. Typically, a BillQuick Supervisor (or an IT 
Administrator) handles this task and then informs the other users about its location, User ID and 
Password (if applicable).  
 

1. Click on ‘Create a New Company File’ option.  
 

 
 

 You can create a new company file in a Standard database (Microsoft 
Access) or SQL Server (SQL Express or SQL Server). Your options depend on 
which edition of BillQuick you have purchased - Basic, Pro or Enterprise. 
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2. Select the correct database option. (To choose SQL, make sure you have already installed and 
configured SQL database.)  
 

3. Navigate to the folder where you want to store your company database. If you are in a network 
environment, this should be a shared folder. Place this file in a safe location such as My Documents. 

 

4. Enter a name for your BillQuick company database and click . 
 

5. You will receive a message confirming the successful creation of your database. Clicking 

 will launch the BillQuick Start-Up Interview wizard. 
 

6. You can skip it or step through it without worrying about your selections. You can change them 
later. Click Finish and exit. 
 

 In specific situations, you might have to close the BillQuick database 
connection for a logged-in user. E.g., If a user is logged into BillQuick for more 
than 48 hours, use the ‘Force Close DB Connection’ option (from Utilities 
menu) to force the BillQuick connection to close.  

 
 

Setting-Up a Company Database 
 
After creating a new database, you can add your company information to it in the following way: 
 

1. When you create a new database, it prompts you with a BillQuick Start-Up Interview. Else, select 
it from the View menu, Wizards or Sidebar, Wizards.  
 

2. On the BillQuick Start-Up Interview screen, click Next.  
 

3. On the Business Type screen, choose your industry type, such as Business Consultant, 
Accounting, Computer Programming, etc. BillQuick copies industry-specific activity (service) and 
expense codes into your company database. Click Next.  
 

4. Custom Labels allow you to change key business terms to suit your professional and company 
preferences in BillQuick. Select your preferred terms from the drop-down lists, such as 
Customer instead of Clients, Jobs instead of projects and so on. When you are done, click Next. 
 

5. On the Company Name panel, enter your company name. Spell it exactly as it appears in your 
License and Registration email. 
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6. Click Next to accept the defaults on the remainder of the screens. You can update these options 
later in the Global Settings and Preferences screen. On the last panel, click Finish. 

 
7. After the Interview is over, you will be taken to the Data Import screen if you selected ‘Yes’ for 

importing data from Timeslips. Skip this for now. 
 

8. The BillQuick Initial Setup Checklist screen displays. It enables the first time user to create master 
information (employee, client, project, activity and expense codes) by clicking on the relevant 
option.  
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9. When you are done, click Close to exit. 
 

Once you have successfully created your database, BillQuick prompts you for product activation and 
login. 
 
 

Activating BillQuick 
 
When BillQuick is in the evaluation mode or un-licensed, the Product Activation screen displays. It 
provides various options.  
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 ‘Activate Now’ allows you to obtain an evaluation key. 
 ‘Activate Later’ allows you to continue working with BillQuick during a 7-day free trial. 

After this period, you must obtain an evaluation key or purchase a full software license.  
 ‘I am Ready to Buy’ option allows you to provide your details to BQE Software. This is 

how BQE Software will contact you with your license and registration keys.  
 ‘Already Purchased’ option allows you to license and register your BillQuick software. 

(See License and Registration below for details.) 
 
 

License and Registration 
 
BQE Software provides various options for licensing and registering your copy of BillQuick. You can use 
the Product Activation, Company or Product Licensing and User Management screen in BillQuick to do 
so. The BillQuick Supervisor usually licenses and registers the BillQuick software. 
 
Select your scenario and move on: 
 

 Licensing and Registering BillQuick for the First Time 
 Licensing BillQuick and Add-Ons 
 Updating a License Key 

 
 

Licensing and Registering BillQuick for the First Time 
 
If you have successfully created your company file and received the Product Activation screen upon 
opening BillQuick, follow these steps to proceed: 
 

1. When you are ready to purchase and license BillQuick, click ‘I Am Ready to Buy’ option. 
 

2. Purchase your license from the BillQuick website or call BQE Software at (310) 602-4020 to 
speak with a BillQuick Account Rep. You will receive your license and registration keys via email 
at the email address that you provide. 
 

3. After purchasing a software license, click ‘Already Purchased’ on the Product Activation screen. It 
asks for your company name, license key and registration key.  
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4. Using the email you received, enter or cut-and-paste the keys. It should be exactly as you see in 
the email (if you want to change your company name, contact your BillQuick Account Rep). 
  

5. Click Register. You have now licensed BillQuick for unlimited use. 
 

 When you evaluate other modules in the BillQuick Family, you can run the 
evaluation software and licensed software together.  

 
Alternatively, you can register BillQuick using the Company screen. To do so: 
 

1. Open the Company screen from the View menu.   
 

2. Enter your company name on its General tab. It should be exactly as printed on the email you 
received. Click Save. 
 

3. On the Licenses tab, enter or cut-paste the License Key from the email.  
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4. Click Tools and select Validate License Keys, and then click Save. It displays the No. of Licenses 
and Edition purchased by you. 
 

5. Again, click Tools and select Register 
Software.  
 

6. Enter or cut-and-paste the Registration 

Key from your email. Click .  
 
 
You have successfully licensed and registered your BillQuick! 
 

 In a networked environment, the Supervisor needs to repeat the same 
procedure on each computer. 

 
 

Licensing BillQuick and Add-Ons 
 
When you have to license BillQuick as well as add-on module(s), it is convenient to use the Product 
Licensing and User Management Console instead. You can license your software from any PC on a 
network that has BillQuick installed on it. Typically, you would do it from a computer assigned to the 
BillQuick Supervisor.  
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To license BillQuick using the Console: 
 

1. Open the Product Licensing and User Management screen from the File menu. 
 

2. Enter the license key against the relevant product (BillQuick) on the Licenses tab. 
 

 
 

3. Click Update to save the license information.  
 

4. Move to the Users tab. You can grant employees and vendors access to BillQuick and other add-
on module(s) by marking the checkbox in the appropriate column.  
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Alternatively, you can select row(s) and use the right-click menu or button panel to Assign or Un-
Assign user(s) to an application. 

 
5. Choose the desired Security profile for an employee or vendor from the list, e.g., Full Access, 

Time and Expense Only, Billing Only and so on. If you prefer to select individual security 
permissions for employees or vendors, click Security to do so from the Security screen. 
 

6. When you are done, click Close to exit. 
 
 

Updating a License Key 
 
BQE Software provides new license keys 
 

 when you change your company name (spelling, punctuation, etc.) 
 when you purchase additional user licenses for BillQuick 
 when you upgrade to a new version of software (e.g., from BillQuick 2010 to BillQuick 

2011) 
 
To update your license key: 
 

1. Open the Company screen from the View menu. 
 

2. Click the Licenses tab. 
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3. Enter the new License Key received from BQE Software in the field provided or cut-
paste the same from the License and Registration email. 
 

4.   Click Tools and select Validate License Keys, and then click Save. It updates the No. of 
Licenses and Flavor (software edition) purchased. 

 
5. When you are done, click Close. 

 

 If you type the License Key or Company Name incorrectly, an error 
message displays. Enter the information again. If the error persists, contact 
BillQuick Support at (310) 602-4030 or Support@bqe.com. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 
 

mailto:Support@bqe.com
mailto:BQ-Ideas@bqe.com
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BillQuick Basics 
 
After installing BillQuick, you need to have an understanding of the basic options and procedures related 
to login, navigation and other general features.  
 
This section covers the following basic topics: 
 

 BillQuick Login 
 Navigation 
 Grids 
 Filters 
 File Linking 
 Printing Reports 
 Using Wizards 
 Using Calendars 

 
 

BillQuick Login 
 
Once you have successfully created your company database and turned on security, BillQuick will prompt 
you for a login. Supervisor and other users of BillQuick – employees and vendors – need to log into the 
program to access its functions and features. 
 
By default, the Employee ID of a user is also its login (User ID) and password. If you change the 
Employee ID of a user, the User ID is also changed. You can change the login password as needed (see 
Setting and Changing Passwords in the Company Management chapter) and make them case-sensitive (from 
Global Settings-Rules screen). 
 
BillQuick allows you to specify a separate Login ID per user in the Employee screen (or Vendor screen). 
E.g., a user ‘Curtis James’ may have an Employee ID ‘CJ’ and Login ID ‘Curtis’. 
 
You can choose between the following login options: 
 

 Logging into Standard Database 
 Logging into SQL Database 

 
 

Logging into Standard Database 
 
The BillQuick Login dialog displays the company name and database location. To log into BillQuick 
standard database, note the following: 

 
1. For the BillQuick Supervisor, the default User ID and Password is ‘Supervisor’ (without quotes). 

Please change the Supervisor password before deploying BillQuick in your company. 
 
 
 



General Features 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 53 

2. Enter your User ID and 
Password provided by the 
Supervisor.  
 

3. When only one person uses a 
particular computer, mark the 
Remember checkbox to make 
your User ID the default.  
 

4. Click OK to access BillQuick. 
 
 
 
 

Logging into SQL Database 
 
If you are using a SQL Server database, you have to log in with correct User ID, Password and other 
information. SQL Server will not complete a connection unless it has verified your login ID, a process 
called authentication.  
 

 
 

 Support for full SQL Server as backend is available in the BillQuick 
Enterprise edition only. 

 
When BillQuick Enterprise creates or up-sizes a database on the SQL Server, it creates two logins:  
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 BillQuickSQL with password ‘admin’ 
 BillQuickGuest with password ‘Guest’ 

  

 You can change the password of BillQuickSQL User using Global Settings 
from the Settings menu. 

 
The BillQuickGuest user has read-only access to the database while the BillQuickSQL user has full access 
to the database. 
 

 Do not delete or change these two logins and their privileges. If deleted, 
the application will not be able to connect to the SQL database. 

 
BillQuick allows you to connect to the SQL Server via  
 

 Windows Authentication (Trusted Connection): establishes connection to the SQL Server using the 
Windows Logon credentials (i.e. Windows User ID and Password). It does not need your login 
ID.  

Or 
 

 SQL Server Authentication (Standard Security): establishes connection to the SQL Server using your 
assigned SQL Server login ID and password. 

 

 See BillQuick Help -Introduction-Database Options section for more on 
SQL Login & Authentication. 

 
 

Navigation 
 
Anyone familiar with Microsoft Windows and Microsoft Office will find BillQuick easy to use. Role-based 
and standard navigators, menus, sidebar, icon toolbars, action buttons, screen layouts, spreadsheet-like 
grids, shortcut keys and other user interface elements look and feel like these applications.  
 

 Security permissions determine what features, functions and information a 
user can view and access on the navigators, toolbars, menus and screens. 
BillQuick disables (grays out) unavailable items. 

 
Besides navigation, you can also do the following in BillQuick: 
 

 Navigating in BillQuick 
 Customizing BillQuick 
 Accessing Help and Support 
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Navigating in BillQuick 
 
After logging in to BillQuick, you can access various screens and functions of the application using any of 
the several navigation options provided by BillQuick. Many new users start with a role-based navigator. 
As they gain experience and their needs change, they use menus, toolbars, standard navigators, 
dashboard and sidebar. The status bar at the bottom of the screen displays the database location and 
highlights any process related message. 
 
Like all Windows applications, BillQuick has a menu bar at the top, from where you can access the 
following menus: 
 

 
 
The main toolbar allows you to access the most common and important BillQuick functions and screens 
quickly. The following tools are available on the main toolbar: 
 

 
 
You can show or hide the toolbar using the right-click option or from the Preferences-Options screen. It 
is hidden by default. 
 
You can conveniently access the major functions and screens of BillQuick from the Sidebar. It has four 
panels, grouping common functions together:  
 

 Main 
 Time & Expense 
 Billing 
 Wizards 

 

 You can turn off the Sidebar on your PC from the Preferences-
Options screen. 

 
You can re-arrange the Sidebar items up or down by dragging-and-dropping them. 
You can also display fewer items (or buttons) on it using the appropriate option. 
 
 
 
 
 
 
 
The BillQuick navigators let you easily 
understand the workflow and quickly 
access important features and screens of 
the application. These navigators have active action buttons, data flows, charts and 
links, making it easier for first time and experienced users to work with BillQuick. 
These navigators include: Company, Business Management, Time & Expense 
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Workflow, Billing and Accounting. 
 

 
 
BillQuick also comes with four role-based navigators that provide easy access to the often-performed 
actions by you. Selected on the Employee (or Vendor) screen, the Role determines which role-based 
navigator displays at your startup. These role-based navigators –Default, Time & Expense, Billing and 
Principal/Management—offer the core functions you need.  
 

 
You can find other easy options for navigation within various BillQuick screens. You can access related 
screens from the ‘View’ dropdown menu as in case of Sheet View, Expense Log, etc. Alternatively, 
screens may contain links to other related screens; e.g., you can directly access the Invoice Review 
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screen from the Billing Review screen and Payment screen from the Invoice Review screen.  
 
Besides this, you can quickly switch between open screens by using Ctrl + Alt + Tab. 
 
 

Customizing BillQuick 
 
BillQuick screens follow industry-standard designs. The screens contain data fields and grids making it 
easy to scan, enter and edit data. However, you can customize BillQuick in many ways. 
 

 You can set the screens as tabbed/non-tabbed/MDI/non-MDI windows (Preferences screen). 
 

 
 

 You can customize the grids by turning on/off columns, resizing columns, rearranging columns 
and sorting data with a click of the mouse.  
 

 You can change the tab position (left or right) in various BillQuick screens by dragging-and-
dropping. E.g., you may prefer having Detail tab before the Rate tab in the Employee screen. 
 

 You can adjust screen dimensions as needed. To maximize the screen, click . To restore it 

to its previous size, click . You can also manually change the size by clicking in the lower 
right corner of the screen and dragging it. BillQuick remembers the window size on your PC 
from one session to the next.  
 

 You can customize BillQuick terminology to industry and company preferences, including 
changing captions, field labels and field masks (BillQuick Start-Up Interview and Custom Labels 
screen). The changes apply throughout BillQuick on menus, screens and reports. E.g., you may 
change the Company screen title to ‘Firm’. You may customize the ‘Custom’ field labels or 
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change the input masks for phone number and zip code. 
 

 At a global level, business rules can be set to match company policies and industry standards. For 
example, with a single click you can set BillQuick to adhere to DCAA requirements (Global 
Settings screen).  
 

In short, BillQuick adapts to you, your company policies and your industry.  
 
 

Accessing Help and Support 
 
You have access to many help and support options in BillQuick.  
 

 You can access the in-context BillQuick Help by clicking the Help button and ‘How Do I’ links on 
the screens. You can also press F1 in any window or dialog to access the Help. 
 

 You can access various help and other support options from the main Help menu. It contains the 
following: 

 
o Contents – Opens the BillQuick Help where you can find all BillQuick-related topics.   
o Frequently Asked Questions – Opens the Frequently Asked Questions Help topic where 

you can find answers to common questions.   
o Support – Takes you to our Support web page where 

you can access documents, knowledgebase, 
downloads, eLetters and more.  

o Support Downloads –Takes you to our Support 
Downloads web page where you can download 
application setups, hot fixes, service packs, etc.  

o Get Updates –Checks whether you are using the 
latest build of your BillQuick version. If not, it lets you 
download and install an updated version. You will need 
to use this option when you have not opted for Automatic 
Updates in the Preferences screen. 

 
 You can access our website www.bqe.com and search through our online Knowledge Base 

articles, e-Letter Archives, FAQ or Support Documents. It also provides information on other 
products, services and business solutions. 
 

 You can contact our Technical Support to get answers to specific questions at 310-602-4030 or 
Support@bqe.com. 
 

 You can undergo standard or customized ‘one-on-one’ Training Courses. BillQuick Certified 
Trainers can train you on using BillQuick and add-on modules. Check out the courses at (310) 
602-4020 or www.bqe.com/Services.asp. 
 

 BQE also offers professional Consulting Services to help you install, implement and deploy our 
products in a cost-effective and professional manner. Find more at (310) 602-4020 or 
www.BillQuick.com/Services.asp. 

http://bqesoftware.net/media/PDF/BQ/2011/DCAA-Compliance-Guide-2011.pdf
http://www.bqe.com/Support.asp?pageId=Home
http://www.bqe.com/Support.asp?pageId=Download
http://www.bqe.com/Support.asp?pageId=Download
http://www.bqe.com/Default.asp
http://www.bqe.com/BillQuickKB/kb.aspx
http://www.bqe.com/Support.asp?pageId=eLetter
http://www.bqe.com/Support.asp?pageId=FAQ
http://www.bqe.com/Support.asp?pageId=Documents
mailto:support@bqe.com
http://www.bqe.com/Services.asp?pageId=Training
http://www.billquick.com/Services.asp
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 You can use our Report Customization Services to efficiently develop custom reports and invoice 

templates for you as per your specifications. Find out more at (310) 602-4020 or 
www.bqe.com/Services.asp. 

 
 

Grids 
 
Grids are columns and rows that look similar to a table or spreadsheet. BillQuick uses grids for drop-
down lists, time and expense entry, schedules, budgets, and master information. 
 
You can customize the grids in many ways: 
 

 Hiding/Showing Columns 
 Sorting Grids 
 Sorting Dropdowns 
 Selecting Multiple Rows 
 Re-arranging Columns 
 Changing Fonts and Colors 

 
 

Hiding/Showing Columns in Grids 
 
At times, you may have too many columns displayed in a grid and want to simplify it by hiding unused 
columns. For instance, Sheet View or Expense Log screens. On the other hand, you may want to see 
more information than what displays, by default, on the screens. E.g., while doing percent complete 
billing in Billing Review screen, you may want to show extra columns in the grid, such as % Complete, 
Contract Type and so on.   
 
To hide or show columns in a grid: 
 

1. Open the desired BillQuick screen; e.g., Sheet View. 
 

2. Click  at the top left of the grid to open the field chooser window. Alternatively, select Field 
Chooser from the Edit menu. 
 

http://www.bqe.com/Services.asp?pageId=Reports
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3. Check the field or column name you wish to show in the grid.  
 

4. Uncheck the field or column name to hide the column in the grid. You can also drag-and-drop 
fields from the field chooser into the grid. 

 
 

Sorting Grids 
 
You can sort the grids in the order you prefer. You can sort the order of grid columns by doing the 
following: 
 

1. Open the desired BillQuick screen, e.g., Time Entry-Sheet View. 
 

2. Select the column on the grid that you want to sort. 
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3. Click on the column heading, say Date, once for ascending order  and twice for descending 

order . Clicking on the column header reverses the order of entries.  
 

4. To sort multiple columns, click the first column heading, and then point to the next column to 
sort, say Project ID. Press Shift + Click. While pressing the Shift key, click on the second column 
heading. 
 

5. If you want BillQuick to always remember this sort order, click on the More tab. Then check 
‘Remember Grid Sort Order’ option.  
 

Similarly, you can sort grids in the Expense Log or other BillQuick screens. 
 
 

Sorting Dropdowns 
 
You can change the sort order of drop-down lists by doing the following: 
 

1. Open the 
desired BillQuick 
screen, e.g., 
Time Entry-
Sheet View. 

 
2. Select any drop-

down list on the 
grid, say Project 
ID. 

 
3. Click on the 

column heading 
in the drop-
down list, once 
for ascending 

order  and 
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twice for descending order .   
 

4. In some screens, you can also sort the drop-down lists by right clicking and using the ‘Sort By ID’ 
and ‘Sort By Name’ options.  
 

Whatever the sort order, BillQuick will remember it in future. 
 
 

Selecting Multiple Items 
 
At times, you need to select multiple rows or records in a grid to perform some action on them. For 
example, you may want to select rows to make batch changes or submit items. You can select multiple 
rows or records using a combination of mouse click and Shift or Ctrl keys.  
 

 Use ‘Click + Shift’ to select rows in a continuous range. 
 

 Use ‘Click+ Ctrl’ to select individual items in a list.  
 

 Use ‘Ctrl + A’ to select all items in a list. 
 

 Use the Select button options to select or un-select all rows in 
screens.  

 
 

Re-arranging Columns 
 
You can re-arrange columns in a number of ways to suit your preference: 
 

 You can move the columns by dragging and dropping with the mouse at the desired location.  
 

 
 

 When too many columns are visible in a grid or too many records display, you can use the 
vertical and horizontal grid splitters (as in Sheet View, Project, etc.). Drag the grid splitters to 
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split the grid at the desired place. Vertical splitters lock columns while the horizontal splitters 
lock rows. These are available only with the vertical and horizontal scroll bars. 
 

 Columns can fit to the screen in two ways. Place the cursor on row and column dividers and drag 
them to the desired size. You can also use the Layout button options: 

 
o Auto Fit - fits the columns to the screen 
o Best Fit - adjusts the columns to best fit the 

content 
 
 
 
 
 
 

Filters 
 
Filters limit the number of records displayed in the grids and drop-down lists. This is helpful because it 
reduces the time taken to find, view or select data in any BillQuick screen. There is no need to waste 
time in scrolling and scanning hundreds of items when you want to view selective information.  
 
You can apply filters in the following BillQuick screens: 
 
 

 Employee     

 Client 
 Activity Codes 

 Expense Codes 
 Project 
 Document Management 

 Expense Log 
 Reviewer 

 Statements 
 Report Filters 

 Import/Export 
 Sync Settings 
 Vendor Bills 

 Vendors 

 Service Fee Schedule 
 Expense Fee Schedule 

 Project Control 
 Employee Control 
 Sheet View 

 Timer 
 Invoice Review 

 Retainer Management 
 Report Center 

 QuickUpdate 
 Purchase Order 

 
 

Applying Filters 
 
By applying filters, only the specified items display in the main grid (and dropdowns). To apply filters: 
 

1. Open any BillQuick screen, say, Activity Codes. 
 

2. Select the Filters tab (or in some screens, click Tools on the button panel and select Filters from 
it).  

 
3. Click on the desired filter option, say Activity.  
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4. Then select the desired items or rows in the filter grid on the right. You can select multiple items 
using a combination of a mouse click and Shift or Ctrl keys.  
 

5. After selecting your items on the grid, click on the same filter option to display the selected 
item(s).  Doing so automatically activates the filter by marking its checkbox.  
 

6. Click Clear All below the grid to deselect the items for the filter. 
 

7. You can activate individual filters by marking their adjoining checkboxes. Removing a checkmark 
deactivates that particular filter. 
 

8. To apply all the specified filters to the grids and/or dropdown lists, click Filters on the button 
panel. This toggle button turns the filters on/off. 

 
Filter By Selection 
 
A special ‘Filter by Selection’ option is available on many grid lists such as Activity Codes, Expense Codes, 
etc. It allows you to filter the grid records by the contents of a cell. After selecting a cell on the grid, 
right-click to open the context menu and select ‘Filter by Selection’. The list filters instantly.  
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Funnel Filters 
 
Many BillQuick screens offer funnel filters for selective viewing of data in the grids. You can find them in 
screens like Reviewer, Project Control, Sheet View, Expense Log, etc. Funnel filters allow you to be 
more specific as to what data to display - All, Custom, Blanks, Non-Blanks, etc. Data selectively displays 
in the grid depending on your choice.  
 

 
 
If you select ‘All’, all records display. If you select ‘Blanks Only’, records display for which no value exists 
for the selected cell. Similarly, if you select ‘Non-Blanks Only’, records display for which a value exists for 
the selected cell. If you select ‘Custom’, a new screen displays on which you can choose more options. 
You can set more than one filter option, add filter conditions, and remove them as well. 
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File Linking 
 
You can link scanned documents and graphics to BillQuick records like employees, clients, projects, time, 
expenses, purchase orders, vendor bills, etc. For instance, you may want to attach letters, employee 
performance reports, contracts, scanned receipts, site pictures, consultant invoices,  bills or anything that 
is digital to record(s) for quick reference.   
 
The linked file is not stored in your company database; rather this feature simply points to its location. 
Files can be located anywhere on your computer or your company network. On clicking, the linked file 
opens in the native application (if installed on your computer). When you link files, BillQuick can copy 
them to a shared folder (specified in Global Settings or Preferences screens). Optionally, it can even 
organize them into folders. You can base the folder structure on the parent record type such as Project, 
Client, Time Entry, and so on. You can view all these files, regardless of the record type, on the Linked 
Documents or Document Management screen (Security permissions are required to access this 
information).  
 

If you delete a master record with a linked file, a warning displays. BillQuick displays  with the records 
or grid columns to make it visually easier for you to identify records having files attached to them. E.g., if 
an employee links a document to his time or expense entry, you can immediately spot the entries having 
files linked to them by looking at the Attachment (F) column in the Sheet View or Expense Log grid. 
 

BillQuick also displays the  Link Files option on the screens. It has a badge indicating the number of 
files attached to a record, if any. 
 
BillQuick allows you to link any type of file (with appropriate security permissions): 
 

 Graphics  AutoCAD 
 Microsoft Excel  Scanned plans 
 Microsoft Word  Scanned research drawings 
 WordPerfect  Other scanned document 
 Microsoft Visio  Portable Document Format (PDF) 

 

 BillQuick will not link programs (exe), folders or similar files.  

 
 

Linking Files to Records 

 
To link a file: 
 

1. Open the desired screen, say Project. 
 

2. Click  Link Files on the General tab. Alternatively, right click and select Link Files option from 
the menu. 
 

3. Click Add to add a file to the project record. You can also select the file in Windows Explorer 
(drag) and drop it to the Link Files window.   
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4. Click Save to save the file location. You have an option of copying the linked files to a shared 
folder on your network drive. 
 

5. When you are done, click Close to exit. 
 

 It is recommended to store electronic files in a shared location on your 
network. In addition, you can create a folder structure that is recognizable by 
anyone in your company using our Document Management feature (See 
Document Management in the Project Management chapter).  

 
 

Printing Reports 
 
You can access and print in-context reports from almost all the screens in BillQuick. To do so: 
 

1. Open the desired screen whose report 
you want to print, say Project (Project 
menu).  
 

2.   Click Print to access any in-context report 
from the ‘Select a Report’ dialog.  
 

3.  Click Preview to view the report. From 
the report viewer, you can print, export, 
save or modify the report. 
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You can access different categories and types of reports from the Reports menu and Report Center 
screen in BillQuick. To do so: 
 

1.   Select Report Center from the Reports menu. 
 

2.   Open the reports list on the left and select the desired report category by clicking  next to it. 
Select a report, say Time & Expense Detail. 
 

 
 

3.  In the Other Filters section, choose Project ID from the drop-down. 
 

4.  Next, select the IDs of the project you want to include in the From-To or Select Items fields. 
 

5.  Click Preview to view the report on your screen. To print it directly, click Print. 
 

6.  When you are done, click Close to exit. 
 
 

Using Wizards 
 
Wizards are special screens that step you through a task, easily and quickly. BillQuick provides the 
following timesaving and simple wizards for first-time users: 
 

 BillQuick Start-Up Interview 
 Employee 
 Client 
 Project  
 Phased Invoice 
 Invoice 

 Activity 
 Expense 
 Service Fee Schedule 
 Expense Fee Schedule 
 Timeslips Conversion 
 Wind2/FMS Conversion 



General Features 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 69 

 The Timeslips Conversion and Wind2/FMS Conversion are special wizards 
used for data conversion. 

 
To use a wizard: 
 

1.  Open a wizard from the View menu, Wizards or the Sidebar, Wizards. Several navigators also 
include links to wizards.  
 

2.  Follow the instructions on each panel and enter or select the desired data. 
 

 
 

3.  Navigation in all wizards follows the same pattern: 
 
 Click Next to move to the next panel.  
 Click Previous to move back one panel.  

 Click Finish to save the new record.  
 Click Cancel to exit without saving data.  

 
 

Using Calendars 
 
The BillQuick drop-down calendars make entries quick and easy. They are available in all the Date fields 
throughout BillQuick. All date fields disallow entering dates older than 1/1/1990 or newer than 10 years 
from the current date. 
 

 You can skip from one month to another by clicking on the arrows on the top of the calendar.  
 

 To skip from year to year, click on the year at the top of the calendar.  
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 To choose a day, first make sure you are in the correct 
month and year. It highlights the current date (Today). 
Click on the appropriate date box. Clicking on a date box 
closes the calendar. 

 

 By default, calendars have Sunday as the first 
day of the week. However, you can change this 
setting on the Global Settings screen. 

 
 

Custom Labels 
 
You can customize BillQuick to your preferred terminology. For various BillQuick screens, you can 
change the screen title or caption, field labels and masks. Changes immediately ripple to menus, screens, 
reports and invoices. For example: 
 

BillQuick Term Common Industry Terms 

Activity Code  Task Code, Service Code, Work Code 

Expense Code  Expenditure, Charge Item 

Project Job, Engagement, Matter, Work Order 

Employee Timekeeper, Staff, Associate 

Vendor Consultant, Subcontractor, Contractor 

Client Customer 

Time Entry Hours, Time Card, Time Sheet 

Expense Log Expense Report, Expense 

 

 When running the BillQuick Start-Up Interview, you can select a Business 
Type. When you choose one, BillQuick changes the main terms to ones 
common to the selected industry. You can customize them further using 
Custom Labels screen. 

 
With Custom Labels, you can do the following: 
 

 Changing Labels 
 Changing Field Masks 
 Using Custom Fields 

 
 

Changing Labels 
 
To change a label: 
 

1. Open the Custom Labels screen from the Settings menu or toolbar.  
 
2. Select a screen whose label you want to customize, say Project.  

 



General Features 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 71 

3. Click  or press the right arrow 
key to open the branch. Else, click 
Expand Tree to open all branches 
of the tree list. 
 

4. Select the item to change, and then 
type the new label in the Caption 
field below (say Engagement). The 
Caption for the screen title can be 
up to 15 characters long; field labels 
can be up to 9.  
 

5. If you select a ‘Custom’ field, you 
can also choose a Data Type, Size 
and UI Type for it. See Using 
Custom Fields below for details. 
 

6. Click Save and then Close to exit. 
 

 To restore a caption or field label 
to its default terminology, highlight the 
item in the Custom Labels list 
(changed labels are in boldface), then 
click Reset. 

 
 
 
 
 
 
 
 
 
 

Changing Field Masks 
 
You may not find a pre-defined mask for zip codes in BillQuick for a specific country. You may want to 
limit the way users enter zip codes in Employee, Project, Client, and Vendor screens. To do so, you can 
create a new mask. 
 
You can change BillQuick field masks and formats using the Custom Labels screen. You may want to 
change the 9-digit (99999-9999) mask and Zip Code label to a 6-digit (?9?-9?9) mask and Postal Code 
label to suit your location or a client’s location. These changes pass on to the reports as well. 
 
To change field masks:  
 

1. Open the Custom Labels screen from the Settings menu or toolbar.  
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2. Select a screen name whose 
mask you want to customize, say 
Project.  
 

3. Click  or press the right arrow 
key to open the branch. It 
displays various customizable 
field labels on the Project screen.  

 
4. From the tree list, select the field 

whose mask you want to 
changed, Zip in this case. The 
Mask field below the list is active 
only when you select a field with a 
modifiable mask.  
 

5. In the Mask field, select the 
desired pre-defined format 
(placeholders) from the drop-
down list.  Alternatively, enter 
placeholder characters for a 
special mask, e.g., for a 6-digit 
Canadian Postal Code, enter 
999-999 or ?9?-9?9. For a 3 digit 
postal code, enter &&& or &&-&. 
 

6. Click Save and then Yes if you 
would like to have all other 
screens with a zip code field to 
use this format. 
 

7. When you are done, click Close 
to exit. 

 
 

Using Custom Fields 
 
Custom fields are available in many BillQuick screens, such as Employee, Project, Activity Codes, Client, 
Vendor, Budget, etc. You can customize their labels, data type, size or length of characters and type of 
user interface according to your needs. A custom field can support any data type. E.g., Text for alphabets 
and letters, Numeric for numerals and digits, Date for dates, Currency for an amount with a currency 
sign, Decimal for decimal values and Memo RTF for memos that can be stylized in Rich Text Format. You 
can choose any type of UI for the custom field. E.g., a text box, a date drop-down, an auto-fill drop-down 
list or a custom list drop-down.  
 
Using these custom fields, you can track extra characteristics and attributes of master records. E.g., track 
employee (or vendor) skills and experience to match your company’s needs. You may want to use a 
custom field in the Employee screen to store the date the employee received his professional license. For 



General Features 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 73 

that, you can change its interface to a calendar drop-down. You may want to have a time entry custom 
field be used when a service is provided out of state. For that, you can create a custom list called ‘US 
State’ and make it a drop-down list. 
 

 Custom fields are available in the BillQuick Enterprise edition only. 

 
To use custom fields: 
 

1.   Open the Custom Labels screen 
from the Settings menu or toolbar. 

 
2.   Scroll down to the Employee 

branch, and then click  to open 
the branch. The customizable fields 
on the Employee screen display.  
 

3.  Select Custom 1 and then type 
‘Experience’ (without quotes) in the 
Caption field.  
 

4.    Select ‘Text’ for Data Type and 100 
for Size (characters long). 
 

5.  Next, select the UI Type from the 
dropdown list, say ‘Text Box’. Click 
Save. 
 

6.   When you are done, click Close to 
exit. 

 
 
 
 
 
 
 
 
 
To confirm the changes: 
 

1.  Open the Employee screen from the View menu, toolbar or navigator. 
 

2.  On the General tab, the field label now reads ‘Experience’ instead of Custom 1 or 2. If you 
customized Custom 3, Custom 4 or Custom 5, see the Detail tab. 
 

3.  Select an employee on the grid for whom you want to add customized information. 
 



General Features 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 74 

 
 
4.  Define and enter a shorthand code or short phrases into the customized fields. This custom field 

accepts up to 100 characters. For example, in the Experience field you can add Computer 
Programming. 
 

5.  In the Memo, you may add details such as the types of programming experience or specialization, 
etc. Enter as much text as you wish. 
 

6.  When you are done, click Save and then Close to exit.  
 
 

Memos 
 
You can use memos to record important qualitative or quantitative information in BillQuick. For example, 
you can enter a descriptive memo for an activity, expense, time entry, etc. If your company or client 
prefers, you may add memos to invoices that explain the scope of the work and change orders. You can 
add memos to provide detailed information for internal (staff) or external (clients) use. 
 
BillQuick allows you to customize the font style and size for all the memos at the global level from the 
Global Settings-More screen.  
 
Check out the following memo-related capabilities of BillQuick: 
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 Creating Memos 
 Spell Checking 
 Auto Complete 
 BillQuick Messages 

 
 

Creating Memos 
 
Most screens in BillQuick contain built-in memos. All memos accept unlimited amounts of text. Security 
permissions restrict your ability to add and edit memos. 
 

 You can easy jump into and out of it with a mouse-click or by using a keyboard. For example, 

Simple Time Card and Expense Log have collapsible memo boxes. Click  to expand (and  to 
collapse) the box or press Ctrl + M to jump in and jump out.  
 

 
 

 To open a memo in other BillQuick screens, click Tools on the button panel and select Memo. 
 

 Every memo box has a toolbar. You can 
spell-check, format text, apply font 
attributes, and insert the current date-
time stamp anywhere in the memo by 

clicking . 
 

 You can enter Auto Complete shorthand codes into the memo. Besides that, you can highlight 

the memo text and make an auto complete entry out of it by clicking on its toolbar. 
 

 Invoices can have one or two memos. On the Billing Review and Invoice Review screens, you can 
enter text in a double memo space. 
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Spell Checking 
 
Spell checking ensures that you put your best professional image forward. It allows you to perform 
formatting and spelling check for the messages, memo and grid text. BillQuick provides two spell-check 
options. 
 

 Click on the Memo toolbar to 
spell-check the memo text. 
 

 Click Spell on the button panel to 
perform a global spell-check of 
the memo as well as the 
description in the time, expense 
and other grids. 
 

 Spell-check begins at the start of 
the text and displays 
unrecognized words. After 
changing, ignoring or adding a 
word, it continues to the next 
unknown word automatically.  
 

 You can add new words that are 
unique to your industry, 
company, clients, and projects to 
the dictionary using the Add To 
Dictionary option.  
 

 The dialog closes itself when the 
spell-check it over. 

 
 

Auto Complete 
 
Auto Complete allows you to record ‘longhand’ standard text and link it to a ‘shorthand’ code. Shorthand 
codes are abbreviations consisting of letters and numbers. When you enter a shorthand code in a memo 
field (e.g., Project Journal, Time Entry, Expense Log, BillQuick Messages, Email, etc.), it instantly inserts 
the longhand text, phrases, sentences, paragraphs or pages of text.  
 
You can also create auto-complete shorthand codes directly from the memos. BillQuick lets you save any 
text – a phrase, sentence, paragraph or an entire memo – as a shorthand code.   
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 Shorthand codes are case sensitive. For example, ‘wu’ code for ‘write up 
services’ is not the same as ‘Wu’ or ‘WU’. In addition, shorthand codes cannot 
contain punctuation or spaces. 

 
 

Creating Auto Complete Shorthand Codes 
 
To create shorthand codes: 
 

1.  Open the Auto Complete screen from the Settings menu. 
 

2.  Click New to enter a new shorthand code. 
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3.  Type the shorthand text in the Replace field and the longhand explanation in the ‘With’ field. 
 

4.  Check ‘Is Shared’ option to make the shorthand codes available for all BillQuick users.  
 

5.  If desired, you can add a reminder in your longhand text by including [  ] (or other unique 
characters like ~, > or ^) as placeholder information, indicating a timekeeper, billing manager 
or project manager needs to insert information specific to the situation.  
 

 If desired, you can add ‘placeholders’ in longhand text of shorthand codes. 
Utilizing curly {} or square [ ] brackets for easy identification, placeholders 
prompt you to add or edit information for the situation – date, client name, 
contact name, issue and so on. If you neglect to replace placeholders, a 
reviewer or manager can see the omission and ask for correction. Standard text 
also makes it easier for managers to review memos because they follow a 
standard, consistent format. Thus, when memos carry to detailed invoices, they 
present a consistent, professional image.  

 
6.  Click Spell to perform a spell-check of the new Auto Complete text. 

 
7.  When you are done, click Save and then Close to exit. 

 

 You can highlight the memo text and make an auto complete entry out of 

it by clicking  on its toolbar. 

 
 

BillQuick Messages 
  
BillQuick Messages feature delivers ‘contextual’ messages to users based on a trigger event. For example, 
it can deliver a time card rejection message when you log in or when you open a time entry screen. 
Alternatively, you may receive a message about billing a project when you open the Billing Review screen. 
This improves communication by notifying, reminding or advising another user within the context of the 
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task at-hand.  
 
 

Sending Messages 

 
To create and send a message: 
 

1.  Open the BillQuick Messages screen from the View menu. 
 

2.  Click New to create a new message. 
 

 
 

3.  You can send a message to one employee (or vendor), multiple employees or a group of 
employees (or vendors). Select the desired Employees or Employee Group as the recipient of 
the message. 
 

4.  Set the trigger event to determine when to deliver the message. For example, when a user:  
 

 Logs in  Uses Payment screen 
 Records expenses  Does billing 
 Records time  Uses Purchase Order screen 
 Runs reports 
 Opens any master record 

 Uses Vendor Bills screen 
 Opens Reviewer screen 

 
5.  Type your message for the recipient. You can use Auto Complete shorthand codes for your 

convenience. 
 

6.  Click Send to send the message. You can preview your message on the right panel. 
 

7.  Select the message in the Sent list and click Link Files to attach any file or document with this 
message. See File Linking for more information. 
 

8.  When you are done, click Close to exit. 
 

When the trigger event occurs, the recipient receives a BillQuick 
Message Alert. Clicking on the link opens the BillQuick Messages 
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screen. After receiving a message, the recipient can: 
 

 Reply to the message (BillQuick automatically directs the reply to the sender.) 
 Forward the message to one or more BillQuick Users 
 Delete the message 

 
 

To Do List 
 
The To Do List feature allows you to create and track various to-do items for employees, clients, 
vendors and projects. BillQuick adds these to-do items to the Reminders screen, thus reminding you to 
take action on them. Various reports are available displaying the task list, past due tasks, etc.  
 

 To Do List feature is available in the BillQuick Pro and Enterprise editions 
only. 

 
To create a to-do task: 
 

1.  Open the To Do List screen from the View menu. 
 

2.  Click New to create a new task. Optionally, you can click ‘Copy Existing’ and select an existing task 
to copy. 
 

 
 

3.  Enter a heading or title for the task in the Subject field, say Correspondence. 
 

4.  In the Assigned To field, specify the ID of the person to whom this task is assigned. 
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5.  Set a Priority for this task –Low, Medium or High. You can also indicate the percentage of 
completion of this task in the Complete (%) field.  
 

6.  You can enter the Start and End dates for the scheduled task. Also, enter a ‘Remind On’ date. 
BillQuick will remind you about this task on that date. 
 

7.  If required, type a Memo for this task. You can enter unlimited text here. 
 

8.  When you are done, click Save and then Close to exit. 
 
 

Find 
 
At times, you need to find records that contain important information, say, from a conversation recorded 
within a time entry memo. You remember typing it into BillQuick Timer’s Memo as you talked to a 
client, but you cannot remember the exact date or which client it was. All you do remember is a 
reference to ‘extension’. In BillQuick, searching for information is easy and fast.  
 
BillQuick provides two options for finding information:  
 

 Quickly Finding Information 
 Globally Finding Information 

 
 

Quickly Finding Information 
 
On the master information screens, Quick Find instantly searches all the records in the list as you type in 
the search box. BillQuick automatically suggests the nearest matches in a dropdown list and narrows it as 
you keep on typing. If you remember just a part of the Client ID or name, simply: 
 

1.  Enter the text you 
remember in the 
search box. It 
displays a 
dropdown list of 
possible matches.  

 
2.  You can select the 

record you are 
looking for from 
the dropdown list. 
Else, click  to find 
your match in the 
grid list.  

 
 

3.  Click  again or press Enter to find the next match. 
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Globally Finding Information 
 
BillQuick can search data tables, such as Activity, Budget, Project, Employee, Fee Schedule, Time Entry, 
Vendor Bill, Chart of Accounts, etc. to provide the right information to you. Global Find searches all fields 
for a keyword text, including custom fields. It displays a list of records that match your criteria, whether 
simple or advanced.  
 
Searches can be simple or advanced with more criteria. Advanced criteria also includes AND/OR options 
to narrow or expand the search. The AND option narrows the search to inclusive criteria. The OR option 
expands the search to exclusive criteria. Up to five keywords may be defined in a search, each one 
narrowing or expanding the search using the AND/OR option.  
 
Keywords can employ wildcards to search for patterns. A percent sign (%) represents one or more 
alphanumeric character(s) that appear in a position within a keyword. In contrast, a hyphen (-) replaces 
only one character in a keyword. For example, ‘Bill%’ will find ‘Bill Jones’, ‘BillQuick’ and ‘Billings to date 
for ABC Corporation’ within a data table. ‘Bill-’ would find only records with ‘Bill’ or ‘Bills’.  
 
To find information: 
 

1.  Open the Find screen from the Edit menu or by pressing Ctrl + F. Some screens also contain a 
Find link to open this screen. 
 

2.  Select the desired type of information from the Data Tables list. If you have an active/open window, 
that screen is pre-selected. 
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3.  Enter your Find Criteria. Type in a Keyword using '%' and '-' wildcards as needed. Specify the 
search for a match in Any Part of Field, Whole Field or Start of Field. 
 

4.  Apply AND/OR search option, if needed. 
 

5.  Click Find. Immediately, BillQuick displays a list of records that contain the word(s).  
 

 
 

6.  Click on any record to drill down to the details. 
 
 

Batch Change 
 
In many situations, it can be tedious and time-consuming to make changes to records. For example, an 
item tax change can affect dozens of expense codes. Similarly, you can change the Manager or Payment 
Terms for multiple projects in bulk. Rather than select each item and make a change, use the Change 
feature to update multiple items and records at one time. 
 
The Change feature changes the contents of a field from ‘A’ to ‘B’ for the selected records. If you need to 
change some fields from A to B and others from C to D, perform the change function twice.  
 
Batch change feature is available in the following BillQuick screens: 
 

 Activity Codes 
 Client 
 Employee 
 Sheet View 
 Billing Review 

 Expense Codes 
 Project 
 Vendor 
 Expense Log 

 
You can make batch changes to all master and other records in BillQuick: 
 

 Changing Master Records 
 Changing Time Records 
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Changing Master Records 
 
To change one or multiple fields in one or multiple BillQuick master records, follow the steps mentioned 
below. You can make these batch changes in any of the screens listed above. 
 

1. Open any of the master information screen, say Activity Codes from the View menu, toolbar or 
navigator.  
 

2. If the activity codes you want to update are all part of a group, select the Filter tab and choose 
the Group filter to shorten the list. If not, continue to the next step. 
 

3. On the Activity tab, scroll through the list and select the activity codes you want to batch change. 
 

4. Click Tools and select Change from the menu to open the Change screen. 
 

 
 

5. Enter the new data for each field you want to update. BillQuick automatically marks the adjoining 
checkbox.  
 

 Review your work. If you incorrectly modify something, you must 
manually reset or change each record. 

 
6. Click Apply. BillQuick applies the changes to the selected activity records. 

 
However, what do you do if the new data varies for different records? E.g., say you created 100 activities. 
Of these, 65 are billable while the rest are non-billable. Most of them have a fixed markup of 5%. Some 
have to be taxed once while others need to be taxed twice. In this scenario, you would make multiple 
passes through the records using the Change screen 
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Changing Time Records 
 
To change one or multiple fields in one or multiple BillQuick records, follow the steps mentioned below. 
You can make these batch changes in any of the screens listed above. 
 

1. Open the desired BillQuick screen, say Sheet View from the Time-Expense menu, toolbar, 
Sidebar or navigator. 
 

2. Select multiple rows or records in the grid to make batch changes to them. 
 

3. Next, click Tools and select Change. 
 
4. On the Change screen, enter new values, change options and mark/un-mark checkboxes as 

needed.  
 

 
 

5. Click OK to apply the changes and exit. You will see the changes reflected in all the selected 
records. 
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Keyboard Shortcuts 
 
BillQuick provides many ways to access commands and dialog boxes. These shortcut keys are available in 
specific areas of BillQuick. To access the command, press the key(s) indicated. For example, press Ctrl + 
F to open the Find dialog. This means that while pressing and holding the Ctrl key, you press the F key. 
 

Function Keys 

File menu Alt + F  

Log Viewer Open menu, L  

Exit Ctrl + Q or  
Open menu, X 

Edit menu Alt + E 

Undo Ctrl + Z 

Cut Ctrl + X 

Copy Ctrl + C 

Paste Ctrl + V 

Paste Special Open menu, S 

Delete Ctrl + D 

Refresh F5 

Find Ctrl + F 

View menu Alt + V 

Employees Ctrl + Shift + E 

Clients Ctrl + F8 

Activity Codes Ctrl + F5 

Expense Codes Ctrl + F7  

Service Fee Schedule Ctrl + F6 or  
Open menu, 6 

Expense Fee Schedule Ctrl + Shift + F or  
Open menu, 7 

Vendors Ctrl + Shift + D or  
Open menu, V 

Reminders Ctrl + Shift + R 

Dashboard Ctrl + Shift + B 

BillQuick Navigator Ctrl + Shift + N 

Project menu Alt + P 

Project Information Ctrl + Shift + P 

Budgets Ctrl + Shift + G 

Estimates Open menu, E 

Project Control Ctrl + Shift + J 

Time-Expense menu Alt + T 

Sheet View Ctrl + T 
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Function Keys 

Calendar View Ctrl + W 

Timer Ctrl + Shift + S 

Expense Log Ctrl + L 

Review Time & Expenses Open menu, R 

Billing menu Alt + B 

Billing Review Ctrl + Shift + K 

Manual Invoice Ctrl + Shift + U 

Memorized Invoices Open menu, M 

Invoice Review Ctrl + Shift + I 

Payments Ctrl + Shift + Y 

Reports menu Alt + R 

Custom Report List Open menu, R 

Settings menu Alt + S 

Currency Manager Open menu, C 

Utilities menu Alt + U 

Integration menu Alt + I 

QuickBooks Open menu, Q 

Real-Time Sync Open menu, E 

Accounting menu Alt + A 

Chart of Accounts Open menu, A 

Receive Items Open menu, R 

Add-Ons menu Alt + O 

Agent Open menu, A 

Window menu Alt + W 

Close All Windows Open menu, L 

Help menu Alt + H 

Switch screens Ctrl + Alt + Tab 

Date up/down (T&E) + / * 

Open dropdown list,  
activate item 

F4, Alt 

 

 Pressing the Esc key twice can undo screen actions or revert to original 
state. E.g. Expense Log screen. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 
 

mailto:BQ-Ideas@bqe.com
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BillQuick Workflow 
 
BillQuick is a time and expense tracking, project management, billing and reporting solution. It is highly 
flexible and hence adapts to your business and company preferences.  
 

 To get started with BillQuick, first set up the Company database.  You can do this by entering new 
data, importing it from external sources or integrating it with your accounting packages. This is followed 

by setting up of master information- employees and vendors,  clients,  activity and expense items, 

 projects and related information such as fee schedules, budgets and estimates, and billing schedules. 
Time and expense entry requires data input from this master information. Employees or vendors charge 

 activities and  expenses against various projects while recording time and expense entries.  In 
addition, you can convert vendor bills into time and expense entries or vice versa. Approved time and 
expense becomes work-in-progress, ready to bill. 
 

 Billing decisions begin with the client and project setup (master information). When ready to bill, 
accumulated work-in-progress or pre-defined billing schedule flows to the Billing Review or Manual 

Invoice. You can also use the wizards to do your billing. After processing and reviewing invoices,  the 

manager typically generates final invoices in Invoice Review and sends them to the clients.  BillQuick 
tracks accounts receivable and then records payments when received. Some companies prefer linking the 
payment of vendor bills with the payment received from their clients (pay when paid). Throughout the 
BillQuick workflow, useful reports are available for staff and management. 
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Company Setup 
 
A BillQuick Supervisor is typically responsible for the setup and management of the company database. 
Setting up a new company and associated master information should follow a plan to ensure tasks are 
completed and checked off.  
 
This section covers the issues and options to consider as you make decisions to build your company 
database. Once you are done with the planning and decision-making, you must enter master information 
in BillQuick or delegate this task to a staff person. 
 

 General Decisions 

Area Decision Where to Implement 

Business Type Add standard activity codes according to your 
industry. 

BillQuick Start-Up Interview 

Add Industry Codes 

Custom Labels Change standard terminology in BillQuick to your 
industry/profession. 

BillQuick Start-Up Interview 

Database Hide location of database on BillQuick status bar. Global Settings-More 

User Interface Change screen terminology or caption in 
BillQuick to your industry/profession. 

Custom Labels 

Customize field labels such as Tax, Custom fields, 
Zip, Flags, etc. to your preference. (say, Zip to 

Custom Labels 
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Postal Code; MST to GST or VAT) 

Change the postal or phone field mask (say 99-
999-9999 to 999-999-9999) 

Custom Labels 

Change colors and backgrounds for data grids 
(master information lists, time entry, etc.) 

Global Settings 
Preferences 

Change colors and backgrounds for drop-down 
lists (master information lists, time entry, etc.) 

Global Settings 
Preferences 

Master Information 

Area Decision Where to Implement 

ID Structure Define desired ID and Code structure. Master screens: Project, 
Client, Activity Codes, 
Expense Codes 

Import Timeslips or 
Wind2/FMS data  

Choose the Timeslips or Wind2/FMS fields that 
correspond to fields in BillQuick. 

Timeslips Conversion 
Wizard 
Wind2/FMS Conversion 
Wizard 

Integration with 
accounting packages 

Get data from QuickBooks. Integration menu, 
QuickBooks 

Get data from Peachtree Accounting. Integration menu, Peachtree  

Get data from MYOB. Integration menu, MYOB  

Get data from any other application. BillQuick’s Custom Data 
Conversion services 

Import data from 
other programs 

Manually re-enter data from an old paper or 
electronic system. 

Import/Export utility 

Company Profile Enter required data. Company-General screen 

Specify company-wide settings. Company screen 
Global Settings screen 

Employee Profile Enter required data. Employee: General and Rate 
tab 

Set default bill and cost rates for the employee.  Employee-Rate screen 

Set standard work, vacation, holiday and sick 
hours. 

Employee-Detail screen 

Client Profile Enter required data. Client screen 

Create client contacts. Client: Client Contacts 
screen 

Client Relationship Identify the principal/partner, manager or staff 
member who has primary responsibility for the 
client relationship. 

Client-General screen: 
Client Manager or Custom 
field 

Activity Profile Create activity codes for all services or tasks. Activity Codes screen 

Organize tasks by category: Use Code field for 
the category and Sub-code field for the task 
within the category. 

Activity Codes screen 

Organize tasks by department: Use Code field for 
the department and Sub-code field for the task 

Activity Codes screen 
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performed in the department. 

Transfer from an integrated accounting package. Integration menu 
Activity Codes screen 

Expense Codes Create expense codes for all expenses or charges. Expense Codes screen 

Organize expenses by category: Use Code field 
for the category and Sub-code field for the 
expense within the category. 

Expense Codes screen 

Organize expenses by department: Use Code 
field for the department and Sub-code field for 
the expense incurred in the department. 

Expense Codes screen  

Transfer from an integrated accounting package. Integration menu 
Expense Codes screen 

Project Profile Enter required data. Project screen 

Automatically increment project codes Global Settings-
Miscellaneous 

Create project phases and segments, if needed. Project screen 

Assign percentage of parent project’s Contract 
Amount to the phases. 

Project-Detail screen 

Project Management Identify the principal/partner, manager or staff 
member who has primary responsibility for the 
project. 

Project-General screen: 
Project Manager field 
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Setting up a company involves the following initial tasks: 
 
 ID Structures 
 Creating a Company Profile 
 Adding a Logo 

 
 

ID Structures 
 
BillQuick uses shorthand abbreviations, called IDs, to identify master records and items. Client, project, 
activity and expense code IDs are used while making time and expense entries, creating budgets, 
estimates and fee schedules; and more. These IDs have a specific character length and can include 
alphanumeric characters and punctuation marks as well; say, a client ID can be ABC 2011. Descriptive 
IDs can communicate useful information, especially if you plan their structure well. You can sort the grids 
and lists IDs, making it easier and faster to work in BillQuick.  
 

 Whatever you adopt as a policy for ID structures, communicate it to your 
managers and staff who will set up employees, projects, budgets and so on. If 
you need to change an ID for any reason, use BillQuick’s Change ID Codes 
utility.  

 
Client ID can communicate who a client is without requiring a reference to the company name. Say, ABC 
Corp communicates the company name, ABC Corporation or HUD shortens the company name 
Housing and Urban Development. 
 
For Project ID, the best practice is to combine the Client ID and a descriptive abbreviation for the type 
of work involved in the project. For example, a corporate tax return project for a client might be ABC-
1120Tax. Your ID structure can also communicate the start date of a project and its phase. E.g., ABC-
Const-2011:II indicates it is the second phase of the parent construction project, started in 2011.   
 
For companies offering a single category of services, BillQuick provides the option to auto-create project 
codes (Global Settings-Miscellaneous screen). A Project ID structure includes a static portion and a variable 
with numerical increment. E.g., CAD-2011-{000} combines the static CAD service for the year 2011 
with the incremental numbers inside curly brackets. The first project created would be CAD-2011-001, 
then CAD-2011-002, and so on. Automatic generation of IDs can save time during initial setup. However, 
if you decide to include the fiscal year in the IDs, be sure to change it at the start of a new year. 
 
Activity and expense items support both a Code and Sub-code. While BillQuick requires only a single-
level code, you may prefer a two-level code structure to separate activities and expenses by department, 
function, type, etc. E.g., TAX could be the main activity Code for the Tax Department, while PREP and 
REV would be the sub-codes that define the individual tasks of preparing and reviewing tax returns. 
Similarly, an architectural firm may use DRFT (drafters) and ARCH (architects) as main codes, and then 
add sub-codes based on tasks such as preliminary drawing, CAD, etc. to differentiate the two groups. 
 
BillQuick supports default activity and expense prefixes (e.g. TAX, ARCH, DRFT), defined in the 
Preferences-Format screen. Setting prefixes enables BillQuick’s smart find feature to locate the activities 
and expenses easily while recording time and expenses.  
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You can link budgets and fee schedules to a single project or multiple projects. To ensure all users 
understand which items to use with single projects, make sure the IDs they see communicate well. E.g., if 
a budget is for a single project, make the Budget ID similar to the Project ID. Budget ABC-I is clearly a 
budget for the first phase of project ABC while ABC-II is for the second phase. If a budget is for multiple 
projects, use general and descriptive IDs that refer to the type of work or service. E.g., a general budget 
for all network installation projects may use the identifier NET-INST. 
 
 

Creating a Company Profile 
 
The Company screen allows you to create a profile of your business. You can modify any information – 
except for the company name and license keys. To create your company profile, follow the steps below: 
 

 You can set up your BillQuick Company at a basic level with a few 
mouse-clicks or at an advanced level with all the details. Please read the 
desired sections. 

 
Basic Setup 
 

1. When you exit the BillQuick Initial Setup Checklist, the Company screen automatically opens. 
You can also open it from the View menu, Sidebar, toolbar or navigator. 
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2. Enter your company Name and Address details on the General tab. 
 

3. Click Save and you are done! 
 
Advanced Setup 
 

1. Enter the company’s Tax ID and Employer ID.  
 

2. Enter any unique information in the Custom 1/2/3/4/5 fields (up to 50 characters). You can have 
these values displayed on the invoices.  
 

3. Type a global message in the ‘Message on Invoices’ box. This text prints on all invoices if neither a 

project nor a client message exists separately. Click  and add the message for all clients and 
projects. 
 

4. Specify Main Service Tax and Main Expense Tax percentages to apply on total services and 
expenses included on project invoices billed to clients. These tax rates become the default in the 
client and project profiles. For more, see Taxes in the Billing Basics chapter. 
 

5. Enter first and last day of the company’s Financial Year, or click  and select dates from the 
drop-down calendar. BillQuick uses these fields as a financial year filter in reports.  
 

6. Also, enter a Closing Date for your last accounting period. This feature prevents unauthorized or 
untimely editing of data (time, expense, invoice or payment records) in BillQuick after the closing 
date. This is useful for companies requiring DCAA compliance. 
 

7. Click Tools and select Add Logo to add a company logo to invoices and reports. See below for 
details. 
 

8. When you are done, click Close to exit. 
 
BillQuick saves your company information in the database.  
 
 

Adding a Logo 
 
You can add a company logo to standard BillQuick invoices, statements and reports. However, you can 
customize the size of the logo in the Preview window. Resizing is done proportionally. 
 

 BillQuick support a 125 x 125 pixel (1 inch x 1 inch) logo. If you select a 
larger image, BillQuick automatically downsizes it to the default size. The 
graphic must be in the .bmp or .jpg format.  

 
To add a standard logo to BillQuick: 
 

1. Open the Company screen from the View menu, Sidebar, toolbar or navigator. 
 

2. On the General tab, click Tools and select Add Logo. 
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3. In the ‘Select Company Logo’ window, navigate to the folder containing your graphics. Select the 

file and click . The graphic displays on the Company screen. 
 

4. Click Save and then Close to exit. 
 
 

Employee and Vendor Setup 
 
You can set up new employees and vendors in the following ways: 
 

 Creating Employee or Vendor Profiles 
 Using Wizards (for employees only) 
 Cloning Employees 
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 Transferring from an integrated accounting package (see Data Integration in the 
Accounting chapter) 

 Transferring from another time and billing package using built-in or custom data 
conversion  

 Importing employee and vendor records 
 
 

Creating Employee Profiles 
 
You can set up new or edit existing profiles in the Employee screen. BillQuick also allows you to transfer 
employee records from a supported accounting package or import them from another source.  
 

 Employee Wizard (View menu or Sidebar) quickly and easily walks you 
through the process of creating new employee profiles, using only basic 
information. You can later make changes in the Employee screen.  

 

 You can set up your employee profile at a basic level with a few 
mouse-clicks or at an advanced level with all the details. Please read the 
desired sections. 

 
Basic Setup 
 
To create an employee profile: 
 

1. Open the Employee screen from the Company navigator, toolbar or View menu. 
 

2. If this is your first employee, the cursor will default to the Employee ID field. If other employees 
exist in your company database, click New on the button panel.  
 

3. Enter the Employee ID. You can use numbers, letters or a combination of both, up to 65 
characters. For example, if the name of the employee is Allen Marcello, you might enter AM as 
his ID. 
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4. Enter the First Name and Last Name. Press the Tab key to move from field to field or click on 
the next field.  
 

5. Move to the Rate tab. Enter the default Bill Rate and Cost Rate (Pay Rate x Overhead Multiplier) 
for the employee. E.g., enter $80 as the Bill Rate, $33.50 as the Pay Rate and 1 as the OM to 
make the Cost Rate $33.50. 
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6. Click Save and you are done! 
 
Advanced Setup 
 
To add additional information about the employee: 
 

1. On the General tab, enter the employee’s Social Security number, Department and other 
information. 
 

2. Specify a Title for the employee. BillQuick may use it as a classification for tagging time and 
expense entries. 
 

 While fetching a classification, BillQuick will look for it in the following 
order: Service Fee Schedule, Project Control or Employee screen (Title). 
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3. Specify a Manager or supervisor for this employee. You can also select a person in the Submit to 
field as the default reviewer for this employee’s time and expense entries. It could be Anyone, 
Client Manager, Project Manager or Employee Manager. 
 

4. Select a Status for the employee—Active, Inactive or Terminated. Drop-down lists in BillQuick 
include only ‘Active’ status employees. Changing the status to Inactive or Terminated does not 
delete the employee. 
 

5. Choose a Default Group for the employee. This can be specified in addition to any group you 
choose. 
 

 This is useful for reports, such as Budget Comparison. If there is a budget 
for employee group A and B, and employee CJ is the member of both groups 
but his default group is A, then CJ's hours will be listed against A. 

 

6. Assign the employee to one or more groups by clicking . Else, click Tools and select Group to 
create new groups for the employees (see Groups in the Company Management chapter for 
details). 
 

7. Enter the address details of the employee along with the other Contact Info. 
 

8. Enter any information (up to 50 characters) about the employee in the Custom 1/2 fields, e.g., 
work experience or degrees completed. You can customize these fields in the Custom Labels 
screen. More custom fields are available on the Detail tab. 
 

9. Click  Link Files (or right-click) to link documents or files to the employee record. (See File 
Linking in the General Features chapter for more.) 
 

10. Click  at the bottom to open the Memo box and add unlimited length memo to the employee 
record. (See Memos in the General Features chapter for details.) 
 

11. On the Rate tab, you can set Reminders and related dates for employees (see Reminders in 
Company Management chapter for details). 
 

12. Click on the Assign tab to assign projects, activities and expenses to the employee. (See Project 
Assignments in the Project Management chapter for details.) 

 
To set up employee as a user:  
 

1.  On the General tab, select a Role for this employee in your organization; say Time & Expense or 
Billing. 
 

2.  Choose a Security profile (Billing Only, Time and Expense Only, Full Access, etc.) for the 

employee from the drop-down list or click  to open the Security screen and choose detailed 
permissions.  
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7.  Enter a Login name if you want this employee to have a different Login ID than the default 
Employee ID. See BillQuick Login for more. 
 

8.  Mark the employee as a BillQuick User (depending upon the number of BillQuick licenses 
purchased) so that security and login can be implemented. 

 

 The Role or Security chosen here affects the security permissions of 
employees, besides determining their default role-based navigator. 

 
To add employee’s HR-related information: 

 
1. On the Rate tab, specify the Overtime Bill Rate to charge for time worked beyond the standard 

hours (daily and weekly) specified for the employee. BillQuick uses this rate to calculate the bill 
amount for overtime entries.  
 

2. Similarly, enter the Overtime Pay Rate. BillQuick uses this rate to calculate the cost amount for 
overtime entries. 
 

3. Next, specify the Salary information for the employee. 
 

4. Enter the dates when the employee was hired, received last raise and so on. 
 

5. Move to the Detail tab. Enter the employee’s emergency Contact details and other information 
known. 
 

6. Enter the Permissible Hours/Year for vacation, sick, or any other specific purpose and the 
Standard Hours of work, Per Day and Per Week, say 8 hours per day and 40 hours per week. 
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7. Check Automatic Overtime option if you want BillQuick to evaluate overtime entries 
automatically for the employee.  If daily or weekly hours worked exceed the standard hours, 
BillQuick splits the entry into a regular entry and an overtime entry. BillQuick applies the OT Bill 
Rate to the overtime entries for billing purposes. 

 

 When unchecked, in case of excess hours, BillQuick marks the extra hours 
as regular time. See Overtime and Comp Time in the Time Tracking chapter for 
details. 

 
8. Specify the Comp Time Frequency (Daily, Weekly, Yearly, etc.) and the number of Hours for 

BillQuick to calculate the compensation time.  
 

 In this case, extra time worked will be calculated as Comp Time. E.g., if 
Alice is supposed to work 40 hours per week but at times, she works 45 hours, 
BillQuick banks 5 hours of comp time for her. 
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9.  Check Auto Approve Time/Expense options if you want BillQuick to approve all time and 
expense entries of this employee automatically, regardless of the client, project or global settings. 
You can specify these options for the owner or principal of the company. 

 
To set up payroll information: 
 

1. On the Tax tab, enter the Federal/State/Local tax information for the employee if you want to 
export it to a payroll software or service bureau. 
 

 
 

2. Move to the Allowance tab. Similarly, enter the payroll deductions for various items in 
Percentage or Amount. 
 

3. If your company provides Automatic Deposit of pay checks/salary, enter the bank account 
information for the employee (especially if you want to export this data to a payroll system). 
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4. When you are done, click Save and then Close to exit. 
 
 

Cloning Employees 
 
Many employees share attributes such as rates, title, department or supervisor. Using a ‘clone template’ 
with default information saves time and effort. First, determine what is common for a group of 
employees, and then clone it as needed, giving it a unique ID (template) and then cloning it for all 
members of that group. You can later modify individual profile. 
 
To create clone templates for employees: 
 

1. Open the Employee screen from the Company navigator, toolbar or View menu. 
 

2. Click New. On the General tab, enter a unique ID for the employee template, such as Clone-
[common attribute].  
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3. Enter required data along with common attributes to clone. Use the Name fields to describe the 
template’s key attributes.  
 

4. Repeat this step for each employee clone template you wish to set up, e.g., Clone-Marketing, 
Clone-Manager, etc. Remember to click Save after creating each template profile. 

 
To clone employee profile: 
 

1. On the Employee screen, click Tools and 
select Clone.  
 

2. On the Clone screen, select the desired 
employee template from the ‘Clone from’ 
drop-down list, e.g., Clone-R. 

 
3. Enter a new employee ID in the ‘Clone to’ 

field. Click Save.  
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4. Back on the Employee screen, BillQuick creates your new employee. Add more details or edit 
information.  
 

5. When you are done, click Save and then Close to exit. 
 
 

Creating Vendor Profiles 
 
You can set up new or edit existing profiles in the Vendor screen. BillQuick also allows you to transfer 
vendor records from a supported accounting package or import them from another source. 
 
Basic Setup 
 
To set up a new vendor:  
 

1. Open the Vendor screen from the Company navigator, toolbar or View menu. 
 

2. If this is your first vendor, the cursor will default to the Vendor ID field. If other vendors exist in 
your company database, click New on the button panel.  
 

 
 

3. Enter the Vendor ID. You can use numbers, letters or a combination of both, up to 65 
characters. For example, if the name of the vendor is AT&T Wireless Service, you might enter 
AT&T as the ID. 
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4. Enter the First Name and Last Name. Press the Tab key to move from field to field or click on 
the next field.  
 

5. Click on the Rate tab. Enter the default Bill Rate and Cost Rate (Pay Rate x Overhead Multiplier) 
for the vendor. E.g., enter $100 as the Bill Rate, $60 as the Pay Rate and 1 as the OM to making 
the Cost Rate $60. 
 

 
 

6. Click Save and you are done! 
 
Advanced Setup 
 
To add additional information about the vendor: 
 

1. On the General tab, enter the government Tax ID of the vendor. Also, enter the name of the 
vendor’s Company, Title, etc. 
 

2. Specify a Manager or supervisor for this vendor. You can also select a person in the ‘Submit to’ 
field as the default reviewer for this vendor’s time and expense entries. It could be Anyone, 
Client Manager, Project Manager or Employee Manager. 
 

3. Select a Status for the vendor —Active or Inactive. Drop-down lists in BillQuick include only 
‘Active’ status vendors. Changing the status to Inactive does not delete the vendor. 
 

4. Choose a Default Group for the vendor. This can be specified in addition to any group you 
choose. 
 



Master Information Setup 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 108 

 This is useful for reports, such as Budget Comparison. If there is a budget 
for vendor group A and B, and vendor JD is the member of both groups but his 
default group is A, then JD’s hours will be listed against A. 

 

5. Assign the vendor to one or more groups by clicking . Else, click Tools and select Group to 
create new groups for the vendors (see Groups in the Company Management chapter for details). 
 

6. Enter the address details of the vendor, along with the other Contact Info. 
 

7. Enter any additional information (up to 50 characters) about the vendor in the Custom 1/2 fields, 
e.g., work experience or industry contacts. You can customize these fields in the Custom Labels 
screen. More custom fields are available on the Detail tab.  
 

8. Click  Link Files (or right-click) to link documents or files to the vendor record. (See File 
Linking in the General Features chapter for more.) 
 

9. Click the Convert to Employee link to convert the vendor record to an employee record. You 
need to specify the First Name and Last Name for that. 
 

 To convert to an employee, a vendor cannot have vendor bills associated 
with it. The conversion also converts associated to-do tasks, if any. 

 

10. Click  at the bottom to open a Memo box and add a memo to the vendor record. (See Memos 
in the General Features chapter for details.) 
 

11. On the Rate tab, specify the Overtime Bill Rate. BillQuick charges this rate for time worked 
beyond standard hours (daily and weekly). BillQuick uses it to calculate the bill amount for 
overtime entries. 
 

12. Similarly, you may enter the Overtime Pay Rate. BillQuick uses this rate to calculate the cost 
amount for overtime entries.  
 

13. Next, specify the Dates when the company contracted or hired the vendor. 
 

14. Move to the Detail tab. Enter the vendor’s emergency Contact details and other information 
known. 
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15. You may set Reminders and related dates for the vendor (see Reminders in Company Management 
chapter for details). 
 

16. Click Tools and select Clone to copy these vendor details to a new record. 
 

To set up vendor as a user: 
 

1. On the General tab, choose a Security profile (Default, Time Only, etc.) for the vendor from the 

drop-down list or click  to open the Security screen and choose detailed permissions.  
 
2. Select a Role for this vendor in your organization; say Default or Time and Expense. 

 
3. Enter a Login name if you want this vendor to have a different Login ID than the default Vendor 

ID. See BillQuick Login for more. 
 
4. Mark the vendor as a BillQuick User (depending upon the number of BillQuick licenses 

purchased) so that security and login can be applied.  
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 The Role or Security chosen here affects the security permissions of 
vendors, besides determining their default role-based navigator. 

 
5. When you are done, click Save and then Close to exit. 

 
 

Client Setup 
 
You can set up a new client in the following ways: 
 

 Client screen (see below) 
 Wizard (see Using Wizards in the General Features chapter) 
 Clone (see Clone Templates in the Company Management chapter) 
 Transfer from an integrated accounting package (see Data Integration in the Accounting 

chapter) 
 Import client records (see External Data below)  

 
This section covers the following tasks related to setting up of client records: 
 

 Creating Client Profiles 
 Creating Client Contacts 
 Deleting Clients 

 
 

Creating Client Profiles 
 
You can use the Client screen to create client profiles, add or edit client-related information.  
 

 You can set up your client profile at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Setup 
 
To create a client profile: 
 

1. Open the Client screen from the Company navigator, View menu, toolbar or Sidebar. 
 

2. If this is your first client, BillQuick automatically places the cursor in the Client ID field. 
Otherwise, click New on the button panel to create a new client.  
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3. Enter an ID for the client, up to 65 characters long. You can enter a short ID or a descriptive ID, 
e.g., Allied Tech for Allied Technology or BQES for BQE Software, Inc. 
 

4. Click Save and you are done! 
 
Advanced Setup 
 
To add additional information for the client: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. On the General tab, enter other information such as name of the client’s Company, Manager 
responsible for the client relationship, address and other contact information and so on. Press the 
Tab key to move from field to field or simply click on the desired field.  
 

3. Select a status for the client—Active or Inactive. Drop-down lists in BillQuick include only 
‘Active’ status clients. Changing the status to Inactive does not delete the client.  
 

4. Enter the client’s federal tax identification number (Federal ID) or the social security number for 
a sole proprietorship (up to 20 characters). You can customize this label from the Custom labels 
screen.  
 

5. Choose a Default Group for the client. This can be specified in addition to any group you choose. 
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6. Click  to assign a group to the client. Else, click Tools and select Group to create new groups 
for the clients (see Groups in the Company Management chapter for details). 
 

7. Enter any additional information in the Custom 1/2 fields (up to 50 characters). More custom fields 
are available on the Detail tab. You can customize these fields in the Custom Labels screen. 
 

8. Click  Link Files (or right-click). BillQuick allows you to link documents and files to the client. 
E.g., you may want to attach invoices or contract documents to the client record. (See File Linking 
in the General Features chapter for details.) 
 

9. Click  to open the Memo box at the bottom and type some notes related to the client. (For 
details, see Memos in the General Features chapter.) 
 

To add billing information for the client: 
 

1. Move to the Billing tab. Select a Payment Term from the drop-down. This determines the 
accounts receivables and aging for the invoice. To add a new term, select Add New and define 
the terms (See Payment Terms in the Billing Basics chapter for more). 
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2. Select the local Currency of the client from the drop-down list for the purposes of payment. 
 

 When you change the currency for a client, BillQuick prompts you 
whether to update the currency setting for all projects that belong to the client. 

 
3. Select a Service FS and an Expense FS if you want to bill your client using special rates. See Fee 

Schedules for more. 
 

4. Enter the rates for the Main Service Tax and Main Expense Tax to be applied to labor and 
expenses included on invoices. The taxes specified at the Company level carry to the clients but 
you can change them here. (For more information, see Taxes in the Billing Basics chapter.)  
 

5. If you want MST and MET to exclude item taxes (Tax1/Tax2/Tax3), check those options here. 
BillQuick directly applies the main taxes to labor/service and expense amount on invoices. 
 

6. Check the Exempt Item Taxes option to exempt all projects of this client from item taxes 
(Tax1/Tax2/Tax3) assigned to activity codes and expense codes. 
 

7. Check ‘Send Invoices Via Email’ option to send project and joint invoices generated for a client to 
the client’s email address.  
 

8. Check ‘Default to Joint Invoice’ option to combine all project bills for the client (with current 
billed activity) onto a single, joint invoice.  
 

9. You may specify a ‘Message on Invoice’; the text prints on all the invoices of this client. 
 

 When determining which invoice message to print, BillQuick checks the 
Project profile, then the Client profile and finally the Company profile. The first 
message found in the sequence prints on the invoice. 

 
10. Move to the Detail tab. Enter the Main Contact details for the client. If you want to add more 

contacts, click Tools and select Contacts to do so. 
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11. The Additional Contacts list at the bottom includes all client contacts. Double-click on a row to 
view their details in the Client Contacts screen.  
 

12. When you are done, click Save and then Close to exit.  
 
 

Creating Client Contacts 
 
You can assign a main contact and many additional contacts to a client. By default, BillQuick addresses 
invoices to the main contact of a client. Optionally, you can select an additional contact for a project and 
send the invoices to them.   
 
To add a contact, follow the steps below: 
 

1. Open the Client screen from the Company navigator, View menu, toolbar or Sidebar. 
 

2. Select the desired client from the grid list and then click on the Detail tab. 
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3. Enter the Main Contact details- First Name, Last Name, Phone, etc. 
 

4. Click Save to add the main contact to the client record. 
 

5. To add additional contacts, click Tools and select Contacts. Alternatively, select the Client 
Contacts screen from the View menu. 
 

6. To add a new contact in the Client Contacts screen, click New.  
 

7. Enter the ID, Name, Company and other contact information about the contact.  
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8. Enter any additional information (up to 50 characters) about the contact in the Custom 1/2/3 
fields, e.g., work experience or industry. You can customize these fields in the Custom Labels 
screen.  
 

9. If desired, click  Link Files to attach a file or a document to the contact. See File Linking for 
more information. 
 

10. Click Tools and select Clone to copy the contact details to a new contact record. 
 

11. When you are done, click Save and then Close to exit. 
 
 

Deleting Clients 
 
To delete a client record: 
 

1. Open the Client screen from the View menu, toolbar or navigator.  
 
2. Select the desired client in the grid. Verify this is the right client. 
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3. Click Delete, and then click  to verify your decision.  
 

4. When you are done, click Close to exit. 
 
 

Item Codes Setup 
 
You can set up a new activity or expense code in the following ways: 
 

 Creating Activity Codes and Expense Codes  
 Activity and Expense Wizards 
 Transferring items from an integrated accounting package (see Data Integration in the 

Accounting chapter) 
 Transferring from another time and billing program using a built-in data conversion 

utility 
 Importing activity and expense codes 

 
 

Activity Codes Setup 
 
You can create activity codes in many ways (besides those mentioned above): 
 

 In the BillQuick Start-Up Interview, you can choose a standard list of activity codes for 
your business type.  

 If you skip this step, you can do so in the Add Industry Codes screen (Utilities menu).  
 

 Activity Wizard (View menu or Sidebar) quickly and easily walks you through 
the process of creating new activity codes, using only basic information. You can 
later make changes in the Activity Codes screen.  

 
The ways in which you can create activity codes include: 
 

 Creating Activity Codes 
 Creating Two-Level Activity Codes 
 Adding Industry Codes 

 
 

Creating Activity Codes 

 

 You can set up your activity code at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 
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Basic Setup 
 
To create activity codes: 
 

1. Open the Activity Codes screen from the Company navigator, toolbar or View menu. 
 

2. To add a new activity, click New. Type the desired Code (and optionally, a Sub code) in the grid. 
The resulting Activity ID must be unique, allowing maximum of 15 characters for each. 
 

 
 

3. Press the Tab key or click to move to the Description field. Enter a description or name for the 
activity (up to 100 characters).  
 

4. Make sure each billable activity is marked as ‘Billable’ in the grid. Billable status carries to time 
entries. 
 

5. Enter the default hourly Cost Rate and Bill Rate of the activity item. BillQuick applies these rates 
to the time entries only when you turn on this option on the Project-Detail screen. 
 

6. Click on another row or press Tab through the end of the row to save the new record. You are 
done! 

 
Advanced Setup 
 
To add additional information: 
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1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. Use the custom fields to record any specific information about the activity (up to 50 characters). 
You can customize these fields in the Custom Labels screen.  
 

 The Custom Fields 1/2/3 will pre-fill the time entry custom fields and 
inherit the same data type. 

 
3. In addition, specify the Overtime Bill Rate to charge for overtime hours worked. If you do not 

define a rate here, BillQuick uses the default bill rate or special bill rate applicable to the task. 
 

4. Mark the activity Status as ‘Active’. Only active activities are included in the drop-down lists. 
 

5. Enter Minimum Hours to record for an activity. When recording a time entry, the Billing Hours 
(B-Hrs) default to the minimum hours set for the activity here. 
 

6. Select the desired Income Account and/or Expense Account from the drop-down list for the 
activity item. BillQuick displays the accounts only if they are available in the Chart of Accounts 
screen. (Check out the free Integration Guides for more information). 
 

7. Set up to three item taxes for the activity—Tax 1/2/3. BillQuick sums the rates (percentages) 
before applying them to individual activities. BillQuick applies item taxes in addition to any 
Main Service Tax on invoiced activities. 
 

8. Choose a Default Group for the activity. This can be specified in addition to any group you 
choose. 
 

 This is useful for reports, such as Budget Comparison. If there is a budget 
for activity group A and B, and activity CAD is the member of both groups but 
its default group is A, then CAD will be listed against A. 

 
 

9. Press Ctrl + M or click  to open the Memo box. You may enter unlimited text or notes for 
the activity. (See Memos in the General Features chapter for details.) This becomes the default 
memo for an activity charged for hours worked (time entry) on a project. 
 

10. Click Tools and select Link Files to attach any document or graphic to the activity record. 
 

11. If needed, you can drag and merge two activity codes on the grid. When it is possible to do so, 
BillQuick highlights the record in green. 
 

 If you have linked the merged activities with your accounting software, 
then you need to merge the activity items there as well. After you merge the 
records in BillQuick and your accounting software, run the Smart Match utility 
to make sure the two records are linked. See Data Integration for details. 

 
12. When you are done, click Close to exit. 

http://www.bqe.com/Support.asp?pageId=Documents
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 BillQuick automatically adds GEN:HOL, GEN:SICK and GEN:VAC to the 
Activity Codes table. You can customize the activity codes for these special 
items in the Global Settings screen. 

 
 

Creating Two-Level Activity Codes 
 
Consider a scenario where an architectural firm wants to track a category of activity as well as the activity 
or task. For example, if activity category is ‘Architecture’, the activities under it could be ‘Schematic 
Design’ and ‘Design Development’. At times, ‘Schematic Design’ could be the category and ‘Drawing’ and 
‘Correspondence’ could be its tasks.  
 
BillQuick easily handles such situations with two-level activity codes (and expense codes). BillQuick 
represents a two-level activity code by two fields: Code and Sub-Code. 
 
The Code field (also called the ‘Main Code’) along with Sub-Code can be up to 30 characters long (15 
characters each). Between the main and sub code, BillQuick automatically inserts a colon (:) as a 
separator.  
 
For the Code, you might use ‘AR’, ‘Arch’ or ‘Architecture’ as a category. Then for the Sub-Code, you 
might use ‘SD’, ‘SchDes’ or ‘Schem Design’ for the Architecture category. However, if your team thinks 
of their work differently, you can use ‘Schematic Design’ as a category (Code), and then define ‘Drawing’, 
‘Correspondence’ and other items as tasks (Sub-Codes).  
 

 Similarly, you can create two-level expense codes in BillQuick. 

 
 

Adding Industry Codes 
 
BillQuick allows you to select a standard list of activities or tasks for your company. While activities are 
easy to set up, you may want to spend some time deciding how they can work best for you before you 
start using them. Use the standard activity codes as a starting point.  
 

 Prior to running this utility, all BillQuick users need to log out from the 
shared database. 

 
To do so: 
 

1. Open the Add Industry Codes screen from the Utilities menu. 
 

2. Select your industry type or profession from the available list. 
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3. If you want to exclude some of the activity (service) items from the standard list, click Exclude. 
 

4. Check the items to exclude and then click Back to go back to the main screen. 
 

5. When you are done, click OK to allow BillQuick to add the standard activity codes to your 
database. You have an option to later add or delete activity codes from the Activity Codes screen. 

 
 

Expense Codes Setup 
 
Expenses incurred by an employee or a vendor can be reimbursable by the company and/or billable to 
the client. 
 

 Expense Wizard (View menu or Sidebar) quickly and easily walks you 
through the process of creating new expense codes, using only basic 
information. You can later make changes in the Expense Codes screen.  

 
 

Creating Expense Codes 
 

 You can set up your expense code at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 
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Basic Setup 
 
To create an expense item: 
 

1. Open the Expense Codes screen from the Company navigator, toolbar or View menu. 
 

2. To add a new expense, click New. Type the desired Code and, optionally, Sub code in the grid. 
The resulting Expense ID must be unique, maximum 13 characters long. 
 

 
 

3. Press the Tab key or click to move to the Description field. Enter a description or name for the 
expense (up to 100 characters).  
 

4. Enter the default per unit Cost for the expense item. For proper tracking, exclude any markups 
and taxes from this value. If the cost of an expense varies, leave the field blank; you can enter the 
rate in the Expense Log. 
 

5. Enter the MU% by which you want to increase or mark up the cost. BillQuick uses it to compute 
the amount charged to a client. Leave the field blank if the percentage varies with each expense 
entry.  

 

 BillQuick also allows you to enter negative markup. This markup 
automatically displays on the Expense Log screen.  

 
6. Make sure that each billable expense is marked as ‘Billable’ in the grid. 

 
7. Click on another row or press Tab through the end of the row to save the new record. You are 

done! 
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Advanced Setup 
 
To add additional information: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 

 
2. For reimbursable expenses, mark the ‘R’ checkbox. In this case, the cost amount is payable to an 

employee or a vendor. 
 
3. Custom fields allow you to record any specific information about the expense (up to 50 

characters). You can customize these fields in the Custom labels screen. 
 
4. Specify Tax 1/2/3 rates for the expense. BillQuick sums the percentages before applying them to 

individual expenses. BillQuick applies item taxes in addition to any Main Expense Tax on 
invoiced expenses. 
 

5. Enter a Purchase Tax amount for the expense item. This is the tax paid by the company on that 
item and is subtracted from the Charge Amount to avoid double-taxation for the client. 

 
6. Select an expense Type. This allows you to identify the type of expense: Inventory, Non-

Inventory or Other Charge Items. 
 
7. Set the expense Status to ‘Active’. Inactive expenses do not display in drop-down lists. 
 
8. Check ‘Product’ option if the expense code is a product sold to the clients.  

 

 When you bill a product and transfer the invoice to QuickBooks, it updates 
the inventory count there. 

 
9. Select the desired Income Account and/or Expense Account from the drop-down list for the 

expense item. Accounts display only if they are available in the Chart of Accounts screen in 
BillQuick. Check out BillQuickQuickBooks Integration Guide for more information. 

 
10. Choose a Default Group for the expense. This can be specified in addition to any group you 

choose. 
 

 This is useful for reports, such as Budget Comparison. If there is a budget 
for expense group A and B, and expense Mileage is the member of both groups 
but its default group is A, then Mileage will be listed against A. 

 

11. Press Ctrl + M or click  to open the Memo box. You may enter unlimited text or notes for 
the expense. (See Memos in the General Features chapter for details.) 
 

12. Click Tools and select Link Files to attach any document or graphic to the expense record. 
 

13. When you are done, click Close to exit. 
 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-QuickBooks-Integration-Guide-2011.pdf
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Project Setup 
 
In BillQuick, each client must have at least one project. A project is a scope of work done for a client. In 
addition, a project’s scope can be broken down into parts called phases. If desired, you can further refine 
phases into segments, and these can be broken down into sub-segments. In essence, BillQuick supports 
up to four levels in a project hierarchy.  
 
When you create a project, phase, segment and sub-segment, you define its profile and characteristics. 
This information is a project record. Each project record has a unique ID, is linked to a client (who 
authorizes and pays for the work), and includes agreed-on contract provisions like fee and contract 
amount. Depending on your needs, a project record might also have a budget, estimate, fee schedule, 
employees, activities and expenses assigned to it.  
 

 Project ID is a shorthand code used throughout BillQuick to identify a 
project quickly. Defining an intuitive ID structure for projects (and clients, 
activities, expenses and so on) can save hundreds of hours a year across your 
company. See the Project Management chapter for more information. 

 
As a part of a project setup plan, you can do the following: 
 

 Creating Project Profiles 
 Cloning Project Records 
 Auto Adding Projects 
 Creating Project Phases and Segments 
 Deleting Projects 
 Budget and Estimate Setup 
 Fee Schedule Setup 

 
 

Creating Project Profiles 
 
BillQuick provides several ways to create a new project profile, including several shortcuts that can 
reduce setup time.  
 

 Project Wizard (select Wizards from View menu or Sidebar) quickly and 
easily walks you through the process of creating new project profiles, using only 
basic information. You can later make changes in the Project screen. 

 

 You can set up your project profile at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Setup 
 
To create a new project profile: 
 

1. Open the Project screen from the Company navigator, Project menu, Sidebar or toolbar. 
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2. If this is your first project, BillQuick automatically places the cursor in the Code field. Otherwise, 

click New at the top of this screen to create a new project. 
 

 
 

3. On the General tab, enter a Code for the project and, optionally, a Phase. On saving, BillQuick 
automatically combines the Code and Phase into a single Project ID, max 65 characters long. 
 

4. Enter other required data, such as Name (up to 50 characters). Move from field to field by 
pressing the Tab key or clicking on the desired field.  
 

5. Enter the Client to whom this project belongs. Click  to open the Client screen and view its 
details.  
 

6. Specify a Manager who is responsible for the project. Select one from the drop-down list.  
 

7. Select the relevant Contract Type, such as Hourly, Fixed, etc. It determines the processing rules 
and billing arrangement for the project. See Contract Types in the Project Management chapter. 
 

8. Enter a Status for the project (normally Active for a new project). For details, see Project Status in 
the Project Management chapter. 
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9. Click Save and you are done! 
 
Advanced Setup 
 
To add additional information for the project: 
 

1. On the General tab, select a Start Date and Due Date for the project (if required). 
 

 BillQuick includes the start and due date on several reports, including 
Project Master File, Project Due Date and Project Master File by Project Status. 

 
2. Enter the address details of the project and other Contact Info. Else check the ‘Use Client 

Address’ option if you want to assign the client address to it. 
 

 On saving the project information, BillQuick auto populates the project 
address fields with the client address.  

 
3. Optionally, enter any specific information in the Custom 1/2/3/4 fields (up to 50 characters each). 

More custom fields are available on the Detail tab. You can customize these fields in the Custom 
Labels screen. 
 

4. Click  Link Files to link any file or document to the project. E.g., you may want to scan and 
attach contract documents for reference. 
 

5. Click  View Journal to view or create a project journal. It is helpful in maintaining qualitative 
information about the project as you work on it. 
 

6. Click  at the bottom to open the Memo box and enter as much text as you need. See Memos in 
the General Features chapter for details. 
 

7. Move to the Detail tab. Choose a Default Group for the project. This can be specified in addition 
to any other group you choose. 
 

 This is useful for reports. If there is a budget for project PV, which is a 
member of both group A and B but its default group is A, then PV will be listed 
against A. 
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8. Assign the project to one or more existing groups. Else, create a new project group by clicking 
Tools and selecting Group. See Grouping Projects in the Project Management chapter for more. 
 

9. On the Assign tab (visible only if specified in the Preferences screen), you can assign specific 
activities, expenses and employees to your project. See Project Assignments in the Project 
Management chapter for details. 

 



Master Information Setup 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 128 

 
 
To set up billing information for the project: 
 

1. On the General tab, enter a Contract Amount (required for fixed-type projects). This amount 
can be broken into a Service Amount and Expense Amount. Entering values in the two fields 
calculates the third. 

 

 By default, BillQuick assumes billable expenses are not part of the 
contract. If these are to be included in the contract, mark ‘Expense Part of 
Contract’ rule on the Detail tab. 

 

2. Click  to open the Project 
Settlement Amount dialog. 
BillQuick re-calculates the 
Contract Amount based on a 
settlement percentage 
entered here. 
 
 
 
 
 

3. In the Fixed Fee field, enter a percentage for Cost + Percentage contract. For Cost + Fixed Fee 
contract, enter a fixed fee amount. This field is visible only if you select a Cost Plus contract 
type. 
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4. Enter the % Complete value for the project. Usually, the project manager manually updates this 
percentage.  
 

 When you do percent complete billing (for any contract type), this value 
carries to the Billing Review screen (and vice versa). BillQuick uses it to 
compute the bill amount and earned value. 

 
5. Now, move to the Billing tab.  

 

 
 

6. Enter a Recurring Bill Amount and Frequency for recurring-type contracts. It triggers a reminder 
when it is time to bill the client. 
 

 Frequency of billing for a project starts from the date of the invoice. Billing 
frequency can also be set for the non-recurring project contracts. 
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7. Enter the Retainage % that a client will hold back while making payments on invoices. The client 
pays this amount after the verification of work done or completion of entire project. (See 
SettingRetainageRetainage in the Billing Basics chapter for details.) 
 

8. Specify a Maximum Retainage Amount allowed by a company for the project. Billed amounts 
above the maximum retainage are due from the client. 
 

9. Next, select and assign a service fee schedule to the project. Click Add New in the drop-down to 
create a new schedule or click the Service FS link to open it. 
 

10. Similarly, select and assign an expense fee schedule, estimate or budget to the project. Click Add 
New in the drop-downs to create a new Expense FS, Estimate or Budget, or click on the links to 
open the respective screens.  
 

 For details, see Project Assignments in the Project Management chapter. 

 
11. Select an additional Delayed Service FS if you want to use different bill rates when services are 

pre-sold. Based on the Trigger Type and Amount specified, BillQuick applies the delayed rates 
instead of the scheduled rates. For details, see Assigning Delayed SFS in the Project Management 
chapter. 
 
Click Add New in the drop-down to create a new Delayed Service FS or click its link to open the 
screen. 
 

12. Select a Payment Term for the invoices generated for this project. To add a new term, select 
Add New and define the payment terms.  
 

 A blank payment term means the invoice is due upon receipt. The payment 
term for a project overrides the default term set for the client. See Payment Terms in 
the Billing Basics chapter for details.  

 
13. Select a local Currency for the project. You can maintain currency conversion rates on the 

Currency Manager screen. The currency selected for a project overrides the default currency set at 
the client level. 

 
14. In the Options section, check ‘Send as Joint Invoice’ option to bill this and other marked projects 

belonging to the same client on a joint invoice. 
 

15. Check ‘Email Invoices’ to automatically email a PDF of project invoice to the client. 
 

16. Click Automatic Billing to define an automatic billing schedule for the project. BillQuick saves the 
settings and generates invoices accordingly. See Automatic Billing for more.  
 

17. Check ‘Use Custom Invoice Number’ to customize the project’s invoice number format. You can 
use it in exceptional cases, when you want to replace the default format defined in the Global 
Settings screen. 
 

18. Enter the static text for the Prefix and Suffix of the invoice number format. In the Last Invoice 
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Number field, enter a variable (or static text and a variable). For example, the prefix might be the 
name of a project type (Tax) while the suffix is the year (2011) the project started. With a digit 
variable beginning with 1100, the next invoice number would be Tax11012011. #1 - {  } are not 
accepted in these field. 
 

 See Customizing Invoice Numbers in the Billing Basics chapter for more. 
 

19. Enter a Retainer Amount if you want the client to pay some amount in advance. To create and 

preview a retainer invoice, click . 
 

20. Select a Contact for the project. You can address the invoices and statements to this contact 
instead of the client contact. (See Assigning Project Contacts in the Project Management chapter.) 
 

21. Check ‘Send Invoice to Contact’ if you want BillQuick to send invoices to the project contact 
instead of the client contact. This rule also applies when emailing invoices. 
 

22. Enter a Code in the Misc section if relevant. Architects and engineers who work with federal 
agencies may use this as a reference for Forms SF 254 and SF 255. 
 

23. Now click on the Detail tab. Enter the number of days or grace period after which BillQuick will 
charge an interest % per month on past due invoices. The payment term set for a project on the 
Billing tab is carried to the ‘After…Days’ field here.  
 

24. Enter the Main Service Tax/Expense Tax rates for the labor and expense amount on invoices. 
BillQuick applies the rates from the Client or Company screen, unless specified here. 
 

25. Enter a ‘Message on Invoice’ to print on all invoices for this project.  
 

 You can also define standard invoice messages at the Company and Client 
level. BillQuick checks for a message in the following order: Project, Client and 
then Company. If none has an invoice message, none will print. 

 

 You can see a summary activity and account information of an existing 
project on the Account and History tabs. See Project Information in the Project 
Management chapter for details. 

 
To create a phase for the project: 
 

1. On the General tab, click Create Phase. It opens the ‘Create Project Phase’ window.  
 

2. Enter the required data to create a phase. Click OK when you are done and exit.  
 
Alternatively, click on the Detail tab and enter required data to set the current project as a phase.  
See Creating Project Phases and Segments below for more. 

 
To set up project rules: 
 

1. Move to the Detail tab.  
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2. In the Rules section, 
check the relevant 
rules in the 
dropdown list to 
apply to the selected 
project. These rules 
affect the 
management and 
billing of the project. 

 

3. When you are done, 
click Save and then 
Close to exit. 

 
 
 

 See Project Settings in the Project Management chapter for details. 

 
 

Cloning Project Records 
 
At times, you may have to create similar project profiles or offer similar services to multiple clients. 
BillQuick’s Project Cloning feature includes the ability to clone a project record for one or many clients. 
Later, you can fine-tune each cloned project with unique data using the Change feature. 
 
Batch cloning is most helpful when you want to maintain separate project record for each fiscal year 
you work for a client. For example, an accounting firm delivers tax preparation services to hundreds, 
perhaps thousands, of clients every year. Setting up tax preparation projects for even 50 clients is a major 
chore, hundreds could take days to complete. Using a ‘clone template’ to create projects in bulk can save 
a lot of time and effort. For the accounting firm, this means you can clone ‘1040-2011’ project to all tax 
preparation clients in one go!  
 

 Project Clone allows you to clone the associated Project Control settings 
as well. 

 
To clone a project record:  
 

1. Open the Project screen from the Company navigator, Project menu, Sidebar or toolbar. 
 

2. Select an existing project from the grid list that you want to clone.   
 

Or 
 

Create a new project clone template from scratch (as explained above).  
 

 Make sure the fields contain only the data you want to duplicate among 
cloned projects. For required fields with no common data, type a few 
placeholder characters. 
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3. Now, click Tools and select Clone. The ‘Project Cloning’ screen opens. 

 
4. In the Clone From field, select the ID of the desired project to clone (source project).  

 

 
 

5. To clone the selected project for the same client, enter a Code and optionally a Phase for the 
new project. 
 

 When cloning a project and its phases, BillQuick retains the phase ID of the 
cloned phase. 

 
6. Enter up to 50 characters for the project’s name or Description. 

 
7. To clone the selected project for a different client or multiple clients, check the ‘Clone for 

selected Client(s)’ box. Select the desired client(s). 
 

8. If you have checked the ‘Clone for selected Client(s)’ option, you can enter the optional Phase 
only.  
 

 Generally, BillQuick uses the Code + Phase to create a Project ID. 
However, it automatically uses the Client ID + Phase to create a Project ID 
when creating new project record(s) for selected client(s).  
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9. Check the ‘Skip Copying Memo’ option if you do not want to clone the project memo. 

 
10. Click OK to complete the cloning process. 

 
Back on the Project screen, the newly cloned projects display. You can modify the data in individual 
project records or use Project Change to edit multiple projects at once.  
 
 

Auto Adding Projects 
 
You can automatically create a project for a client right from the Client screen. Follow the steps below to 
do so: 
 

1. Open the Client screen from the Company navigator, View menu, toolbar or Sidebar. 
 

2. Create a new client (as explained earlier). Else, select any existing client from the grid list. 
 

3. Check the ‘Auto Add New Project’ option on the General tab. Enter the Code and Phase for the 
new project.  
 

 
 

4. Optionally, select any existing project in the ‘Copy From’ drop-down list. The Code of the 
project will be auto-generated based on the Client ID. 
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5. BillQuick uses the Client Manager as the Project Manager for the new project. If you have not 
provided a Client Manager, then it prompts you for this information. 
 

6. When you are done, click Save. 
 
 

Creating Project Phases and Segments 
 
A parent project can be broken down into child projects called phases. Phases can be further broken 
down into segments and segments into sub-segments. Each of these has a complete project profile 
including an optional budget, fee schedule and other elements.  
 
There are four ways to create a phase: 
 

 Using the Create Phase button 
 Linking child to parent projects 
 Dragging-and-dropping projects 
 Cloning projects 

 
Using the Create Phase Button 
 
To clone a phase from a project record: 
 

1. Open the Project screen from the Company navigator, Project menu, Sidebar or toolbar. 
 

2. Select the desired project from the grid list. This is the parent project for the new phase. 
 

3. On the General tab, click Create Phase. The ‘Create Project Phase’ dialog opens.  
 

 
4. Enter the Phase Details: Phase, Description, Name, Contract Amount and Contract Type. 

Optionally, you can allocate a percentage of contract amount from the parent project. Click OK.  
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5. To create a segment of the phase, select the project phase from the grid list and repeat the 
above steps.  
 

 When creating a segment for a project phase, BillQuick uses the Project ID 
of the phase as the Code. It adds the Phase to it to create a Project ID for the 
new segment. E.g., if an existing phase is 10-Hillard:4-CA and you are creating a 
segment for it, BillQuick will pre-fill its Code as 10-Hillard-4-CA and attach a 
Phase name (specified by you) to it separated by a colon. 

 
6. When you are done, click Close to exit. 

 
Linking Child Project to Parent Project 
 
You can link a new child project to a parent project. To create and then link a project (phase, segment or 
sub-segment) to its parent record:  
 

1. Open the Project screen from the Company navigator, Project menu, Sidebar or toolbar. 
 

2. Create a new project (as explained above). 
 

3. Click the Detail tab. In the Phase Information section, check the ‘Set this Project as a Phase of’ 
option and then select a parent project from the dropdown.  
 

 
 

4. Enter the % of Total Project contract amount (parent project) to distribute to the phases (child 
projects below in the hierarchy). For example, if the contract amount of a main or parent project 
is $100,000 and the phase is 55% of the total project, then BillQuick assigns $55,000 to it. 
 

5. Optionally, enter an appropriate phase description and click Save. 
 

6. To create its segment, select this project phase as a parent project (at step 3) and repeat the 
above steps. 
 

7. When you are done, click Save and then Close to exit.  
 
 
 
Dragging-and-Dropping to Change Project Relationships  
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You can create a new parent-child project relationship or rearrange an existing project hierarchy by 
dragging and dropping projects in the grid. To do so:  
 

1. Open the Project screen from the Company navigator, Project menu, Sidebar or toolbar. 
 

2. In the project grid, double-click on the project you want to move (child/phase), hold down your 
left mouse button and drag it up or down in the grid list. 

 

 
 
3. Move it over the desired parent project. The highlighted project row changes colors as you drag 

across it. You cannot place a project for one client under a project for another client (a reddish-
orange highlight visually indicates this). When the highlighted row is green, you can release the 
mouse button and drop the child project. The project record instantly moves below the parent 
project. 
 

4. To create its segment, drag and drop a project under a phase, and repeat as above. 
 

5. When you are done, click Save and then Close to exit. 
 
Cloning Project Hierarchy  
 
To clone an entire project hierarchy from a parent/main project to the sub-segment at the lowest level:  
 

1. Open the Project screen from the Company navigator, Project menu, Sidebar or toolbar. 
 

2. Click Tools and select Clone to open the Project Cloning screen. 
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3. In the Clone From field, select the parent project whose entire hierarchy you want to clone.  
 

 
 

4. In the New Project section, enter the new project Code and Description. Then click OK. 
 
5. BillQuick asks if you want to clone all phases (including segments and sub-segments) of the 

parent project. Click . 
 

 When cloning a project and its phases, BillQuick retains the phase ID of the 
cloned phase.  

 
6. When you are done, click Save and then Close to exit.  

 
 

Deleting Projects 
 

 To safeguard your assets, make a backup of your company database 
before deleting a project. 

 
You can delete a project but its status must be ‘Active’ to appear in the drop-down lists. To delete a 
project: 
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1. Open the Project screen from the Project menu, toolbar, Sidebar or navigator. 
 
2. Scroll the grid list and find the project you want to delete. Also, note the client associated with 

this project.  
 

3. Click Delete and then click  to verify your decision. 
 

4. When you are done, click Save and then Close to exit. 
 
If some data is associated with the project, you must first delete that (time entries, expense entries, 
invoices and payments). The best plan of action is: 
 

1. For the project that you want to delete, determine what you have recorded against it by 
reviewing the Project-Account screen. (Note the values pointing to time, expense, invoice and 
payments.) 
 

 

 ‘Services x Billable’ shows there are time entries on file. ‘Expenses x 
Billable’ shows there are expense entries. ‘Total Amount Billed’ shows there is 
invoice activity and ‘Total Amount Paid’ shows there are payment records. 
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2. Open the Payment screen from the Billing menu, toolbar, Sidebar or navigator. 
 
3. Select View By: Project and then select a project. 
 

 
 

4. Next, move to the Previous Payment field and select the previous payment. The corresponding 
invoice and payment details display in the grid.  
 

5. Click Delete. BillQuick confirms that the deletion was successful. When you are done, click 
Close. 

 
6. Next, open the Invoice Review screen from the Billing menu, Sidebar, toolbar or navigator.  
 

7. In the Filters section, click  in the Project field and select the relevant Project ID(s) from the 
dropdown.  
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8. Click Refresh to display the invoices. Then click Select and choose the Select All option. 
 

9. Next, click Reverse and confirm this action. (If you missed deleting any associated payments, 
BillQuick displays a message.) 
 

10. When you are done, click Close and move on. 
 
11. Open Sheet View from the Time-Expense menu, toolbar, Sidebar or navigator.  
 
12. Select View By: Project, then select the project.  

 
13. Next, move to the Period field and select ‘All’. Click Refresh to display all time entries for the 

project.  
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14. Click Select and choose Select All option, and then press Delete on your keyboard to delete all 
the associated time entries.  
 

 BillQuick does not delete time entries associated with vendor bills. You 
will have to edit the vendor bills to do that. 

 
15. When you are done, click Close to exit.  
 
16. Next, open the Expense Log screen from the Time-Expense menu, toolbar, Sidebar or navigator. 
 
17. Repeat these steps to delete expense entries for the project. If there are no expenses for the 

project, continue to the next step. 
 
18. Open the Project screen from the Project menu, toolbar, Sidebar or navigator. 

 

19. Select the project you want to delete. Click Delete, and then click  to verify your 
decision. 
 

 Be sure about the project record that you want to delete. If you delete any 
data by mistake, you cannot recover it. 

 
20. When you are done, click Save and then Close to exit. 
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Budget and Estimate Setup 
 
Budgets are a good way to track the expected revenue or cost of a project against the actual. They 
combine detailed service and expense items to calculate the total budget of a project. You may use the 
same budget for several projects. 
 
An estimate is a proposed task list with hours and bill rates used to compute the amount for each line 
item. A budget is the same except it is used for internal purposes and you can assign an employee or a 
vendor (or group) to a task. You can convert a budget to an estimate and vice versa. You can mark up 
your budget for profit and then create an estimate for the client. Budgets and estimates include separate 
services and expense portions. Both can draw bill rates from a service fee schedule and expense fee 
schedule. 
 
Before creating a budget, consider the following points: 
 

 Discuss it with your team members. Get their estimated hours and units. 
 Research similar job or project costs in the industry. 
 Add anticipated expenses to the budget. 
 Add a contingency to the budget. 
 Share the budget with the client and make it a part of the contract. 
 If using groups, make sure that no two groups have the same items for budget reporting 

purposes. 
 Assign individual items for budget comparison purposes. 

 
This section covers the following tasks: 
 

 Creating Budgets 
 Creating Estimates 
 Converting Budgets to Estimates 

 
 

Creating Budgets 
 

 You can set up your budget at a basic level with a few mouse-clicks or 
at an advanced level with all the details. Please read the desired sections. 

 
Basic Setup 
 
To set up a new budget: 
 

1. Open the Budget screen from the Project menu or toolbar. Alternatively, open it from the 
Project-Billing screen. 
 

2. Click New. On the New dialog, enter an ID and a Description for the budget.  
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3.  Optionally, base your budget on an existing 
one by selecting it in the ‘Budget Based On’ 
field. When you are done, click OK.  
 

Or 
 

Consider whether you want to pull bill rates 
from a SFS or EFS. If so, select it from the 
Service Fee Schedule and Expense Fee 
Schedule drop-down lists. BillQuick pre-fills 
the grids with that data. 

 
 

 

 
 
4.  On the Service tab, select an Employee and Activity in the grid. You can also track a budget by 

selecting an Employee Group or Activity Group. 
 
5. Enter the number of hours (Hrs) budgeted for the employee-activity item. BillQuick allows you 

to enter negative hours. 
 

6.  Accept the Bill Rate carried forward from service fee schedule (if you have selected it).  
 
Alternatively, enter a new rate for the employee-activity combination. Amount is calculated for 
the budget item (Hours x Rate). 
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7.  Move to the Expense tab. Select the desired Employee and Expense. 
 

 
 

8.  Accept the values carried forward from expense fee schedule (if you have selected it). 
Alternatively, enter the expected Units, Cost or MU % for the expense. 
 

 Do not enter a percentage as a decimal. For example, to mark up the cost 
rate by 10%, enter 10, not 0.10. BillQuick allows you to enter a negative 
markup. 

 
9.  Charge Amount is calculated for the budget item [Units x Cost Rate x (1 + MU%)] x (1 + Tax1 

+ Tax2 + Tax3). The budget totals appear at the bottom, combining labor and expense 
amounts. Click Save and you are done! 

 
Advanced Setup 
 
To add additional information: 

 
1. In the Created By field, select the ID of the employee responsible for the budget.  
 
2. Set the budget status to Incomplete (after it is approved, change the status to Active). 
 
3. Mark ‘Show Vendors’ option if you want to display vendors and vendor groups in the employee 

drop-down list. 
 

4. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

5. On the Service tab, BillQuick retrieves the Cost Rate of the activity item being budgeted from 
the Activity Codes screen. You can enter any other rate if you want. You can use this rate to 
base your budget on the cost to the company and not the billable value. 
 

6. Optionally, add a % Done value to represent how much of the budgeted activity have you 
performed. 
 

7. Enter Tax 1/2/3 percentages to add to the cost to compute the budget Amount for the line item. 
Tax rates carry from the Activity Codes screen but you can change them here. 

8. If desired, enter any custom data for the service line item in the Custom 1/2/3 fields (up to 50 
characters). You can do so for the expense item as well. 
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9. On the Expense tab, enter Tax 1/2/3 percentages to add to the cost to compute the budget 
Amount for the line item. Tax rates carry from the Expense Codes screen but you can change 
them here.  

 
10. You can add a % Done value that represents how much of the budgeted expense you have 

incurred. 
 
11. Check the Approve option. Once approved, a budget is put to use and cannot be edited (requires 

security permissions). 
 

12. To type a Memo, press Ctrl + M from a row or click  at the bottom. You can enter as much 
text as you need or insert Auto Complete shorthand codes into it. 
 

13. If desired, click Tools and select Link Files to attach any document or graphic to the budget. See 
File Linking for more information. 
 

14. When you are done, click Save and then Close to exit. 
 
Once created, you can click Tools and use a budget for the following: 
 

 Select ‘Convert to Estimate’ to convert a budget into an estimate. 
 Select Create Invoice to convert a budget into a manual invoice. 

 

 When creating a manual invoice from a budget, BillQuick calculates the 
total bill amount based on the % Done values less any previously billed 
amounts. 

 
 Select Assign to assign a budget to a project or multiple projects. 
 Select Purchase Orders to create a purchase order from the selected budget.  

 

 A budget must be assigned to a project and contain at least one vendor-
related service or expense item to be converted into a purchase order. 

 
 

Creating Estimates 
 
Typically, you send estimates to clients as part of a project proposal. BillQuick includes an Estimate 
Comparison Report that compares estimate hours and amounts to what you spent, how much remains, 
and whether you are over or under the estimate for each activity and expense. 
 

 You can set up your estimate at a basic level with a few mouse-clicks 
or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Setup 
 
To create a new estimate: 
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1. Open the Estimate screen from the Project menu or toolbar. You can also do so from the 
Project-Billing screen. 
 

2. Click New; enter a unique Estimate ID and 
Description in the dialog box. 
 

3. Optionally, you can base it on an existing one. 
Check the ‘Estimate Based On’ option and select 
the existing estimate from the drop-down list. 
When you are done, click OK. 
 

Or 
 

Consider whether you want to pull data from a SFS 
or EFS for the estimate. If so, select a Service Fee Schedule or Expense Fee Schedule from the 
drop-down list. BillQuick pre-fills the grid with that data. 
 

4. On the Service tab, enter the expected activity (ID) to be performed and expected time (Hrs) 
required for that activity. BillQuick allows you to enter negative hours. 
 

 
 

5. Accept or enter a new bill Rate to charge for the activity. BillQuick calculates the Amount for the 
estimated item (Hours x Rate). 
 

6. On the Expense tab, enter the expense (ID) expected to incur.  
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7. Enter the estimated number of Units and Cost rate charged for that expense. 
 

8. Enter the markup percentage (MU %) on the cost rate.  
 

 Do not enter a percentage as a decimal. For example, to mark up the cost 
rate by 10%, enter 10, not 0.10. BillQuick allows you to enter a negative 
markup. 

 
BillQuick calculates the charge Amount for the expense item [Units x Cost Rate x (1 + MU%)] x 
(1 + Tax1 + Tax2 + Tax3). The estimated totals appear at the bottom, combining labor and 
expense amounts.  

 
9. Click Save and you are done! 

 
Advanced Setup 
 
To add additional details: 
 

1. In the Created By field, select the ID of the employee responsible for the estimate. 
 

2. Select a Status for the estimate—Active, Incomplete or Inactive—from the drop-down list. 
 

3. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

4. On the Service tab, add a % Done value to represent the percentage of an activity worked. 
 

 You can use the % Done value to create a manual invoice with percent 
done information for contractors.  

 
5. If desired, enter any custom data for the service line item in the Custom 1/2/3 fields (up to 50 

characters). You can do so for the expense item as well. 
 

6. On the Expense tab, enter the Tax 1/2/3 percentages to add to the cost of the estimated item. 
Tax rates carry from the Expense Codes screen but you can change them here.  
 

7. Next, enter a % Done value that represents the percentage of the expense used up. 
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8. Check the Approve option to approve the estimate. Once approved, an estimate cannot be 
edited (requires security permission). 
 

9. To type a memo, press Ctrl + M from any row or click  at the bottom. You can enter as much 
text as you need or insert Auto Complete shorthand codes into it. 
 

10. If desired, click Tools and select Link Files to attach any document or graphic to the estimate. See 
File Linking for more information. 
 

11. When you are done, click Save and then Close to exit. 
 
Once created, you can and use the estimate for the following: 
 

 Click Email to send the estimate to the client via email. 
 Click Tools and select ‘Convert to Budget’ to convert this estimate into a budget. 
 Click Tools and select Create Invoice to convert an estimate into a manual invoice. 

 

 When creating a manual invoice from an estimate, BillQuick calculates the 
total bill amount based on the % Done values less any previously billed 
amounts. 

 
 Click Tools and select Assign to assign this budget to a project or multiple projects. 

 
 

Converting Budgets to Estimates 
 
If you have created a budget, you can easily convert it into an estimate. Similarly, if you have an estimate, 
you can convert it to a budget.  
 
To convert a budget into an estimate: 
 

1.   Open the Budget screen and select the desired budget. 
 

2.  Click Tools and select ‘Convert to Estimate’. When prompted, enter the Estimate ID and 
Description. 
 

3.  Once created, you can then assign that estimate to a project in the Project screen.  
 
 

Fee Schedule Setup 
 
Service fee schedules (SFS) and expense fee schedules (EFS) contain special bill and cost rates. With fee 
schedules, BillQuick eliminates manual entry and changing of alternative rates or setting up extra codes 
for special situations. When you assign a fee schedule to a project, BillQuick automatically determines 
whether to apply the default or special rate to a time or an expense entry. 
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BillQuick allows you to set fee schedule rates by employee-activity combination. Further, you can specify 
an employee title or classification for each rate. BillQuick associates this classification with relevant time 
and expense entries, though you can edit it in the respective screens. See Determining Rates for details. 
 
This section covers the following setup tasks: 
 

 Creating Service Fee Schedules 
 Creating Fee Schedules Based on Existing Schedule 
 Creating Expense Fee Schedules 

 
 

Creating Service Fee Schedules 
 

 Service Fee Schedule Wizard (select Wizards from View menu or Sidebar) 
quickly and easily walks you through the process of creating new SFS, using only 
basic information. You can later make changes in the Project screen. 

 

 You can set up your service fee schedule at a basic level with a few 
mouse-clicks or at an advanced level with all the details. Please read the 
desired sections. 

 
Basic Setup 
 
To create a SFS: 
  

1. Open the Service Fee Schedule screen from the View menu or toolbar. You can also do so from 
the Project-Billing screen. 
 

2.  Click New. On the ‘New Fee Schedule’ 
dialog, enter the ID and Description of the 
schedule. When you are done, click OK.  

 
 
 
 
 
 
 
 
 
 
3. On the Service Fee Schedule tab, select either an Employee or an Employee Group from the 

drop-down lists. You may choose only one or the other. 
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4. Select either an Activity or an Activity Group from the drop-down lists. You may choose only one 
or the other.  
 

5. If you select a single employee, the employee’s Bill Rate and Cost Rate carry forward from the 
Employee profile. You can (a) change the default rates or (b) apply a Multiplier. If you select an 
employee group, simply enter the special rate.  
 

 BillQuick allows you to enter a $0 or null rate if you check the ‘Zero rates 
in Fee Schedules are valid’ option in the Global Settings-Rules screen.  

 
6. To save the schedule item, click on another row or press Tab for the remaining fields in the row. 

You are done! 
 
Advanced Setup 
 
To add additional information: 
 

1. Select a Status for the schedule—Active or Inactive—from the drop-down list. Drop-down lists 
in BillQuick include only active schedules. 
 

2. You may select a budget in the From Budget field to populate a SFS with the same information. 
You can then simply edit it here to suit your requirements. 
 

3. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
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4. When you select an Employee ID, you may use a PR Multiplier. It uses the employee’s Pay Rate 
to compute the special Bill Rate. 
 

 If you change the default Pay Rate of an employee (e.g., a raise) after 
defining a fee schedule that contains the Pay Rate Multiplier, BillQuick prompts 
you to update the associated SFS.  

 
5. When you select an Employee ID, you may use a BR Multiplier. It uses the employee’s Bill Rate to 

compute the special Bill Rate. For example, if the employee’s default bill rate is $100 and you 
enter ‘1.5’ into the BR Multiple field, the bill rate on the schedule will be $150 ($100 x 1.5). 
 

6. When you select any employee/group-activity/group combination, you may use an OT Multiplier. 
It uses the scheduled Bill Rate to compute the special OT Bill Rate. For example, if the bill rate 
for the schedule item (not the employee’s default bill rate) is $120 and you enter 1.5 in the OT 
Mult Field, the overtime bill rate will be $180 ($120 x 1.5). 
 

7. Enter the Minimum B-Hrs to record minimum time for this employee-activity combination in a 
time entry screen. You can edit these billing hours and use it to assign special day-rates (see Rates 
in the Billing Basics chapter). 
 

8. Optionally, enter text for a Memo to carry forward to the time entry when you choose the 
special item. 
 

9. Select a Classification or title for the selected employee/group if you want to assign different 
rates to the same employee with several job titles. BillQuick will associate it with the relevant 
time entries. See Determining Rates for details.  
 

10. BillQuick assigns a Priority number to this entry but you can change it using the Up and Down 
buttons. Priority is important because it determines which rate BillQuick fetches from the SFS in 
case of multiple matches. 
 

11. If desired, click Tools and select Link Files to attach any document or graphics to the SFS. See File 
Linking for more information. 
 

 Click Tools and select Assign to assign the SFS to one or multiple projects.   

 
12. When you are done, click Close to exit.  

 

 If desired, you can base a new schedule on an existing one. For example, if 
you create a new schedule with updated bill rates based on an outdated one, it 
saves time to copy the existing items to the new schedule. 

 
 

Creating Fee Schedules Based on Existing Schedule 
 
A company often adjusts rates, including special rates, one or more times a year. At times, you may want 
a new fee schedule that is similar to an existing one. To save time and effort, do the following: 
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1. Open the Service Fee Schedule screen from the View menu or toolbar. You can also do so from 
the Project-Billing screen. 
 

2. Click New. On the ‘New Fee Schedule’ 
dialog, enter the ID and Description of the 
schedule. 
 

3.  Check ‘Schedule Based On’ option and 
choose an existing SFS to use as a basis for a 
new one. When you are done, click OK  
 

4.  The existing fee schedule’s information 
displays. Make the desired modifications to 
the data.  
 

5.  When you are done, click Close to exit.  
 
 

Creating Expense Fee Schedules 
 

 You can set up your expense fee schedule at a basic level with a few 
mouse-clicks or at an advanced level with all the details. Please read the 
desired sections. 

 
Basic Setup 
 
To create an expense fee schedule: 
 

1. Open the Expense Fee Schedule screen from the View menu or toolbar. You can also do so from 
the Project-Billing screen. 
 

2. Click New. On the ‘New Fee Schedule’ 
dialog, enter the ID and Description of the 
schedule. When you are done, click OK. 
 
 
 
 
 
 
 
 
 
 
 

3. On the Expense Fee Schedule tab, select either an Employee ID or an Employee Group from the 
drop-down lists. You may choose only one or the other.  
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4. Select either an Expense ID or an Expense Group from the drop-down lists. You may choose only 

one or the other.  
 
5. If you select a single expense, its default Cost and Markup carries forward from the Expense 

Code profile. You can change these default values. If you select an expense group, simply enter 
the special rates.  

 
6. To save the schedule item, click on another row or press Tab for the remaining fields in the row. 

You are done! 
 

 If desired, you can base a new fee schedule on an existing one. For 
example, if you create a new EFS with updated cost rates based on an outdated 
one, it saves time to copy the existing items to the new schedule. (See above for 
details.) 

 
Advanced Setup 
 
To add additional information: 
 

1. Select a Status for the schedule—Active or Inactive—from the drop-down list. Drop-down lists 
in BillQuick include only active status schedules. 
 

2. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

3. Enter up to three tax percentages per schedule item (Tax 1/2/3). BillQuick sums these 
percentages before applying them to the individual expenses. 
 

4. Check ‘Reimb’ if the expense is reimbursable to the employee who incurred it. 
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5. Optionally, enter text for a Memo to carry forward to the expense entry when you choose the 
special item. 
 

6. Select a Classification or title for the selected employee/group if you want to assign different 
rates to the same employee with several job titles. BillQuick will associate it to the relevant 
expense entries. See Determining Rates for details.  

 
7. BillQuick assigns a Priority number to this entry but you can change it using the Up and Down 

buttons. Priority is important because it determines which rate BillQuick fetches from the EFS in 
case of multiple matches. 
 

8. If desired, click Tools and select Link Files to attach any document or graphic to the EFS. See File 
Linking for more information. 
 

 Click Tools and select Assign to assign the EFS to one or multiple projects. 

 
9. When you are done, click Close to exit.  

 
 

External Data 
 
You can fill the BillQuick Company database with new data created in BillQuick or transferred from 
another application to it. You can add or import data to BillQuick using the Import/Export, data 
conversion and data integration utilities. 
 
This section explains the two ways of importing external data into BillQuick: 
 

 Data Import 
 Data Conversion 

 
 

Data Import 
 
BillQuick can import data from comma separated (.csv) and tab separated (.tab) files. If the software from 
which you wish to import data cannot create a comma- or tab-separated file format, you should first 
export that data to Microsoft Excel and then save it in a comma (.csv) or tab-separated (.tab) file.  
 
 

Importing Data 

 
To import data into BillQuick: 
 

1. Open the Import/Export screen from the Utilities menu. 
 
2. When security is on, BillQuick prompts you for a login. Enter your User ID and Password. Then 

click OK. 
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3. On the Import tab, select the File Name from which data should be read (maybe a previously 
exported file) by clicking Browse. To use an existing export layout file (.elf), click Load. 
 

 
 
4. In the dialog, select the file (with.asc, .csv, .tab or .txt file extension) to be imported and click 

.  
 
5. Back on the Import/Export screen, select the File Type. It can be either comma or tab delimited 

file. 
 

6. Check ‘Ignore Header’ option if you do not want BillQuick to read the first record in the import 
file as a header or field name. 

 
7. Select ‘Ignore Encoding’ option if your data is already in Western European format or if you wish 

to ignore decoding options. Else, to ensure that BillQuick imports all the data in the correct 
format, deselect Ignore Encoding. In that case, also select the From Encoding format of your 
particular database (e.g. Baltic Windows) and To Encoding format (Western European).  
 

8. Click Read to populate the Import Data grid on the right with data from your file. 
 

9. In the BillQuick Import Table field, select the desired table. The Required Fields and Optional 
Fields display below.  

 
10. To map imported data to BillQuick fields, enter the column number of the imported data into 
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the Col # of the desired Field Name.  
 

11. Click Import to import the data into the BillQuick database. 
 

12. Click Save to save the import settings and layout as a Field Layout File (.flf) for future use. 
 

13. When you are done, Close to exit. Check the imported data in the appropriate BillQuick screens. 
 
 

Data Conversion 
 
BillQuick includes built-in data conversion utilities. In addition, BillQuick consultants provide custom data 
conversion services. Custom conversions include Deltek Advantage, Deltek Vision, Deltek Costpoint, 
Deltek Time, Sema4, ProSystem fx Practice Management, Sage MAS 90, HighTower Time and Billing, 
Tenrox, Replicon, Journyx, Axium and ArchiOffice.  
 
You have the following built-in conversion options in BillQuick: 
 

 Converting Data from Timeslips 
 Converting Data from Wind2/FMS 

 
 

Converting Data from Timeslips 
 
The TimeslipsBillQuick Conversion utility transfers master, current and historical data from 
Timeslips® to BillQuick. Once you convert Timeslips data to BillQuick, you have a single database to 
work with.  
 
All BillQuick editions can convert data from Timeslips (version 10 or later). If you have an earlier version, 
you need to first update or convert the data to version 10 or later. Contact BillQuick Consulting Services 
if you want guidance through the conversion process or if you want to transfer more than required data 
from your Timeslips database to BillQuick. 
 

 Prior to data conversion, create a backup of your BillQuick and Timeslips 
databases. 

 
To convert data from Timeslips to BillQuick, follow these steps: 
 

1. As a new BillQuick user, you must first create a new BillQuick company database. 
 

2. Open the Timeslips to BillQuick Conversion Wizard from the File menu or Sidebar. 
 

3. On the Select Data File panel, verify the BillQuick Data File to receive the Timeslips data. Click 
Browse to navigate to another location and select a different data file.  
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4. Next, click Browse to locate your Timeslips Data File. If you are converting a Timeslips 2006 or 
an older version, check the option provided. Click Next. 

 

 If you exit and return to TimeslipsBillQuick Conversion Wizard later, 
the program remembers the last location entered for the databases. 

 
5. On the Address Field Mapping panel, select the appropriate Timeslips fields and map it to the 

BillQuick fields. Default choices are pre-selected.  
 

6. Move to the Client and Job Field Mapping panel. Select Timeslips fields from the drop-downs and 
map them to the BillQuick fields. Default choices are pre-selected. 
 
If you used the Client References method in Timeslips, check the ‘Copy Client References as 
Projects’ option. If you used the Client Project method, do not check it.  
 

 When the Client Project method is used, BillQuick automatically identifies 
the client name as the text to the left of the project separator. This text 
transfers to the Project Name field as a default. You can easily change project 
names in BillQuick.  

 
7. If there are zero invoice numbers in your Timeslips database, check the Copy Zero Invoices 

option here.  
 

8. Click Previous and verify your choices, if needed.  
 

9. When ready, click Finish to start the conversion process. A progress bar keeps you informed 
about the data transfer.  
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 For more details on data conversion from Timeslips to BillQuick, check the 
Timeslips-BillQuick Data Conversion Guide. 

 
 

Converting Data from Wind2/FMS 
 
The Wind2/FMSBillQuick Conversion utility transfers master, current and historical data from Wind2 
(now Deltek FMS®) to BillQuick. Once you convert Wind2/Deltek FMS data to BillQuick, you have a 
single database to work with. 
 
All BillQuick editions can convert data from Wind2 (version 2003.3.03 or later) or Deltek Financial 
Management System to BillQuick. If you have a Wind2/Deltek FMS SQL database, contact BillQuick 
Support or your Account Rep to have a BillQuick Consultant do the conversion for you.  
 

 Prior to data conversion, create a backup of your BillQuick and 
Wind2/FMS databases. 

 
To convert data from Wind2/Deltek FMS to BillQuick, follow these steps: 
 

1. As a new BillQuick user, you must first create a new BillQuick company database. 
 

2. Select the Wind2 Conversion option from the File menu. 
 

3. The Wind2/Deltek FMS To BillQuick Conversion Utility displays. On the Welcome screen, click 
Next. 
 

4. On the BillQuick Database Type panel, specify the database to receive data from Wind2/FMS. 
Allow BillQuick to detect the currently open database automatically. Else, choose the other 
option. Click Next. 
 

 

http://bqesoftware.net/media/PDF/BQ/2011/TimeSlips-BillQuick-Conversion-Guide-2011.pdf
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5. By default, the wizard accesses the currently open BillQuick Database. If you wish to select 

another file, click   to browse to its location. Click Next. 
 

6. On the Wind2/FMS Database Name panel, select the Wind2/FMS database backend and database 

you want to use for data conversion. Click  to browse to its location and then click Next. 
 

7. Identify where the Wind2/Deltek FMS Card File is. Typically, Wind2 Card File is named 

Sycont.DBF and is located in your Wind2/Deltek FMS folder. Click  to browse to its 
location and then click Next. 
 

8. Click Previous and verify your choices, if needed.  
 

9. When ready, click Finish to start the conversion process. A progress bar keeps you informed 
about the data transfer.  

 

 For more details on data conversion from Wind2 or Deltek FMS to 
BillQuick, check the Wind2/Deltek FMS-BillQuick Data Conversion Guide. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

 
 

 

http://bqesoftware.net/media/PDF/BQ/2011/Wind2-DeltekFMS-BillQuick-Conversion-Guide-2011.pdf
mailto:BQ-Ideas@bqe.com
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Company Overview 
 
A BillQuick Supervisor or administrator typically manages the general company affairs. After initial setup 
of the company database and master information, the BillQuick Supervisor can set company-wide rules 
and preferences.  
 
This section covers a variety of issues and options to consider as you manage your company.  
 

Company Decisions 

Area Decision Where to Implement 

First Day of the Week Define the first day of a workweek for internal 
processing and reporting. 

BillQuick Start-Up Interview 
Global Settings 

Database 
Maintenance  

Specify the number of times BillQuick starts 
before database utilities automatically run. 

BillQuick Start-Up Interview 
Global Settings 

Automatic Backup Schedule backup reminder – on exit, daily, never, 
weekly or monthly 

BillQuick Start-Up Interview 
Global Settings 

Database Hide location of database on BillQuick status bar. Global Settings-More 

Company-wide 
Settings 

Review and specify other settings and preferences 
for implementing BillQuick.  

Global Settings 

User Preferences Determine other settings and preferences for 
users to maximize interaction with BillQuick.  

Preferences 

Security Permissions Assign security permissions and passwords for 
users.  

Employee screen 
Security screen 

Company Profile Specify company-wide settings. Company screen 
Global Settings screen 

Master Information Create groups for employees, client, activity and 
expense codes, projects. 

Employee: Groups screen 
Client : Groups screen 
Activity Codes 
Expense: Groups screen 
Project: Groups screen 

 View a quick snapshot of employee performance 
and profitability. 
View a quick snapshot of vendor accounts. 

Employee-Performance 
screen 
Vendor –Account screen 

Client Relationship Identify the principal/partner, manager or staff 
member who has primary responsibility for the 
client relationship. 

Client Manager or Custom 
fields 

Project Management Identify the principal/partner, manager or staff 
member who has primary responsibility for the 
project. 

Project-General screen: 
Project Manager field 

Reports Automatically generate and deliver reports.  BillQuick Agent: Reports 
Scheduler 

Generate and memorize reports. Reports Filters 
Report Center screen 
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Security 

 
Security is integral to BillQuick’s design and operation. A BillQuick Supervisor or any authorized person 
can grant users access to BillQuick’s features, functions, reports and other information. You must first 
designate an employee or vendor as a BillQuick User. 
 
After identifying BillQuick Users, you need to determine the level of access they require for each module 
of BillQuick and corresponding reports. For example, you may grant your staff permission to enter time 
while managers receive more extensive security permissions.  It is strongly recommended to assign 
security permissions soon after your company’s core information is set up. If security is not in force, any user 
can add, change, delete and print data. 
 

 If you require more licenses to increase the number of BillQuick Users, 
contact BillQuick Sales at 888-245-5669. Also, if managers and staff travel or 
work remotely, discuss alternatives such as Web Suite, Outlook Add-In, etc. See 
BillQuick Family of ProductsBillQuickAddons for more. 

 
This section covers the following security-related tasks: 
 

 Turning On Security 
 Setting-Up BillQuick Users 
 Assigning Roles 
 Assigning Security Permissions 
 Customizing Security Profiles 
 Assigning Security Permissions to Multiple Employees 
 Setting and Changing Passwords 
 Assigning Report Level Security 
 Logging Actions in BillQuick 
 Changing Company Name 
 Changing and Merging IDs 

 
 

Turning On Security 
 
When you turn on the security, only authorized users (marked as BillQuick Users) can log into BillQuick. 
They must enter a User ID (login) and Password. The same is true for users of add-on modules. By 
default, a user’s Employee ID (or Vendor ID) is also his/her User ID and Password. However, you can 
assign a separate Login ID for a user and change the password at any time. 
 
To turn security on for BillQuick: 

 
1.  Log in to BillQuick. You must have security permission to access the Security screen. By default, 

only the BillQuick ‘Supervisor’ can turn the security on or off.  
 

2.    Open the Security screen from the Settings menu or toolbar. 
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3.    Check the ‘Security On’ option above the Employee field.  

 
4.  When you are done, click Save and then Close to exit. 

 
Alternatively, you can turn on security by simply clicking the Turn Security On option on the Settings 
menu, Security. 
 

 BillQuick automatically turns the security on once the number of 
employees in the database exceeds the number of licensed users. 

 
 

Setting-Up BillQuick Users 
 
The number of users who can log into and access BillQuick (BillQuick User) is limited to the number of 
licenses purchased by your company. You can assign employees as well as vendors as BillQuick Users. 
 
To set up a BillQuick User: 
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Employee Screen 
 

1. Open the Employee screen from the View menu, toolbar, navigator or Sidebar.  
 

2. To assign as a BillQuick User, select an employee from the grid.  
 

 
 

3. On the General tab, check the BillQuick User option. This indicates the selected employee can 
log in and access BillQuick features allowed by security permissions (See Assigning Security below). 
 

4. When you are done, click Save and then Close to exit. 
 

 In a similar manner, you can set up vendor as a ‘BillQuick User’ in the 
Vendor screen. 

 
Product Licensing and User Management Screen 
 
You can also assign BillQuick Users in the following way: 
 

1. Open the Product Licensing and User Management Console from the File menu. 
 

2. Click on the Users tab. Select an option in the View by field, say ‘Employees and Vendors’. 
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3. A list of employees and vendors displays in the grid. Check the box in the BillQuick column for 
the ones you want to license as a BillQuick User. 
 

4. You can also use the Assign button or the right-click option to make the assignments. Then, click 
Close to exit. 

 

 The same Console can be used to assign users for BillQuick Add-On 
modules. 

 
 

Assigning Roles 
 
BillQuick allows you to select an organizational role for the employees and vendors. Based on your 
selection, a special role-based navigator displays when you log into BillQuick. This provides easy access to 
the frequent tasks associated with the role. Available roles include Default, Principal/Management, Billing 
and Time & Expense.  
 
To assign a role: 
 

1. Open the Employee screen from the View menu, toolbar, navigator or Sidebar.  
 

2. Select the desired employee from the grid. The employee must be marked as a BillQuick User.  
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3. On the General tab, select a suitable role for the employee in the Role field, e.g., Time and 
Expense. 
 

4. You can also specify the manager or supervisor to whom this employee reports or submits his 
time card. Select the desired ID in the Submit to field. 
 

5. When you are done, click Save and then Close to exit. 
 

You have now authorized the employee to access BillQuick, fully or selectively, using an ID and 
Password.  
 

 In a similar manner, you can assign role and security to vendors from the 
Vendor screen. 

 
 

Assigning Security Permissions 
 
You can assign a pre-defined Security Profile to a user. Based on the template assigned, users can access 
all or selective BillQuick functions, features and reports. Standard security templates ship with BillQuick 
and include Billing Only, Default Access, Full Access, Manager Level Access, Principal, Time & Expense 
Only, and Time Entry Only.  
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However, you can customize these built-in security profiles to new ones. You may do this if you want to 
modify the default template for employees. In addition, you can assign security permissions for each 
BillQuick module. 
 

 While assigning a security profile to an employee, BillQuick does not assign 
report security automatically. You have to set that separately. 

 
To assign a security profile: 
 

1. Log in to BillQuick. You must have security permissions to access the Security, Employee or 
Vendor screen. By default, only the BillQuick Supervisor has authority to do so. 
 

2. Open the Employee (or Vendor) screen from the View menu, toolbar, Sidebar or navigator. 
 

3. Select the desired employee/vendor (BillQuick User) from the grid list. 
 

 
 

4. On the General tab, select the desired template from the Security drop-down. This assigns pre-
defined security settings to the employee/vendor.  
 

5. When you are done, click save and then Close to exit.  
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To assign security permissions:  
 

1. Click on the Employee-General screen to open the Security screen. You can directly open it 
from the Settings menu or toolbar.  
 

2. In the Security screen, select the desired Employee from the drop-down list. 
 

 
 

3. Assign or change the Password for the employee using . You can make it case-sensitive 
by checking that option from Global Settings-Rules screen. 
 

4. Select a Module Name from the list on the left, e.g., Activity. Now you are ready to assign 
individual security permissions for this module. 
 

5. Start assigning the Permissions by checking the relevant options in the list on the right. 
 

6. When you are done, click Save and then Close to exit.  
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Customizing Security Profiles 
 
When defining a new security profile, it is easier to edit an existing template and save it under a new 
name.  
 
To customize a security profile: 
 

1. Open the Security screen from the Settings menu or toolbar. 
 

2. Select an Employee (or vendor) from the drop-down list. Click Tools and select Security Profiles. 
 
3. On the Security Profile dialog, select a security template from the drop-down list. Click Load. 
 

 
 

4. Back on the Security screen, select an active Module Name (black text) and review the 
Permissions on the right-hand list. Grant access permissions as needed.  
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5. Repeat the process for inactive modules (red text). When you are done, open the Security Profile 
screen again. 
 

6. Type a new name to save your changes as a new security template. Click Save and exit. 
 

 BillQuick Help provides detailed descriptions of all security permissions 
available in BillQuick.  

 
 

Assigning Security Permissions to Multiple Employees 
 
You can apply security settings to multiple employees and vendors at a time, thus saving time and effort. 
While copying the security settings of employees, you may also copy the report security.  
 
To copy security settings: 
 

1. Log in to BillQuick. You must have security permission to access the Security screen. By default, 
only the BillQuick ‘Supervisor’ has authority to do so. 
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2. Open the Security screen from the Settings menu or toolbar. 
 

3. Select an Employee (or vendor) from the drop-down list.  
 

4. Assign the desired security profile or permissions (See Assigning Security above).  
 

5. When you are done, click Tools and select ‘Copy Security To’ option.  
 

 
 

6. On the Copy To panel, choose your option. You can copy the security profile of the selected 
employee to multiple employees: Specific Employee, Employee Group, Employees with selected 
Titles or Employees in the selected Department. 
 

7. Click  to copy the security settings of the current employee to the selected item. 
 

8. When you are done, click Save and then Close to exit. 
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Setting and Changing Passwords 
 
By default, your user ID and password is same as your Employee ID (or Vendor ID). A BillQuick User as 
well as the Supervisor can change the password. BillQuick allows changing password at individual user 
level and at the supervisor level. You can make passwords case-sensitive throughout BillQuick by 
checking that option on the Global Settings-Rules screen. It is highly recommended to change 
passwords once security is established. 
 
To change your password: 
 

1. Log into BillQuick with your User ID 
and Password.  
 

2. Open the Change Password dialog 
from the Edit menu.  
 

3. Your existing ID displays in the User 
ID field. Enter your Current 
Password in the field provided.  
 

4. Next, enter the New Password and 
confirm it. 
 

5. Click Change to apply the changes. 
 
 

 You can change the User ID in the Change ID Codes screen. See Changing 
IDs below for details. 

 
If you are the Supervisor, then change the password of any employee or vendor in the following way: 
 

1. Open the Security screen. 
 

2. Enter the new Password and then re-type it. Passwords are not case sensitive by default. 
However, you can make them case-sensitive by checking that option from Global Settings-Rules 
screen. 
 

3. Click  to apply the new password. 
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4. If a user forgets his password, you can reset it to the default by clicking Tools and selecting Reset 
Security. The default password of a user is his Employee or Vendor ID. 
 

5. When you are done, click Save and then Close to exit. 
 
 

Assigning Report Level Security 
 
You can assign security permissions to BillQuick users for individual reports. This permission allows them 
to view and print only selective reports. On the Report Permissions screen, you can select as few or as 
many reports as you wish to assign to a user. Report level security follows a restrictive approach. You can 
access a report only if you have permission to view standard reports (permission granted on the Security 
screen) as well as those on the Report Permissions screen.  
 
Depending upon the security permissions for reports, you will see only the reports you have permission 
to view. In the Report Center as well as Reports menu, BillQuick will filter out the reports that you do 
not have access to. 
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 By default, BillQuick limits the reports a user can access to those that 
match security permissions for each module. Assigning report level security 
further refines those permissions. 

 
To assign report level security permission to a user: 
 

1.  Open the Security screen and select an employee. 
 

2.  Click Tools and select Report Level Security option to open the Report Permissions screen. 
 

3.  To sort the list, click the column header (or use the Find option to search for a report). Check 
the Allow box for each report assigned to a user. 
 

 
 

4.  You can also select one or multiple rows and click Assign to assign that report to the selected 
employee. (You can click Un-Assign to un-assign any report.) 
 

5.  When you are done, click Save and then Close to exit. 
 
 

Logging Actions in BillQuick 
 
BillQuick allows you to track all key actions taken by users in the program. Using the Log Viewer, you can 
view actions, know who performed them and when someone performed them. This monitors and 
encourages user accountability and proper procedures by tracking actions over time. 
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In addition to the Log Viewer, you can read log records with a text editor or word processor. BillQuick 
maintains separate audit log files (text files) for each month in the same folder as your company database 
(for example, the standard installation folder X:\Program Files\BillQuick2011; where X is the drive 
letter).  You can choose another folder on the Global Settings screen. 
 
To track actions in BillQuick: 
 

1. Open the Global Settings screen from the Settings menu.  
 
2. Select the Folders option on the left and check the ‘Automatically log actions to a log file’ option.  

 
3. Specify a Log File Location, if it is different from the default folder. 
 
4. To check the log, open the Log Viewer screen from the File menu.  

 
5. Select your View By option (e.g., User, Action taken, etc.) and the desired Period (e.g., Year, 

Month, etc.). All the related details display in the grid. 
 

 
 

6. The grid displays various icons as visual cues to the Status of the action it is tracking or logging, 

such as information , warning  and so on.  
 

7. After viewing the log, click Close to exit. 
 
 

Changing Company Name 
 
Your company name may change, perhaps after merging with another company. Alternatively, company 
growth may likely increase the number of staff members. In such cases, be sure to obtain a new license 
key for your company prior to making any changes because that invalidates your license, locking your 
BillQuick program. In addition, you may need to change the number of authorized users for BillQuick by 
purchasing additional licenses. 
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To change your company name: 
 

1. Determine exactly how your company name should print – spelling, spacing and punctuation – on 
invoices and statements, then contact BQE Sales. You will receive a new license key via email.  
 

2. Open the Company screen from the View menu, navigator, Sidebar or toolbar. 
 

3. On the General tab, enter the new company name, exactly as it appears on the instruction page. 
You can cut and paste it from the email received.  
 

 
 

4. On the Licenses tab, enter the new license key. Click Tools and select Validate License Keys to 
update the key and user count. 
 

5. When you are done, click Save and then Close to exit. 
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Changing ID Codes 
 
At times, you may have to change an ID for a client, activity or other master record. You can even 
rename group IDs using the Change ID Codes utility. This utility searches the entire database for all 
records with the old ID and changes them to the new ID.  
 

 Prior to running this utility, all the BillQuick users must log out from the 
shared database. Also, backup your BillQuick database. 

 
To change an ID code: 
 

1. Open the Change screen from the Utilities menu. 
 

2. Select the desired option in the Change section, say Activity ID. 
 

 
 

3. Select the Old ID and then enter the New ID. 
 

4. When you are done, click OK to save the changes and then Close to exit. 
 
 

Reminders 
 
System-generated and user-defined messages display on the Reminders screen. System-generated 
messages inform you about actions to take, such as print invoices, approve time entries, process 
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recurring invoices, and so on. Who receives a reminder depends on the option chosen, role in the 
company and billing decisions. Besides that, you can define reminder messages for yourself on the 
Employee (and Vendor) screen (see Settings Reminders below for details). 
 
Date-triggered reminders use your computer’s system date to determine when to deliver the reminder. 
Due Date reminders start showing up in the Reminder screen 7 days prior to due date (it is customizable 
from the Preferences-Notification and Reminders screen). BillQuick triggers some reminders when you 
specify those options in the Global Settings or Preferences screens. 
 
This section teaches you the following tasks: 
 

 Viewing Reminders 
 Settings Reminders 

 
 

Viewing Reminders 
 
What you view on the Reminders screen is tied to your security settings and is specific to your 
responsibilities. You can view some reminders only if they have been set for you in the in the Employee 
and Vendor screens.  
 
You can view the following reminders on the Reminders screen: 
  

 Back up data file 
 Project due dates 
 Billing: process invoices 
 Billings scheduled on a specific date 
 Unprinted invoices in Invoice Review 
 Special and important dates along with the reminder message 
 Submitted time and expenses awaiting approval 
 Submitted PTO requests awaiting approval 
 Unsaved timers 
 To-do tasks 

 
To access reminders: 
 

1.  Open the Reminders screen from the View menu or toolbar. To load it automatically on startup, 
click Auto Load on the Reminders screen. 
 

2.  Double-click on any reminder or click View to drill-down to its details. 
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3.  For time and expense reminders, you can select a parent (main) reminder and right click to 
choose View by Employee or View by Project. 
 

4.   When you are done, click Close to exit. 
 

 Also, see Setting Global Reminders under Settings and Preferences below. 
 
 

Setting Reminders 
 
BillQuick allows you to create reminders. As an example, if you are a manager or a supervisor, you may 
want a reminder a few days prior to an employee’s birthday. Alternatively, you may want a reminder 
about arranging your next out-of-town meeting and so on.  
 
To set reminders: 
 

1. Open the Employee screen. 
 

2. Select the employee from the grid for which a reminder is to be set.  
 

3. Move to the Rate tab. In the Reminders section, type a Reminder Message and enter the Date on 
which you want that reminder message. 
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4. In the Reminders For field, select an employee or group for whom the reminder is intended. 
Only the specified person(s) receives the reminder message. If you specify none, then BillQuick 
sets it for the employee manager. 
 

5. Optionally, enter an Important Date and then check the ‘Remind me about the Important Date’ 
option. As an example, you may want to enter your employee’s next review date.  
 
On the set date, the Reminders screen will display this reminder for you. 
 

6. In the Reminders screen (View menu), you can select the employee reminder and directly access 
the Employee screen. You can also send a message to the employee using the right-click menu. 

 

 Similarly, you can set reminders for your vendors or consultants in the 
Vendor screen. 
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Groups 
 
Groups are a valuable tool. Companies can create groups to make it easier and faster to set up and 
maintain budgets, service fee schedules and expense fee schedules. Groups also act as filters to shorten 
grid lists and reduce record management effort. You can group employees, vendors, activity codes, 
expenses codes, etc. in BillQuick based on shared or common attributes. You may create groups to 
match situations, whether it is a refined group of clients or projects to bill, groups for payroll items, 
groups for ledger accounts, or groups for precision reports. 
 
The great benefit is that you can also filter reports by these groups and expand the value of reports. You 
can create groups for departments, type of project, type of client, region, territory, and skill set – virtually 
anything you want and then view reports accordingly. 
 
Some of the common groupings include: 
 

 Projects: industry, commercial, not-for-profit, government, etc. 
 Employees: hired date, department, title, annual reviews, skills, etc. 
 Vendors: skills, location, ability to travel, etc. 
 Clients: Architects/Engineers – Commercial, Residential and Government 

 Accounting Firms – 1040 Tax, 1120 Tax, Write-Up, Consulting, Litigation Support 
 Law Firms – Contracts, Bankruptcy, Divorces, Real Estate 
 Computer Consulting – Networks, Remote Maintenance Services, Solutions 

 Activity Codes: tax services, rates, administrative, marketing, etc. 
 Expense Codes: overheads, tax, costs, reimbursable, administrative, etc. 

 
BillQuick group are dynamic; when you add or remove items from a group, they dynamically update in 
the schedules, filters and other places to which they are applied E.g., when you add a new activity or 
remove an expense code from a group assigned to a fee schedule, BillQuick updates the schedule 
accordingly. However, if you want to delete a group that is included in any fee schedule, budget, etc., it is 
better to make it inactive. 
 
You can create various groups and use them for different purposes: 
 

 Grouping Employees and Vendors 
 Assigning Groups to Employees and Vendors 
 Filtering by Groups 
 Grouping Clients 
 Grouping Item Codes 

 
 

Grouping Employees and Vendors 
 
You can use groups to filter employee records. Below is an example of creating groups for employees (or 
vendors) based their departments: 
 

1.  Open the Employee screen from the View menu, toolbar or navigator. 
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2.  Decide what attribute(s) you want to build an employee group on. Say you want employees from 
the Administrative Department.  

 
3. Select the first employee in the list on the left. On the General tab, check the department to 

which this employee belongs. 
 
4. Repeat the above steps, maintaining a list of all employees belonging to the Admin department.  

 

 If you have based your group on multiple attributes, review the necessary 
fields to compile your employee list.  

 
5. When ready, click Tools and select Group.  

 

6. On the Employee Groups screen, click 
New.  
 

7. In the Group dialog, enter an ID and Name 
for the group. For our example, enter 
‘Admin’ and ‘Administrative’, respectively. 
Click OK to save the information.  
 
 
 
 
 
 
 

8. Using the list that you compiled, select those employees in the Available Items list and then click 

 to move them to the Assigned Items list.  
 

 

  



Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 184 

9. When you are done, click Save and then Close to exit.  
 

 Creating vendor groups follows similar steps in the Vendor screen. 
 

 

Assigning Groups to Employees and Vendors 
 
You can assign employees to groups in the following way:  
 

1.  Open the Employee screen from the View menu, toolbar or navigator. 
 

2.  Select an employee from the list on the left. 
 

3.  On the General tab, accept the pre-filled Default Group for the employee or select another one 
from the dropdown. 
 

4.  Next, click the Groups option. A dropdown list of existing employee groups displays. 
 

 
 

5.  Check the desired group for this employee. You can assign the same employee to multiple 
groups.  
 

6.  When you are done, click Save and then Close to exit.  
 
 

Filtering by Groups 
 
To filter employee records based on groups: 
 

1.  On the Employee screen, click Tools and select Filters.  
 

2.  Click on the Employee Group filter and select ‘Administrative’ from the grid.  
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3.  Check the filter option and then click Apply to apply that filter to the list.  
 

4.  Next, click OK to exit. 
  
5.  The employee grid list is shorter now. To verify that the list contains only the desired group 

members (Administrative), click on the employees in the list and check their Department on the 
General tab.  
 

6.  When you are done, click Close to exit.  
 
 

Grouping Clients 
 
To create a client group: 
 

1. Open the Client screen from the View menu, toolbar or navigator. 
 
2. Decide upon the attribute around which you want to build a client group, say location or 

industry. 
 

3. Select the General tab. List the clients who belong to a specific industry, say Architectural & 
Engineering.  

 

 If you have based your group on multiple attributes, you may need to 
review multiple fields across other tabs to compile your client list. 

 
4. When your list is complete, click Tools and select Group.  
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5. On the Client Groups screen, click 
New. 
 

6. Enter an ID and Name for the group. 
Click OK to save the information. 
 
 
 
 
 
 
 
 
 
 
 

7. Back on the Client Groups screen, select the relevant clients from the Available Items list and use 

 to move them to the Assigned Items. 
 

 
 

8. Click Save and then Close. 
 

9. After creating groups, you can specify a Default Group for the client by selecting one from the 
dropdown. You can also assign the selected client to one or more groups by checking them in 
the Groups dropdown. 
 

10. When you are done, click Save and then Close to exit. 
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Grouping Item Codes 
 
To create an activity group: 
 

1. Open the Activity Codes screen from the View menu, toolbar or navigator. 
 

2. Decide upon the attribute around which you want to build a group, say activities associated with 
the general administration of the office or computer related tasks. List those activities.  
 

 If you have based your group on multiple attributes, you may need to 
review multiple fields in the grid to compile your item list. 

 
3. To open the Activity Groups screen, click Tools and select Group.  

 
4. Click New. Enter an ID and Name for the new 

group in the dialog box.  
 

5. Click OK to save the information. 
 
 
 

6. Back on the Activity Groups screen, select the 
activity codes from the Available Items list and use 

 to move them to the Assigned Items list.  
 

 



Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 188 

7. Click Save and then Close to exit. 
 

8. After creating groups, you can specify a Default Group for the activity by selecting one from the 
dropdown.  
 

9. When you are done, click Close to exit. 
 

 Similarly, you can create expense groups in the Expense Codes screen. 

 
 

Clone Templates 
 
Setting up profiles for employees, vendors, clients and projects can be tedious and time-consuming, 
especially when manually setting up information from another system. Many records contain the same 
data. BillQuick’s Clone feature allows you to duplicate a record to a new one. Then, you can add or 
modify the unique data. Cloning does not change the original information or ID. Because BillQuick copies 
all fields from the source record to the new record, using a clone template reduces editing and setup 
time. 
 
You need examine your records for commonalities and then create ‘clone templates’. A clone template 
contains general or common data you want to include in all new records. For example, if you employ 
many sub-contractors for network installation and administration projects, it saves time to create a clone 
template for this type of vendor. Similarly, drafters in an architectural firm typically have similar 
information in their records, such as bill rates, standard hours and so on. Again, you can create a clone 
template for drafters, and then use it to set up new profiles quickly. In short, you can create a Staff 
Employee Template, Manager Employee Template, Standard House Project Template, and so on. Be sure 
to give a special ID to each clone template. 
 

 See Cloning Employees and Cloning Projects Records in the Master 
Information Setup chapter for details. 

 
 

Status 
 
Status has a special meaning in BillQuick. Master records such as employees and clients can be active or 
inactive; similarly, projects can be active, on hold, complete and so on. BillQuick records with only an 
active status appear in the dropdown lists while inactive items may appear grayed out in the master lists 
and grids. There are situations that require special attention while deciding what status to assign to 
important master records such as clients and projects. 
 
This section covers the following tasks: 

 
 Deciding Status of Clients and Projects 
 Deleting Records 
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Deciding Status of Clients and Projects 
 
In certain situations, you may have to decide as to when archiving is a better choice than deleting a client. 
On the other hand, when is changing client status to Inactive the best option? Consider the following 
recommendations: 
 

 To safeguard your assets, make a backup of your company database 
before deleting or archiving any record. 

 
 For inactive clients with billed/unbilled time and expenses and/or complete/incomplete projects, retain 

the client record and all associated information in the company database for one or two years to 
ensure accurate and complete reporting. After this, archive the client. 
 

 For inactive clients for whom all projects are complete, retain the records in the company database 
for one or two years for reporting purposes. Additionally, set the project status as ‘Completed’ 
(Project-General screen) and client status as ‘Inactive’ (Client-General screen). After this, 
determine whether to archive or delete the client.  
 

 For clients who owe you money and whose projects are on hold, change the client status to ‘Inactive’ 
(Client-General screen) and project status to ‘Hold’ (Project-General screen). Also, check the 
Prevent TE/EL Entries options on Project-Detail screen to prevent any time or expense entry for 
the client’s project(s). When the client brings arrears up-to-date and you are prepared to 
continue working on this projects, change the project and client status back to ‘Active’ and 
uncheck these options. 
 

 For clients who default entirely on the money owed to your company and there is no hope of even 
partial recovery, maintain the records for the remainder of the fiscal year to ensure accurate and 
complete reporting. Then, depending on your company policy, you can archive the client and 
related information for future reference or delete it.  

 
 For clients who run out of money but plan to resume incomplete projects in future, change client 

status and project status to ‘Inactive’. Else, check the Prevent TE/EL Entries options on the 
Project-Detail screen to prevent any time and expense entry for the client’s project(s). When the 
client brings arrears up-to-date and you are prepared to continue working on this projects, 
change the project and client status back to ‘Active’ or uncheck these options. 
 

 For clients who have projects terminated, change the client status to ‘Inactive’ and project status to 
‘Cancelled’. As there is no data of consequence, it is better to delete the projects as well as the 
client.  

 

 For more information on project status, see Project Status in the Project 
Management chapter. 

 
 

Deleting Records 
 
Deleting master records or other information in BillQuick requires a plan of action if some data is 
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associated with it. Before you can delete a client, you must delete the time entries, expense entries, 
invoices and payments associated with the client’s projects; then delete the projects; and finally delete the 
client. When deleting a client or project, its status must be ‘Active’ in order to appear in the drop-down 
lists during the deletion.  
 

 You need proper security permissions to delete BillQuick information. 

 
Follow this order while deleting records in BillQuick: 
 

1.  Payments 
2.  Invoices 
3.  Time Entries 
4.  Expense Entries 
5.  Projects 
6.  Clients 

 

 Deleting an employee or vendor record does not delete time, expense or 
other data associated with it. Rather than delete, the better option is to change 
the status to ‘Inactive’ or ‘Terminated’, where available. 

 
 

Archive and Restore Data 
 
Many companies adopt archiving policies for various reasons. For example, you might archive inactive 
clients and projects every 36 months because their management information value decreases. Reasons 
companies archive clients and projects include: 
 

 To reduce database size by archiving data to another location 
 To speed up database retrieval in Microsoft Access 
 To have faster information for management  
 To manage and report more recent information 

 
In BillQuick, you can archive (and restore) data by client or project and use filters for selective archiving. 
All related information, such as time, expenses, invoices and payments, transfers to the archive database. 
Archive function archives the Workflow events when you archive time entries. You can also run reports 
on the archive database. However, only by a Supervisor or anyone with proper security permissions can 
perform these tasks. 
 

 After archiving or restoring data, run the ‘Recalculate Account Summaries’ 
utility to ensure all information is correct. In addition, run the ‘Repair and 
Compact Database’ utility to optimize your database (Access only) for fastest 
speed. 

 
The archive database has the same name as your company database except it has an .ar extension (e.g., 
BQE.ar). It is stored in the same directory (folder) as the main database (default directory is X:\Program 
Files\BillQuick2011) and cannot be moved. However, in case of SQL Express/SQL Server, BillQuick 
appends ark.mdf to it (e.g., BQEark.mdf) and you can move it to another location. 
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 No other user should log into BillQuick when you archive and restore 
data. When you do so, BillQuick automatically closes all screens, interrupting 
any work-in-process. 

 
Choose the appropriate task for yourself: 
 

 Archiving Clients  
 Archiving Projects 
 Restoring Client and Project Data 

 
 

Archiving Clients 
 
BillQuick allows you to archive client and related data. To archive a client: 
 

1. Use the ‘Current BillQuick Users’ option from the View menu to make sure no one is currently 
logged into BillQuick. Continue only when everyone has logged off. 
 

2. Open the Archive and Restore screen from the Utilities menu. 
 

3. If this is your first time archiving, BillQuick prompts you to create a new archive file. Please do so 

by clicking . 
 

4. On the Archive-Restore screen, select OPTION 1: Client and all Projects… 
 

 
 

5. To archive, select the desired client in the grid. To archive multiple clients, select the rows using 
the Shift and Ctrl keys. Review your selection to ensure you selected the correct records. 
 

6. You can move to the Filter tab and apply Client Filters to archive only selective client data. 
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7. When ready, click Begin. BillQuick displays a progress bar for each data group as it transfers to 
the archive database.  
 

8. When the process is complete, click Close to exit. 
 
 

Archiving Projects 
 
To archive projects, follow the steps below: 
 

1. Use the ‘Current BillQuick Users’ option from the View menu to make sure no one is currently 
logged into BillQuick. If so, continue. 

 
2. Open the Archive and Restore screen from the Utilities menu. 

 
3. If this is your first time archiving, BillQuick prompts you to create a new archive file. Please do so 

by clicking . 
 

 If you have archived data before but there is no archive file (you are asked 
to create a new archive file), STOP. Determine what happened to your 
previously archived data before continuing. 

 
4. On the Archive-Restore screen, select OPTION 2: Projects and related Time…  
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5. In the grid, select the project records to archive. You can use Shift + Click to select a range of 
records or Ctrl + Click to select individual records. 
 

6. Move to the Filter tab and apply Project Filters to archive only selective project data. E.g., you 
can archive only billed time and expense entries associated with the selected projects. 
 

7. When ready, click Begin. BillQuick displays a progress bar as it transfers data to the archive 
database. 
 

8. When the process is complete, click Close to exit. 
 
 

Restoring Client and Project Data 
 
You can restore archived data at any time. Problems can arise if you create a new project similar to a 
previously archived project (ID). In this case, BillQuick will restore all other data archived with that 
project, except the project record. If you archived only billed time and expenses, BillQuick allows you to 
restore that data for a project. 
 
To restore archived data, follow the steps below: 
 

1. Use the ‘Current BillQuick Users’ option from the View menu to make sure no one else is logged 
into BillQuick. If none is, continue. 
 

2. Open the Archive and Restore screen from the Utilities menu. 
 

3. On the Archive-Restore screen, select the Restore Mode. The contents of the archive file display 
on the grid.  
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4. Select either OPTION 1: Clients and related data or OPTION 2: Projects and related data. This 
would depend on the data that you want to restore.  
 

5. For any reason, if you want to overwrite the existing data with the archived data, check the 
‘Overwrite existing data’ option. 

6. Accordingly select the archived client/project records in the grid to restore. You can use Shift + 
Click to select a range of records or Ctrl + Click to select individual records. 
 

7. Check the ‘TE/EL Only’ option in the grid to restore only time and expense entries associated 
with the selected projects (in case of OPTION 2). 
 

8. Click Begin. BillQuick displays a progress bar for each data group as it transfers data from the 
archive database to the current database. 
 

9. When the process is complete, click Close to exit. 
 

 After archiving or restoring data, run the ‘Recalculate Account Summaries’ 
utility to ensure all information is correct. In addition, run the ‘Repair and 
Compact Database’ utility to optimize your database for fastest speed. 

 
 

Backup and Restore 
 
It is recommended that you should back up your data regularly to safeguard against a damaged company 
database (e.g. after a power loss or computer failure). You should also back up before making significant 
changes to your data. Backup copies allow you to restore data in case you change your mind about the 
changes or if your data is lost or damaged. You can back up your data on a local hard drive or any 
external media.  
 
When backing up your database you should backup your archive database too. The archive database has 
the same name as your BillQuick database with .ark file extension. 
 
BillQuick offers a built-in back-up utility for Standard/Access databases. For SQL Express and SQL Server, 
you can use their built-in backup utility or any other tool to make complete and incremental backups. 
 

 To automate your backup routine, specify the Application Backup 
Reminder in the Global Settings-Options screen. You can set a reminder of 
Daily, Weekly, Monthly or any other option. 

 
This section covers the following database-related tasks: 
 

 Backing-Up Access Database 
 Backing-Up SQL Database 
 Restoring Database 
 Repairing Database 
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Backing-Up Access Database 
 

 BillQuick’s backup utility does not replace making a backup for offsite 
storage. It is an in-place safety measure in case you need to return to a previous 
version of the database quickly. 

 
To back up your standard Access database: 
 

1.  Select the storage media on which you want to back up your BillQuick Company. Common 
choices include your local hard drive (C, F, E) or external media like the CD-ROMs, DVD-ROMs, 
thumb/pen drives, network drives, etc. and the other external storage media.  
 

 If you need to format the disk prior to backup, do not choose Quick 
Format. Instead, choose Full Format. 

 
2.  By default, BillQuick stores the backup copy in the same folder as your company database (for 

example, in the standard installation folder x:\Program Files\ BillQuick2011; where x is the drive 
letter).  To change this location, do so in the Global Settings-Miscellaneous screen (Backup 
Folder). 

 
3.  Now, select the Backup Database option from the Utilities menu. When completed, BillQuick 

will display a message. 
 
After backing up, My_Company.mdb becomes My_Company20110807104102.bbk. This 
indicates that you backed up the database on July 8, 2011 at 10:41:02 a.m. 

 
 

Backing-Up SQL Database 
 
You can back up a SQL Express or SQL Server database using the SQL Server Management Studio. To do 
so, please check the steps defined by Microsoft to make a full backup of you BillQuick SQL database: 
http://msdn.microsoft.com/en-us/library/ms187510.aspx   
 

 Support for full SQL Server as backend is available in the BillQuick 
Enterprise edition only. 

 
 

Restoring Database 
 
To restore a backup copy of a BillQuick database, do the following: 
 

1.  Select the Restore Data option from the Utilities menu. 
 

2.  In the dialog, select the desired backup file with a .bbk file extension (e.g., 

My_Company20110807104102.bbk). Click . 
 

3.  In the next dialog, select the location and File name with .mdb file extension (e.g., 

http://msdn.microsoft.com/en-us/library/ms187510.aspx
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My_Company.mdb) for the restored database.  
 

4.  Click . When completed, BillQuick will display a message. 
 
 

Repairing Database 
 
BillQuick provides various built-in tools that attempt to repair a damaged database (MS Access and SQL) 
and protect the information stored in it. To guard against time delays resulting from database corruption, 
run the Repair Database utilities periodically.  
 
To do so, select the Repair Database option from the Utilities menu and click on any of the relevant 
options: 
 

 Prior to running this utility, all the BillQuick users need to log out from the 
shared database. 

 
 Repair Time Entry 

Table—Attempts to 
repair all errors 
that it finds in the 
time entry data 
table.  
 

 Repair Expense Log 
Table—Attempts to 
repair all errors 
that it finds in 
expense entry data 
table. 
 

 Repair Other 
Tables—Attempts 
to repair all errors 
that it finds in all 
other BillQuick 
tables.  
 

 Repair and Compact 
Database—Sets the 
database fields to their default values and removes errors. It attempts to fix structural integrity 
errors in your BillQuick database (Access only). For a large database, this process can take a great 
deal of time. 

 

 Do not interrupt the repair procedure. Wait until a message confirms that 
the process is complete. Depending on the number of records in your database, 
the repair process may take some time. 
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Data Exchange 
 
BillQuick exchanges data with other software applications. Various options are available to do so: 
 

1.  The Import/Export utility imports and exports data via ASCII files to and from BillQuick. You can 
use the utility to synchronize useful data between BillQuick and other applications. Please refer to 
Importing Data in the Master Information Setup chapter and Exporting Data below for more 
information.  

 
2.  BillQuick allows you to export documents such as invoices, reports (standard and custom) and 

statements to Microsoft Excel, MS Word, PDF and other formats. BillQuick can also email these 
documents.  
 

3.  In BillQuick, you can export data from any grid to Microsoft Excel using the Export option in the 
right-click menu or Edit menu. 

 
4.  BillQuick includes built-in data conversion wizards for Timeslips and Wind2/FMS. BillQuick 

Consultants also provide custom data conversion for 20 applications and homegrown solutions. 
See Data Conversion in the Master Information Setup chapter for more. 

 
5.  BillQuick integrates with various accounting packages such as QuickBooks, Peachtree Accounting 

and MYOB. You can synchronize data between BillQuick and other supported accounting 
packages. See Data Integration in the Accounting chapter for more. 
 

6.  BillQuick allows you to export invoices to the LEDES (Legal Electronic Data Exchange Standard) 
format. The LEDES is a standard file format used by the legal industry for the electronic 
exchange of information. See Exporting Invoices to LEDES below for more. 

 

 If you need to convert or transfer data from another application to 
BillQuick and do not have the time or technical expertise, BQE Software 
provides exclusive and customized Data Conversion Services. For more, visit 
www.bqe.com/Services.asp or contact us at 310-602-4020. 

 
This section explains the following data exchange options: 
 

 Data Export 
 Entering Data Manually 
 Exporting Invoices to LEDES Format 

 
 

Data Export 
 
You can export all data fields in the BillQuick data tables. For instance, you may export time data for use 
with an external payroll service or program. Additionally, if you work with two different BillQuick 
companies, you can export the client list from one company and import it into the second. 
 
You can export BillQuick data using the Import/Export feature (Utilities menu) or ‘Export to Excel’ 

http://www.bqe.com/Services.asp?pageId=Convert
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option (BillQuick screens or View menu). 
 
 

Exporting Data 

 
To export data: 
 

1.  Open the Import/Export screen from the Utilities menu. 
 

2.  When security is on, you must enter your User ID and Password; then click OK. 
 

3.  On the Export tab, select the desired data table from the Export dropdown list. To use an 
existing export layout file (.elf), click Load to select it. 
 

 
 

4.  Specify the directory path and file name where you want to write or save the export file. Click 
Browse to open the Export To dialog and select the desired location. 
 

5.  Mark the ‘Set Filters’ checkbox so that all defined filters restrict the records extracted for export. 
Removing the checkmark deactivates all filters. 
 

6.  Select the individual filters for data you want to export. These filters change depending upon the 
data table chosen in the Export field above.  
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7.  Check the ‘Keep Text Fields within Quotes’ option to save text fields within quotes in the report 
file. Quoting the text ensures that the program does not misread the imported data. 
 

8.  In the grid, define the Export File Layout. First, select the Prefix to insert before each data field, 
such as Comma, Tab, etc. 
 

9.  Next, select the Field Names to export from the data table.  
 

10.  Now, select the Postfix to separate one field from the next.  
 

11.  Finally, specify the Length of characters in the field to export. BillQuick defaults to the field length 
in the data table if you leave the field blank. You must know the length of the receiving field in the 
application into which you want to import data.  
 

12.  Click Build to generate a set of records to export using the defined filters and layout. 
 

13.  Click Save to save it as an Export Layout File (.elf) for future use. 
 

14.  You may click View to view the Selected Records before exporting them.  
   

15.  When you are ready to export, click Export. 
 

16.  When you are done, click Close to exit. 
 
 

Entering Data Manually 
 
If you have not been using any accounting package nor have any electronic data to convert into BillQuick 
data, you may have to manually enter and set up historical invoices, payments or opening balances. You 
can use an A/R listing with invoice and payment information or a separate invoice and payment listing.  
 
The purpose is to: 
 

 Set up historical invoices for a record of revenue (invoices) by project and client.  
 Establish the A/R balance for each invoice, project and client. You can do that by entering 

a payment per invoice or a cumulative payment for all invoices. 
 Set up opening balances per project, which would be the net of all invoices issued for the 

project less all the payment applied to them. 
   
The Manual Invoice screen in BillQuick enables you to create an invoice for a project that has no time or 
expense logged to it. If you have a series of transactions, it is recommended to enter the historical ones 
first and then the current ones. For example, if today you receive a payment for an invoice not yet 
entered in BillQuick, you should enter the invoice first. 
 

 You can also use Manual Invoice to produce a quick invoice. 

 
To enter historical invoices: 
 



Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 200 

1.  Open the Manual Invoice screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2.  Click New to create a new invoice. 
 

 
 

3.  Select the ID of the Project whose historical invoice you want to record. 
 

4.  BillQuick pre-fills the ‘Bill To’ address, displaying the client information. Click Billing Address to 
edit the address. 
 

5.  Replace current date (today) with the date of the historical invoice. You can enter the date or 
change it using the drop-down calendar. 
 

6.  Replace the default invoice number with that of the historical invoice. BillQuick will not allow 
duplicate invoice numbers. If desired, you can add a prefix to historical invoice numbers for easy 
identification. 
 

7.  In the Description field, type the service or expense to bill. If you want to record only a summary 
service and expense, enter an appropriate description. 
 

8.  Enter the Amount charged for the service or expense (without taxes or discounts); else the total 
for services or expenses. You can also enter the Tax percentage if desired. 
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9.  Check the Exp option for expense items. 
 

10.  You can add a Miscellaneous Amount to the invoice, Discount and Retainer in the fields at the 
bottom.  
 

11.  If the client has paid all or part of the invoice, enter that amount in the ‘Paid Today’ field. This is a 
quick way of recording a payment associated with the historical invoice. 
 

12.  Click Process to process your manual invoice. Once processed, you can print it here or apply 
historical payments from the Payment screen. 

 
To edit historical invoices: 
 
If you want to edit or delete historical invoices, there are two possible scenarios for that. 
 

 You have selected the wrong project in the Manual Invoice screen for the historical ‘balance 
forward’ information. In this case: 
 

1. Open the Invoice Review screen and select the incorrect invoice.  
2. Click on the Reverse button. The invoice is now gone.  
3. Return to the Manual Invoice screen and record the correct information. 

 
 You have selected the right project but entered the wrong ‘balance forward’ information. In this 

case: 
 

1. Open the Manual Invoice screen and choose the project. 
2. Now choose the desired invoice from the Invoice Number drop-down.  
3. Change the incorrect amount and then click Process.  
4. It asks you to overwrite the invoice or create a new one. Choose Overwrite.  

 
To record a historical payment against a manual invoice (created above): 
 

1. Open the Payment screen from the Billing menu, toolbar, Sidebar or navigator.  
 

2. Select the View by Invoice option and choose the invoice created above.  
 

3. Choose the Date of payment and enter the total Amount of payment received. 
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4. In the grid, enter the payment or a portion of it in the Amt Applied field to apply against each 
invoice. Else, use the Auto Apply option to automatically apply the payments to the invoices in 
the ‘older first’ order.  
 

5. When you are done, click Save and then Close to exit. 
 
 

Exporting Invoices to LEDES Format 
 
Conventionally, you use the LEDES format for hourly billing but it can also handle alternative billing 
arrangements. BillQuick allows you to transfer your invoices to the LEDES 1998-B and LEDES2000XML 
format as a text file. This helps the law firms to output bills in a format acceptable by the legal industry.  
 
Export BillQuick Invoices To LEDES Wizard enables you to transfer BillQuick invoice data easily to a 
LEDES export database.  
 
To export your invoices to LEDES format: 
 

1.  Open the Export BillQuick Invoices To LEDES Wizard from the Integration menu. 
 

2.  On the Select File Name panel, specify the location and name of the BillQuick data file (.mdb) 
and LEDES export data file (.lds). By default, it accesses the currently used BillQuick database. 
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3.  On the Company Information panel, provide your BillQuick company name. It retrieves the 
company name from the BillQuick database specified above. 
 

4.  Next, enter the Employer ID or Company ID. It can be a number assigned to the BillQuick 
Company. 
 

5.  On the Global Options panel, check the relevant option if you want to override the default First 
Name Last Name combination to Last Name First Name combination for the timekeeper’s 
name. Also, specify the character for separating the first name from the last name. 
 

 



Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 204 

6.  Check the relevant option if you want to export the sales tax as a separate line item. 
 

7.  Select a custom field, either in Client screen or in Project screen, with which you want to map 
the Client Matter ID. BillQuick will use this value from the chosen screen to generate a Client 
Matter ID. 
 

8.  On the Select BillQuick Invoices panel, select the desired invoice number(s) from the drop-down 
list. You may select all the invoices or a range of invoices to export to the LEDES format. 
 

 Check the ‘Show Joint Invoice Only’ option if you want to view only joint 
invoices in the Invoice # drop-down. 

 
Alternatively, check the Date option and select the invoice dates in the From-To fields to specify 
which invoices to be exported to LEDES.  
 

 If you filter invoices based on the Invoice Date, data transfers in the 
LEDES 1998 – B format only. 

 
9.  At the bottom, check the relevant options for mapping BillQuick item codes with custom codes 

for specific clients. 
 

 If you choose to map BillQuick Activity Codes or Expense Codes with 
Custom Codes, a new panel opens where you can customize codes for each 
activity/expense item for the selected client. Alternatively, you can specify Task 
Codes for activities from there. 
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10.  You can also choose to map summarized line items for projects by checking that option. It opens 
the Custom Settings panel. 
 

 
 

11. For a selected project, you can replace the time and expense data to be exported with 

summarized line items using the custom values entered here. Click  when you are 
done. 
 
While transferring data to LEDES format, the custom codes and settings will replace the 
BillQuick data.  

 
12.  You can choose to exclude time details for fixed type is projects. Check that option and click 

Next. 
 

13.  Choose the LEDES format for export—whether 1998B or 2000 XML format. Click Finish to 
start the data export process.  
 

After the process ends, BillQuick prompts you to open the export file. 
 
 

Settings and Preferences 
 
To optimize BillQuick to your company based on its size, business goals, operations, management styles 
and company policies, you can choose various global settings or business rules. These control how 
BillQuick works for your company. Global Settings apply to all the users of BillQuick; settings specified in 
the Preferences screen take precedence over them and apply only to an individual user.  
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This section covers the following topics: 
 

 Specifying Time and Expense Settings 
 Specifying Activity Settings 
 Assigning Global Templates 
 Setting Global Reminders 
 Setting Interest Rates 
 Setting Global Taxes 
 Specifying Invoice Settings 
 Specifying Folder Settings 
 Specifying General Settings 
 Specifying Email Settings 

  
 

Specifying Time and Expense Settings 
 
You can specify processing rules and settings related to time and expense in the Global Settings and 
Preferences screens. These settings control the entry of time and expenses, their approval, processing 
and billing in BillQuick. 
 

 
 
Below is a list of time and expense related settings, action to be taken and where they can be set. 
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Setting Action/Effect Where 

Allow Negative 
Time Entry 

Check this option to allow negative hours for time entry. Some companies use this feature 
to maintain an audit trail of changes to time records. 

Global Settings-
Time/Expense 

Allow Zero-Hour 
Time Entry 

Check this option to accept zero hours in the time entry screens.  Global Settings-
Time/Expense 

Hide Non-Billable 
Time/Expense 
Entries on Invoice  

By default, BillQuick includes time and expense entries with $0 amounts on detailed invoices 
as ‘No Charge’ items. Check this option to prevent such (non-billable) entries from printing 
on invoices.  

Global Settings-
Time/Expense 

Show Time and 
Expense Memos on 
Invoices 

Check this option to display the memos attached with time and expense entries on the 
invoices. 

Global Settings-
Time/Expense 

Add Time and 
Expense Memos to 
Journal 

Check this to copy all time and expense entry memos to the project journals. Global Settings-
Time/Expense 

Compare amount 
spent against total 
budget 

Check this option to compare Amount Spent against total budget instead of the usual 
contract amount.  

Global Settings-
Time/Expense 

Prompt for 
submission of new 
Time and Expense... 

Check this option if you want BillQuick to prompt you automatically for submission of new 
time and expense entries. If ignored, a message will display each time you log in to remind 
you about the submission. 

Global Settings-
Time/Expense 

Evaluate Time and 
Expense Billable 
status based on 
Billable value 

Check this option to include only billable hours and expenses for time and expense 
evaluation against the contract amount. The Total Amount Spent on a fixed-type project is 
calculated [(Billable Hrs x Bill Rate) + billable Expense Amount] and then compared to the 
contract amount (Red Flag Rule).  
 
When the amount spent exceeds the contract amount, BillQuick prompts you accordingly 
(only when you have checked ‘Lock at Contract Amount’ rule in the Project profile). The entry is 
split into two—one ‘billable’ for the portion that is still within the contract, and the other 
‘non-billable’ for the portion that is over the contract amount. 

Global Settings-
Time/Expense 

Exclude Vacation, 
Sick,. . . when 
Calculating  

Some companies calculate overtime only from actual hours worked. Check this to exclude 
vacation, sick, holiday and comp-time hours in the automatic calculations of overtime hours 
of employees.  

Global Settings-
Time/Expense 
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Setting Action/Effect Where 

Overtime 

Approve 
Time/Expense 
Entries 
Automatically 

Check these options to approve time/expense entries automatically for all new projects. You 

can also click  and approve all the entries for existing or older projects as well. 

Global Settings-
Time/Expense 

Skip Time and 
Expense Evaluation 

Check this option to skip the automatic evaluation of time and expense entries (Red Flag 
Rule). When you make an entry, BillQuick does not compare the Total Amount Spent 
against the Contract Amount of fixed-type projects.  

Global Settings-
Time/Expense 

Auto Approve 
Time/Expense Entry 
for Employees 

Check these options to approve time/expense entries automatically for all new employees. 

You can also click and approve all the entries for existing or older employees as well. 

Global Settings-
Time/Expense 

Time/Expense Entry 
memo required 

Check these options if you want all timekeepers to enter memos for all their time and expense 
entries. This is usually required for government contracts. 

Global Settings-
Time/Expense 

Smallest time 
increment for Time 
Entry 

It rounds the hours for a time entry to the next time interval. Enter the increment in Hours: 
Minutes format. The default setting is 0:15 (15 minutes).  

Global Settings-
Time/Expense 

Apply to B-Hours 
Only 

Check this option to round only billing hours as per the above rule. If un-checked, BillQuick 
rounds both Actual Hours (A-Hours) and Billing Hours (B-Hours).  
 

 When you use time entries to process payroll, it is a common practice to round only Billing 
Hours.  

 

Global Settings-
Time/Expense 

Smallest Time 
Increment  for Start/ 
Stop Time 

It is the minimum time increment for Start and Stop time fields. Enter the increment as a 
whole number. The default is 15 minutes. 
 

Global Settings-
Time/Expense 

Adjust Stop Time 
when B-Hours is 
changed 

Check this option to adjust the Stop time automatically whenever the billing hours are 
changed. 

Global Settings-
Time/Expense 

Time/Expense Entry 
should not be 

This defines the number of days into the past and the future allowed for saving or deleting a 
time or expense entry. BillQuick rejects a date more than or less than those number of days. 

Global Settings-
Time/Expense 
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Setting Action/Effect Where 

saved/deleted if date 
entered falls 
before/after 

For example, if today’s date is 5/1/2011 and you enter 365 in these text boxes, BillQuick will 
not allow you to make time/expense entries older than the year 5/1/2010 and forward 
beyond 5/1/2011. 
 

 You can grant selected users permission to enter and edit dates outside this period. In the 
Security screen, mark ‘Allow Adjust Date Beyond Global Setting restriction’ for the Time/Expense 
Entry modules.  

 

Employee standard 
hours per week/day  

Enter the number of hours employees are required to work per week and per day. 
BillQuick uses this value for all employees unless you override it in the Employee screen. 

Global Settings-
Options 

Show Time and 
Expense Memos … 

Check this option if you want to show time and expense entry memos on detailed invoices. Global Settings-Rules 

Email me when My 
Time or Expense is 
Approved or 
Rejected  

Check this option to let BillQuick automatically notify you via email about your submitted 
time and expense. This feature is useful for informing you whether the reviewer approved 
or rejected your entries. 

Preferences- 
Notifications and 
Reminders 

Email me when My 
PTO Request is 
Approved or 
Rejected 

Check this option to let BillQuick automatically notify you via email about your submitted 
personal time off requests. This feature is useful for informing you whether the reviewer 
approved or rejected your request. 

Preferences- 
Notifications and 
Reminders 

Email me when 
Time or Expense is 
Submitted to me  

Check this option to let BillQuick automatically notify you via email about time and expense 
submitted to you. This feature is useful for all managers who review and approve time and 
expense entries of employees and vendors. 

Preferences- 
Notifications and 
Reminders 

Email me when 
PTO Request is 
Submitted to me  

Check this option to let BillQuick automatically notify you via email about personal time off 
requests submitted to you. This feature is useful for all managers who approve PTO 
requests of employees. 

Preferences- 
Notifications and 
Reminders 

Time/Expense Entry 
Colors 

This is the text color of time and expense entries based on their status. It defaults to Black 
for Billable, Blue for Billed, and Red for Non-Billable. 

Click  to select from a predefined palette or to fine-tune colors by hue, saturation, 
luminosity, etc. on the Color dialog.  

Preferences- Format 
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Setting Action/Effect Where 

Auto Start Timer… Check this option to start the timer automatically whenever you launch the BillQuick Timer 
screen. 

Preferences- Options 

Open Timers as 
MDI forms when in 
MDI mode 

Check this option to set your timer to open as a tabbed window in Tabbed MDI mode. Preferences- Options 

Launch Timer 
Control 

Check this option for the Timer Control to launch automatically when you open BillQuick 
Timer.  

Preferences- Options 

Auto pause Timer 
after…system idle 
time 

Enter time in minutes after which you want Timer to pause because of no computer activity 
or system idle time. No more hassle to adjust the timer when you forget to stop it prior to a 
meeting or going out for lunch. 

Preferences- Options 

Turn Off 
Unapproved Time 
and Expense 
Notification… 

Generally, you receive notifications when unapproved, unbilled time and expenses exist for 
one or more projects billed in the Billing Review screen. You can turn this off by checking 
this option here. 

Preferences- Options 

Auto-fill Simple 
TE/EL and Cal View 
with … Projects 

Select the number of projects to pre-fill on the Simple Time Card and Calendar View 
screens. BillQuick copies that many projects last charged by users to the next session. This 
auto-fill feature filters the list based on the Employee Control settings, if any. 

Preferences- Options 

 



Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 211 

Specifying Activity Settings 
 
You can specify settings related to activity codes in the Global Settings and Preferences screens. These 
settings control the naming of activities or services in BillQuick.  
 

 
 

 

Setting Action/Effect Where 

Customizable 
Activity Codes 

BillQuick automatically adds default activity codes for 
Vacation, Sick, Holiday and Comp Time. Assign a 
different code for each activity or same code for 
multiple activities. E.g., you may set vacation and 
holiday time with the same GEN:VAC code. 

Global Settings- 
Activity 

Default Prefix 
for 
Activity/Expense 

These are the default prefixes for the activity and 
expense codes used when recording time and 
expenses. BillQuick’s smart Find quickly locates these 
IDs. When you work mostly with one service type (e.g. 
Draft, Payroll) or with a set of codes for a department 
(e.g. Admin, Paralegal), you can reduce non-billable 
administrative time spent recording time or expense 
entries with this option.  

Preferences- 
Format 
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Assigning Global Templates 
 
Each contract type in BillQuick has a default invoice and statement template. In addition, you can also find 
default templates for manual and joint invoices. 
 
To assign a template: 

 
1.  Open the Global Settings screen. Choose the Templates option on the left. 

 

 
 

2.  Click  next to the contract type to which you want to assign a different template.  
 

3.  To open a category on the Invoice Selection screen, click .  
 

4.  Highlight an invoice format and preview it on the right panel. To select it, click OK.  
 
 

Setting Global Reminders 
 
For those who integrate with accounting software, a reminder can prompt you to synchronize data 
between the two applications. BillQuick uses the sync settings as rules for transferring data to and from 
BillQuick and your accounting software.  
 
You can also set a reminder for backing up your BillQuick database. Besides reminders, you can set email 
notifications for yourself. 
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To set a reminder: 
 

1. Open the Global Setting screen. Select the Reminders option on the left. 
 

 
 
2. Reminder options for sync are available for QuickBooks, Peachtree and MYOB. Select the 

desired option, say weekly or on startup, and click Save. 
 

 It is best to activate the reminder option after initial integration with your 
accounting software. 

 
3. Next, select Options on the left.  

 
4. In the Application Backup Reminder section, choose the day of the week, date of the month or 

any other option to get a reminder for backing up your company database.  
 

 BillQuick’s Backup and Restore feature works with Microsoft Access 
(standard) database only. 

 
5. Next, open the Preferences screen. 

 
6. Click on the Notification and Reminders panel and enter the number of days ahead when you 

want the Due Date reminder to show up. 
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 You can also set the relevant email notifications for yourself. 

 
7. You can view all these reminders in the Reminders screen. To upload it automatically, select 

Options on the left and mark the ‘Load Reminder on Startup’ checkbox. 
 

8. When you are done, click Save and then Close to exit. 
 
 

Setting Interest Rates 
 
You can specify interest rates for late fee on outstanding invoices in the Global Settings screen. These 
settings control the calculation of late fee in the Invoice Review screen, unless overwritten by different 
settings in the Project screen.  
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Below is a list of late fee settings, actions to take and where they can be set. 
 

Settings Action/Effect Where 

% per month 
 

Enter the rate of interest to charge as late fee on 
invoices. Enter the percentage as a whole number (for 
example, 1.5 for 1. 5%).  

Global Settings-
Options 

Days After Enter the number of days or grace period before 
BillQuick charges the monthly interest rate on past due 
invoices when calculating late fees.  

Global Settings-
Options 

Apply to blank/ 
zero/non-blank 
rates 

You can apply the interest settings to project records 
based on whether these fields are blank, with zero value 
or any other value. Select the relevant option and click 

 to apply these settings to existing data. 

Global Settings-
Options 

Interest on 
Past Due 
Invoices 

Enter the number of days or grace period after which 
BillQuick will charge interest per month on past due 
invoices. The Payment Term set for a project (Billing tab) 
is carried to the ‘After Days’ field. 

Project-Detail 
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Setting Global Taxes 
 
You can specify tax rates in the Global Settings screen. These settings control the calculation of item 
taxes (Tax 1/2/3) and main taxes (MST/MET) on service and expense items in BillQuick, unless 
overwritten by different settings in the Client or Project screen.  
 

 
 

Below is a list of settings, actions and location where they can be set. 
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Setting Action/Effect Where 

Taxes Rate 1/2/3 Enter the default Tax 1/2/3 rates for new activity and expense items, say 9%. BillQuick 
applies these tax rates to time and expense entries to calculate the bill amount and expense 
charges. You can override these rates for individual activity and expense codes in their 
respective screens.  

Global Settings-Options 

Contract Amount 
Includes Taxes 

Check this if your company includes taxes in contract amount for projects. When calculating 
Net Bill amount based on % Complete, calculations take into account such options. When 
un-checked, BillQuick adds the tax separately to the pre-tax bill amount. 

Global Settings-Rules 

MST/MET to 
exclude Item Tax 

Check these options so that Main Service Tax and Main Expense Tax exclude item taxes 
(Tax1/2/3) associated with the activity and expense codes while computing the total tax 
amount to be charged on invoices. 

Global Settings-Rules 

Apply Discount to 
Pre-Tax Amount 

By default, BillQuick applies a discount to the calculated bill amount after applying the taxes. 
Check this option to apply a discount to the bill amount before taxes. 

Global Settings-Rules 

Show GST 
Separately on 
Invoices 

Check this option if you want to show the Goods and Services Tax separately on all invoices. Global Settings-Rules 

Time/Expense Entry 
Hide Tax fields 

Check these options to hide the Tax 1/2/3 fields on the time entry and expense entry 
screens. These fields do not appear on the Hide/Show (Field Chooser) list as well.  

Global Settings- More 

Apply Taxes These are the Main Service Tax and Main Expense Tax rates applied to total labor and total 

expenses on invoices, respectively. Enter the rates and click to apply these rates to 
existing data. 
You can override MET and MST for a client or project. See Computing Taxes in the Billing 
chapter for more. 

Global Settings-More 

Ceiling for Taxes Enter the maximum amount that you can charge per invoice as Main Service Tax and Main 
Expense Tax. Enter a dollar amount. 

Global Settings-More 

 

 For tax settings specified at the client and project level, see Client Setup and Project 
Setup in the Master Information Setup chapter.  
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Specifying Invoice Settings 
 
You can specify processing rules and settings related to invoices in the Global Settings and Preferences 
screens. These settings control the generation, processing and behavior of invoices in BillQuick.  
 

 
 
Below is a list of invoice related settings, action to be taken and where they can be set. 
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Settings Action/Effect Where 

Reference 
Calculation Method 

Some companies prefer electronic invoicing, especially in European countries. Specify a 
calculation method for electronic invoices –137 Method or RF Creditor Reference. 
Check ‘Show Reference Number on Invoices’ if you want to display the reference numbers 
on invoices. See Electronic Invoices for details. 

Global Settings-
Options 

Last Printed Invoice 
# 

This counter shows the number of the last printed invoice (up to 10 characters long). 
BillQuick automatically increments the number for each standard and manual invoice 
generated.  
 
BillQuick supports both numeric and alphanumeric invoice numbers. Put the numeric 
segment that you want to increment inside curly brackets. E.g., the next invoice number 
after INV-{0000} would be INV-0001, then INV-0002, and so on. 
 

 Reversing an invoice does not decrease the counter; however, BillQuick does reuse the 
invoice number. If you edit the invoice number on Invoice Review, Manual Invoice or Billing 
Review, BillQuick will check for duplicate invoice numbers. 

 

Global Settings-
Miscellaneous 

Retainer Invoice # BillQuick automatically assigns numbers to retainer invoices as per the value entered here. 
You can choose numbers, letters or a combination to track invoices. Enter the value to be 
incremented in the Invoice Number field. You can also specify a Prefix and Suffix to go with 
the number. E.g., RET-1001-2011 

Global Settings-
Miscellaneous 

Aging Period This is the length of each aging period for invoices, but you can change the interval anytime. 
Aging is based on the invoice date.  

Global Settings-
Miscellaneous 

Minimum Bill Amount This is the minimum amount for billing a new invoice. It carries to the Billing Review screen 
but you can override it there.  

Global Settings-
Miscellaneous 

Mark Projects 
Completed when 
Billed 100% 

Check this option to change a project’s status to ‘Completed’ when you fully bill the Service 
Amount portion of the Contract Amount. 

Global Settings-Rules 

Reverse Write-
Up/Down when 
invoice reversed 

Check this so that while reversing an invoice, BillQuick also reverses any write-ups or write-
downs executed during the billing process.  

Global Settings-Rules 

Show Project Memo Check this option to display the project memo on the invoices. This memo displays at the Global Settings-Rules 
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Settings Action/Effect Where 

on Invoices at the 
Bottom 

bottom of the invoice (Second Memo).  

Zero rates in Service 
Fee Schedules are 
Valid 

You may want to use a service fee schedule to have both the bill and cost rates default to 
zero dollars but keep the entry billable. Check this option if you want to be able to enter 
zero dollar rates in a SFS. 

Global Settings-Rules 

Void Invoices/ 
Payments on 
Deletion 

Mark this checkbox so that BillQuick voids invoices and payments rather than delete 
(reverse) them. BillQuick retains the voided items in the database and you can print such 
lists.  

Global Settings-Rules 

Show Billing 
Through on Invoices 

Check this option if you want to view time entries on the Billing Review screen and invoices 
as of a specific ‘mm/dd/yy’ date instead of a ‘From and To’ range. 

Global Settings-Rules 

Auto Apply Retainer Mark this checkbox if you want to apply retainers automatically to invoices when you are 
generating billing records on the Billing Review screen. BillQuick applies the project retainer 
prior to applying the client retainer. 

Global Settings-Rules 

Print Statement for 
posted invoices 

When you check this option and later print a posted invoice, BillQuick prints the invoice to 
your default printer and then displays the project statement. This way you can preview and 
print a statement, provided the balance is greater than zero. 

Global Settings-Rules 

Show Account 
Summary… 

This option lets you display account summaries at the bottom of your invoices. This option is 
checked by default. 

Global Settings-Rules 

Show Time and 
Expense Memos … 

This option lets you display time and expense entry memos on detailed invoices. Uncheck it 
if you do not want to show the memos on invoices. 

Global Settings-Rules 

Show GST Separately 
on Invoices 

Check this option if you want to display Goods and Services Tax separately on all invoices.  Global Settings-Rules 

Show Retainer 
Summary on Invoice 

Check this option if you want to display retainer summary on your invoices. Global Settings-Rules 

Include Innovative 
Merchant Solutions 
link on invoices 

Check this option to embed the IMS web link on the invoices. It provides the self-service 
credit card payment service to the clients, enabling them to pay easily via credit card or 
debit card. 

Global Settings-
Merchant 

Innovative Web Link Enter the internet address of the IMS web site that links to your account. A payment 
processes via your IMS account. 

Global Settings-
Merchant 
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Settings Action/Effect Where 

Account Email Enter an email address where you want IMS to notify you whenever someone makes a 
payment. 

Global Settings-
Merchant 

Account ID/Password Enter your company’s IMS account number and password. Global Settings-
Merchant 

Currency This is the currency to use for making and receiving payments. It defaults to U.S. Dollars. 
You can change it, if desired. 

Global Settings-
Merchant 

Add Credit Card 
Processing to 
BillQuick 

Click this link to sign up for an IMS account via BillQuick.  Global Settings-
Merchant 

Include  PayPal link 
on invoices 

Check this option to embed the PayPal payment link on your invoices. It provides the self-
service credit card payment service to the clients, enabling them to pay easily via credit card, 
bank account or debit card. 

Global Settings-
Merchant 

PayPal Web Link Enter the internet address of the PayPal web site that links to your account. A payment 
processes via your PayPal account. 

Global Settings-
Merchant 

Account Email Enter an email address where you want PayPal to notify you when someone makes a 
payment.  

Global Settings-
Merchant 

Currency This is the currency to use for making and receiving payments. It defaults to U.S. Dollars, but 
you can change it here.  

Global Settings-
Merchant 

Email me when 
Invoices are 
Submitted to me for 
Approval 

Check this option to let BillQuick automatically notify you via email about invoices 
submitted to you for approval. This feature is useful for all managers who review and 
approve invoices before billing the client. 

Preferences- 
Notifications and 
Reminders 
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Specifying Folder Settings 
 
You can specify settings related to folders in the Global Settings and Preferences screens. These settings 
control the path or location where various folders, files and documents in BillQuick are stored. 
 
Settings specified in the Preferences screen will override the ones in the Global Settings screen. You 
cannot specify mapped drives in Global Settings screen; hence, specify a local drive (e.g., 
C:\Users\Administrator\Desktop\Linked Documents) or a UNC (\\computerName\shareName). 
 

 
 
Below is a list of settings, actions and location where they can be set.
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Settings Action/Effect Where 

Backup Folder Click  to browse for the directory path on your computer or network server to the 
folder in which backup copies of your BillQuick database should be stored. Default is the 
same directory as your company database (x:\Program Files\BillQuick2011).  

Global Settings-Folders 

Automatically log 
actions to a log file 

Check this option to record or log every action in BillQuick, including who performed it and 
when. Log Viewer allows you to view all log entries.  

Global Settings-Folders 

Log File Location Specify the location where BillQuick stores the log file. By default, it is the same folder as 
your company database (x:\Program Files\BillQuick2011). For SQL Server, you MUST specify 
the location.  
 

 It is recommended to keep the log file on a server rather than your local drive (C or D 

drive). 
 

Global Settings-Folders 

Location of Report 
Files/Report 
Designer/Invoice 
Templates 

The location of special folders for report and invoice templates customized or created. 

Enter the directory path or click  to browse to the desired folder. If you leave the field 
blank, BillQuick searches the default folders: x:\Program Files\BillQuick2011\Reports and 
x:\Program Files\BillQuick2011\Invoices.  
 

In Preferences, you can click  to create a new Custom Invoice Folder. The 
Preferences setting overrides the one selected in Global Settings. 

Global Settings-Folders 
Preferences-Folders 

Automatic Update 
Files 

This is the directory path or location of the folder where BillQuick stores its software 

updates. Enter the directory path or click  to browse for it. The Preferences setting 
overrides the one selected in Global Settings. 

Global Settings-Folders 
Preferences-Folders 

Shared Folder for 
Linked Files 

This is the location of the shared folder, where BillQuick stores files linked to its records. 

Enter the directory path or click  to browse to the desired folder. The Preferences setting 
overrides the one selected in Global Settings. 

Global Settings-Folders 
Preferences - Folders 

Location of Folders 
for PDF Files 

This is the location of the folders, where BillQuick stores all its PDF files. Enter the 

directory path or click  to browse to the desired folder. The Document Management 
screen also points to the same location. The Preferences setting overrides the one selected in 
Global Settings. 

Global Settings-Folders 
Preferences - Folders 



Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 224 

Settings Action/Effect Where 

Available Fields When defining the path and folder for PDF files, you can select an existing folder, or you can 
use variable information from BillQuick. For example,  
 
...\My Documents\Client Files\{CLIENTCOMPANY}\{PROJECTNAME} 

 
stores PDFs in the folder named for the project under the client company folder. This 
ensures BillQuick saves PDFs in the right location automatically. You can select the variable 
information (Client ID, Project ID, Manager, etc.) from the dropdown list.  
 
The Preferences setting overrides the one selected in Global Settings. 

Global Settings-Folders 
Preferences - Folders 
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Specifying General Settings 
 
You can specify general or miscellaneous settings in the Global Settings and Preferences screens. These 
settings control the behavior of BillQuick functions and features, such as filters, UI, memo, etc.  
 

 
 
Below is a list of settings, actions and location where they can be set. 
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Settings Action/Effect Where 

First Day of the 
Week 

Select the first day of the workweek. BillQuick uses this day to present correct information 
on screens and reports. E.g., the Calendar View and various time reports adjust to show the 
correct beginning of the week. 

Global Settings-Options 

Apply Filters To This setting determines whether filters in various screens apply to the grids and/or drop-

down lists. Click  to select the desired option—Both Grids and Drop-downs, Grids Only 
or Drop-downs Only.  

Global Settings-Options 

No. of digits after 
decimal 

This field defaults to 2 digits. Enter a value from 0 to 9 for the number of digits to display 
after a decimal in the numeric fields.  

Global Settings-Options 

Make this 
application DCAA 
Compliant 

Government contractors and agencies require their time tracking systems to be DCAA 
compliant. Check this option to override the existing or default security settings in BillQuick 
to ensure DCAA compliance. However, authorized users can edit those settings. See the 
DCAA Compliance Guide for details. 

Global Settings-Options 

Set DCAA password On checking the above option, you are prompted to set a password for DCAA settings in 
BillQuick. This ensures the DCAA compliance setting is password-protected and no one 
turns it off accidentally. 

Global Settings-Options 

Last Project Code Check this option to increment the numeric portion of the ID automatically for newly 
created projects. You can increment only the numeric portion of a code, identified by curly 
brackets. E.g., the next project ID after 2011-{000} would be 2011-001 and so on. 

Global Settings-
Miscellaneous 

Last Vendor Bill # This counter shows the number of the last vendor bill (up to four characters long). Enter the 
number that you want to be incremented. BillQuick automatically assigns the numbers to 
vendor bills as per this value. 
 

 Vendor Bills screen allows re-using the previous Bill# as in Invoice Review.  
 

Global Settings-
Miscellaneous 

Last Purchase Order 
# 

This counter shows the number of the last purchase order. BillQuick automatically 
increments the number for each PO generated. 
 
You can choose numbers, letters or a combination of both to track purchase orders. Enter 
the value that you want to be incremented within curly braces. E.g., if you enter ‘{1000}’ 
here, the next PO number will be ‘1001’. 

Global Settings-
Miscellaneous 

http://bqesoftware.net/media/PDF/BQ/2011/DCAA-Compliance-Guide-2011.pdf
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Settings Action/Effect Where 

Number of uses 
prior to running 
repair 

Set the number of times you open BillQuick before it prompts you to run the ‘Repair and 
Compact’ utility. The utility removes records marked for deletion, checks for other issues, 
and then ‘compacts’ the database to optimize speed. This utility runs on the Standard 
database (Microsoft Access) only. 

Global Settings-
Miscellaneous 

Maximum Records 
to Load 

Select the maximum number of records to load from your database. This setting allows you 
to maintain control over the data requested from the server and avoid server timeout when 
the returned data rows exceeded one million rows. 

Global Settings-
Miscellaneous 

Current/New 
Password 

You can use a password to access your company database outside of BillQuick, to open the 
database in Microsoft Access 2000 or to access it when working with Crystal Reports. The 
default password is admin (case-sensitive). To change it, enter the current password, a new 
password, and then verify the new password by entering it again. 

Click  to apply the password settings. 

Global Settings-
Miscellaneous 

Delete Records in 
QuickBooks when 
Deleted in BillQuick 

Check this option so that records deleted in BillQuick are automatically deleted in 
QuickBooks during the next synchronization. The Preferences setting overrides the one 
selected in Global Settings. 

Global Settings-Rules 
Preferences-Options 

Do Not Display 
Database Location in 
Status Bar 

Check this to hide the location of your company database on the status bar of the BillQuick 
Desktop. 

Global Settings-Rules 

Do not allow 
receiving items… 

Check this option to prevent anyone from receiving items against unapproved purchase 
orders. This option ensures that you approve the purchase orders first and then receive 
items against them from vendors and suppliers.   

Global Settings- Rules 

Make Passwords 
Case Sensitive 

Check this option if you want to make all passwords in BillQuick case sensitive. If you assign 
a user Curtis James a password ‘CJ’, he cannot log in with ‘cj’ as his password. 

Global Settings- Rules 

Default Font for 
Memo Box 

Specify the standard font (name and size) to use for all time, expense and invoice memos 
created by all users. You can preview the selected font in the sample box. 

Global Settings- More 

Do not allow… 
change Memo Font 

Check this option to prevent users from changing the default font on the memos. Global Settings- More 

URL for Currency 
Exchange rates 

Specify a URL or web link from where BillQuick can retrieve the latest currency exchange 
rates, e.g., Yahoo Currency Convertor. BillQuick uses these rates as current multipliers in 
the Currency Manager screen. 

Global Settings- More 
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Settings Action/Effect Where 

Default Accounts If you are using Accounts Payable modules in BillQuick, specify the default accounts for 
writing checks, paying vendor bills and making deposits. You can changes these accounts 
later from each screen.  

Global Settings- 
Accounts Payable 

Report Basis Specify what should be the basis for your A/P reporting—whether accrual basis or cash 
basis. This will depend on the accounting method followed by your company. 
 
Cash basis involves recording income when it is received and recording expense when it is 
paid. Accrual basis involves recording income when it is earned and recording expense when 
it is incurred. 

Global Settings- 
Accounts Payable 

Theme BillQuick 2011 applies the default theme to the application. However, you can change it to 
your preference by selecting any other from the dropdown list like Desert, Pear, Blue, etc. 

Preferences-
Appearance 

Email me when 
Purchase Order is 
sent to me for 
approval  

Check this option to let BillQuick automatically notify you via email about purchase orders 
submitted to you for approval. This feature is useful for all managers who review and 
approve purchase orders before sending them to vendors and suppliers. 

Preferences- 
Notifications and 
Reminders 

Email me when 
Vendor Bills are sent 
to me for approval 

Check this option to let BillQuick automatically notify you via email about vendor bills 
submitted to you for approval. This feature is useful for all managers who review and 
approve vendor bills. 

Preferences- 
Notifications and 
Reminders 

Reset Message box 
notifications 

Click  to reset or turn on confirmation messages or notifications in BillQuick. It restores 
all confirmations to the default state. 

Preferences- 
Notifications and 
Reminders 

Skip Warning Upon 
Exit 

Check this option, if you do not want BillQuick to prompt you to verify whether you want 
to exit the BillQuick program. 

Preferences- Options 

Turn Off Navigator Check this option so that the Navigator does not display when you start BillQuick. Preferences- Options 

Turn Off Auto 
Update 

Mark this checkbox to prevent automatic check of the web site for a new version of the 
BillQuick program. Without auto-update, you need to manually check the web site and 
download the newer versions from the Support page. Contact BillQuick Support (310-602-
4030) to find out if an update is available. 

Preferences- Options 

Turn Off 
Confirmation 

Check this option to turn off BillQuick playing a sound bite to confirm saving data and other 
actions. 

Preferences- Options 
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Settings Action/Effect Where 

Sounds 

Turn Off Usage 
Tracking 

Check this option to turn off BillQuick sending usage statistics for features and functions to 
BQE Software for analysis and planning of future versions. 

Preferences- Options 

Remember 
State…on All 
Screens 

Check this option so that BillQuick remembers the state of collapsible panels (such as open 
Memo box in Project screen) on all screens.  

Preferences- Options 

Hide features 
…Access to 

Check this option if you want to hide all the menus, toolbar buttons and features in 
BillQuick that you are not supposed to access. This will be determined by the security 
settings or permissions assigned to you. It helps in simplifying the UI for a user. 

Preferences- Options 

Make All Screens 
Tabbed MDI 

Check this option to view all the open screens in BillQuick as tabs in the main BillQuick 
window. 

Preferences- Options 

Make All Screens 
Non-MDI 

Check this option to drag any window outside the main BillQuick window. This facilitates 
easier dual-monitor operations. 

Preferences- Options 

Hide Sidebar Mark this checkbox to hide the Sidebar on the BillQuick desktop. Preferences- Options 

Turn Off Auto 
Match for One 
Column Lists 

By default, BillQuick automatically completes field values when you enter a partial value. To 
turn off this auto-complete feature for the combos, check this option. 

Preferences- Options 

Show Project Assign 
Tab 

Check this option to display the Assign tab in the Project screen. You can use this tab to set 
up project control by assigning activities, expenses and employees to projects. 

Preferences- Options 

Show Main Toolbar Check this option to display the main toolbar in BillQuick. This toolbar contains icons that 
provide easy access to various screens. By default, the main toolbar is hidden.  

Preferences- Options 
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Specifying Email Settings 
 
While sending emails from BillQuick, you need to give permission to Outlook or your email program to 
access BillQuick. By specifying proper email settings, you can by-pass that step and let BillQuick directly 
send emails by connecting to the specified mail server. A System/IT Administrator should configure 
your email settings.   
 
You can specify email settings at the company level in the Global Settings screen or override them on the 
user-level in the Preferences screen.  
 

 
 
Below is a list of email-related settings, actions to take and where they can be set. 
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Settings Action/Effect Where 

SMTP Server Specify the SMTP mail server name for sending emails. SMTP is a simple, text-based 
protocol used to send messages to one or more recipients. E.g., for Gmail you use 
‘smtp.gmail.com’. The Preferences setting overrides the one selected in Global Settings. 

Global Settings-Email 
Preferences- Email 

Use SSL Check this option if you want to protect the confidentiality and security of data transmitted 
between your email program and the servers. (SSL stands for ‘Secure Sockets Layer’.) The 
Preferences setting overrides the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

SMTP Server Requires 
Authentication 

Check this option if you want SMTP server to ask for authentication before sending emails. 
The Preferences setting overrides the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Your Name Enter your first name to provide the recipient intimation for identification. The Preferences 
setting overrides the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Email From Enter your email address for sending and receiving emails. The Preferences setting overrides 
the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

CC Mail To Enter the email address of a person to whom you want to send a copy of your emails, 
typically your own email ID or your supervisor’s. When you email an invoice or report to 
someone, the CC is auto populated with this address. The Preferences setting overrides the 
one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

User Name Specify the log-on account name for the SMTP mail server used. For example, if you are 
using Gmail services, enter your Gmail user name here. The Preferences setting overrides the 
one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Password Specify the log-on password for the SMTP mail server used. Click ‘Test email settings’ to 
verify your email settings. The Preferences setting overrides the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Delivery Method Choose an option—Network, Specified Pickup Directory, Pickup from IIS—for delivery of 
emails. In ‘Pickup from IIS’, the email file is dropped in the default location and then IIS 
searches for these emails. In ‘Network’, the email file is sent directly through the network. 
In ‘Specified Pickup Directory’, the email file is delivered to the specified directory location.  
The Preferences setting overrides the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Directory Name If the Delivery Method is ‘Specified Pickup Directory’, then you need to specify the 

directory path. Click  to browse to the desired location. The Preferences setting overrides 
the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Port You need to mention the SMTP Server Port number for outgoing mails. The SMTP client Global Settings- Email 
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Settings Action/Effect Where 

initiates a TCP connection to server's port 25. However, some servers may have their own 
configurations. E.g., Gmail uses port 465. The Preferences setting overrides the one selected in 
Global Settings. 

Preferences- Email 

Auth. Type Select an option—Anonymous, Basic or NTLM—for authenticating your emails. In 
‘Anonymous’ authentication, there is no way to verify the sender. ‘Basic’ authentication 
allows clear text user names and passwords for authentication. NLTM or Integrated 
Windows Authentication only works in configurations where the client computer can 
contact a domain computer to validate their credentials. 
 
The Preferences setting overrides the one selected in Global Settings. 

Global Settings- Email 
Preferences- Email 

Default Email Settings Enter a default email Subject, Attachment name and Message for invoices, statements and 
reports. This gives you flexibility to customize the name of your attachments, say you want 
to name all attached invoices other than their default invoice template. You may insert 
placeholders into any of these using the Available Fields option, say Project ID, Client ID 
and so on.  
 
If desired, you can type a standard signature in the Message that displays on all emails. You 
can edit the message and attachment name on the Email screen before sending any email.  

Global Settings- Email 

Use MAP1 Specify the mail server information for sending emails directly from BillQuick. Select this 
option to use your local MAPI email client (e.g., Outlook, Eudora). Sent attachments, 
invoices, etc. are stored in your email account’s Sent Folder. 

Preferences- Email 
Settings 

Use SMTP Specify the mail server information for sending emails directly from BillQuick. Select this 
option to use an SMTP Server (Outgoing mail server).  
 
SMTP (Simple Mail Transfer Protocol) sends emails across Internet Protocol (IP) networks 
and is independent of your email client (you can still use your email client). While sending 
attachments, invoices, etc., you can copy the email (CC) to yourself. 

Preferences- Email 
Settings 

Default Email Message Enter a default email message for invoices, statements and reports. If desired, you can type 
auto-complete shorthand codes or a standard signature in the Message box that displays on 
your emails. You can edit the message on the Email screen before sending any email.  

Preferences- Email 
Settings 
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Customizing Theme 
 
BillQuick includes many pre-defined themes. The theme setting is a preference for individual users. It 
controls the background colors for toolbars, button bars and screens, as well as grid highlights. 
 
To customize the theme: 
 

1.  Open the Preferences screen from the Settings menu. 
 

2.   Click on Appearance option on the left.  
 

 
 

3.  In the Theme field, select any desired theme. The default theme is Ocean. 
 

4.  When you are done, click Save and then Close to exit. BillQuick now displays the new theme. 
 
 

BillQuick Family of Products 
 
BQE Software offers other stand-alone products and add-on modules that can help you effectively and 
efficiently manage your company. They expand BillQuick’s core capabilities, providing you with smart 
tools and features. 
 
To take benefit of these products, you need to purchase and install them separately. After installation, 
you can access them from within BillQuick (Add-Ons menu). 
 

 To learn more about other BQE products, please visit 
www.BQE.com/Products.asp. 30-day trial versions of add-on modules and 
stand-alone applications are available here. To check out related support 
documents for each, please visit www.bqe.com/Support.asp. To purchase, 
contact Sales at (310) 602-4020. 

 

http://www.bqe.com/Products.asp
http://www.bqe.com/Support.asp?pageId=Home


Company Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 234 

The BillQuick Family includes various software modules. All modules are available as downloadable trial 
software (30-day evaluation period).  
 

Product/Edition Trial Lite Basic Pro Enterprise 

BillQuick      

BillQuick Online  — —  
1 

Web Suite 
2 —    

Agent  —    

Outlook Add-In  —    

Resource Allocator3  — 3 3 3 

BillQuick HR3  — 3 3 3 

Auto-Reporter  — 3 3 3 
1It offers Enterprise and Enterprise Plus plans. 
2BQE Software maintains a test server on the web for prospects to evaluate Web Suite. 
If desired, they can download Web Suite and install it on their local network. 
3Resource Allocator, AutoReporter and BillQuick HR are not segmented into editions 
like other modules. These modules include all features available for the software. 

 
This section briefly highlights the core capabilities and benefits offered by major BQE Software products. 
Accordingly, you may decide to use the ones better suited for your company and situation. 
 

 Web Suite 
 BillQuick Online 
 BillQuick Agent 
 BillQuick Outlook Add-In 
 BillQuick HR 
 AutoReporter for QuickBooks 
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BillQuick Online – online version of BillQuick 
 

 
 

 It is a subscription-based, hybrid Software-as-a-Service (SaaS) model of BillQuick desktop 
that is hosted by us. 

 It provides you with a secure, hassle-free, investment-free time tracking, billing and 
project management software. 

 It not only stores data solely at the hosted site (called ‘cloud’) but also at your local site. If 
you have been using BillQuick desktop on a computer or laptop, whenever Internet 
connection is available, you can synchronize that data with the BillQuick Online database 
using the sync tool. 

 You do not have to worry about backups. Data backups are automatically taken by us.  
 

 To learn more about BillQuick Online, please check out the BillQuick 
Online Help. Also, check out www.BillQuickOnline.com. 

 
 
 

http://www.billquickonline.com/WebiHelp/bqonline.htm
http://www.billquickonline.com/WebiHelp/bqonline.htm
http://www.billquickonline.com/
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Web Suite – browser-based version of BillQuick 
 

 
 

 It allows you to access BillQuick through a web browser, via your local company 
network/server, an Intranet or Internet. The Web Suite Mobile module operates from a 
smart phone like iPhone, Blackberry, Palm Treo or Palm Pre. 

 It is useful for companies with satellite offices or with staff, managers or consultants who 
work remotely.  

 Some companies also deploy Web Suite inside their company to cut the total cost of 
ownership. 

 It allows you to track time and expenses, bill your clients and generate reports anywhere, 
anytime. 

 Security and other settings in BillQuick carry to Web Suite, but you can overwrite them 
to suit your needs.  

 

 To learn more about Web Suite, please check out Web Suite User Guide 
and Web Suite Help. Also, check out Web Suite Getting Started Guide for 
installation instructions and main procedures. 

 
 

http://bqesoftware.net/media/PDF/BQ/2011/Web-Suite-User-Guide-2011.pdf
http://bqesoftware.net/media/PDF/BQ/2011/Web-Suite-Getting-Started-Guide-2011.pdf
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BillQuick Agent - workflow automation tool 
 

 
 

 It allows timesheet tracking or monitoring. Agent checks employee and subcontractor 
timesheets daily or weekly to make sure they record their hours according to company 
policy. It sends email reminders to delinquent timekeepers and their supervisors.  

 It schedules any standard or custom report in BillQuick for automatic generation and 
delivery to anyone inside or outside the firm via email or onscreen. You can also print 
reports.  

 It is useful for setting up and generating business alerts. Agent automatically tracks the 
changes in the database that signal a special situation or an event that requires your 
immediate attention. It then sends an email or instant message to your BillQuick desktop. 

 

 To learn more about Agent, please check out BillQuick Agent Getting 
Started Guide for installation instructions and main procedures. 

 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Agent-Getting-Started-Guide-2011.pdf
http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Agent-Getting-Started-Guide-2011.pdf
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BillQuick Outlook Add-In – integration with Microsoft Outlook 

 

 
 

 Outlook Add-In is embedded in Microsoft Outlook and captures time from appointment, 
tasks and emails.  

 It allows you to send Outlook data to BillQuick. 
 It allows you to exchange contacts between BillQuick and MS Outlook. 

 

 To learn more about Outlook Add-In, please check out BillQuick Outlook 
Add-In Getting Started Guide for installation instructions and main procedures. 

 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Outlook-AddIn-Getting-Started-Guide-2011.pdf
http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Outlook-AddIn-Getting-Started-Guide-2011.pdf
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BillQuick HR – management of employees 
 

 
 

 It enables you to manage your employees and fulfill the associated human and legal 
obligations. 

 You can maintain employee profiles, track employee benefits, incidents and vacation 
time, conduct performance reviews, generate related reports and much more.  

 You can import employees from BillQuick and exchange data with BillQuick without any 
special setup.  

 

 To learn more about BillQuick HR, please check out BillQuick HR Getting 
Started Guide for installation instructions and main procedures. 

 
 
 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-HR-Getting-Started-Guide-2011.pdf
http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-HR-Getting-Started-Guide-2011.pdf
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AutoReporter for QuickBooks – report automation tool 
 

 
 

 It enables you to generate QuickBooks reports, memorize filters and formats to standard 
reports and schedule them for automatic processing 

 It schedules QuickBooks reports for automatic generation and delivery to anyone inside 
or outside the firm via email or onscreen. You can also print reports. 

 

 To learn more about AutoReporter, please check out 
www.bqe.com/ProductOverview for more. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

http://www.bqe.com/ProductOverview.asp?prodId=AR
mailto:BQ-Ideas@bqe.com
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 7 
Project 
Management 

 Project Hierarchy 

 Contract Types 

 Budgets and Estimates 

 Fee Schedules 

 Project & Employee Control 

 File Linking 

 Project Journals 

 Project Settings 

 Dashboard 

 Document Management 
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Project Overview 
 
BillQuick is a project-centric system that supports an unlimited number of projects. In addition, a 
project’s scope can be broken down into parts called phases. If desired, you can further refine phases into 
segments, and these can be broken down into sub-segments. In essence, BillQuick supports up to four 
levels in a project hierarchy (See Project Hierarchy below for details).  
 
Each project record has a unique ID, is linked to a client (who authorizes and pays for the work), and 
includes agreed-on contract provisions like fee and contract amount. Depending on your needs, a project 
record might also have a budget, estimate, fee schedule, employees, activities and expenses assigned to 
it. See Project Setup and Maintenance section in the Master Information Setup chapter for more. 
 
After winning a project, you need to plan and set up the scope of work to be done. You need to charge 
time and expenses to it and accordingly bill the client. All these billable and non-billable charges, issues 
and events occurring over the life of the project affect budgets, job costs, billing, profitability and 
utilization. The quality of project management depends on timely, complete and accurate capture and 
processing of time and expenses.  
 
When ready to bill, accumulated time and expenses flow to the project billing record. After executing 
billing decisions, a manager typically reviews and signs off on draft invoices, generates final invoices and 
then sends to clients. Project managers can produce reports on-demand. Using reports combined with 
qualitative information captured in the project journal, project managers learn what went well and what 
did not. This helps in making the future clients more satisfied and projects more profitable. 
 

Project Decisions 

Area Decision Where to implement 

Project Assign a project manager, project contact and 
contract type. 

Project-General screen 

Create project hierarchy, if needed. Allocate the 
contract amount to phases. 

Project-General screen 
Project-Detail screen 

Groups Identify projects with common attributes for 
purposes of grouping the project. 

Project screen: Group  

Budgets Define standard budgets applicable to multiple 
projects.  
Assign employees, vendors, activity codes, and 
expense codes to budgets by group (rather than as 
individual items). 

Budget screen 

Assign budgets to projects and phases. Project-Billing screen 
Assign screen 

Share a parent or Main project budget with project 
phases using the ‘% of Total Project’ feature. 

Project-Detail screen 

Set budgeted employees, activities and expenses on 
a project. 

Project-Detail screen: Rules 

Project Control Control who (employee) works on what (activity) 
and incurs what (expense) on a project. 

Project-Assign screen or 
Project Control screen 

Filters Identify projects for purposes of filtering the project Project screen: Filters 
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Project Decisions 

Area Decision Where to implement 

lists. 

Billing Rules and 
Invoice Settings 

Adjust or set up special bill and cost rates. Project-Billing screen 
Client-Billing screen 
Service Fee Schedule 
Expense Fee Schedule 

Specify the retainage, if any. Project-Billing screen 

Specify invoice format, number, message and 
options for the project.  

Project-Billing screen 
Project-Detail screen 
Client-Billing screen 
Client-Detail screen 
Global Settings-Miscellaneous 

Assign payment terms. Project-Billing screen 
Client-Billing screen 

Assign interest and tax rates to the project. Project-Detail screen 
Client-Detail screen 
Global Settings 

Project Documents Define folder structure and manage project-
documents. 

Document Management  
Preferences-Folders 
Global Settings-Folders 

Link related files to project records. Project-General screen: Link 
Files 
Preferences-Folders 
Global Settings-Folders 

 
This section provides an overview of the following project-related concepts and tasks: 
 

 Project Hierarchy 
 Project ID Structure 
 Contract Types 
 Project Status 
 Assigning Project Contacts 
 Changing Multiple Projects 
 Project Groups 
 Changing Project Invoice Templates 
 Merging Projects 

 
 

Project Hierarchy 
 
A project can be a single, separate entity or broken down into smaller parts. In the latter case, you would 
probably bill all the sub-projects together on a joint invoice. 
 
When you break down a project into smaller parts, there is always a parent or main project at the top of 
the hierarchy. Under it, you can add child projects, called phases. Phases can be broken down further 
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into segments and segments broken down into sub-segments. 
A project hierarchy can have up to four levels below the parent. 
 

 For complex needs, you can create a project 
hierarchy within a project hierarchy. 

 
 

The parent can be a standard project to which you can charge time and expenses, or it can be a ‘Main’ 
status project (no time and expenses allowed). If the parent project has a Main status, you can allocate a 
percentage of the contract amount to child projects. You can assign a different contract type, budget, 
project manager and items to each project record in the hierarchy.  
 
 

Project ID Structure 
 
A ‘Project ID’ is a shorthand code used throughout BillQuick to identify a project quickly. When you set 
up a new project, you define the two parts of an ID – Project Code and Phase. Only Project Code is 
required.  
 
A Project ID must often balance multiple information goals. It may include continuity from prior software 
used in your company and processing requirements. On the other hand, it may be a piece of information 
defined and required by a client to be on invoices.  
 
Defining an intuitive ID structure for projects (and for clients, activities, expenses, etc.) can save hundreds 
of hours a year across your firm. An ‘intuitive’ ID is one that anyone in your company can understand and 
relate to just by looking at it. What is intuitive for your firm may not be what is intuitive for another firm.  
 
For internal purposes, a key goal is to minimize the effort needed to find and recognize the right project 
in lists. This is especially important when recording time and expenses. An intuitive ID reduces 
timekeeper’s resistance to timely capture of hours and expenses. It can also improve accuracy and 
completeness. Thus, project managers and others gain on-demand access to quality, real-time project 
information for effective and efficient decision-making.  
 
An intuitive ID structure depends entirely on how your employees and managers think of the work they 
do. Say you are an accounting firm with a client, ABC Corporation. You do their 2011 corporate (Form 
1120) tax returns. Which of the following Project IDs would your staff recognize more easily in a list? 
 

ABCCorp-Tax1120:10    1120-34125:2011 

 
The first ID structure is descriptive in nature. It is intuitive for the staff as they think first of the client, 
then the type of work, and then the year of the tax return. The second ID structure is encoded. It might 
be the way staff think – first the work being done (the tax return), then they recognize the client number, 
and finally the tax year.  
 
Choosing the right ID structure reduces time and effort spent searching time and expense drop-down 
lists. You can scan a single column rather than bounce your eyes back and forward between columns to 
verify whether you have the right ID.  
BillQuick supports whatever structure works for your company. The ID can be letters, numbers and 
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special characters (e.g., dash, underscore, space)-64 characters long. If you use a special character that 
BillQuick does not permit, you will receive a message.  
 
 

Contract Types 
 
It is important for Project Managers to understand contract types and their effect on the billing process. 
The contract type chosen for a project triggers business-processing rules. Though you can change it any 
time, it is best to choose the right type while setting up a project. You can do it in consultation with the 
Billing Manager of the company. In addition, it is a good practice to include a ‘Stop Work’ clause in your 
contracts to safeguard your interests. Projects will be profitable only if the client pays you on time for the 
work done. 
 
BillQuick uses each project record to track information for any of these purposes: 
 

 Revenue 
 Marketing costs 
 Overhead costs 

 
For revenue-generating projects, you might choose a contract type such as Fixed (lump sum), Hourly 
(time and materials), Hourly Not to Exceed, Recurring and Cost Plus. These contracts may or may not 
have time and expenses or contract amounts associated with them. 
 
Typically, BillQuick computes the default net bill amount based on the total time and expenses relieved 
with an invoice. It compares all time and expense flowing to a project to the revenue generated to show 
gross profit. Fixed types require a contract amount though it is a good idea to provide a contract amount 
for hourly contracts as well. BillQuick uses this information to evaluate time and expenses by comparing 
the amount spent against the contract amount. In such cases, your time and expense entries display in 
red. However, nothing will stop you from overbilling a project except if it is a Recurring with Cap 
contract or has a billing schedule.  
 
For projects that your firm is trying to ‘win’, set them up as soon as you have the indication of 
opportunity and set them as ‘Marketing’ type. BillQuick tracks all time and expense, giving you better 
profitability and management information for setting fees. Tracking of marketing time and expense costs 
begins when a new or existing client calls. Conversations, budget and estimate preparations, meetings, 
planning, and bid proposals all affect a project’s profitability. After winning the project, you can carry out 
your plan through to final close of the project.   
 
Finally, you can use the Overhead type to track internal activities and expenses like education, staff 
meetings, research, and so on. You could set up one or more research project(s) for the firm with the 
objective of improving your services and expanding your professional offerings to customers. An 
overhead project requires that you set up your company as a ‘client’ and then assign the overhead project 
to it.  
 
You can choose BillQuick’s predefined contract types on the Project-General screen. It includes: 
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Fixed-Type 
Fixed 
Hourly Not to Exceed 
Percentage 
Recurring With Cap 

These contracts types are used when you want to bill: 
 
 Accumulated value of time and expenses up to the contract amount 
 A percentage of the contract amount/settlement amount 

 A milestone achieved 
 A predefined billing schedule or bill amount and frequency up to the 

contract amount 
 Any amount up to the contract amount 

Hourly-Type 
Hourly 
Cost + Percentage 
Cost + Fixed Fee 

These contract types are used when you want to bill: 
 

 Accumulated value of time and expenses  
 Accumulated direct costs of time and expenses plus profit/fee 

 A percentage of the contract amount 
 A milestone reached 

 A predefined billing schedule 
 Any amount you want to bill 

Recurring-Type 
Recurring 
Recurring + Expense 

These contracts types are used when you want to bill: 
 

 A predefined bill amount and frequency 
 Expenses as part of the recurring amount 
 Expenses in addition to the recurring amount 

Non-Billable  
Marketing 
Overhead 

These contracts types are used when you want to record: 
 
 All time and expenses incurred before the project starts 
 Non-billable marketing costs 

 Administrative time and expenses 

 

 See Billing Basics for more on contract types and associated invoices.   
 
 

Project Status 
 
In BillQuick, you need to choose a status for the project, the most common being the Active status. 
Drop-down lists in BillQuick include only active projects and other master records. In addition, you can 
filter the grid list and various reports by active projects.  
 
You can choose the Status option on the Project-General tab. It includes: 
 

Status Time & Expense Billing Payment 

Active    

Archived    

Completed    

Hold    

Inactive    

Main    

Cancelled    
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Note: 
 BillQuick sets the ‘Archived’ status automatically when you archive the project data 

(using Archive-Restore utility).  
 Projects currently on hold or inactive can be re-activated later. When displayed, inactive 

projects appear grayed out in lists and grids. 
 Main Project is a parent to a child project (phases, segments and sub-segments). Hence, 

BillQuick does not allow direct time and expense, billing and payments to it.  
 

 If you change the status of a Main project to ‘Inactive’, BillQuick ask if you 
want to change the status of all phases under it. 

 
 

Assigning Project Contacts 
 
You can assign a client contact to an individual project. Optionally, you can address invoices to the 
contact assigned at the project level. You can do this when a client and internal project manager signs off 
on invoices before forwarding them to the accounting department.  
 
To do so, follow the steps below: 
 

1. Open the Project screen from the Project menu, toolbar, Sidebar or navigator. 
 

2. Select the desired project on the grid.  
 

3. On the Billing tab, select a Contact from the dropdown list (at the bottom).  
 
 



Project Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 248 

 
 

4. When the ‘Send Invoice to Contact’ option is checked, BillQuick sends the invoices for this 
project to the project contact instead of the client contact. 
 

5. When you are done, click Save and then Close to exit. 
 
 

Changing Multiple Projects 
 
If you need to change one or more fields across multiple projects, Project Change screen makes the task 
simple and fast. To change multiple project records at once, follow the steps below: 
 

1.  Open the Project screen from the Project menu, toolbar, Sidebar or navigator. 
 

2.  Click Tools and select Change to open the Project Change screen. 
 

3.  Select the desired projects or project groups in the ‘Apply Changes to’ field. 
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4.  To update data, enter new values in the fields. The adjoining checkboxes are automatically 
marked. 
 

5.  Click Apply and then Close to exit. 
 

 BillQuick enables some fields for projects with specific contract types only. 

 
 

Project Groups 
 
You can group projects in BillQuick based on shared or common attributes –type, industry, location, etc. 
You may use groups to filter records included in the grid lists and some reports. In addition, groups save 
time and effort when setting up fee schedules and budgets. 
 
You can assign a regular group and a default group to projects. This is useful for reports. If a budget is 
assigned to a project PV, which is a member of both group A and B but its default group is A, project PV 
will be listed under group A. 
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Grouping Projects 

 
To create a project group: 
 

1.  Open the Project screen from the Project menu, Sidebar toolbar or navigator. 
 
2.  Decide what attribute(s) you want to use to build a project group. List the projects having that 

attribute. 
 

3.  Click Tools and select Groups. On the Project Groups screen, click New.  
 

4.  Enter an ID and Name for the project 
group such that everyone will know the 
shared characteristic. Click OK to save the 
information. 

 
 
 
 
 
 
5.  Select the relevant project in the Available 

Items list. You can move them to the 

Assigned Items list using .  
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6.  Click Save and then Close. 
 

7.  After creating groups, you can specify a Default Group for the project on the Detail tab by 
selecting one from the dropdown. You can also assign the selected project to one or more 
groups by checking them in the Groups dropdown. 
 

8.  When you are done, click Save and then Close to exit. 
 
 

Changing Project Invoice Templates 
 
All the invoices associated with a specific project will have a default invoice template based on its contract 
type. BillQuick specifies these templates in the Global Settings-Templates screen and applies to all the 
clients and projects. However, you can assign a different invoice template to a project (usually done for 
certain demanding clients). For example, most of your clients may like a particular invoice template 
because it displays detailed memos for each time and expense entry. However, a certain client wants his 
invoice to display time entries by activity.  
 
You can change the default invoice template per project from the Project screen. See Choosing Invoice 
Templates in the Billing Basics chapter for more.  
 

 You can set all your invoice templates to show Goods and Services Tax 
(GST) at the project or global level. This option is checked by default for all 
countries other than USA when creating a new database. 

 
 

Merging Projects 
 
If needed, you can merge two or more projects into an existing one or into a new project record. 
BillQuick updates and adds time, expenses, invoices, payments and other information to the project 
receiving the merged items. BillQuick deletes the projects selected for merging while combining their 
attributes and properties to assign a single, common identity to them.  
 
Project merge feature also handles joint invoices. When you merge two projects (say P1 with bill value of 
$100 and P2 with bill value of $200) having a joint invoice associated with them (Invoice # 1001 = $300), 
a merged project is created (P1), while separating the joint invoice into two invoices (Invoice # 1001 = 
$100 and Invoice # 1001-2 = $200).  
 
To merge projects: 
 

1.  On the Project screen, click Tools and select Merge to open the Merge Projects screen. 
 
2.  Select the project(s) to merge from the grid.  
 



Project Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 252 

 
 

3.  Choose your Merge Options: whether to merge with an existing project or a new one. 
 
4.  Enter the required data for a New Project –Code, Phase, Description, Client and Manager. 

 
5.   Click OK when you are done. 

 
This action produces changes in the related tables such as Time Entry, Expense Entry, Payment, etc.  
 
 

Budgets and Estimates 
 
Project managers need to understand how budgets and estimates are useful tools for managing projects 
and how BillQuick handles them. You can assign budgets and estimates to projects and phases. Some 
companies start with a preliminary budget and then convert it to an estimate, and may go through 
multiple iterations until the client signs off. Once signed off and project begins, project managers keep 
track of the budgeted project.  
 
Some companies use a budget to assign employees and consultants to a project with specific tasks, hours 
and expenses, then use the Budget by Employee report to track whether those employees are over or 
under budget for the assigned task. As a means of self-policing, you can allocate hours to them so that 
they are able to stay on track.  
 
You can assign budgets and estimates to projects for the following purposes: 
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 View the Budget Comparison report, daily or weekly, to compare the actual vs. 
budgeted items. Comparing actual time and expense against budgeted amounts and 
hours helps you gauge progress of a project and identify issues for immediate 
management attention.  

 Analyze actual-to-budget results to improve operations, employee skill-sets, fee 
structures and other aspects of the profitable delivery of services to clients.  

 Use the total budget amount as the contract amount; however, the contract amount can 
also be a higher or lower amount. 

 Restrict employees, expenses and activities to the budgeted ones while recording time 
and expenses for a project. 

 Track line item tasks on budgets by % done, provided a budget is assigned to a project. 
(You can assign the same budget to multiple projects.) 

 Create a Purchase Order from a budget.  
 Allocate budgeted hours and units (time and expenses) to projects.  
 Create a manual invoice from a budget, using % Done to calculate the amount of each 

line item (it does not carry back to the budget). 
 
Estimates support later-stage marketing efforts with a bid to provide specified services. For many 
professional services firms – architects, engineers, IT consulting, surveyors, computer consultants, etc. – 
the estimate is what they send to the client as part of their bid proposal. When accepted, it usually 
becomes the foundation for the project contract or engagement letter. Some companies start with an 
estimate and go through iterations, then convert it to a budget. 
 
BillQuick provides many reports containing information from budgets and estimates such as Budget 
Comparison, Estimate Details, Over-Budget Projects, Budget-Cost and other reports. Often project 
managers drill down into details by reviewing job costs, amount spent and project profitability reports.  
You can export budgets and estimates directly to Excel or convert their reports to PDF, Word, etc. You 
can even schedule these reports for automatic delivery using BillQuick Agent module. 
 
Once you have created budgets and estimates, you can make the following assignments: 
 

 Assigning Budgets 
 Assigning Estimates 
 Tracking Project Progress 

 
 

Assigning Budgets 
 

 BillQuick recommends that you set up a budget before an estimate when 
you work on a bid proposal. 

 
To assign a budget to a project: 
 

1.  Open the Project screen from the Project menu, Sidebar, toolbar or navigator.  
 

2.  Select the desired project from the grid. Click the Billing tab. 
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3.  Select an existing budget from the Budget drop-down.  
 

 You can click Budget to create a new one. You can also add a new budget 
on the fly using the ‘Add New’ option in the drop-down list. 

 
4.  On the Detail tab, Rules section, check the appropriate Budgeted Employees/Activities/Expenses 

Only options to restrict these items when recording time and expenses. 
 

5.  When you are done, click Save and then Close to exit. 
 

 You can easily assign budgets to projects using the Assign screen (via 
Project menu or Budget screen). 

 
 
 
 



Project Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 255 

Assigning Estimates 
 
You can copy items from an existing budget or estimate to a new one. Here are some examples: 
 

 An architect creates an estimate for a restoration project and then uses it as the basis for 
the project budget after winning the job. When bidding on another restoration project, 
the first budget becomes the foundation for a new one and then you can convert it into 
an estimate.  

 A consulting firm (IT) sets up multiple budgets for network installations and related 
training based on size of company and other factors. After identifying a new project, the 
client is set up, a Marketing project created, and one of the budgets assigned to it. You 
can then convert the budget to an estimate as a starting point for negotiations.  

 An accounting firm creates a standard budget for accounting services, identifying bank 
reconciliation, review and other tasks and the ‘standard’ hours they should work. 
Reviewing the Budget Comparison report, they can determine what factors contributed 
to the success of the service or where it needs skill improvements.  

 

 You can assign estimates to projects in the same way as budgets. See 
Assigning Budgets above for details. 

 
 

Tracking Project Progress 
 
In many companies, projects involve Hourly Not to Exceed (HNTE) contracts with many phases and 
segments. You may track your projects against a target amount (Target Budget) and a ‘Not to Exceed’ 
amount (NTE Budget) including a built-in variance beyond the target. You estimate a target number of 
hours and dollars on each phase in a project. You can do this to manage progress and budgets to the 
individual phase within a given contract.  
 
You can also create fee schedules for special rates. Depending upon the majority of your contracts, you 
may charge different hourly rates for different activities or employees. Else, you may charge a single 
hourly rate for the entire contract regardless of the activity performed or employee working on the 
project. In this case, you only need to track your project against the Target and Not to Exceed figures.  
 
BillQuick is designed to handle your NTE Budget in the Project’s Contract Amount field. It is configurable 
at the project/phase/segment level. Regarding the Target Budget, you have various options: 
 

 Use Budgets to define your Target Amount for each phase or segment on a line-item 
level. You can measure it against a series of employees, vendors, activities or their groups 
with different rates. You can also generate numerous budget reports in BillQuick. 
However, make sure that no two groups have the same items for budget reporting purposes. 

 Use Project’s Custom field to define your Target Budget for each phase/segment. You 
can set the caption and data type (Currency) for Custom 1 in the Custom Labels screen 
(Settings menu).  
If you want, the target hours or dollars can appear in a custom report as well.  
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Some of the calculations involved are: 
 
Remaining Target Budget to Date = Target Amount - Actual Amount Billed  
Remaining NTE Budget to Date = NTE Budget - Actual Amount Billed  
 
 

Fee Schedules 
 
Fee Schedules allow you to override the default bill and cost rates for selected employee-activity or 
expense combinations, whether individual or group items. You can assign a SFS or EFS to one project or 
multiple projects.  
 
BillQuick allows you to set fee schedule rates by classification or employee title. You can have several 
titles for an employee and may want to set different rates for different titles or labor categories. E.g., the 
same employee may be called a Research Analyst by one agency and a Junior Consultant by another. 
Therefore, BillQuick lets you specify employee titles for classification purposes in the SFS or EFS. This 
classification is associated with relevant time and expense entries, though you can edit it in the respective 
screens.  
 
After creating your fee schedules, you can make the following assignments: 
 

 Assigning Fee Schedules 
 Delayed SFS 

 
 

Assigning Fee Schedules 
 
Let us look at how a consulting firm may use a service fee schedule. Suppose a group of employees, 
called Junior Consultants, is responsible for installing computers for a project. The contract calls for 
charging Junior Consultants at a rate of $65 per hour. Their individual default bill rates range from $50 to 
$80 per hour.  
 
To handle this situation: 
 

1. Define an employee group, Jr. Consultants. Note that BillQuick automatically creates an activity 
group called ‘All’. 
 

2. Create a service fee schedule. 
 

3. In the schedule, choose the Jr. Consultant employee group and the All activity group, and then 
assign a $65 bill rate.  
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4. Click Tools and select Assign to assign this SFS to your project.  
 
Now, when a junior consultant listed in the group charges any activity to the project, the bill rate is $65 
per hour. 
 

 You can also assign fee schedules to a client (Client-Billing screen) and let 
BillQuick use these special fee schedule rates for all projects of that client. 

  
 

Delayed Service Fee Schedule 
 
You can assign a Delayed SFS to a project to handle specific situations in which the bill rate changes based 
on a trigger event (e.g., project retainer balance, recurring amount, unbilled hours or unbilled amount). 
With a Delayed SFS assigned to a project, BillQuick applies the regular SFS rates to time entries until the 
trigger (specified in the Project-Billing screen) prompts the delayed schedule. This schedule typically 
contains higher rates. 
 
A company can use a Delayed SFS when offering prepaid services to clients. E.g., an IT company can offer 
a discounted bill rate for purchasing a certain number of hours or dollar value of help desk, remote 
assistance or on-demand consulting services. You would probably pre-sell a service; accept advanced 
payment from a client; use a SFS for discounted bill rates (that expires when the prepaid amount is 
used). Employees or vendors charge their hours to these prepaid service projects until the trigger value 
exceeds. Then onwards, BillQuick automatically replaces the regular SFS in the Rate Hierarchy with the 
Delayed SFS.  
 
The trigger type tells BillQuick what to look at when deciding whether to use the rates in the regular SFS, 
the Delayed SFS, or the default rates for the employee. Different companies track the prepayment and its 
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usage in different ways. If the trigger is based on a retainer amount received, the retainer available is the 
key amount. If it is more than $0, then BillQuick will use the regular SFS or employee rates; if the retainer 
bucket is empty, then BillQuick will apply Delayed SFS rates to hours charged to a project.   
 
Other companies may use unbilled hours or other options as the trigger type. Triggers are set in the 
Project-Billing screen and include: 
 

 Unused Retainer – Triggered when the bill value of time entries charged to a project 
exceeds the Retainer Available (check on Project-Account screen). 

 Recurring Amount – Triggered when the bill value of time entries charged to a project 
exceeds the Recurring Amount for the project. 

 Unbilled Hours – Triggered when the sum of hours charged to a project exceeds the 
specified trigger value (set in the Hours/Amount field). 

 Unbilled Amount – Triggered when the bill value of time entries charged to a project 
exceeds the specified trigger value (set in the Hours/Amount field). 

 
 

Assigning Delayed SFS 
 
To assign a Delayed SFS for a project: 
 

1.  Open the Project screen from the Project menu, Sidebar, toolbar or navigator.  
 

2.  Select the desired project from the grid. Click the Billing tab. 
 

3.  Select an existing fee schedule from the Delayed SFS drop-down, preferably with higher rates 
than the default rates. 
 

 You can create a new Delayed SFS by clicking Delayed SFS. You can also 
add a new schedule on the fly using the ‘Add New’ option in the drop-down list. 
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4.  Specify the Trigger Type and Amount for the Delayed SFS; e.g., Un-Used Retainer with $0. 
 

5.  Click Save to link the fee schedule with the project and then Close to exit. 
 
 

Project Assignments 
 
You may have staff and managers whose time and expenses need checking and double-checking because 
they regularly misapply their hours to projects. On the other hand, maybe your budget or profitability 
information is skewed because someone charged the wrong activities. How do you get the right 
employees to record the right activities and expenses to the right projects? Simply restrict who can 
charge activities and expenses to which project. BillQuick’s Project Control and Employee Control 
features let you define all this. 
 
Project Control is a feature designed essentially for timekeepers, limiting who can charge time and 
expenses to a project. Employee Control has a wider scope and it applies throughout BillQuick. It works 
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with Security to manage what information an employee can view and work with throughout BillQuick. 
The net effect is that drop-down lists are significantly shorter, resulting in faster time and expense entry. 
It also increases data accuracy because there is less chance for error. 
 

 In case of conflict, Employee Control settings take precedence over 
Project Control.  

 
In BillQuick, you can make the following assignments for projects: 
 

 Project Control 
 Employee Control 
 Assigning All Items to Projects 
 Allocation 
 File Linking 

 
 

Project Control 
 
You can apply project control by restricting the employees, activities and expenses available for a project. 
Project Control assignments extend to all time and expense screens and to Web Suite. For example, if 
you assign three employees to work on a project, only those employees will see that project in their 
drop-down list on time and expense entry screens (in BillQuick and in add-ons).  
 

 You can turn off project control for a project by simply checking that rule 
in the Project-Detail screen. This is especially helpful when you are 
implementing project control settings at a group level but do not want it for a 
particular project. 

 
You can set up and assign project control in the following ways: 
 

 Assigning Items to Projects with Project Control 
 Cloning Project Control Settings 
 Assigning Items to Projects 

 
 

Assigning Items to Projects with Project Control 
 
To assign employees to projects:  
 

1. Open Project Control from the Project menu, toolbar or navigator.  
 
2. Enter the Project ID or select one from the drop-down list. 

 



Project Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 261 

 
 
3.    Select the Assign: Employee option. (If desired, you can view a subset of employees by using the 

Filter option for a range or a defined group.) 
 

4. Select the desired employees in the Available Items list on the left. Click  to transfer them 
to the Assigned Items list.  
 

5.  If desired, change the Classification of the assigned employees. BillQuick may use it for tagging 
time and expense entries. 
 

 While fetching a classification, BillQuick will look for it in the following 
order: Service Fee Schedule, Project Control or Employee screen (Title). 

 
6.  Repeat this step for Activity and/or Expense assignment you want to make for the selected 

project by selecting the appropriate Assign option. 
 

7.  Click Tools and select ‘Copy To’ to clone the project control settings to another project or a 
group of projects (See below for more). 
 

 Click Re-Assign Employee link to replace an employee assigned to a 
project with another employee. This may occur when an employee becomes 
unavailable for work and re-assignment is required. 
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8.  When you are done, click Close to exit.  
 

 To un-assign an inactive item to a project, you can un-check Show Active 
Only option above the Assigned Items grid. It displays active as well as inactive 
items previously assigned to a project. 

 
 

Cloning Project Control Settings 
 
You can copy or clone project control settings to a project or a group of projects. This is quite useful if 
you have too many projects and need to assign items to each.  
 

 While cloning a project, BillQuick also clones the associated Project 
Control settings. 

 
To do so: 
 

1.  Open the Project Control screen from the Project menu. 
 

2.  Select a project and assign the desired project control settings to it, as you normally would. 
 

3.  Click Tools and select Copy To. 
 

4.  Select the desired 
Project Group from 
the dropdown (only 
when Copy To Group 
option is checked). 
 
Else, uncheck Copy 
To Group option and 
select an individual 
Project from the 
dropdown. 
 

5.  Check ‘Overwrite’ if you want to update or overwrite the existing project control settings of any 
project in the group.  
 

6.  Click OK to copy the settings to all projects in the group and then Close to exit. 
 
 

Assigning Items to Projects 
 
BillQuick allows your to assign project control directly from the Project-Assign screen. This saves time 
when you are creating projects and want to get done with the assignments as well. 
 
To assign items to a project: 
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1. Open the Project screen and select the desired project on the grid.  
 

2. Move to the Assign tab.  
 

 By default, BillQuick keeps this tab hidden. However, you can show it by 
checking the Show Project Assign Tab option in the Preferences-Option screen. 

 

 
 

3. Select the Employee option. (If desired, you can view a subset of employees by using filters for a 
range or a defined group.)  
 

4. Select the desired employees in the Available Items list on the left. Click  to transfer them 
to the Assigned Items list.  

5. Repeat this for Activity and/or Expense assignments to make for the project by selecting the 
appropriate option. 
 

6. When you are done, click Save and then Close to exit. 
 

 Assignments made here also carry to the Project Control screen and vice 
versa. You can turn off project control on the Project-Detail screen by checking 
that rule. 
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Employee Control 
 
Employee control results in faster interaction with BillQuick because data is limited to assigned projects, 
activities and expenses. For example, if you assign John to work on six projects, he will only see these 
projects in the Project drop-down list on time and expense entry screens (in BillQuick and in add-ons). 
You can apply employee control selectively or throughout BillQuick using security permissions. It ensures 
that confidential data is not accessible to employees who should not see it. You may grant access to 
project managers to view all information related to their projects – time, expenses, reports, invoices, 
payments, etc.  
 
You can set up and assign employee control in the following ways: 
 

 Assigning Items to Employees with Employee Control 
 Cloning Employee Control Settings 
 Assigning Items to Employees 

 
 

Assigning Items to Employees with Employee Control 
 
To assign projects to an employee:  
 

1. Open the Employee Control screen from the Settings menu or navigator.  
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2. Enter the Employee ID or select one from the drop-down list. 
 

3. On the Assign tab, select the Assign: Project option. (If desired, you can view a subset of projects by 
using the Filter options for a range or a defined group.) 
 

4. Select the desired projects in the Available Items list on the left. Click  to transfer them to 
the Assigned Items list.  
 

5. Repeat this for Activity and/or Expense assignment you want to make for the selected employee 
by selecting the appropriate Assign option. 
 

 Click Re-Assign Employee link to replace an employee assigned to a 
project with another employee. This may occur when an employee becomes 
unavailable for work and re-assignment is required. 

 
6. Click the Security tab. Check the desired screen names to Disable Employee Control for them. 

 

 
 

7. To update these security settings for the selected employee, click . 
 

8. When you are done, click Save and then Close to exit. 
 

 To un-assign an inactive item to an employee, you can un-check Show 
Active Only option above the Assigned Items grid. It displays active as well as 
inactive items previously assigned to an employee. 

 
Alternatively, you can turn on security for employee control in the following way: 
 

1. Open the Security screen and select the desired Employee from the drop-down.  
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2. For each of the BillQuick Module Name listed on the left, accordingly mark or unmark the 
‘Disable Employee Control’ permission on the right.  
 

3. You can ‘Turn on Employee Control’ for all modules in one click by selecting that option at the 
top. If required, you can directly switch to the Employee Control screen by clicking the link 
below. 
 

4. After granting security permissions for employee control, click Save and then Close to exit. 
 
 

Cloning Employee Control Settings 
 
You can copy or clone employee control settings to an employee or a group of employees. This is quite 
useful if you have many employee and need to assign items to each. To do so: 
 

1.  Open the Employee Control screen from the Settings menu. 
 

2.  Select an employee and assign the desired employee control settings to it, as you normally would. 
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3.  Click Tools and select Copy To. 
 

4.  Select the desired 
Employee Group to 
which you are 
copying the settings. 
Else, uncheck Copy 
To Group option and 
select an 
Employee/Vendor 
from the dropdown. 
 

 Group is available only when Copy To Group option is checked. 

 
5.  Check ‘Overwrite’ if you want to update or overwrite the existing employee control settings of 

any employee in the group.  
 

6.  Click OK to copy the settings and then Close to exit. 
 
 

Assigning Items to Employees 
 
BillQuick allows your to assign employe control directly from the Employee-Assign screen. This saves 
time when you are creating employees and want to get done with the assignments as well. 
 
To assign items to an employee: 
 

1. Open the Employee screen and select the desired employee on the grid.  
 
2. Click the Assign tab.  

 
3. Select the Project option. (If desired, you can view a subset of projects by using filters for a range or a 

defined group.)  
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4. Select the desired projects in the Available Items list on the left. Click  to transfer them to 
the Assigned Items list. 

 
5. Repeat this for Activity and/or Expense assignment you want to make for the selected employee 

by selecting the appropriate Assign option. 
 
6. Click on the Re-Assign Employee link to replace the selected employee by another for the 

current assignment of items.  You may do this when an assigned employee is not available for 
work. 

7. When you are done, click Save and then Close to exit. 
 

 Assignments made here also carry to the Employee Control screen and 
vice versa.  

 
 

Assigning All Items to Projects 

 
You can assign budgets, estimates and fee schedules to one project or to multiple projects using an 
alternative Assign Form. You can even review the assignments made to project(s). To do so: 
 

1.   Open the Assign screen from the Budget, Estimate, Service Fee Schedule or Expense Fee 
Schedule screens. You can also open it from the Project menu.  
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2.  Select the type of item you want to assign in the View By field to a project, say Budget. 
Accordingly, select the items from the drop-down list. 
 

 
 

3.  Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

4.  Now mark the checkbox against all the projects to which you want to assign the selected budget. 
Alternatively, click Assign to assign the item (budget) to the selected project and Un-Assign to 
un-assign it. 
 

5.  When you are done, click Close to exit. 
 

 You can add a new budget, estimate, EFS or SFS on the fly using the ‘Add 
New’ option from the drop-down list. 

 
 

Allocation 
 
Using the Allocate feature in BillQuick, you can define hours-to-complete (activities or their groups) and 
units to incur (expenses or their groups) for individual employees and teams (employee groups). Setting 
expectations for how long it should take to complete a task (allocated hours) or how much expense to 
incur (allocated units) establishes a self-policing process. BillQuick does not stop timekeepers from exceeding 
allocated hours or units, but it does provide instant information so they can police themselves. When the 
rules, ‘Lock at Control Hours’ and ‘Lock at Control Units’, are checked in the Project screen, and the 
hours or units entered exceed the allocation, user is warned accordingly. In short, a project manager 
does not need to micro-manage timekeepers and their tasks. They know what is expected of them. 
 
Allocation of units and hours to the staff after consulting them is very good practice, especially for 
budgeting purposes. Companies mostly create budgets without involving the employees in that process. 
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This leads to inaccurate and unrealistic budgets. If you have already created a budget, enter those details 
in the Allocate screen and send it to the staff via email. 
 
You can limit allocated hours to a start-end date range, putting an expiration or target date on the work.  
After allocating hours and units, you can view Assigned Hours, Used Hours and Remaining Hours on the 
time and expense entry screens. 
 
BillQuick searches for allocation data in the following order: 
 

1.  Employee ID + Item ID 
2.  Employee ID + Item Group 
3.  Employee Group + Item ID 
4.  Employee Group + Item Group 

 
We can have the following scenarios: 
 

 Allocation with no Start Date and End Date: When you exceed allocated units or hours, 
negative values display. 

  Allocation with End Date only: While searching, BillQuick looks for the time entry Date to 
be less or equal to the End Date. When you exceed allocated units or hours, negative 
values display. However, no values display after the end date. 

 Allocation with Start Date and End Date: While searching, BillQuick looks for the time 
entry Date to be greater or equal to the Start Date but less or equal to the End Date. 
When you exceed allocated units or hours, negative values display. However, no values 
display after the End Date. 
 
If you assign the same employee to same item hours/units in multiple rows, thus creating 
a duplicate or overlap, BillQuick uses the sum of hours or units. e.g., 
 

CJ  AR:CAD  02/01/2011 to 02/28/2011  30 hours 
CJ   AR:CAD  02/12/2011 to 02/19/2011  10 hours 

 
The Assigned Hours displayed for a date between 12th and 19th will be 40 hours. 

 Allocation with Start Date only: While searching, BillQuick looks for the time entry Date to 
be greater or equal to the Start Date. When you exceed allocated units or hours, 
negative values display. 

  

 You can find useful reports to see allocated and used hours, staff workload, 
revenue forecaster and more related to task allocation in BillQuick. E.g., Work-
in-Hand report. 

 
 

Allocating Hours and Units 
 
To allocate hours and units: 
 

1. Open the Allocate screen from the Project menu. 
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2. Select the desired View By option. Accordingly select the Project/Employee for which the 
allocation is to be done.  
 

 
 

 In the View By Project mode, you can allocate budgeted hours and units to 
the employee by clicking Tools and selecting From Budget option. It pre-fills the 
grid with the budget data. 

 
3. In the grid, select the Project ID or Employee ID to which you want to allocate control hours or 

units. 
 

4. Select the Item –activity, expense or group—for which hours or units are being allocated. It is a 
good practice to select groups because tasks and expenses keep on changing from time to time. 

 
5. Next, in the Units field, specify the number of hours (activity) or units (expense) you expect the 

employee or vendor to spend completing the task on a project.  
 

 When allocating hours or units to a group of activities or expenses, BillQuick 
applies the value to all items in the group combined. For example, if the CAD 
Activity Group contains seven items and you allocate 10 hours to the group for 
a project, then BillQuick allocates 10 hours to the entire group. 

 
6. Enter specific dates in the Start Date and End Date fields for the allocated tasks or expenses. This 
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limits the allocation to a specified date range, giving managers more control. 
 

7. Click Tools and select ‘Send Allocation via Email’ to send this schedule to the appropriate staff 
member. 

 

 When dates are specified and you send them to the staff via email, it 
populates their MS Outlook Calendar. If not, allocation appears as a text 
message. 

 
8. When you are done, click Close to exit. 

 
 

File Linking 
 
You may want to link contract documents, agreements, receipts or bills to related project records. 
BillQuick allows you to do so easily and quickly using the Link Files feature.  
 
The linked file is not stored in your company database; rather this feature points to its location. Files can 
be located anywhere on your computer or your company network (better). On clicking, the linked file 
opens in the native application (if installed on your computer). For easy browsing, you can view all linked 
files on the Linked Documents or Document Management screen. 
 
BillQuick allows you to link any file to a project: 
 

 Graphics  AutoCAD 
 Microsoft Excel  Scanned plans 
 Microsoft Word  Scanned research drawings 
 WordPerfect  Other scanned document 
 Microsoft Visio  Portable Document Format (PDF) 

 

 File linking is also available for employee, activity code, time entry, vendor 
bills, budget, invoice, payment and other BillQuick records. See File Linking for 
more. 

 
 

Project Journals 
 
Project Journal is a centralized record of project issues, events, billing decisions, change orders and other 
qualitative information about a project. By tracking project-related information in one ‘central’ place, you 
do not waste time trying to get in touch with the project manager or owner about the project. It is useful 
in the following situations: 
 

 when making billing decisions, record all billing decisions and notes for later reference and 
analysis. 

 post-project analysis, as part of the company’s continuous improvement and client evaluation 
process 
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 for recording collections conversations 
 
You can create and view journal notes from the Project, Billing Review, Invoice Review, Payment, 
Purchase Order, Vendor Bills, Time Entry and other screens. These journals link to bills, invoices and 
payments. You can also add time entry memos to the project journals.  
 
BillQuick offers three Project Journal options: 
 

 Journal Category List (Project menu): You can create your own journal type or category. 
You can make pre-existing categories such as Billing Review, General, Time Entry, 
Vendor Bill, etc. inactive. 

 Project Journal (Project menu): You can view existing journal entries of all types and 
period for any project, employee, client, group and so on. You can also create a new 
journal entry for any category.  

 BillQuick screens: You can view or create journal entries directly from a BillQuick screen. 
 
This section covers the following tasks: 
 

 Creating Project Journals 
 Creating Journal Categories 

 
 

Creating Project Journals 
 
To create a project journal: 
 

1. Open the Project Journal screen from the Project menu. Alternatively, click  View Journal on 
the Project screen. 
 

2. On the Project Journal screen, click New. It opens the Add Journal Note screen. 
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3. Select the Project ID for which you are recording a journal. 
 

4. Enter a Date for the journal or choose one from the dropdown calendar. 
 

5. Choose a Category, such as General, Time Entry, etc. or any new category created by you. This 
depends on what type of journal you want to create. 
 

6. Next, type your Journal Note. Type as much text as desired or use Auto Complete shorthand 
codes to insert standard text. 
 

7. If desired, click  Link Files to attach a file to this journal. You might include a video of 
infrastructure damage your client wants fixed, a photo of damage done at a site by a 
subcontractor, or scanned soil or metallurgy test results with your conclusions in the note. 
 

8. When you are done, click Save and then Close to exit. 
 

Back on the Project Journal screen, all journals display in the grid. You can view and edit previous journal 
notes using the View By and Period criteria. 
 

 In some screens, you can display the Journal field in the grid using the  

Field Chooser. Hover your mouse over the  cell and click to launch the 
Project Journal screen. Else, you can select the Journal option from the Tools 
button. 

 
 
 

Creating Journal Categories 
 
BillQuick provides the ability to customize the standard journal list. You can create your own journal 
categories and be able to report on them. For example, you can add ‘Telcon’ as a new category to 
indicate a telephone note. Alternatively, you may add ‘Opportunities’ to identify situations that could lead 
to new contracts with an existing client. Another category might be ‘Issues’, the identification of special 
situations that arise that could have an impact on billing decisions, client relationships, costs, and so on. 
 
To create a journal category: 
 

1.  Open the Journal Category List screen from the Project menu. 
 

2.  Click New to add a new type or category. 
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3.  Enter the Description and tab or click on another row to save it. 
 

4.  When you are done, click Close to exit. 
 
 

To Do List 
 
The To Do List feature allows you to add tasks to the project’s To Do list and track the task status of 
each item easily. It allows you to assign tasks to employees, set priority on them, track the status of each 
item and get reminders, thus making project execution and management as efficient and simple as 
possible. It supports various types of tasks and categorization with specific start-end dates. BillQuick adds 
these to-do items to the Reminders screen, thus reminding you to take action on them.  
 
Whether you use it to remind you of the employee’s upcoming review or simply manage a list of tasks 
that you need to complete on a specific project, it will definitely help you remain focused and organized. 
Various related reports are available displaying the task list, past due tasks, etc. See To Do List in the 
General Features chapter for details. 
 
 

Project Settings 

 
BillQuick executes business-processing rules that follow standard practices for professional service 
companies. Project managers need to understand and then apply these rules to projects when required. 
Project rules can be set at the global level, user level as well as at the project level.  
 

 The project rules are exceptions. Most companies never need them 
because the defaults rules built into BillQuick meet their needs. 

 
The following projects rules can be set on the Project screen: 
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Project Rules and Settings 

Rule Explanation Where to Implement 

Contract Type When you select a contract type, BillQuick executes key 
business rules: 

 For Fixed, Hourly Not to Exceed and Recurring with Cap 
contract types, BillQuick requires a contract amount.  

 For Recurring and Recurring + Expenses contract types, 
BillQuick requires a Recurring Amount and Frequency.  

 For Cost-Plus contract types, BillQuick requires a Fixed 
Fee Percentage or a Fixed Fee Amount. 

 For all contract types, BillQuick applies the default formats 
to new invoices and statements. You can choose an 
alternative format for a project. 

Project-General screen 

Invoice Templates When specified, the custom invoice template overrides the 
global default invoice or statement template assigned to the 
contract type.  

Project screen 

Frequency Regardless of the contract type, choosing a frequency creates a 
reminder to bill a project. BillQuick adds the reminder to the 
Reminders screen. 

Project-Billing screen 

Service Fee 
Schedule, Expense 
Fee Schedule 

Adds the schedule containing special rates to the Rate 
Hierarchy used by BillQuick to determine which rate to apply 
to a time entry charged to a project. 

Project-Billing screen 

Delayed Service Fee 
Schedule, Trigger 
Type 

When the Trigger Type and associated amount or hours are 
used, BillQuick automatically replaces the SFS in the Rate 
Hierarchy with the Delayed SFS. This schedule typically 
contains higher rates.  

Project-Billing screen 

Custom Invoice 
Number 

When you define a format at both the global and project level, 
BillQuick applies the invoice number format at the project 
level.  

Project-Billing screen 

Always Show in 
Billing Review 

Adds a project to the Billing Review screen whether it has 
unbilled, approved time and expenses or not. This allows you 
to include (for instance) completed and yet-to-start projects 
on a joint invoice.  

Project-Detail screen 

Auto Approve 
EL/TE 

Automatically approves time and expenses charged to a 
project. It overrides the default setting defined in Global Settings-
Time/ Expense screen. 

Project-Detail screen 

Budgeted Activities/ 
Employees/Expenses 
Only 

Restricts charging of time and expenses to only those 
timekeepers, activities and expenses that are in a budget 
assigned to a project 

Project-Detail screen 

EL/TE Memo 
Required 

These settings require all timekeepers to enter a memo for 
their expense or time entries. It is usually needed for 
government contracts. 

Project-Detail screen 

Exempt Item Taxes When activated, BillQuick exempts Tax 1, 2 and 3 on activities 
and expenses, hence not charging them to the project.  

Project-Detail screen 

Exp Part of Contract By default, BillQuick includes only non-billable expenses in the 
contract amount, not the billable ones. To include billable 
expenses as part of the contract amount for a project, check 
this option. The Total Amount Spent is calculated as [(Hours x 

Project-Detail screen 
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Project Rules and Settings 

Rule Explanation Where to Implement 

Bill Rate) + Billable Expense Amount + Non-Billable Expense 
Amount].  

Lock at Contract 
Amount 

Locks out additional time and expenses once the total amount 
charged to a project equals the contract amount. You may use 
this rule when a strict contract limit is in place and the project 
manager must negotiate additional authorization before 
continuing.   

Project-Detail screen 

Lock at Control 
Hours/Units 

Locks out additional time and expenses once the total number 
of hours or units exceeds the allocation. You can allocate Hours 
and Units on the Project Control and Employee Control 
screens.  

Project-Detail screen 

MET/MST Excludes 
Item Tax 

When activated, Main Service Tax and Main Expense Tax are 
not computed on item taxes (Tax 1/2/3).  

Project-Detail screen 

Prevent EL/TE 
Entries 

Locks out additional time and expenses for a project. You may 
activate these rules if there is a temporary issue or dispute 
with a client about a project, such as lack of payments. You can 
apply it to any project regardless of its contract type.  

Project-Detail screen 

Rates from Activity 
Table 

Adds rates from the Activity Codes table to the Rate Hierarchy 
(see Rates in the Billing Basics chapter).  

Project-Detail screen 

Show Account 
Summary on 
Invoices 

You can customize the invoice layout per project by showing 
or hiding the account summary on selected project. 

Project-Detail screen 

Show GST on 
Invoices 

You can choose to display the Goods and Services Tax on all 
invoices of the selected project. 

Project-Detail screen 

Skip Automatic 
EL/TE Eval 

For fixed-type projects, BillQuick does not compare total time 
and expense amount spent against the contract amount to 
determine the billable status.  

Project-Detail screen 

Turn off Project 
Control 

If needed, check this option to turn off project control for the 
selected project. 

Project-Detail screen 

Use Memos on 
Invoices 

BillQuick automatically inserts the project memo into the 
standard invoice memo (First or Second, as specified in Global 
Settings-More screen). As needed, you can edit the invoice 
memo. 

Project-Detail screen 

 

 These project rules take precedence over the Global Settings and User 
Preferences. For global business rules and settings related to projects, see 
Settings and Preferences in the Company Management chapter.  

 
 

Locking Projects at Contract Amount 
 
Over-budget behavior of projects can be tracked using project rules in BillQuick. To do so: 
 

1. Open the Project screen from the Project menu, Sidebar, navigator or toolbar.  
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2. Select a project. Ensure or enter a Contract Amount for the project. 
 

3. Move to the Detail tab, Rules section. Make sure the Skip Automatic TE/EL Evaluation options 
are un-checked. (BillQuick performs an automatic time and expense entry evaluation for fixed-type 
contract to determine whether the entry will push it over the Contract Amount.) 
 

4. Optionally, check the ‘Lock at Contract Amount’ rule. BillQuick prevents all time entries (billable 
and non-billable) and non-billable expense entries once the project is over-budget. 
 

5. When you are done, click Save and then Close to exit. 
 
In the Time Entry and Expense Entry screens, when the Total Amount Spent on the project exceeds the 
Contract Amount, BillQuick prompts you and adjusts the entry accordingly. 
 
 

Project Information 
 
Having access to right information at the right time is the key to effective management. Project managers 
can obtain important project information in various BillQuick screens. In addition, you can manage your 
projects or track over-budget projects via alerts, scheduled reports or on-demand project reports.  
 
You can generate critical business alerts and get notifications about the due date of a project or its 
completion. You can also set your reports for automatic generation and delivery. BillQuick provides these 
options via its workflow automation add-on module, BillQuick Agent. 
 
There are various ways to obtain project-related information in BillQuick: 
 

 Viewing Project Information 
 Using Filters for Data Analysis 
 Dashboard 
 Project Reports 

 
 

Viewing Project Information 
 
For a quick at-a-glance checking of project information, project managers can use the following options: 
 

 Project-Account screen 
 Project-History screen 
 Right-click menu 

 
The Account tab on the Project screen provides a quick summary of cost, billable, unbilled and billed 
value of a project and associated retainer. For phased projects, you can roll up account information into a 
parent project by clicking ‘Show Cumulative Data’. You can also print a Project Account report from 
here, if desired. 
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Services  

Sum of Hrs x Cost 
Rate 

The sum of the product of the employees’ cost rates and the actual 
hours (A-Hrs) spent on the project. 

Sum of Hrs x Bill Rate The sum of the product of the employees’ bill rates and the billable hours 
(B-Hrs) spent on the project. 

Services Billed  The service or labor amount billed to the project to-date. It is the total of 
the Service Amount Billed before taxes (Tax 1, 2, 3 and MST). 

Services Un-Billed The service or labor amount not yet billed to the project. It is the total of 
the Service Amount to be billed including taxes (Tax 1, 2, 3 and MST). 

Extra Services  

Xtra Hrs x Cost Rate  The product of the employees’ cost rates and extra hours spent on the 
project. Extra hours are marked as ‘XT’ in the time entry screens.  

Xtra Hrs x Bill Rate The product of the employees’ bill rates and extra hours spent on the 
project. Extra hours are marked as ‘XT’ in the time entry screens.  

Extra Services Billed  The extra service or labor amount billed to the project to date. 
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Extra Services Un-
Billed  

The extra service or labor amount not yet billed to the project. 

Total Services  

Total Services Cost The sum total of all the service/labor costs spent on the project. It is 
calculated as: (Sum of Hrs x Cost Rate) + (Xtra Hrs x Cost Rate) 

Total Billable Services The sum total of all the billable service/labor spent on the project. It is 
calculated as: (Sum of Hrs x Bill Rate) + (Xtra Hrs x Bill Rate) 

Total Services Billed The sum total of all the service/labor billed to the project. It is calculated 
as: (Services Billed) + (Extra Services Billed) 

Total Services Un-
Billed 

The sum total of all the service/labor not yet billed to the project. It is 
calculated as: (Services Un-Billed) + (Extra Services Un-Billed) 

Expenses  

Billable Exp Cost The cost of billable expenses incurred on the project. 

Billable Exp Amt The billable expense amount incurred on the project. 

Expenses Billed The expense amount billed to the project to-date. It is the total of the 
Expense Amount to be billed including taxes (Tax 1, 2, 3 and MET). 

Expenses Un-Billed The expense amount not yet billed to the project. It is the total of the 
Expense Amount Billed before taxes (Tax 1, 2, 3 and MET). 

Extra Expenses  

Extra Expenses Cost The cost of extra expenses incurred on the project. 

Extra Billable Expenses  The billable expense amount for extra expenses incurred on the project. 

Extra Expenses Billed The extra expense amount billed to the project to date. 

Extra Expenses Un-
Billed 

The extra expense amount not yet billed to the project. 

Total Expenses  

Total Expenses Cost The sum total of all the expense costs spent on the project. It is 
calculated as: (Billable Exp Cost) + (Extra Expenses Cost) 

Total Billable Expenses The sum total of all the billable expenses spent on the project. It is 
calculated as: (Billable Exp Amt) + (Extra Billable Expenses) 

Total Expenses Billed  The sum total of all the expenses billed to the project. It is calculated as: 
(Expenses Billed) + (Extra Expenses Billed) 

Total Expenses Un-
Billed  

The sum total of all the expenses not yet billed to the project. It is 
calculated as: (Expenses Un-Billed) + (Extra Expenses Un-Billed) 

Totals  

Total Cost The total cost amount spent on the project. It is the sum of Total 
Expenses Cost and Total Services Cost. 

Total Billable Amount The total billable amount spent on the project. It is the sum of Total 
Billable Services and Total Billable Expenses. 

Total Billed Amount The total amount billed to the project before taxes. It is the sum of Total 
Services Billed and Total Expenses Billed. 

Total Un-Billed 
Amount 

The total amount not yet billed to the project. It is the sum of Total 
Services Un-Billed and Total Expenses Un-Billed. 

Total Hours  The total actual hours (A-Hrs) recorded for a project. 
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Total B-Hrs  The total billable hours (B-Hrs) recorded for a project. 

Earned Value  The total value of earnings on the project from billable services and 
expenses. It the sum of Total Services and Billable Expense Amount. 

Earned Value %  The percentage of project contract amount earned to-date compared to 
the total contract amount.  
Earned Value % = Earned Value / Contract Amount x 100. 

Project Retainer Paid  The amount of retainer payments made to-date for the project. It is the 
sum of all retainer payments received and recorded in the Payment 
screen for the project. 

Project Retainer Used  The retainer amount used or applied on the project to-date. It is the sum 
of all retainer payments used or applied on invoices in the Payment or 
Billing Review screen for the project. 

Project Retainer 
Available 

The retainer amount available for the project. It is calculated as Retainer 
Paid – Retainer Used. 

Client Retainer 
Available 

The retainer amount available for the client of the project. It is calculated 
as Client Retainer Paid – Client Retainer Used. 

Total Billed (Pre-Tax)  The total amount billed to the project before taxes.  

Net Amount Billed  The total amount billed to the project before applying project retainer on 
it, including taxes. It is calculated as Total Amount Billed – Retainer Used.  

Total Amount Billed  This is the total amount billed to the project (all invoices) including taxes. 

Total Amount Paid  The total amount paid by the client, excluding retainers and debit 
payments.  

Total Amount Owed  The total outstanding balance on the project. It is calculated as Total 
Amount Billed - Total Amount Paid. 

 

 Retainers are excluded since they are applied to invoices when processed, 
which results in a reduced invoice amount and therefore a reduced Total 
Amount Billed. If you have applied a Debit payment, the amount of the Debit 
payment will be subtracted from the total payments.  
 

 You can find similar rolled-up information on client basis on the Client-
Account screen. You can also see performance and profitability information on 
employee basis on the Employee-Performance screen. 

 
The History tab displays the invoice history of a project, including payments and retainers. It also shows 
the purchase order and vendor bills history and totals for the selected project. The Invoices option shows 
information including payment type, date of the item, the invoice number involved, and the amount. At 
the bottom of the Amount column is the net balance for the project, indicating the amount owed by the 
client for billed project work, the overpayment or monies on account, or that the project account is paid 
in full.  
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If you need more information, say when a client calls with questions, you can drill down to the invoice or 
payment report behind this summary by double-clicking it. From there, you can further drill-down to 
view detailed services and expenses. You may even check out the linked files and project journals for 
extra information. 
 
Similarly, for Purchase Orders and Vendor Bills options, you can view useful information like the bill 
numbers, dates, status, amount and so on. You can use the right-click Filter By Selection option to filter 
the data based on any selected cell such as Status (Open, Not Billed, etc.) or Type (Invoice, Payment, 
etc.) and so on. 
 

 You can find similar rolled-up information on a client and vendor basis on 
the Client-History and Vendor-History screens, respectively. 

 
The right-click menu on the project grid allows you to view the project’s time and expense activity 
performed by the employees and vendors. You can click the ‘Show Activity’ option to open the Reviewer 
screen. This is a great time saver as you can have direct access to time entry and expense details, quickly 
review and approve them, check the billing format, and so on. Then the ‘View Open Invoices’ option 
allows you to view the outstanding invoices for the selected project from the Invoice Review screen. 
 
 

Using Filters for Data Analysis 
 
Data analysis and work-in-progress reporting is an important aspect of project management. Project 
managers have to view time and expenses for multiple projects. They can use filter options provided by 
BillQuick to perform this task easily and efficiently. Filters are data management tools provided to lessen 
the task of managing a large BillQuick database and for focused data analysis.  
 
Managers can use Filter by Selection option for analysis of a certain type of expense or activity. They can 
use Funnel Filters or More Filters to view and analyze selective data as per the criteria specified. 
 
To filter time and expense records:  
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1. Open the Reviewer screen from the Time-Expense menu.  
 
2. Being a project manager, you may want to view time and expense data for your designated 

projects. On the Reviewer screen, select View By: Projects mode. Choose the desired project(s) 
in the From-To fields.  

 

 
 
3. Next, select the Period and Period From-To dates for the desired time-period. E.g., choose ‘This 

Year-to-Date’ option to review time and expense data for a year until today or ‘All’ to see all 
entries. 

 
4. Depending upon your requirement, you can select more filters from the More Filters drop-down 

list. E.g., check ‘Active Only’ filters. 
 

5. Click Refresh (or select Refresh from the right-click menu). All matching records display in the 
grid. To turn on Auto-Refresh, click Auto.  

 

6. Click  to open the Field Chooser window. Turn the grid columns on/off by checking/un-
checking the list. For instance, you may turn on the Project Name and Invoice fields and hide the 
Project ID and Created On fields. 

 

7. For further selective analysis, click  (funnel filter) on the column header of the desired field to 
open the filter drop-down list and choose an option—All, Blanks, Non-Blanks, etc. The grid 
displays only those records having the selected item in it. See Applying Filters for more. 

 
8. Similarly, you can right-click on any cell in the grid and select ‘Filter by Selection’ option. The grid 

displays only the records with the selected item. See Applying Filters for more. 
 

9. According to the requirement, review and edit the entries. When you are done, click Save and 
then Close to exit. 
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Dashboard 
 

Dashboard contains information that project managers as well as principals, partners, owners and 
accountants need to monitor. Rather than run through menu commands, set filters, run reports and then 
read them one after another to find exceptions and visualize trends, Dashboard lets you view business 
metrics at-a-glance and keep track of the key performance indicators. 
 
 

Using the Dashboard 
 
To use the dashboard: 
 

1.  Open the Dashboard from the View menu, toolbar or the Sidebar. Else, use the shortcut Ctrl + 
Shift + B keys to do that. 

 

 
 
 Oddities in annual trends, presented as simple bar charts, draw your attention like a flashing 

sign, e.g., Monthly Aging. 
 
 You can quickly view the work assigned to your employees or staff members (workload), and 

know their utilization and effective rates. The graph enables you to make informed 
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allocations and decisions based on this information. 
 

 
 

 
 You can view account balances, aging, billable hours, money owed, aged receivables and 

other summary information for your projects. 
 

 
 
 You can view rankings of top performers in the past or new year – Clients, Projects, 

Employees, Activities and Expenses. 
 

 
 

2.  Click (Settings) to choose the widget you want displayed on the Dashboard. For information, 
choose the year you want to view. For all widgets, indicate how often you want to refresh the 
data. Enter the number of minutes BillQuick should wait before automatically refreshing the 
information in a widget. 
 

3.  Click (Refresh) to instantly refresh the widget data and re-display it in the panel. 
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4.  To move a widget panel to another location on the dashboard, point to the panel you want to 
move, press and hold the left mouse button, then drag the panel to the new location. Release the 

mouse button. Click to close the widget. 
 
You can access more options from the right-click menu.  
 

5.  Like other grids in BillQuick, you can sort the widget grids by clicking the column header – once 
for ascending order, twice for descending order. 
 
Widget grids also include funnel filters. With a funnel filter, you can specify conditions and apply 
them to the selected column to display selective data. Funnel filters include All, Custom, Blanks, 
Non-Blanks and so on. 
 

 
 
For advanced users, special filters are available by selecting the Custom funnel filter. The Custom 
Filter allows you to fine-tune the widgets to exactly what you need by specifying conditions. 

 

 
 
6.  Many widgets include drill-down reports that support the summary information in a chart or list. 

Click on the report link at the bottom to view and print related reports. 
 

7.  Check the ‘Default’ option at the bottom of the Dashboard to make it your default screen upon 
login. 
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Workflow Event Tracking 
 

BillQuick’s built-in submit and approve feature enables employees and vendors to follow company policy 
and submit their time, expenses, PTO requests, invoices, vendor bills, etc. to a designated reviewer or 
manager. Once submitted, BillQuick notifies the managers to review the submitted entries for approval 
and billing. BillQuick allows a chain of reviewers to check entries before a final reviewer approves them.  
 
The Workflow event tracking system allows you to track the flow path of the entire submit-approve 
process and take the desired action on events. It gives you the status of all submitted timesheets, 
expenses, vendor bills, invoices, etc. –all in one screen. From here, reviewers and managers can check 
the details of the event, action taken and status. Besides the submitted and approved items, you can 
reference the rejected, forwarded and un-submitted items from this screen.  
 

 The Workflow feature is available in the BillQuick Enterprise edition only. 

 
 

Tracking Workflow in BillQuick 
 
To track workflow events: 
 

1.   Open the Workflow screen from the View menu. 
 

2.  Select the desired employee or vendor in the Employee field. 
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3.  Select the Module ID whose events you want to track, say Time Entry. 
 

4.  You can filter the records displayed in the grid by choosing an Action Type—All, Submit, 
Approve, etc. 
 

5.  Next, select the Period for which you want to track events, e.g., Year. Specify a ‘Period 
Including’ date. 
 

6.  Click Refresh to display all the records meeting your criteria. You can view useful information 
such as event date, action taken and by whom, type of workflow and associated 
employee/vendor. 
 

7.  Click on any item, such as time entry, and see a full history of its submittal, approval or rejection. 
 

8.  Select an event and click Action. Choose the desired action– Approve, Reject, Forward or 
Delete. 
 

9.  When you are done, click Close to exit. 
 
 

Project Reports  
 
BillQuick provides numerous reports useful for project managers. You can run the desired reports on a 
daily, weekly or monthly basis, or simple schedule it for automatic generation and delivery using BillQuick 
Agent. Which reports project managers prefer depend on their management style and the nature of 
projects.  
 
Project managers might need reports for many reasons, including: 
 

 Tracking the work-in-progress for an assigned project 
 Determining whether projects are under or over-budget 
 Comparing the budgeted amount to the actual amount spent on a project 
 Tracing the qualitative information about a project’s progress 
 Reviewing time entries associated with a project 
 Checking out expenses incurred on a project 
 Determining the due dates of the assigned projects 
 Analyzing billing details of a project 
 Employees working on a project and their performance 

 
You can access project reports from the Project screen, Reports Menu and Report Center screen. If 
desired, you can apply relevant report filters to display selective information. See the Report Management 
chapter for more on reports.  
 
Project manager’s day-to-day reports include: 
 

 Budget Comparison   Project List – Over-Budget 
 Estimate Comparison  Project Time and Expense (summary, detail) 
 Project Contract Spent  Project Time and Expenses + Accounts Receivable  
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 Project Journal Notes  Project Due Dates 
 
Periodic analysis and performance reports include:  
 

 Staff Billing Performance 
 Project Investment Reconciliation 

(WIP Reconciliation Summary) 
 Percentage Billed 

 Project Manager Work-in-Hand 
 Project Manager Billing Analysis 
 Staff Utilization by Project 
 Project Profitability 

 

 In addition, you can create custom reports for your projects. You can also 
buy the BillQuick Report Book for detailed information about useful reports. 
Contact Sales at (310) 602-4020.  

 
 

Document Management 
 
BillQuick’s Document Management feature offers a desktop solution to managing and storing your entire 
client and project-related documents- contracts, engagement letters, spreadsheets, tax returns, financial 
statements, CAD files, etc. It handles client and project document management, folder creation and email 
review. 
 
Choose the tasks you want to perform: 
 

 Folder Structure 
 Creating Documents 
 Viewing Emails 
 Viewing Linked Documents 

 
 

Folder Structure 
 
You can define any desired folder structure in Document Management that makes sense to everyone in 
your company. BillQuick inserts the actual client or project data into the folder name. Once created, you 
can access client and project folders and files from the Documents tab. Double-clicking on a document 
icon, opens it in the native program. (You can also access those documents from other applications and 
Windows Explorer.) 
 
If you organize project information around the client, 
you might define a structure like the one on the right. 
The three-level structure starts with the client at the 
top. Under it will be contracts, other files plus a project 
folder, under which are specific folders for project 
items.  
 
 
 
 

http://sites.fastspring.com/billquick/product/BillQuick-Report-Book-2011
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A variation on this structure combines the client and project at the 
first level. Contracts, CAD files, invoices, statements and so on are 
stored beneath it.  
 
 
 
 
 
 
Another folder structure is one centered on a project 
manager at the first level and projects at the second level. 
This makes it easy to identify the manager and the project. 
Under it will be contracts, correspondence, scanned 
documents, special reports, invoices, and so on. 
 
When you link files to records, BillQuick can copy them to a 
shared folder (specified in Global Settings or Preferences 
screens). Optionally, it can even organize them into folders 
as described above. The folder structure is based on the 
parent record type such as Project, Client, Time Entry and so on. You can view all these files on the 
Document Management-Linked Documents screen. 
 
 

Creating Documents 
 
To create documents: 
 

1. Open the Document Management screen from the Project menu, toolbar or navigator. 
 

2. In the grid, click  to expand the client list and view related projects. 
 

3. On the Management tab, specify the Client Folder Structure. Click  to browse for a 
folder or create a new folder at the desired location. 
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4. Specify desired fields from the Available Fields drop-down. Enclose the field names in curly 
brackets. To specify multiple folders, you can separate the names with a comma or use a new 
line in the text box. The result will be like: 
C:\Documents and Settings\Erin\My Documents\Client Files\{CLIENTCOMPANY}\Correspondence 

 
5. Similarly, specify the Project Folder Structure. It will be like: 

C:\Documents and Settings\Erin\My Documents\Client Files\{CLIENTCOMPANY}\{PROJECTID} 
{PROJECTNAME}\Contracts 

 
6. Click Tools and select Create to create a new client folder and default files. BillQuick inserts the 

actual client or project data into the folder name – separately or in combination with static text. 
 

7. Move to Documents tab to view the folders and files associated with the selected client or 
project. 
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8. Double-click or use right-click menu to open the selected folder or file. You can also print the file 
in the selected folder, rename or delete the folder. 
 

9. When you are done, click Close to exit. 
 
 

Viewing Emails 
 
Document Management screen displays emails related to clients and their projects by matching email 
addresses. These addresses are located on the Client-General screen, Client Contacts screen or Project-
Detail screen. In addition, you can link email folders from Microsoft Outlook (2000 or later) or Outlook 
Express (6.0 or later) to a client or project. If desired, you can use your PC’s local cache when scanning.  
 
To view client and project-related emails:  
 

1.  Open Document Management screen from the Project menu, toolbar or navigator.  
 

2.  Select a client in the grid, and then click on the Settings tab.  
 

 
 

3.  Based on the email settings you have specified in the Global Settings or Preferences screen, 
check and un-check your email folders to scan. Click Apply. 
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4.  Now, move to the Email tab. Select the ‘In’ tab at the bottom to retrieve emails received from 
the client.  
 

5.  Click View Email. BillQuick accesses Microsoft Outlook or Outlook Express on your computer, 
then scans your emails (Inbox) for addresses that match the client’s or the project contact’s email 
address. A progress bar indicates the scanning of each email folder. When the process is 
complete, a list of emails displays in the grid. 

 

 
 

6.  Click on ‘View’ in the Body column to read the selected email. 
 
7.  Select the ‘Out’ tab to scan for emails sent to the selected client (Outbox). 
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8.  When you are done, click Close to exit. 
 
 

Viewing Linked Documents 
 
For easy browsing and management of linked files, Document Management screen centralizes all 
documents and files linked to BillQuick records such as clients, projects, employees, activity codes, 
vendor bills, budget, fee schedule, invoice, payment, etc. on one screen. You can view, sort and filter all 
linked files directly from the Linked Documents screen. Security permissions are required to access this 
information. 
 
To view linked documents:  
 

1.  Open the Linked Documents screen from the View menu.  
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2.  Select your View By option. E.g., choose ‘All’ from the dropdown to view documents linked to all 
records, regardless of the type. 
 

 
 

3.  Select the Period for which you want to view the linked files. It could be All, This Month or any 
Custom period. 
 

4.  Click Refresh. BillQuick displays all the relevant files attached to the selected record. 
 

 Using  funnel filters, you can further refine the list of linked files. For 
example, you might bring up all linked files, and then use a funnel filter to 
narrow them to a single employee. 

 
5.  You may click on the File Name and launch the file in the native program. 

 
Alternatively, you can see the linked files for clients and projects from the Document Management 
screen. You can select a client or project in the grid and view all the linked files on its Linked Documents 
tab. 
 

 
 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

mailto:BQ-Ideas@bqe.com
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Overview 
 
BillQuick specializes in time tracking and hence includes various ways to capture time. Depending upon 
your preferences, you can choose the frequency and method of capturing time for accurate billing and 
reporting. This section primarily addresses the concerns of a typical timekeeper and reviewer. 
 

 Time entry requires input from the master information in BillQuick. Employees or vendors charge 

various activities against projects while recording time entries.  Time is captured according to the rules 
and settings specified in BillQuick, whether in Global Settings, Preferences, Company, Client or Project 

screen.  You can record time entries in any screen that suits you- Sheet View, Timer or others. In 
addition, several add-on modules (Web Suite, Outlook Add-In, etc.) allow you to capture hours worked 

anytime, anywhere.  Regardless of the internal or add-on module used to capture time, BillQuick can 

automatically monitor time cards to ensure timely and complete hours from timekeepers.  You can 
submit time to the designated reviewers in the company for review and approval. They may reject some 
entries due to any reason and re-send them to the timekeeper via BillQuick Messages. The timekeeper 
can edit and re-submit them. The Workflow feature allows you to track all events related to time and 

expense entries, including submit/approve status.  The approved time along with the approved 
expenses becomes the work-in-progress, ready to bill. 
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Time Entry 

Area Decision Where to Implement 

Historical Time Ensure you have billed all time in your old system. 
Enter summary time entries in BillQuick, if desired. 

Time Entry screens 

Smart Time Entry 
Evaluation 

Activate built-in intelligence wherein BillQuick 
monitors whether a time entry should be billable or 
non-billable. 

BillQuick Start-Up Interview 
Global Settings-
Time/Expense 

Smallest Time 
Increment 

Define the smallest time increment for rounding both 
actual hours and billable hours. 

BillQuick Start-Up Interview 
Global Settings-
Time/Expense 

User Interface Change the colors used to visually identify billable, 
billed, unbilled and non-billable time entries 

Preferences-Format screen 

Workweek Specify ‘First Day of the Week’ date settings. BillQuick Start-Up Interview 
Global Settings-Options 

Time Card 
Monitoring 

Monitor timekeepers for timely entry of hours at a 
set frequency. 

BillQuick Agent add-on 
module 

Timekeepers Set up employee as a BillQuick User with proper Employee screen 
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Time Entry 

Area Decision Where to Implement 

security permissions. Employees have to enter their 
own time in BillQuick.  

Security screen  

Set up employee as a User for relevant BillQuick add-
on module. Employees remotely enter their own 
time using Web Suite, Outlook Add-In.  

Employee screen 
Product Licensing and User 
Management screen 

Set up vendor as a BillQuick User with proper 
security permissions. Vendors or sub-consultants 
have to enter their own time in BillQuick.  

Vendor screen 
Security screen 

Set up vendor as a User for relevant BillQuick add-on 
module. Vendors remotely enter their own time in 
Web Suite, Outlook Add-In.  

Vendor screen 
Product Licensing and User 
Management screen 

Set up employee as a BillQuick User with proper 
security permissions. This employee has to enter 
time for all other employees/vendors in BillQuick. 

Employee screen 
Security screen 

Time Entry Set standard shorthand codes to describe an 
extended memo or note when recording a time 
entry.  

Auto Complete screen 

Control how far in the past or future a timekeeper 
can record a time entry. 

Global Settings-
Time/Expense 

Set holiday, sick and vacation activities and track 
those hours for the employees. You can charge these 
hours to a project with ‘Overhead’ contract type. 

Employee-Detail screen 
Activity Codes screen 
Global Settings-Activity 

Timer Set the Timer stopwatch for automatic start. Preferences-Options screen 

Use Timer Control to manage multiple timers in a 
multi-tasking situation.  

Preferences-Options screen 
BillQuick Timer screen 

Time Entry 
Approval 

Company does not approve individual time entries. Global Settings-
Time/Expense 
Project-Detail screen 

Assign Manager for time entry approval. A direct 
supervisor or manager of the employees approves 
the time entries. 

Employee-General screen 

Assign Manager for time entry approval. A manager 
responsible for client relationships approves the time 
entries. 

Client-General screen 

Review and/or approve time entries. Set proper 
security permissions. 

Security screen 
Time Entry screens 
Reviewer screen 

Payroll Send time entries to an accounting package that 
integrates with BillQuick to process payroll. Specify 
proper Send Settings for Time Entry. 

Integration menu 
Sync Settings screen 

Send time entries to an accounting package that does 
not integrate with BillQuick to process payroll. Set up 
a standard export template. 

Import/Export screen 
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Time Entry 
 
BillQuick STRONGLY recommends that you capture all hours worked whether they are billable or not. 
This includes vacation, holiday, sick, education, research and other activities. If you do not track billable as 
well as non-billable hours worked by employees, you cannot effectively measure their performance, 
utilization and profitability. Your time entry options include: 
 

 Sheet View – If you enter time for others, often marking overtime, comp time or 
extra time for a project, or review entries, then use this flexible, customizable 
spreadsheet-like time entry screen. 

 Simple Time Card – If you work steadily on three, four or five tasks during a day, then 
use this efficient, quick-to-enter timesheet screen. 

 Timer (on-screen stopwatch) – If you switch from task to task through the day – client 
calls, staff and management requests, emails, impromptu meetings –  then open as 
many timers as you need. You can easily switch from one timer to another. The 
Timer Control window manages all timers.  

 Outlook Add-In – If you track appointments and hours worked using Microsoft 
Outlook, then use this BillQuick add-in module to save appointments, tasks and 
emails as time entries right from Outlook.  

 Web Suite – You may have remote offices, staff and managers who work on the road 
or from remote sites. In such cases, use this web-based module on laptops and smart 
phones to capture time and expenses. 

 
This section covers the following time entry tasks: 
 

 Vendor Time & Expenses 
 Sheet View 
 Simple Time Card 
 BillQuick Timer 
 Calendar View 
 Customizing Time Entry Screens 
 Filtering Items 
 Batch Changing Time Entries 
 Deleting Time Entries 

 
 

Vendor Time and Expenses 
 
Many companies outsource tasks to vendors (also called subcontractors, consultants, per diems, contract 
employees, etc.). Whether paid an hourly rate or a flat project fee, it is beneficial to track their hours for 
reporting and analysis. This information can help improve future estimates, budgets and other decisions.  
 
BillQuick allows vendors to record time and expenses in two ways: 
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 Mark the vendor as a BillQuick User on the Vendor-General screen. This gives the vendor login 
access to BillQuick to record time and expenses. (Remember to set proper security permissions for 
the vendor.) 

 
 Create a special employee called ‘Vendor’ and mark it as a BillQuick User. Individual vendors 

would log in under this common ID to record time and expenses. Only one vendor can record 
entries at a time and would be able to view and edit entries for other vendors. 

 
 

Sheet View 
 
Most timekeepers (employees or vendors) record and review time for projects and administrative 
activities in Sheet View.  
 
This section covers the following tasks: 
 

 Recording Time in Sheet View 
 Copying and Pasting Time Entries 

 
 

Recording Time in Sheet View 

 

 You can record your time entry at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
 
Basic Time Entry 
 
To enter time in Sheet View:  
 

1. Select Sheet View screen from the Time-Expense menu, toolbar, Sidebar or navigator.  
 

2. In the key fields above the grid, select ‘Employee’ from the View By drop-down. Enter your 
name in the Employee field (depends upon for whom you are recording time).  
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3. Tab through the Period fields (you can enter time for any date irrespective of the period selected 

here).  
 

4. Click Refresh. If there are existing entries, click New to jump to the last row. 
 
5. In the grid, enter the month, day and four-digit year of your first time entry in the Date field. You 

can also select a date from the calendar. Press Tab to move on. 
 
6. To charge your time against a project, enter a Project ID. You can also select a project from the 

drop-down list (could be Employee or Vendor ID, depending on the View By mode selected above). 
 
7. Next, enter the Activity ID or service you provided to the client, or select one from the drop-

down. In the next field, the activity Description displays. You can edit the description, if desired. 
 
8. Tab to the Hours field (actual hours spent doing work) and enter the time. 
 

 BillQuick allows time entry in the decimal or Hour:Minute format. You can 
also enter negative time. Internally, BillQuick copies these hours to Billing Hours 
(B-Hrs) field and rounds it to the next time increment (which is 15 minutes or 
0.25 hours by default).  

 
9. To save the new entry, Tab through the remaining fields in the row or click on another row (a 

beep confirms that). You are done! 
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Advanced Time Entry 
 
To add or view additional information: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. In the Control Hours field, enter the total number of hours for this session. BillQuick warns you if 
the total hours entered do not match the control total. To turn on Control Hours, check the ‘Show 
Control Hours’ option on the More tab. 
 

3. If you prefer, use the Project Name field to select a project for recording a time entry instead of 
the Project ID. 
 

4. Enter the Start time and Stop time for the task instead of Hours. BillQuick automatically adjusts 
the time interval and records the time entry.  

 

 The Start/Stop time links to Billable Hours, by default. However, if you 
want to record this time for Actual Hours instead, you need to un-check this 
option on the Global Settings-Time/Expense screen. 

 

 BillQuick fills the ‘Created On’ column with the system date (saved in 
GMT) automatically when you record a new time entry. You can use this field to 
sort the grid based on the date when you record a time entry or to trace the 
order of entering time entries. 

 
5. The ‘B’ status flag indicates the time record is billable. Billable status defaults from the Activity 

Code record; however, you can change it here. 
 

6. The B-Hours field displays the billing hours carried from the Hours field. You can adjust the B-
Hours here or in the Billing Review screen (with security permissions). 
 

7. The Bill Rate and Cost Rate fields are auto-filled if you have defined them in the Activity Codes 
screen or if the employee-activity combination matches an item in the Service Fee Schedule 
assigned to the project. You can change the rates with appropriate security permissions. 
 

8. Charge Amount for the time entry is auto-calculated by BillQuick (Hours x Bill Rate) but you can 
change it (with proper security permissions).  
 

 If you manually change the Charge Amount of a time entry, it generates or 
recalculates the write-up or write-down percentage (the normal WUD value 
being 0). 

 

9. Click  Link Files (when Memo box is open) or right-click on any entry to link a file to the time 

entry. The grid displays  in the Attachment (F) column to indicate entries having files attached 
to them. 
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10. You can mark an entry as OT (overtime). If Automatic Overtime option is on, BillQuick 

automatically tags the entry when the total hours for the day or workweek exceed Standard 
Hours.  
 

11. Check the ‘Xtra’ flag to mark the entry as extra time beyond that allowed under a fixed-type 
project contract. BillQuick does not deduct the billable extra time from the contract amount, but 
is in addition to it. 
 

12. Check the Flag 1/2/3 fields for an entry that possesses any special attribute for tracking or 
reporting purposes. For example, a flag may indicate that a time entry is tax deductible.  
 

13. Tax 1/2/3 rates pull from the activity record. BillQuick sums these taxes and computes the tax for 
this entry. With proper security permissions, you can modify these rates here. See Taxes in the Billing 
Basics chapter for more. 
 

14. If desired, edit the pre-filled Classification for the employee. See Determining Rates for more. 
 

 While fetching a classification, BillQuick will look for it in the following 
order: Service Fee Schedule, Project Control or Employee screen (Title). 

 
15. BillQuick marks the time entry as ‘CT’ (Compensation Time) if it triggers automatic comp time 

computation or a manager can mark it manually. BillQuick banks these hours for the employee to 
be used in future.  
 

 When comp time is to be used, you would use the special activity code 
(e.g. GEN:COMP) and charge the hours to the company’s Overhead project. 

 
16. Click Tools and select Spell Check to perform a global spell-check of the memo as well as other 

grid text. 
 

17. Click Tools and select Show Totals to turn on the total fields at the bottom. It displays the total 
hours (Actual Hours) for any time (Period) selected. 
 

18. Click Auto toggle button to turn on/off auto refresh. If on, BillQuick refreshes the grid 
automatically whenever you make changes to a key field. 

 

 The Assigned, Used and Left fields at the bottom show the timekeepers 
how many hours are allocated to the task, how many hours have been used, and 
how many are left. 

To add a memo: 
 

1. Press Ctrl + M in the grid. In the Memo box, enter as much text as you want to describe the 
task or related events.  
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2. When you are done, press Ctrl + M to return to the Sheet View grid. Now the ‘M’ memo 
checkbox is marked for this time record. 

 

 Using the Memo toolbar, you can cut, paste, change font size, and add 
bold, italic and underline attributes. You can even perform a spell-check, insert 
date-time stamp and create Auto Complete codes.  

 
3. Check the ‘Memo on Journal’ option if you want to add the memo to the time entry as a journal 

note. 
 

4. By default, BillQuick includes and prints memos on detailed invoice formats. If you want that, 
keep the ‘Memo on Invoices’ option checked. 
 

5. Custom 1/2/3 fields in the grid allow you to record additional information about a time entry (up 
to 50 characters).  
 

 The Custom 1/2/3 fields of activity code will pre-fill the time entry custom 
fields and inherit the same data type. 

 
To submit time entries: 
 

1. On the grid, ‘S’ field indicates the Submit-Approve status of a time entry. The status is indicated 
by an icon:  

[blank] Not submitted    Submitted    Forwarded    Approved    Rejected 

 
2. Select time entries to submit. 

 
3. Click Submit. It opens the Submit-Approve screen from where you can submit them to the 

desired person. See Submitting and Approving Time below for details. 
 
To edit time entries: 
 

1. Select the time records that need to be changed. 
 

2. Click Tools and select Change to launch the Time Entry Change screen. It allows you to modify 
multiple time records at once. (See Batch Changing Time below for more.) 
 

3. When you are done, click Close to exit. 
 
 

Copying and Pasting Time Entries 
 
BillQuick includes ways to save time recording hours worked. For example, many staff and managers 
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work on the same projects every day and from one week to the next. Usually, the only data that changes 
is the date.  
 
BillQuick allows you to copy selected time entries and paste them with/without modifications in the time 
entry grid. Result: You have more hours for billable and productive work. 
 

 BillQuick can copy a maximum of 50 time entries at once. 

 
To copy and paste time entries: 
 

1. Open the Sheet View screen. 
 

2. Select the time record(s) in the grid that you want 
to copy.  
 

3. Click the Copy option at the bottom of the screen.  
 

4. Select the next empty row and then click the Paste 
option (or use the right-click menu or Edit menu).  
 

5. Optionally, use the Paste Special option to paste 
your entries. It allows you to modify the Date, 
Project ID, Group, etc. of the new entries. 
 

6. On the Paste Special dialog, check the ‘Increment 
time entry date by’ option and enter ‘7’. BillQuick 
increments the entry dates by seven days.  
 

 
7. Click OK and you are done!  
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New time entries are added to the grid, exact duplicates of the original except the date has been 
changed. 

 

 BillQuick duplicates an entry to another row including the Activity ID and 
Project ID. To change the Date while in the Hour field, use the + key to 
increase the date and * key to decrease the date. 

 
 

Simple Time Card 
 
 

Recording Time in Simple Time Card 
 

 You can record your time entry at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Time Entry 
 
To enter time using STC: 
 

1. Open the Simple Time Card screen from the Time-Expense menu, toolbar or navigator. 
 
2. Select the View By option, say Employee. In the Employee field, select the desired employee 

from the drop-down list. 
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3. Next, enter or select the ‘Period Including’ date (week) for which you want to record time.  

 

4. Select the relevant Project ID from the drop-down list in the grid. (BillQuick also supports 
selecting projects by name.) 
 

5. Press the Tab key to move to the Activity ID field. Select an activity from the drop-down list. The 
associated Description automatically displays.  
 

 Whether or not a time entry is billable depends on its default value in the 
Activity Codes screen.  

 
6. Move to the next field to enter the billing hours under the desired day/date of the week. Use 

decimals if needed.  
 

 Weekend dates display only if you turn on that option by clicking Tools and 
un-selecting Hide Weekends. 

 
7. After entering all your time for other projects and /or activities, click Save and you are done! 

 
Advanced Time Entry 
 
To add or view additional information:  

 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. Click  Link Files or right-click and select that option from the menu if you want to link any file 
to the time entry. 
 

3. Click Tools and select Spell Check to perform a global spell check on the descriptions and 
memos for all time entries in the grid. 
 

4. After entering all your hours and performing other actions, click Save. 
 
To enter a time memo: 
 

1. Press Ctrl + M to open the Memo box from the grid or click  at the bottom. Enter as much 
text as you wish; then press Ctrl + M again to return to the grid. (You can spell-check, edit or 
date-time stamp your time memo, if desired.) 
 

 
 

 Depending on the invoice format chosen, a time entry memo can appear 
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on your invoices. Memos also print on various reports. 
 

2. Check the ‘Memo on Journal’ option if you want to add the memo to the time entry as a journal 
note. 
 

3. By default, BillQuick includes and prints those memos on detailed invoice formats. If you want 
that, keep the ‘Memo on Invoices’ option checked. 

 
To submit your time entries: 
 

1. Select time entries to submit on the grid. 
 

2. Click Submit. It opens the Submit-Approve screen from where you can submit selected time 
entries to the desired person. See Submit-Approve below for details. 
 

3. When you are done, click Close to exit. 
 
 

BillQuick Timer 
 
BillQuick Timer is a stopwatch that tracks hours worked on an activity for a project. Multiple timers can 
run at the same time. You can manage them from a single Timer Control screen, including opening, 
starting and stopping new timers. 
 
This section teaches you to use the BillQuick Timer: 
 

 Starting and Stopping Timers 
 Logging Time from a Timer 
 Using Timer Control 

 
 

Starting and Stopping Timers 
 

 You can record your time entry at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Time Entry 
 
To start and stop a Timer: 
 

1. Open the Timer screen from the Time-Expense menu, toolbar, Sidebar or navigator.  
 

2. Click Start to start the timer.  
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 You can start and stop a Timer from the Timer Control window. It allows 
you to control single or multiple timers without using the BillQuick desktop. See 
Using Timer Control below. 

 
3. Enter the Date for the time entry or select from the drop-down calendar. Timer defaults to the 

system date of your computer. Press Tab to move between fields or click on the next field. 
 

4. Enter the Employee ID, Project ID and Activity ID, or select the items from the drop-down lists. 
The Description defaults to the activity code description. However, you can change the text.  
 

 BillQuick pre-fills the timer with the Project, Activity, and other data from 
a previously recorded time entry. 

 
5. When you are done working on the specified activity and project, click Stop. You are ready to log 

your time entry! 
 
Advanced Time Entry 
 
To add or view additional information: 
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1. When you have an appointment or another activity for which you want an alarm, you can set an 

internal countdown clock. Enter the time in the ‘Beep when Timer reaches’ field. It beeps when 
the clock runs out until you click Stop. 
 

2. If desired, set the reminder ‘Chime after every’ to sound at a regular interval, such as 15 minutes 
or 1 hour. Enter the time in a decimal format (e.g. 0.25, 3.5, etc.). This alert can remind you that 
a timer is running if you are distracted. 

 
3. Check the Pause Timer option to let BillQuick automatically pause your timer because of non-

activity or system idle time. You can ignore the idle time or add it back, if desired. 
 

 This is a great feature to avoid the hassle of adjusting the timer when you 
forget to stop it prior to any meeting or a going out for lunch. You can specify 
the pause time in the Preferences-Options screen. 

 
4. Check ‘Always on Top’ option to display the timer on top of the applications running on your 

computer screen. 
 

5. Mark the ‘Remember’ checkbox for the timer to memorize the data (including time) if the screen 
is closed, computer is shut down or you lose power. 
 

6. While you are working—talking to a client or a prospect on the phone or to an associate about 
the project—add notes or memo by clicking Show Memo. BillQuick retrieves the associated 
activity memo for the time entry, which you can edit here. 
 

7. You can specify various filters on the Filters tab for selective viewing of data in the dropdown 
lists. Click Filters toggle button to turn on/off all defined filters. (See Filters below for more.) 
 

8. Click on the More tab and set the default Activity ID and Project ID for the time entries. 
BillQuick pre-fills these default IDs in the respective fields on the Time Info tab. 

 

 
 
 
 

Logging Time from a Timer 
 
After recording time using a Timer stopwatch, you need to save or log time to the BillQuick database. If 
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you have used a timer previously without saving it, BillQuick prompts you via Reminders or Messages to 
open and save it (provided you have checked the Remember option). You can also access all unsaved timers 
using the ‘Open all Unsaved Timers’ option from the Time-Expense menu. 
 
To log a time entry:  
 

1. After you click Stop, check the time entry. Do you need to change the status for Billable, Extra or 
Overtime? If so, do so. 
 

 
 
2.  Next, look at the Adjusted Time. Did you forget to turn off the timer when the telephone call 

came in or when a staffer stopped to discuss a project issue? Did you forget to start the timer 
when you began a task? If so, you have two options. 

Click the stopwatch . As needed, enter a new value, click  to decrease elapsed 

time or click  to increase the time. The Adjusted Time field changes accordingly. 
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3.  Total captured time displays in the Adjusted Time field. BillQuick automatically adjusts it based 
on minimum time increment (default is 0.25 hours or 15 minutes). If desired, you can manually 
adjust it here. 
 

4.  You can see the hourly Bill Rate and Cost Rate for a task. These rates may be defaults from the 
timekeeper’s profile, special SFS rates assigned to the project or ones assigned to an activity 
code. You can change it with proper security permissions. 
 

5.  Tax 1/2/3 rates pull from the activity record. BillQuick sums these taxes and computes the tax for 
the entry. With proper security permissions, you can modify these rates.  

 
6.  Check the ‘B Hrs’ option and then manually enter a value into the box for the Billing Hours. This 

value is recorded when you log the time entry to the database. 
 
7.  The Billable status flag indicates the time record is billable. It defaults from the activity record but 

you can change this status here. 
 

8.  When the ‘Extra’ option is checked, BillQuick records the entry as extra time beyond that 
allowed under a fixed-type project contract. BillQuick does not deduct this extra time from the 
contract amount but records it in addition to it. 

 
9.  You can mark an entry as OT (overtime). If Automatic Overtime option is on, BillQuick 

automatically tags the entry when the total hours for the day or workweek exceed Standard 
Hours. 
 

10.  Click Log and select Log Time to save and add the time entry to the database. Else, select 
Log/Submit to save and submit the time entry.  
 

11.  When you are done, click Close to exit. 
 
 

Using Timer Control 
 
The BillQuick Timer Control window opens automatically when you launch a timer so you can manage 
multiple timers from a single screen. It stays on top of Windows desktop and any application; it can be 
moved anywhere on your screen. When active, Timer Control displays the status about all open timers. 
With a quick scan, you know how much time is recorded against an activity and a project.  
 

 If desired you can turn off Timer Control and manage timers from the 
BillQuick desktop (Preferences-Options screen). 

 
To use a Timer Control: 
 

1.  Click Start to start the timer for the selected task (project-activity row). Else, click New to open 
a new Timer window. 
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2.  Check the Status field to see whether the timer is currently running or stopped. Currently 

running timer row has a green background. 
 

3.  Click Project or Activity fields to change them, if desired. 
 

4.  Click  to add a Memo for the selected time entry or Description for the selected activity. 
 

5.  Click Show to open the BillQuick desktop and display the Timer window for the highlighted row. 
 

6.  Click Stop to stop the timer for the selected task. 
 

7.  Click Log to choose an option from its dropdown list:  
 

 ‘Log Timer’ option to log the recorded time for the selected row.  
 ‘Log All’ option to log the recorded time for all rows (all timers). 
 ‘Log and Submit’ option to log the recorded time for the selected row and submit 

it as well. 
   

8.  When you are done, click Close to exit. 
 
 

Calendar View 
 
Calendar View is best suited for timekeepers who work on a limited number of projects. You can enter 
or view time sheets for a week or two week (bi-weekly) period. 
 
 

Recording Time in Calendar View 

 

 You can record your time entry at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Time Entry 
 
To enter time in Calendar View: 
 

1. Open the Calendar View 
screen from the Time-
Expense menu, toolbar or 
navigator. 

 
2. Select the View By option, 

say Employee. In the 
Employee field, select the 
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desired employee from the drop-down list. 
 

 
 

3. Next, enter or select the ‘Period Including’ date for the desired week or the first week when a 
biweekly layout is chosen.  
 

4. Select the relevant Project from the drop-down list in the grid.  
 

5. Press the Tab key to move to the next field to enter the billing hours ‘H’ under the desired 
day/date of the week. Use decimals if needed.  
 

 Weekend dates display only if you turn on that option by clicking Tools and 
un-selecting Hide Weekends. 

 
6. Move to the next field (AC) to enter or select an activity from the drop-down list.  

 
7. Similarly, enter time for other projects and activities. Check the Total hours logged per 

project/employee or per day basis. You are done! 
 
Advanced Time Entry 
 
To add or view additional information: 
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1. Enter the total hours to record in a data entry session in the ‘Ctrl Hrs’ field. If you attempt to end 
the time entry session and hours entered are more or less than the control hours, a message 
displays. 
 

2. Move to Filters tab and set the desired filters. You can turn on/off all defined filters by clicking 
Filters toggle button. (See Filters below for more.) 
 

3. Click Tools and select Show Totals to turn on the Totals fields at the bottom. 
 

4. Click Auto toggle button to turn on/off auto refresh. When turned on, BillQuick automatically 
refreshes the grid whenever you change a key field. 
 

5. Again, click Tools and select Show Two Weeks to display two weeks in the grid. This is useful if 
you enter time on a biweekly basis.  

 
To add a time memo: 
 

1. Press Ctrl + M to open the Memo box from the grid or click  at the bottom. Enter as much 
text as you wish. 

 

 
 

2. Press Ctrl + M again to return to the grid. (You can spell-check, edit or date-time stamp your time 
memo, if desired.) 
 

 Depending on the invoice format chosen, a time entry memo can appear 
on your invoices. Memos also print on various reports. 

 
3. Check the ‘Memo on Journal’ option if you want to add the memo to the time entry as a 

journal note. 
 

4. By default, BillQuick includes and prints memos on detailed invoice formats. If you want 
that, keep the ‘Memo on Invoices’ option checked. 

 
To submit time entries: 
 

1. Select time records to submit on the grid. 
 

2. Click Submit. It opens the Submit-Approve screen from where you can submit them to 
the desired person. See Submitting and Approving Time for details. 
 

3. When you are done, click Close to exit.  
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 BillQuick automatically pre-fills Calendar View with the projects you 
worked on last week. You can uncheck that option on the Filters tab. The 
default is the last ten projects, but you can set the number higher or lower on 
the Preferences screen. 

 
 

Customizing Time Entry Screens 
 
You can customize the columns or fields in a time entry grid, as per your preference. To do so: 
 

1. Open the Calendar View screen from the Time-Expense menu, toolbar, Sidebar or navigator. 
 

2. By default, the weekends do not display in the grid. Click Tools and select/un-select Hide 
Weekend to hide/show weekends in the grid.  
 

 
 

3. In addition, by default, you can view one week on the grid. Click Tools and select Show Two 
Weeks to show two weeks on the grid. 
 

4. BillQuick remembers the settings in future. When you are done, click Close to exit. 
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Filtering Items 
 
While recording a time entry, you can filter items in the grids and dropdown lists by using the Filters 
feature. To do so: 
 

1. Open the Sheet View screen. 
 

2. Select View By: Employee and select the desired Employee from the drop-down list. 
 

3. On the Filters tab, click on the desired filter- Project, Employee, Activity, group or any other 
option. 
 

 
 

4. Select the relevant items from the grid on the right and then click on the filter again. BillQuick 
filters the selected items and marks the checkbox next to that filter. 
 

5. Optionally, check or select the other available options to filter items based on Bill Status, 
Contract Type, etc. 
 

6. Move to the Sheet View tab and click Refresh. Make sure you have clicked the main Filters 
(on/off) button. 
 

7. You can view only the selective items, thus shortening the lists and making the time entry or 
review process faster. 
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Batch Changing Time Entries 
 
Errors, late updates to service fee schedules, changes in project or activities, and other situations can 
result in the need to change multiple time entries. Modifying them one-by-one is time-consuming and 
increases the risk of introducing new errors. BillQuick allows you to batch modify entries for 
straightforward A-to-B changes.  
 
BillQuick allows you to change the cost rate on billed entries except for those entries that are on a Cost 
Plus invoice. However, you should have the security permission to edit billed time. In addition, in the 
View by Project mode, you can mark time entries as billed and associate it to a previously processed 
invoice. See Progress Billing for more. 
 
To make a batch change:  
 

1. Open the Sheet View screen.  
 
2.    On the Sheet View tab, select Project or Employee for the View By field. Your choice depends 

on which will best populate the grid with the time entries you want to change.  
 

3.  Accordingly, select the Project or Employee ID, Period and Period Including for your situation. 
Click Refresh to populate the grid with time entries. 
 

4.    In the grid, select the time entries you want to change. Then click Tools and select Change. 
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5.  On the Change screen, enter new values or to select them from the drop-down lists to replace 
the current values. 
 

6.  Select True or False for each flag you want to change. 
 

7.  The checkbox is marked when you enter a new value. Click OK to apply the changes.  
 

8.    When you are done, click Close to exit. 
 
 

Deleting Time Entries 
 
Deleting an employee or vendor record does not delete time, expense or other data associated with it. 
Thus, when required, you need to delete time entries directly from the time entry screen. 
 
To delete time entries: 
 

1. Open Sheet View from the Time-Expense menu, toolbar, Sidebar or navigator.  
 
2. Select the View By mode. Then select the project or employee from the dropdown.  
 
3. Next, move to the Period field and select the period for which you want to delete the time 

entries. Click Refresh to display the specified time entries.  
 

4. Click Select and choose Select All option. Right-click and choose Delete.  
 

5. When you are done, click Close to exit.  
 

 In Simple Time Card, you can clear the grid of the previously used 
projects. Click Tools and select Clear to clear rows with no hours. 

 
 

Special Time 
 
Besides the regular time, BillQuick lets you tack special time like overtime, compensation and banked 
time, extra time, overhead time, etc. This section covers the following: 
 

 Overtime and Comp Time 
 Tracking Overhead Time 

 
 

Overtime and Comp Time 
 
You may want to track your employees’ overtime or compensation time, or even both. The extra time 
worked by employees (or vendors), whether in the form of overtime or comp time (banked hours), can 
be calculated in BillQuick using its effective time tracking system. 
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BillQuick allow you to specify the standard hours and overtime settings for an employee to track 
overtime. Depending upon whether standard hours are set per day and/or per week, extra hours logged 
by an employee will be flagged as OT (overtime), on a daily and/or weekly basis. In this case, BillQuick 
 

 calculates Bill Amount using regular Hours with the appropriate standard Bill Rate 
 calculates Bill Amount using Overtime Hours with the appropriate Overtime Bill Rate 
 calculates Cost Amount using the appropriate regular and overtime cost rates 

 
If the Automatic Overtime option is not checked but you have specified the comp time details, BillQuick 
will track your comp time instead. Depending upon the comp time frequency and hours set, BillQuick 
will flag the extra hours logged by an employee as CT (comp time). When both overtime and comp time 
options are set, it will flag the extra hours logged by an employee as CT and OT. However, if there is a 
conflict, overtime settings take precedence over comp time. While recording time entries these rules are 
automatically monitored by BillQuick. 
 

 If you change previously recorded time entry, BillQuick will not recalculate 
OT or CT. E.g., if you change the previous 8 hours of regular time to 6 hours, 
BillQuick will not recalculate OT/CT nor set the flag to false. You have to 
manually verify and edit that time entry. 

 
Depending on the settings in the Employee screen, the outcome might be: 
 

Setting BillQuick Action 

Standard Hours = not defined No evaluation of OT 

Standard Hours = 8 Hrs Per Day, 
40 Hrs Per Week 
Automatic Overtime = not checked 

When TE = 10 Hrs, BillQuick records it as 10 Hrs 
regular time 

Standard Hours = 8 Hrs Per Day, 
40 Hrs Per Week 
Automatic Overtime = checked 

When TE = 10 Hrs, BillQuick splits it as 8 Hrs regular 
time, 2 Hrs = OT 

Comp Time Details = 8 Hrs, Daily When TE = 10 Hrs, BillQuick splits it as 8 Hrs regular 
time, 2 Hrs = CT 

Standard Hours = 8 Hrs Per Day, 
40 Hrs Per Week 
Automatic Overtime = checked 
Comp Time Details = 8 Hrs, Daily 

When TE = 10 Hrs, BillQuick splits it as 8 Hrs regular 
time, 2 Hrs = OT, 2 Hrs =CT 

Standard Hours = 8 Hrs Per Day, 
40 Hrs Per Week 
Automatic Overtime = checked 
Comp Time Details = 10 Hrs, Daily 

When TE = 10 Hrs, BillQuick splits it as 8 Hrs regular 
time, 2 Hrs = OT 
When TE = 12 Hrs, BillQuick splits it as 8 Hrs regular 
time, 4 Hrs = OT 

Standard Hours = 40 Hrs Per Week 
Automatic Overtime = checked 
Comp Time Details = 8 Hrs, Daily 

When TE = 10 Hrs, BillQuick splits it as 8 Hrs regular 
time, 2 Hrs =CT 
When TE = 42 Hrs, BillQuick splits it as 40 Hrs regular 
time, 2 Hrs = OT, 2 Hrs = CT 

 
Select the task you want to perform: 
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 Tracking Overtime 
 Tracking Comp Time 

 
 

Tracking Overtime 
 
To track overtime: 
 

1.  Open the Employee screen from the View menu, toolbar, Sidebar or navigator. 
 

2.  Select an employee from the grid list; then click on the Detail tab. 
 

 
 

3.  Enter the Standard Hours Per Day and Per Week for the employee, say 8 hours per day and 40 
hours per week. 
 

4.  Next, check the ‘Automatic Overtime’ option to calculate overtime whenever the time entry 
exceeds the standard hours. 
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5.  When you are done, click Save and then Close to exit.   
 
 

Tracking Comp Time 
 
When employees work for extra hours, they can record it as non-billable comp time (banked hours). 
When these employees use their banked comp time, a special GEN:COMP activity code is to be used 
while recording that time entry. Usually, a company charges comp time to the Overhead project. 
 

 GEN:COMP can be replaced by any activity code you want using Global 
Setting-Activity screen (from the Settings menu). 

 
To track comp time: 
 

1.  In the Employee screen, select the Detail tab.  
 

 
 

2.  In the Comp Time Details section, set the Frequency and Hours for calculating banked comp 
time. E.g., if you want BillQuick to calculate comp time for this employee whenever time entry 
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exceeds 48 hours per week, then you may enter Frequency=Weekly, Hours=48. 
 
3.  Record one time entry for all the banked compensation time that the employee currently has 

against the Overhead project and a non-billable activity code (but not GEN:COMP). 
 
Else, an employee can record time entries as usual and then BillQuick will automatically calculate 
banked comp time based on your settings.  

 
4.  If the employee want to use these banked hours, time entry should be recorded using the 

GEN:COMP activity.  This will reduce the employee’s banked comp time.  
 

 You can have negative comp time by using the GEN:COMP activity for 
more than your banked comp hours. 

 
5.  Run the Employee Comp Time report (from the Reports menu, Employee). It should display the 

banked comp time for that employee. You can also compare the compensation time earned by 
the employee to compensation time utilized. 

 
 

Tracking Overhead Time 
 
In many companies, you have to keep track of internal activities and expenses, even though they may be 
non-billable. You may want to track overhead time like vacation, holiday, sick, company meetings, 
training, research, etc.  In any case, time and expenses flow to the project, allowing you to track 
utilization of all employees and, both billable and non-billable activities –whether you do them for a 
revenue project or an in-house overhead project. 
 
BillQuick requires you to set up projects with some required data such as client, manager, contract type 
and so on. An overhead project will require you to set up your company as a ‘client’ and then assign the 
overhead project to it. 
 
To track overhead time: 
 

1. In the Client screen, set up a client record for your company, say ‘My Company’. 
 

2. In the Project screen, set up a project for general office activities, say ‘General Office’ or 
‘Overhead’. 
 

3. Assign the client, ‘My Company’ to this project. 
 

4. Next, assign the owner/principal/manager of your firm (whoever checks and approves general 
office time and expense) as the Project Manager. 
 

5. Select Overhead as the Contract Type and set the Status to ‘Active’. 
 

 Overhead contract type triggers a business rule to flag all time and 
expenses charged to an overhead project as non-billable, regardless of the 
activity code’s default status. 
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6. Now you can record your time entries against this ‘General Office’ or ‘Overhead’ project with 
any general office activities.  
 

 When comp time is to be used, you would use the special activity code 
(e.g. GEN:COMP) and charge the hours to the company’s Overhead project. 

 
 

Submit-Approve 
 
BillQuick’s built-in submit and approve features enable timekeepers to follow company policy and submit 
time to a client manager, project manager, employee manager or a specific person. Once submitted, 
BillQuick notifies the manager or reviewer concerned about those entries via the Reminders, Company 
Navigator or email. For a company that follows a submit-review-approval process, BillQuick’s built-in 
workflow makes the process easy and fast.  
 
A chain of reviewers can check time and expenses before a final reviewer approves them. You must 
review time and expense entries no less than once a week to avoid write-offs due to fuzzy memories. 
Sometimes this process is called ‘posting’ or ‘releasing work-in-progress’. Only approved entries are 
available for billing even though BillQuick charges all entries against the budget or contract amount.  
 

 You can track the entire submit-approve process for time entries from the 
Workflow event-tracking screen.  

 
This section covers the following tasks: 
 

 Submitting Time Entries 
 Reviewing Time Entries 
 Notifying Managers 
 Approving Time Entries 

 
 

Submitting Time Entries 
 
BillQuick prompts you automatically for submission of new time and expense entries if you set that 
option in Global Settings. If you ignore that, BillQuick will remind you about it upon login via messages or 
reminders. You can submit same item to multiple people. For example, you can submit your time for 
payroll approval to Jennifer and for billing approval to Wendy. 
 
To submit time entries:  
 

1. Open any time entry screen: Simple Time Card, Sheet View or Calendar View. 
 

2.  Select the time records that you want to submit to a particular reviewer. BillQuick will submit all 
the selected rows to the same person. 
 

3. Click Submit to open the Submit-Approve screen. 
 



Time Tracking 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 326 

 
 
4.    Select the person to whom you want to submit the entries. Commonly, you submit hours 

charged to a billable project to the Project Manager or Client Manager. You may submit the non-
billable time charged to the Overhead and Marketing projects to a Specific person or My 
Manager (your direct supervisor). Your BillQuick Supervisor will provide submission 
instructions. 
 

5.  In the Workflow Type, specify the type of submission-whether Billing, Payroll or both. 
 

6.  If required, add a memo to your submission. You can enter unlimited text here. 
 

7.  Click OK and you are done! 
 
 

Reviewing Time Entries 
 
Time entries can be viewed in any of the time entry screens—Sheet View, Simple Time Card or Calendar 
View. You can also review both time and expense entries in the Reviewer screen. A project manager 
primarily performs this function but a billing manager or BillQuick Supervisor can also do it. 
 
To review time entries in Sheet View: 
 

1. Open the Sheet View screen. 
 

2. You can view the time information in the View By: Project/ Employee/ Vendor mode. Employee 
is the default selection, but you can choose Project for now.  



Time Tracking 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 327 

 
 

3. Accordingly, select the Project whose time records you want to review.  
 

4. In the Period and Period Including field, enter the date of the time entries you want to view.  
 

5. Click Refresh. All the time entries meeting your criteria display in the grid. 
 

6. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

7. You can scan the list of entries and instantly know their status by the color of the text: 
 

 Billable – Black text 
 Non-Billable – Red text 
 Billed – Blue text  
 

8. A manager can adjust time entries by a write-up/down as part of his billing decisions. ‘0’ indicates 
no adjustment; ‘50’ indicates increase in value by 50% and ‘-50’ indicates decrease by 50%. You 
can adjust time entries using the Write-Up/Down option on the Change screen as well. 

 
When you turn on the total fields, BillQuick displays total hours by day and overall total for any 
period selected by you- Week, Year, All, etc. For any chosen period, BillQuick displays total 
regular, overtime and comp time hours. Total regular hours include billable and non-billable 
entries. Additionally, BillQuick displays statistics that break down the hours into billable and non-
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billable. The bar graph shows the percentage of billable hours among the displayed time entries.  
 
Project managers may utilize these fields when reviewing all time charged to a project. By 
selecting View By: Project and ‘All’ for Period, totals and statistics quickly break down billable and 
non-billable hours charged to-date to the project. Non-billable hours may indicate how much 
time was lost or given away to gain or keep the business. You can further refine the displayed 
records by filters. 
 
Another potential use of the information here is to check an employee’s year-to-date billable and 
non-billable time. By selecting View By: Employee and ‘Year’ for Period, a manager can gauge 
performance (printed reports showing this information are available). 
 

9. Review, edit or approve entries, as required (See Approving Time Entries below). When you are 
done, click Save and then Close to exit. 

 
To review time entries in the Reviewer screen: 
 

 The Reviewer screen is available in the BillQuick Enterprise edition only. 
 
Accessible from the Time-Expense menu, the Reviewer screen allows you to review, submit, approve 
and reject entries made by employees and vendors for various projects. 
 

 
 
The grid displays color-coded entries based on their status: Black for Billable, Red for Non-Billable and 
Blue for Billed. Security permissions restrict who sees bill and cost rates on the screen and in reports, as 
well as who can edit time and expense records should they need adjustment. You can double-click a time 
entry to open it in the Sheet View screen. 
 
Reviewer screen provides the Update Rates right-click menu option, which allows you to batch update 
the current bill rates of the selected time entries based on the updated Service Fee Schedule rates (or 
other rates as per the Rate Hierarchy). The right-click menu also gives you the option to edit the selected 
time or expense entry by opening it in the respective screen (Sheet View or Expense Log). 
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Notifying Managers 
 
Reviewers and managers need to leverage their time, whether they are in or out of the office. Rather 
than remembering to check for submitted time on the Company Navigator (Workflow section) or 
Reminder screen, BillQuick can notify managers proactively by email when someone submits time entries. 
 
To activate this feature: 
 

1. Log in to BillQuick as a reviewer and open the Preferences screen from the Settings menu. 
 

2. On the Notifications and Reminders panel, check ‘Email me when Time or Expenses are 
Submitted to me’.  
 

3. When your ‘email received’ indicator flashes, you can immediately log into BillQuick or Web 
Suite — in the office or on the road — and review, reject or approve time entries.  
 

 

Approving Time Entries 
 
BillQuick automatically routes time entries to the person responsible for reviewing and approving them. 
The next time a reviewer logs into BillQuick, it will remind him or her via the Reminders screen, 
Workflow section of the Company Navigator or email that time entries are waiting for review. 
Alternatively, a reviewer can use the Reviewer screen to view as well as approve time and expense 
entries for multiple projects, clients, etc. Managers can view and track the submit-approve status of all 
time, expense, invoice and other data in BillQuick from the Workflow screen. 
 

 Managers, directors and CEOs always want all their time to be approved. 
To approve time entries automatically for all users, check the auto-approve 
option on the Global Settings-Time/Expense screen. If you want to approve 
time entries only for a specific project, activate the ‘Auto Approval TE’ option 
on the Project-Detail screen.  

 
To approve submitted time entries: 
 

1. Open your Reminders screen. Double click on any item to open in the Sheet View screen. Else, 
directly open the Sheet View screen. 

 
2. On the Sheet View screen, check hours, bill rate, memos and other information as required. If 

you have appropriate security permissions, you can edit time entries (including bill and cost 
rates).   
 

3. Select the entries to be approved and click Approve.  
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4. If you want to send entries to another person for further review (a review chain), or you want to 
reject one or more entries, click Submit and choose the desired (Submit or Reject) option. When 
a reviewer approves or rejects a time entry, the BillQuick staff receives an email notification 
about it. 
 

 When you reject entries, you have the option of sending a message to the 
users. They will receive it the next time they log into BillQuick. The Workflow 
screen enables you to reference the rejected entries.  

 
8.  When you are done, click Close to exit. 

 

 For timekeepers to be able to approve their own time entries, they must 
have both ‘Allow to Approve time entry’ and ‘Allow Approve My time entries’ 
security permissions. 

 
 

Personal Time Off 
 
No more paper trails for requesting time off. BillQuick provides a feature that allows your employees to 
request time off and give your managers the tool to review these requests and take appropriate action. 
Supervisors or managers can approve it, reject it or forward it for further approval. Addition of personal 
time off (PTO) functionality to the time sheets simplifies the process of requesting and approving PTO. 
 
You can request Personal Time Off from various time and expense screens. Once requested, BillQuick 
notifies the approver or supervisor automatically about the PTO requests via BillQuick Messages or 
email. The Personal Time Off Review screen then allows the approver to take the appropriate action on 
it. 
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 The PTO feature is available in the BillQuick Enterprise edition only. 
 
This section covers the following tasks: 
 

 Requesting Personal Time Off 
 Approving Personal Time Off Request 

 
 

Requesting Personal Time Off 
 
To request time off: 
 

1.  Open the Personal Time Off Request screen from the Time-Expense menu. 
 

2.  Click New to create a new PTO request. 
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3.  In the Time Off Request section, specify your Employee ID in the Requested By dropdown. 
 

4.  Select the ID of the approver (or supervisor) in the Submit To dropdown. 
 

5.  Next, in the Time Off Period section, specify your From-To dates for which you want a time-off. 
It automatically calculates the Hours involved (you can even adjust them). 
 

 Employees need not worry about weekends. For the date range chosen, 
Hours includes only standard workdays. 

 
6.  You can propose what accumulated hours to use for the time off. In the Proposed Time Off 

Duration section, accordingly enter the Paid, Unpaid or Comp Hours. 
 

7.  Enter your reasons for the PTO request in the memo box at the bottom. 
 

8.  Click Submit. BillQuick sends the request to your approver via BillQuick Messages. It also 
prompts you to send it via email. 
 

 
 

9.  When you are done, click Close to exit. 
 

 You can set the option on the Preferences-Notification and Reminders 
screen to email you when the reviewer approves or rejects your PTO request. 

 
 

Approving Personal Time Off Request 
 
A reviewer or supervisor receives of personal time off requests in many ways. When you (manager) log 
in, the BillQuick Message Alert notifies you. Optionally, BillQuick will route messages to your email 
account. If you prefer using Reminders, the request will display there too. You can then review and take 
appropriate action on these requests.  
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 You can set the option on the Preferences-Notification and Reminders 
screen to email you when someone submits PTO request to you. 

 
To approve a PTO request: 
 

1.  Open your Reminders screen and double-click on the PTO request reminder awaiting you. Else, 
open the Personal Time Off Review screen from the Time-Expense menu. 
 

2.  On this screen, select the desired View by mode (say All Employees and Vendors). 
 

 
 

3.  Select the IDs in the From-To fields and the Period for which you are reviewing the requests. 
 

4.  Optionally, click on More Filters for further selective viewing of PTO requests (e.g., Un-
Approved Only). 
 

5.   You can see the PTO history for an employee. Review the records and make changes to 
requested hours or dates, if necessary.  
 

6.   Review the proposed distribution of PTO hours: Paid, Unpaid or Comp Time. Make changes if 
required. 
 

7.   You can read the Time Off Reason below and type your own notes in the Reviewer Notes box.  
 

8.  When ready to take action, select your records and click Action. From its dropdown, select the 
desired option, say Approve in this case. 
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9.  When you are done, click Close to exit. 
 

 You can also un-approve previously approved requests, forward them to a 
senior or project manager for final approval, or reject them. The entire submit-
approve process can be tracked from the Workflow screen.  

 
 

Time Settings 
 
Settings and rules related to time entries can be set at the company or global level and the project level. 
Project-level settings get precedence over the global settings.  
 

 Global Settings: related to time can be specified in the Company, Global Settings and 
Preferences screen. See Specifying Time and Expense Settings in the Company Management 
chapter for details. 

 Project Settings: related to time can be specified in the Project screen. See Project Setup in 
the Master Information Setup chapter and Project SettingsProjectSettings in the Project 
Management chapter for details.  

  
This section explains the following time-related settings: 
 

 Defining Smallest Time Increment 
 Setting Default Items 
 Restricting Time 
 Automatically Evaluating Time 
 Turning Off Time Entry Evaluation 
 Auto Filling Timesheets 

 
 

Defining Smallest Time Increment 
 
Minimum or smallest time increment for a time entry enables BillQuick to automatically adjust hours and 
time to the next time increment specified by you. To do so: 
 

1.  Open the Global Settings screen from the Settings menu or toolbar. Select the Time/Expense 
option on the left. 
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2.  Enter the value for the ‘Smallest time increment for Time Entry(s)’, e.g., 15 minutes or 0.25 
hours. 
 

3.  Enter the value for ‘Smallest Time Increment for Start and Stop Time’. For instance, value of 15 
means increments of 15 minutes, i.e. 12:00, 12:15, 12:30 and so on display in the Start/Stop 
drop-downs. 
 

4.  When you are done, click Save and then Close to exit.  
 
These settings will reflect in all your time entry screens: Sheet View, Calendar View, Simple Time Card 
and Timer. 
 
 

Setting Default Items 
 
Default project and activity codes can be set for recording a time entry.  
 

1. Open the Sheet View screen. Click the More tab. 
 

2. In the ‘Use My Default’ section, select the Activity Code and Project ID from the drop-down 
lists. Setting a default saves time when most new time entries involve the same activity or same 
project. 
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3. If desired, enter the Default Start Time and Default End Time for the time entry. BillQuick pre-
fills your time records with this time; however, you can change it there. 
 

4. Check the ‘Use Military Time’ option if you prefer to display the time in a 24-hour period format, 
e.g., 8:00 and 17:00 to indicate 8 am and 5 pm. 
 

5. Check the ‘Remember Grid Sort Order’ option to remember the sort order (of drop-down lists 
by ID, name/description or original order of entry) between sessions. 
 

6. Check the ‘Show Control Hours’ option to display the Control Hours field on the Sheet View 
tab. 
 

7. The ‘Show Vendors’ option adds vendors to the employee drop-down lists. BillQuick labels 
vendors with a ‘Sub’ tag to differentiate them from the employees. 
 

8. When you are done, click on the Sheet View tab and start entering your time. BillQuick will pre-
fill the fields with your default values. 

 
 

Restricting Time 
 
You can restrict time entry to projects using Project Control or Employee Control feature. In addition, 
you can link a budget to a project and use it to restrict time entry recorded against it. Project Control 
screen gives you the ability to restrict time entry by assigning activities to specific projects. (You can create 
a Project Control from a budget.) Similarly, Employee Control screen gives you the ability to restrict time 
entry by assigning activities to specific employees. 
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 The settings in the Project Control override those in the Project screen, 
while settings in the Employee Control override those in the Project Control. 

 
To restrict time entry through a budget: 
 

1. Open the Project screen. Select a project from the grid. 
 

2. Click on the Billing tab. Select a Budget from the drop-down list. 
 

3. Move to the Detail tab. To restrict time entry by a budget, select the ‘Budgeted Activities Only’ 
option from the Rules dropdown list. 

 
4. When you are done, click Save and then Close to exit. 

 
Now, whenever you enter time for this project, you can see only budgeted activity codes in the drop-
downs. 
 
To restrict time entry through Project Control: 
 

1. Open the Project Control screen from the Project menu. Select a Project ID.  
 

 
 

2. Select the Activity option. All the activities in the BillQuick database display in the Available Items 
list.  
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3. Choose the activities that you want to keep available for the selected project and move them to 

the Assigned Items list using . 
 

4. Click Close to exit.  
 
Now, whenever you make time entries for this project, you can see only assigned activity codes in the 
drop-downs. 
 

 Using the Allocate screen, you can allocate hours to an employee-activity 
combination. This will restrict the same employee from exceeding the specified 
number of hours when making time entries. 

 
To restrict time entries through Employee Control: 
 

1. Open the Employee Control screen from the Settings menu.  
 

2. Select an Employee ID from the dropdown. 
 

 
 

3. On the Assign tab, select the Activity option. All the activities in the BillQuick database display in 
the Available Items list.  
 

4. Choose the activities that you want to keep available for the selected project and move them to 
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the Assigned Items list using . 
 

5. Click the Security tab. Un-check the Time Entry Screen and Timer options (or all, if desired) to 
enable employee control settings. 
 

 You can also use the Security screen to uncheck ‘Disable Employee 
Control’ permission for all BillQuick modules at once by clicking ‘Turn on 
Employee Control’ option. 

 
6. When you are done, click Save and then Close to exit. 

 
Now, whenever an employee enters time, he or she can see only assigned activity codes in the drop-
downs. 
 

 Using the Allocate screen, you can allocate hours to a project-activity 
combination. This will restrict the same employee from exceeding the specified 
number of hours when making time entries.  

 
 

Automatically Evaluating Time 
 
BillQuick does not prevent you from accumulating time above the contract amount. Nor are you 
prevented from billing more than the contract amount for a fixed-type contract. However, BillQuick 
does apply a Red Flag Rule to all time entries. The rule checks time charged to fixed-type contracts 
(except Percentage) to determine if it goes beyond the contract amount. If it does, BillQuick changes the 
status of the entry to ‘non-billable’. It is called the Red Flag Rule because non-billable items display in red 
text, drawing the attention of employees and project managers. With appropriate security permissions, 
you can change the status back to ‘Billable’ and bill it to the client.  
 
The rule recognizes managers are busy and at times may miss something. Rather than inadvertently over-
bill clients and likely lose them, the red flag prompts you to check the non-billable item. 
 

 Special rules allow you to override the Red Flag Rule, as well as to apply 
rules that prevent additional time entry. Check Project and Global Settings.  

 
 

Turning Off Time Entry Evaluation 
 
You can turn off time entry evaluation in BillQuick at the project-level or company-level. To do so: 
 

1.  Open the Project screen. Select the desired project. 
 
2.  Move to the Detail tab, Rules section. 

 
3.  Select the ‘Skip Automatic TE Eval’ option from the Rules dropdown list. BillQuick will skip 

performing the automatic time entry evaluation for the selected project. 
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4.  Click Save and then Close to exit. 
 
5.  Optionally, open the Global Setting-Time/Expense screen. 

 
6.  Check the ‘Skip Time and Expense Evaluation’ option. BillQuick will not perform time entry 

evaluation for all users in the company. 
 

7.  When you are done, click Save and then Close to exit. 
 
 

Auto Filling Timesheets 
 
BillQuick includes ways to save time recording hours worked. For example, many staff and managers 
work on the same projects every day and from one week to the next. The only data that changes is the 
date.  
 
The Simple Time Card or Calendar View screen is a weekly timesheet. You select the project and activity 
and then enter the hours worked on a particular day. Simple and fast. However, there is a way to speed 
up entry even more. When you work on the same projects from one week to the next, BillQuick’s Auto-
fill feature carries forward projects and activities from one week to the next. In other words, BillQuick 
pre-fills the timesheet based on the last projects you worked on. You can even control how many items 
carry forward to a new timesheet. However, the auto-fill feature filters the list based on the Employee 
Control settings, if any. 
 
To do so: 
 

1. Open the Preferences screen and select Options. 
 

2. For the Auto-fill Simple TE and Cal View option, click the drop-down and select how many 
projects to auto-fill. 
 

3. When you are done, click Save and then Close to exit. 
 

 Remote time and expense capture modules include Web Suite (browser-
based, Internet or intranet) with the BillQuick Mobile feature (web-enabled 
PDA or cell phone). BillQuick Outlook Add-In reads Microsoft Outlook data 
and turns it into BillQuick time entries. 
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Overview 
 
BillQuick specializes in time and expense tracking and hence includes various ways to capture expenses. 
Depending upon your preferences, you can choose the frequency and method of capturing expenses for 
accurate billing and reporting. This section primarily addresses the concerns of timekeepers and 
reviewers. 
 
 Expense entry requires input from master information in BillQuick. Employees or vendors charge 
expenses against projects.  Expense is captured according to the rules and settings specified in 
BillQuick, whether in Global Settings, Preferences, Company, Client or Project screen.  
You can record expense entries in any screen that suits you- Expense Log or Simple Expense Log. In 
addition, several add-on modules (Web Suite, Outlook Add-In, etc.) allow you to capture expenses 
incurred anytime, anywhere.  Regardless of the internal or add-on module used to capture expenses, 
BillQuick can automatically track expenses to ensure timely and complete entries from timekeepers.  
They submit these entries to the designated reviewer in the company for review and approval. The 
reviewer may reject some entries due to any reason and re-send them to the timekeeper via BillQuick 
Messages. The timekeeper can edit and re-submit them. You can track all these submit-approve events 
from the Workflow screen.  On the other hand, the approved expenses along with the approved time 
become the work-in-progress, ready to bill. 
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Expense Entry 

Area Decision Where to implement 

Historical Expenses Ensure you have billed all expenses in your old 
system. Enter summary expense entries in BillQuick, 
if desired. 

Expense Entry screens 

Smart Expense 
Entry Evaluation 

Activate built-in intelligence wherein BillQuick 
monitors whether an expense entry should be 
billable or non-billable. 

BillQuick Start-Up Interview 
Global Settings-
Time/Expense screen 

User Interface Change the colors used to visually identify billable, 
billed, unbilled and non-billable expense entries 

Preferences-Format screen 

Workweek Specify ‘First Day of the Week’ date settings. BillQuick Start-Up Interview 
Global Settings-Options  

Timekeepers Set up employee as a BillQuick User with proper 
security permissions. Employees have to enter their 
own expenses in BillQuick.  

Employee screen 
Security screen  

Set up employee as a User for relevant BillQuick add-
on module. Employees remotely enter their own 
expenses using Web Suite or Outlook Add-In.  

Employee screen 
Product Licensing and User 
Management screen 

Set up vendor as a BillQuick User with proper 
security permissions. Vendors or sub-consultants 
have to enter their own expenses in BillQuick.  

Vendor screen 
Security screen 

Set up vendor as a User for relevant BillQuick add-on 
module. Vendors remotely enter their own expenses 
in Web Suite or Outlook Add-In.  

Vendor screen 
Product Licensing and User 
Management screen 

Set up employee as a BillQuick User with proper 
security permissions. This employee has to enter 
expenses for all other employees/vendors in 
BillQuick. 

Employee screen 
Security screen 

Expense Entry Set standard shorthand codes to describe an 
extended memo or note when recording an expense 
entry.  

Auto Complete screen 

Control how far in the past or future a timekeeper 
can record an expense entry. 

Global Settings-
Time/Expense screen 

Expense Entry 
Approval 

Company does not approve individual expense 
entries. 

Global Settings-
Time/Expense screen 
Project screen 

Assign Manager for expense entry approval. Expense 
entries are to be approved by a direct supervisor or 
manager of the employees. 

Employee-General screen 

Assign Manager for expense entry approval. Expense 
entries are to be approved by a manager responsible 
for client relationships. 

Client-General screen 

Review and/or approve expense entries. Set proper 
security permissions. 

Security screen 
Expense Entry screens 
Reviewer screen 

Vendor Bills Set up a vendor profile and record related expenses. 
Vendor or sub-consultant submits invoices containing 

Vendor screen 
Expense Log screen 
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detailed or summary time and expenses. Vendor Bills screen 

 
 

Expense Entry 
 
BillQuick STRONGLY recommends that you record all expenses whether they are billable or not. This 
includes overheads, marketing and other expenses. If you do not track non-billable expenses, you cannot 
effectively measure performance, utilization and profitability.  
 
Your expense entry options include: 
 

 Expense Log – If you enter expenses for others or review entries, then use this 
flexible, customizable spreadsheet-like expense entry screen. 

 Simple Expense Log – If you incur three, four or five expenses regularly during a day, 
then use this efficient, quick-to-enter expense sheet screen.  

 Web Suite – You may have remote offices, staff and managers who work on the road 
or from remote sites. In such cases, use this web-based module on laptops and smart 
phones to capture time and expenses. 

 

 You can turn on/off columns/fields using the  Field Chooser. You can 
customize the grid according to your preferences. 

 
This section covers the following expense entry tasks: 
 

 Expense Log 
 Simple Expense Log 
 Determining Expense Cost and Amount 
 Tracking Overhead Expenses 
 Filtering Items 
 Batch Changing Expense Entries 
 Deleting Expense Entries 

 
 

Expense Log 
 
Expense Log provides a flexible and efficient environment for entering and reviewing expense records. 
You can turn on/off approval, editing, displayed columns, totals, filters, and other options as desired. 
Numerous security permissions ensure effective control over what a timekeeper is able to do in this 
screen. The right-click menu provides access to multiple BillQuick features. 
 
You can perform the following tasks in the Expense log screen: 
 

 Recording Expenses in Expense Log 
 Copying and Pasting Expense Entries 
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Recording Expenses in Expense Log 

 

 You can record your expense entry at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Expense Entry 
 
To enter expenses: 
 

1. Open the Expense Log screen from the Time-Expense menu, toolbar, Sidebar or navigator.  
 

2. In the key fields above the grid, select ‘Employee’ from the View By drop-down list. Press Tab or 
click to move to the Employee field. Enter or select an ID.  

 

 
 

3.  Tab through the Period field (you can enter expenses for any date irrespective of what you select 
here). In the ‘Period Including’ field (not visible when All is selected), you may enter the date of the 
first expense you plan to record. 
 

4.  Click Refresh. If previous entries display, click New to jump to the last row. 
 
5. In an empty row, click the Date field. Enter the month, day and four-digit year of your first 

expense entry. You can also select a date from the calendar.  
 

 Notice that the field background changes to yellow, and the font increases 
in size, thus making it easier to view the data. 
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6. In the next field, enter a Project ID against which to charge the expense. You can also select it 
from the drop-down list.  

 
7. Enter the Expense ID in the next field or select one from the drop-down list.  

 
8.  Press Tab to move to the Description field. BillQuick fills the description automatically from the 

expense record. However, you can edit it. 
 
9. The Cost (per unit) field is auto-filled. It can be the standard cost rate or special rate, as per the 

Rate Hierarchy. You can accept it or enter a new one.  
 

 A negative Cost or Markup can be entered if you want to reduce the 
expense Amount to be billed to the client, discount the expenses or for any 
other purpose. 

 
10.  To save the new entry, Tab through the remaining fields in the row or click on another row (a 

beep confirms that). You are done! 
 
Advanced Expense Entry 
 
To add or view additional information: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. Check the ‘Cost Includes Purchase Tax’ option if your cost amount includes the tax paid by you 
on purchases/expenses.  

 

 BillQuick uses the Purchase Tax Rate to segregate the actual cost and tax 
amount (Cost Amount = Net Cost Amount + Purchase Tax Rate). You can use 
this option to prevent billing the client with doubly taxed expenses. 

 
3. Enter the Units for the expense. If the expense is a flat amount, skip this field. BillQuick defaults it 

to 1.  
 

4. BillQuick pre-fills the Purchase Tax field from the Expense Codes screen, if available. If not, 
specify how much tax you paid for that expense. It deducts this amount from the Cost Amount 
before charging a client. 
 

5. Accept or enter the mark-up percentage in the MU field. It defaults from the expense record but 
you can edit it here. 
 

 A Markup can be entered as a percent (default), dollar amount (e.g., $10 
with the dollar sign) or skip it. You may enter a higher or lower Amount and 
BillQuick will reverse calculate the markup. You can even enter a negative 
markup to reduce the charge amount. 

 
6. Tax 1/2/3 rates carry from the Expense Codes record or the EFS assigned to the project. Security 



Expense Tracking 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 347 

permission is required to edit it. When you define taxes, the ‘Tax’ option is checked. See Taxes in 
the Billing Basics chapter for details. 

 

 The Amount field contains the charge amount of the expense entry. It is 
calculated as: [Cost Amount x (1 + Markup)] x [1 + (Tax 1 + Tax 2 + Tax 3)]. 
For example, if Cost Amount is $15, Markup is 10%, and Tax 1 is 8%, the 
Charge Amount is $17.82. BillQuick subtracts the Purchase Tax from the Cost 
Amount to avoid doubly taxing the client. 

 
7. When checked, the ‘B’ status flag indicates the expense is billable. Billable status defaults from the 

expense code record but you can change it here with appropriate security permissions. 
 

8. Check the ‘R’ reimbursable flag to indicate that the expense is reimbursable to the employee. 
This status defaults from the expense code record but you can edit it here. 
 

 The ‘Created On’ column is automatically filled with the system date when 
a new expense entry is recorded (saved in GMT). You can use this field to sort 
the grid based on the date you record the expense entry or to trace the order 
of entering expense entries. 

 
9. Mark expenses as extra if you do not want to count them against the Contract Amount, rather 

want to bill them in addition to it. BillQuick checks this option automatically for billable expenses 
if the ‘Expense Part of Contract’ rule is set to false (unchecked) in Project-Detail screen. 

 

10. Click  Link Files (when Memo box is open) or right-click on any entry to link a file to the 

expense entry. The grid displays  in the Attachment (F) column to indicate entries having files 
attached to them. 

 
11. Check the Flag 1/2/3 fields for an entry that possesses any special attribute for tracking or 

reporting purposes. For example, a flag may indicate that an expense entry charged to the 
company’s Overhead project is tax deductible.  
 

12. If desired, edit the pre-filled Classification for the employee. See Determining Rates for more. 
 

 While fetching a classification, BillQuick will look for it in the following 
order: Expense Fee Schedule, Project Control or Employee screen (Title). 

 
13. Click Tools and select Spell Check to perform a global spell-check of the memo as well as other 

grid text. 
 

14. Click Auto toggle button to turn on/off auto refresh. If on, BillQuick refreshes the grid 
automatically whenever you make changes to a key field. 

 
To add an expense memo: 
 

1. Press Ctrl + M to jump into the Memo box directly from the grid. Enter as much text as you 
want to describe the expense and related events.  
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2. When you are done, press Ctrl + M to return to the grid. When you attach a memo to an 
expense, the ‘M’ box in the grid is checked. 
 

 Using the Memo toolbar, you can cut, paste, change font size, and add 
bold, italic and underline attributes. You can even perform a spell-check, insert 
date-time stamp and create Auto Complete codes. 

 
3. Check the ‘Memo on Journal’ option if you want to add the memo to the expense entry as a 

journal note. 
 

4. By default, BillQuick includes and prints memos on detailed invoice formats. If you want that, 
keep the ‘Memo on Invoices’ option checked. 
 

5. Custom 1/2/3 fields allow you to record additional information about an expense entry (up to 50 
characters).  
 

 The Custom Fields 1/2/3 of expense code will pre-fill the expense entry 
custom fields and inherit the same data type. 

 
To submit expense entries: 
 

1. On the grid, ‘S’ field indicates the Submit-Approve status of an expense entry. The status is 
indicated by an icon:  

[blank] Not submitted    Submitted    Forwarded    Approved    Rejected 

 
2. Select expense records to submit on the grid. 

 
3. Click Submit. It opens the Submit-Approve screen from where you can submit them to the 

desired person. See Submit-Approve below for details. 
 

To edit expense entries: 
 

1. Select the expense records to be changed. 
 

2. Click Tools and select Change to launch the Expense Entry Change screen, which allows you to 
modify multiple expense records at once. (See Batch Changing Expenses below for more.) 
 

3. When you are done, click Close to exit. 
 

 

Copying and Pasting Expense Entries 
 
BillQuick includes ways to save time recording expenses incurred. For example, many staff and managers 
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work on the same projects every day and from one week to the next. Usually, the only data that changes 
is the date.  
 
BillQuick allows you to copy selected expense entries and paste them with/without modifications in the 
expense entry grid. Result: You have more hours for billable and productive work. 
 
To copy and paste expense entries: 
 

1. Open the Expense Log screen. 
 

2. Select the expense record(s) in the grid that you want to copy.  
 

3. Click the Copy option at the bottom of the screen.  
 

4. Select the next empty row and then click the Paste option (or use the right-click menu or Edit 
menu).  
 

5. Optionally, use the Paste Special option to paste your entries. It allows you to modify the Date, 
Project ID, Group, etc. of the new entries. 
 

6. On the Paste Entries dialog, check the ‘Increment expense entry date by’ option and enter ‘7’. 
BillQuick increments the entry dates by seven days.  
 

 
 

7. Click OK and you are done!  
 

New expense entries are added to the grid, exact duplicates of the original except the date has been 
changed. 
 

 BillQuick can copy a maximum of 50 expense entries at once. 
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Simple Expense Log 
 
Simple Expense Log presents an easy-to-use expense sheet for recording expenses on a weekly basis.  
 
 

Recording Expenses in Simple Expense Log 
 

 You can record your expense entry at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Expense Entry 
 
To enter expenses: 
 

1. Open the Simple Expense Log screen from the Time-Expense menu or toolbar. 
 

2. You can choose to enter expenses in the View By: Employee or Vendor mode. Employee is the 
default selection when you open this screen, so stay in this view for now. 
 

 
 

3. Select an Employee (or vendor) from the drop-down list.  
 

4. Enter a date (week) in the ‘Period Including’ field. Else, select it from the dropdown calendar. 
 

5. Choose either Show Amount or Units option, depending upon how you enter expenses.  
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 BillQuick calculates the Cost Amount based on the Expense Codes value, 
while assigning a value of one to the units. If the Cost Amount is zero in the 
Expense Codes screen and you are entering units, then upon save SEL switches 
to Amount mode and warns you about the zero-cost items. 

 
6. In the grid, select the desired Project ID. Tab or click to move to the next field. 

 
7. Enter or select the Expense from the dropdown. BillQuick brings forward the expense 

Description from the Expense Codes screen; however, you can edit it here. 
 

8. Next, enter the expenses in units or amounts in the appropriate day/date columns.  
 

 Weekend dates display only if you turn them on by clicking Tools and un-
selecting Hide Weekend. 

 
9. The Total amount or units recorded per project or employee display. Click Save and you are 

done! 
 
Advanced Expense Entry 
 
To add or view additional information: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. Check the ‘Amount Includes MET’ option if you want to include the Main Expense Tax with the 
cost amount. BillQuick reverse calculates the MET to segregate the actual Cost Amount and 
MET applied. 
 

3. If you prefer, display the Project Name in the grid and select it while entering expenses instead of 
a Project ID. 
 

4. Click  Link Files or right-click and select that option from the menu if you want to link any file 
to the expense entry (such as receipts, bills, etc.). 
 

5. Click Tools and select Spell Check to perform a global spell check on the descriptions and 
memos for all expense entries in the grid. 

 
To add an expense memo: 
 

1. Press Ctrl + M to open the Memo box from the grid or click  at the bottom. Enter as much 
text as you wish. 
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2. Press Ctrl + M again to return to the grid. (You can spell-check, edit or date-time stamp your 
expense memo, if desired.) 
 

3. Check the ‘Memo on Journal’ option if you want to add the memo to the expense entry as a 
journal note. 
 

4. By default, BillQuick includes and prints memos on detailed invoice formats. If you want that, 
keep the ‘Memo on Invoices’ option checked. 
 

To submit expense entries: 
 

1. Select entries to submit on the grid. 
 

2. Click Submit. It opens the Submit-Approve screen from where you can submit them to the 
desired person. See Submit-Approve below for details. 
 

3. When you are done, click Save and then Close to exit. 
 
 

Determining Expense Cost and Amount 
 
BillQuick calculates the cost and amount of expense entries in the following way: 
 

1. Open the Expense Codes screen. 
 

2. Select an existing expense item or enter a new one.  
 

3. Enter new or review existing values in the Cost, MU% (markup), Tax 1/2/3 and Purchase Tax 
fields. 
 

4. Save data and click Close to exit. 
 

5. Open the Expense Log screen. Create an expense entry using the above expense code. 
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6. Enter a value in the Units field. The Cost, MU and Tax 1/2/3 fields are pre-filled with the Expense 
Codes values. You can enter negative values for Cost and Markup to reduce the charge amount. 
 
BillQuick calculates the Cost Amount (Cost x Units). The total Amount to be charged is 
computed as:  

 
  [Cost Amount x (1 + MU)] x [1 + (Tax 1 + Tax 2 + Tax 3)] 

 

 When calculating Charge Amount, BillQuick subtracts the Purchase Tax 
(paid on expenses) from the Cost Amount to avoid doubly taxing the client. 

 
 

Tracking Overhead Expenses 
 
In many companies, you have to keep track of internal activities and expenses, even though they may be 
non-billable. You may want to track overhead expenses like administrative expenses, training, research, 
marketing costs, etc.  In any case, time and expenses flow to the project, allowing you to track utilization 
of all employees and, both billable and non-billable expenses –whether you incur them for a revenue 
project or an in-house overhead project. 
 
BillQuick requires you to set up projects with some required data such as client, manager, contract type 
and so on. An overhead project will require you to set up your company as a ‘client’ and then assign the 
overhead project to it. 
 
To track overhead expenses: 
 

1. In the Client screen, set up a client record for your company, say ‘My Company’. 
 

2. In the Project screen, set up a project for general office expenses, say ‘General Office’ or 
‘Overhead’. 
 

3. Assign the client, ‘My Company’ to this project. 
 

4. Next, assign the owner/principal/manager of your firm (whoever checks and approves general 
office time and expense) as the Project Manager. 
 

5. Select Overhead as the Contract Type and set the Status to ‘Active’. 
 

 Overhead contract type triggers a business rule to flag all time and 
expenses charged to an overhead project as non-billable, regardless of the 
expense code’s default status. 

 
6. Now you can record your expense entries against this ‘General Office’ or ‘Overhead’ project 

with any general office expenses.  
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Filtering Items 
 
While making an expense entry, you can filter various items in the grid and dropdown lists. To do so: 
 

1.  Open the Expense Log screen. 
 

2.  Select View By: Employee and select the desired Employee from the drop-down list. 
 

3.  On the Filters tab, click on the desired filter- Project, Employee, Expense, group, or any other 
option. 
 

 
 

4.  Select the relevant items from the grid and then click on the filter again. BillQuick filters the 
selected items and marks the checkbox next to the filter. 
 

5.  Optionally, check or select the other available options to filter items based on Bill Status, 
Contract Type, etc. 
 

6.  Move to the Log tab and click Refresh. Make sure to click the main Filters on/off button. 
 

Now you can view only the selective items, thus shortening the lists and making the expense entry or 
review process faster. 
 
 

Batch Changing Expenses 
 
Errors, late updates to expense fee schedules, changes in project or expenses, and other situations can 
result in the need to change multiple expense entries. Modifying them one-by-one is time-consuming and 
increases the risk of introducing new errors. BillQuick allows you to batch modify entries for 
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straightforward A-to-B changes.  
 
To make batch changes:  
 

1. Open the Expense Log screen.  
 

2.    On the Log tab, select Project or Employee for the View By field. Your choice depends on which 
will best populate the grid with the expense entries you want to change.  
 

3.  Accordingly, select the Project or Employee ID, Period and Period Including for your situation. 
Click Refresh to populate the grid with expense entries. 
 

4.    In the grid, select the expense entries you want to change. Then click Tools and select Change. 
 
5.    On the Change screen, enter new values or select them from the drop-down list to replace the 

current values. E.g., you may change the Project, Memo and Markup to something else. 
 

 
 

6.  Change the flag or option to True/False to replace the status, as desired. 
 

7.  The checkbox is marked when you enter a new value. Click OK to apply the changes.  
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8.    When you are done, click Close to exit. 
 
 

Deleting Expense Entries 
 
To delete an expense entry: 
 

1. Open Expense Log from the Time-Expense menu, toolbar, Sidebar or navigator.  
 

2. Select View By: Project or Employee, then select the desired project/employee.  
 

 
 

3. Next, move to the Period field and select the desired option. Click Refresh to display expense 
entries for the project.  
 

4. Click Select and choose Select All option if you want to delete all expense entries displayed in the 
grid. Else, select the desired row(s) manually. 
 

5. Right-click and select Delete to delete the selected records.  
 

6. When you are done, click Close to exit.  
 

 You can clear the SEL grid of the previously used projects. Click Tools and 
select Clear to clear rows with no values. 
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Submit-Approve 
 
BillQuick’s built-in submit-approve features enable timekeepers to follow company policy and submit 
expenses to a client manager, project manager, employee manager or a specific person. Once submitted, 
BillQuick notifies the manager or reviewer concerned about those entries via the Reminders, Company 
Navigator or email.  
 
A chain of reviewers can check time and expenses before a final reviewer approves them. You must 
review time and expense entries no less than once a week to avoid write-offs due to fuzzy memories. 
Sometimes this process is called ‘posting’ or ‘releasing work-in-progress’. Only approved expenses are 
available for billing even though you may charge them against a budget or contract amount (if made a part 
of it). 
 

 You can track the entire submit-approve process for expense entries from 
the Workflow event-tracking screen.  

 
This section covers the following tasks: 
 

 Submitting Expense Entries 
 Reviewing Expense Entries 
 Notifying Managers 
 Approving Expense Entries 
 Approving Time and Expenses Together 

 
 

Submitting Expense Entries 
 
For a company that follows a submit-review-approval process, BillQuick’s built-in workflow makes the 
process easy and fast. Timekeepers generally submit their expense entries to a reviewer, who might be a 
project manager or BillQuick Supervisor. 
 
BillQuick prompts you automatically for submission of new expense entries if you have set that option in 
Global Settings. When ignored, a BillQuick message or reminder displays upon login to remind you about 
the submission. 
 
To submit expense entries:  
 

1. Open any expense entry screen: Simple Expense Log or Expense Log. 
 
2.  Select the expense entry rows that you want to submit to a particular reviewer. BillQuick will 

submit all selected rows to the same person. 
 

3.  Click Submit to open the Submit-Approve screen.  
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4.    Select to whom you want to submit your entries. Commonly, you submit expenses incurred on a 

billable project to a Project Manager or Client Manager. You may submit non-billable expenses 
charged to the Overhead and Marketing projects to a Specific person or My Manager (your direct 
supervisor). Your BillQuick Supervisor will provide the submission instructions.  
 

5.  In the Workflow Type, specify the type of submission-whether Billing, Payroll or both. 
 

6.  Optionally, enter an unlimited length Memo. 
 

7.  Click OK and you are done! 
 
 

Reviewing Expense Entries 
 
Expense entries can be viewed in any of the expense entry screens-Expense Log or Simple Expense Log. 
You can also review both time and expense entries in the Reviewer screen. A project manager primarily 
performs this function but a billing manager or BillQuick Supervisor may also do it. 
 
To review expense entries: 
 

1. Open any expense entry screen, preferably Expense Log. 
 

2. You can view the expense information in the View By: Project/ Employee/ Vendor mode. 
Employee is the default selection, but you can choose Project for now. 
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3. Accordingly, select the Project whose expense records you want to review.  
 

4. In the Period and Period Including field, enter the date of the expense entries you want to view.  
 

5. Click Refresh. All the expense entries meeting your criteria display in the grid. 
 

6. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

7. You can scan the list of entries and instantly know their status by the color of the text: 
 

 Billable – Black text 
 Non-Billable – Red text 
 Billed – Blue text  

 
BillQuick shows the percentage of billable expenses displayed in the grid. For example, by 
selecting View By: Project and ‘All’ for Period, you can quickly view billable expenses charged to-
date to a project. Similarly, selecting View By: Employee and ‘Year’ for Period shows the billable 
expenses recorded by an employee year-to-date. Filters can further refine the displayed records. 
This information may show patterns that impact future project budgeting and bidding as well as 
company policies. 

 
8. Review, edit or approve entries, as required. When you are done, click Save and then Close to 

exit. 
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To review expense entries in the Reviewer screen: 
 

 The Reviewer screen is available in the BillQuick Enterprise edition only. 
 
Accessible from the Time-Expense menu, the Reviewer screen allows you to review, submit, approve 
and reject entries made by employees and vendors for various projects. 
 

 
 
The grid displays color-coded entries based on their status: Black for Billable, Red for Non-Billable and 
Blue for Billed. Security permissions restrict who sees the bill and cost rates on the screen and in 
reports, as well as who can edit time and expense records should they need adjustment.  
 
Reviewer screen provides the right-click menu options to edit selected expense entry by opening it in the 
Expense Log screen. You can also double-click the entry to do so. 
 
 

Notifying Managers 
 
Reviewers and managers need to leverage their time, whether they are in or out of the office. Rather 
than remembering to check for submitted expenses on the Company Navigator or Reminder screen, 
BillQuick can notify managers proactively by email when someone submits expense items. 
 
To activate this feature: 
 

1. Log in to BillQuick as a reviewer and open the Preferences screen from the Settings menu. 
 

2. On the Notification and Reminders panel, check ‘Email me when Time or Expenses are 
Submitted to me’.  
 

3. When your ‘email received’ indicator flashes, you can immediately log into BillQuick or Web 
Suite — in the office or on the road — and review, reject or approve expenses.  
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Approving Expense Entries 
 
BillQuick automatically routes expense entries to the persons responsible for reviewing and approving 
them. The next time they log into BillQuick, BillQuick reminds them via the Reminders screen, Workflow 
section of the Company Navigator or email that expense entries are waiting for review. 
 

 Managers, directors and CEOs always want all their expenses to be 
approved. To approve expense entries automatically for all users, check the 
auto-approve option on the Global Settings-Time/Expense screen. If you want 
to approve expense entries only for a specific project, activate the ‘Auto 
Approval EL’ option on the Project-Detail screen for the desired project.  

 
To approve submitted entries: 
 

1. Check out your Company navigator for submitted expenses. Double click on any item to open it 
in the Expense Log screen. Else, directly open the Expense Log screen. 

 
2. On the Expense Log screen, check units, costs, memos and other information as required. If you 

have appropriate security permissions, you can edit expense entries.   
 

3. Select the entries to be approved and click Approve. Else, click Submit to open the Submit-
Approve screen. 

 

 
 

4. If you want to send entries to another person for further review (a review chain), choose the 
Submit To option. 
 

5. If you want to reject one or more entries, choose the desired option –Reject or Un-Submit. Click 
OK. 
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 When you reject entries, you have the option of sending a message to the 
users. They will receive it the next time they log into BillQuick. The Workflow 
screen enables you to reference the rejected entries.  

 
6. When you are done, click Close to exit. 

 

 For timekeepers to be able to approve their own expense entries, they 
must have both ‘Allow to Approve expense entry’ and ‘Allow Approve My 
expense entries’ security permissions. 

 
 

Approving Time and Expenses Together 
 
You can submit and approve time and expense entries from the individual time and expense entry 
screens. However, BillQuick reduces this task by providing the Reviewer screen wherein you can view 
and approve billable time and expense entries-all in one screen! 
 
BillQuick automatically routes submitted time and expense entries to the person responsible for 
reviewing and approving them. The next time they log into BillQuick, it reminds them via the Reminders 
screen or the Workflow section of the Company Navigator that they have time and expense entries 
waiting for review. 
 
To approve time and expense entries together:  
 

1. Open the Reviewer screen from the Time-Expense menu.  
 
2.    On the Reviewer screen, select the relevant View By mode. If you are a project manager, you 

may want to view all entries by your designated projects. Hence choose View By: Project and 
then select the desired project(s) in the From-To fields.  
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3.    Next, select the Period and Period From-To dates for the review.  
 
4.  From the More Filters drop-down list, select ‘Un-Approved Only’ and ‘Un-Billed Only’. Else, use 

the funnel filters for selective viewing of data in the grid. 
 

5.    Click Refresh to apply the criteria in the key fields to the BillQuick database. All matching records 
display in the grid. To turn on Auto-Refresh, click Auto.  

 
6.    Check and edit the entries for hours/units, bill rates, memos, WUD, MU, charge amount and 

other information. (You can double-click an entry to open it in the respective Sheet View or 
Expense Log screen.) 
 

 BillQuick calculates Cost Amount as Hours x Cost Rate or Units x Cost 
Rate, and Charge Amount as [Cost Amount x (1 + Markup)] x [1 + (Tax 1 + 
Tax 2 + Tax 3)]. 

 
7.  Click Tools and select Spell Check to check the spelling of the time and expense records and 

their memos.  
 

8.    Select the rows or entries to approve and then click Approve. Else, click Submit to open the 
Submit-Approve screen. 
 

 
 

9.  If you want to send entries to another person for further review (a review chain), click Submit To 
option. 
 

10.  If you want to reject one or more entries, choose the desired option –Reject or Un-Submit. Click 
OK. 
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 When you reject entries, you have the option of sending a message to the 
users. They will receive it the next time they log into BillQuick. You can 
reference the rejected entries in the Workflow screen. 

 
11. When you are done, click Close to exit. 

 
  

Expense Settings 

 
Settings and rules related to expense entries can be set at the company or global level and the project 
level. Project-level settings get precedence over the global settings.  
 

 Global Settings: related to expenses can be specified in the Company, Global Settings 
and Preferences screen. See Specifying Time and Expense Settings in the Company 
Management chapter for details. 

 Project Settings: related to expenses can be specified in the Project screen. See Project 
Setup in the Master Information Setup chapter and Project Settings in the Project 
Management chapter for details.  

  
This section covers the following expense-related settings: 
 

 Setting Default Items 
 Restricting Expenses 
 Automatically Evaluating Expenses 
 Turning Off Expense Entry Evaluation 
 Auto-filling Expense Log 

 
 

Setting Default Items 
 
Default project and expense codes can be set for recording an expense entry.  
 

1.  Open the Expense Log screen. Click the More tab. 
 
2.  In the ‘Use My Default’ section, select the Expense ID and Project ID from the drop-down lists. 

Setting a default saves time when most new expense entries involve the same expense to the 
same project. 
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3.  Check ‘Remember Grid Sort Order’ option to sort lists by ID, name/description or original order 

of entry. BillQuick remembers the sort order between sessions. 
 

4.  Check the ‘Show Vendors’ option to display vendors in the employee drop-down lists. The ‘Sub’ 
tag in the list differentiates vendors from employees. 
 

5.  Click on the Log tab and start entering your expenses. BillQuick pre-fills the fields with your 
default values. 
 

6.  When you are done, click Close to exit. 
 
 

Restricting Expenses 
 
You can restrict expense entry to projects using Project Control or Employee Control feature. In 
addition, you can link a budget to a project and use it to restrict expense entry recorded to it. Project 
Control screen gives you the ability to restrict expense entry by assigning expenses to specific projects. 
(You can create a Project Control from a budget.) Similarly, Employee Control screen gives you the ability to 
restrict expense entry by assigning expenses to specific employees. 
 

 The settings in the Project Control override those in the Project screen, 
while settings in the Employee Control override those in the Project Control. 

 
To restrict expense entry through a budget: 
 

1.  Open the Project screen. Select a project from the grid. 
 

2.  Click on the Billing tab. Select a Budget from the drop-down list. 
 
3.  Move to the Detail tab. To restrict expense entry by a budget, select the ‘Budgeted Expenses 

Only’ option from the Rules dropdown list.  
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4.  When you are done, click Save and then Close to exit. 
 

Now, whenever you enter expenses for this project, you can see only budgeted expense codes in the 
drop-downs. 
 
To restrict expense entry through Project Control: 
 

1.  Open the Project Control screen from the Project menu. Select a Project ID.  
 
2.  Select the Expense option. All the expense codes in the BillQuick database display in the 

Available Items list.  
 

 
 

3.  Choose the expenses that you want to keep available for the selected project and move them to 

the Assigned Items list using . 
 

4.  Click Close to exit.  
 
Now, whenever you make expense entries for this project, you can see only assigned expense codes in 
the drop-downs. 
 

 Using the Allocate screen, you can allocate units to an employee- expense 
combination. This will restrict the same employee from exceeding the specified 
number of units when making expense entries.  

 
To restrict expense entries through Employee Control: 
 

1.  Open the Employee Control screen from the Settings menu.  
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2.  Select an Employee ID from the dropdown. 
 
3.  Select the Expense option. All the expense codes in the BillQuick database display in the 

Available Items list.  
 

 
 

4.  Choose the expenses that you want to keep available for the selected employee and move them 

to the Assigned Items list using . 
 

5.  Click the Security tab. Un-check the Expense Log Screen option (or all, if desired) to enable 
employee control settings. 

 

 You can use the Security screen to uncheck ‘Disable Employee Control’ 
permission for all the BillQuick modules at once by clicking ‘Turn on Employee 
Control’ option. 

 
6.  When you are done, click Save and then Close to exit. 

 
Now, whenever an employee records expense entries, he or she can see only assigned expense codes in 
the drop-downs. 
 

 Using the Allocate screen, you can allocate units to a project- expense 
combination. This will restrict the same employee from exceeding the specified 
number of units when making expense entries.  
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Automatically Evaluating Expenses 
 
BillQuick does not prevent you from accumulating expenses above the contract amount (when expenses 
are a part of contract). Nor are you prevented from billing more than the contract amount for a fixed-
type contract. However, BillQuick does apply a Red Flag Rule to all expense entries. The rule checks 
expenses charged to fixed-type contracts (except Percentage) to determine if it goes beyond the 
contract amount. If it does, BillQuick changes the status of the entry to ‘non-billable’. It is called the Red 
Flag Rule because non-billable items display on the screen in red text, drawing the attention of employees 
and project managers. With appropriate security permissions, you can change the status back to ‘Billable’ 
and bill it to the client.  
 
The rule recognizes managers are busy and at times may miss something. Rather than inadvertently over-
bill clients and likely lose them, the red flag prompts you to check the non-billable item. 
 

 Special rules allow you to override the Red Flag Rule, as well as to apply 
rules that prevent additional expense entry. Check Project and Global Settings.  

 
 

Turning Off Expense Entry Evaluation 
 
You can turn off expense entry evaluation in BillQuick at the project-level or company-level. To do so: 
 

1.  Open the Project screen and select the desired project. 
 

2.  Move to the Detail tab. 
 

3.  Select the ‘Skip Automatic EL Eval’ option from the Rules dropdown list. BillQuick will skip 
performing the automatic expense entry evaluation for the selected project. 
 

4.  Click Save and then Close to exit. 
 

5.  Optionally, open the Global Setting-Time/Expense screen. 
 

6.  Check the ‘Skip Time and Expense Evaluation’ option. BillQuick will not perform the expense 
entry evaluation for any user in the company. 
 

7.  When you are done, click Save and then Close to exit.  
 
 

Auto Filling Expense Log 
 
BillQuick includes ways to save time recording expenses incurred. For example, many staff and managers 
work on the same projects every day and from one week to the next. The only data that changes is the 
date.  
 
The Simple Expense Log screen is a weekly expense log. You select the project and expense and then 
enter the expenses incurred on a particular day. Simple and fast. However, there is a way to speed up 
entry even more. When you work on the same projects from one week to the next, BillQuick’s Auto-fill 
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feature carries forward projects and expense codes from one week to the next. In other words, 
BillQuick pre-fills the expense log based on the last projects you worked on. You can even control how 
many items carry forward to a new expense log. However, the auto-fill feature filters the list based on 
the Employee Control settings, if any. 
 
To do so: 
 

1. Open the Preferences screen and select Options. 
 

2. For the Auto-fill Simple EL option, click the drop-down and select how many projects to auto-fill. 
 

3. When you are done, click Save and then Close to exit. 
 

 Remote time and expense capture modules include Web Suite (browser-
based, Internet or intranet) and its Mobile feature (web-enabled PDA or cell 
phone). BillQuick Outlook Add-In reads Microsoft Outlook data and turns it 
into BillQuick time entries. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

mailto:BQ-Ideas@bqe.com
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Overview 
 
To provide your company with day-to-day accounting capabilities, BillQuick comes with some core 
accounting features that make it easier to keep track of accounts payable, transactions and expand data 
integration with supported accounting packages. With these capabilities, you can track purchase orders, 
create and pay vendor bills, receive items, make deposits or write checks, manage your chart of accounts 
and do much more in BillQuick.  
 
This section focuses on the tasks typically performed by billing managers and accountants, or may be 
delegated to the admin staff.  
 
 

Purchase Orders 
 
Purchase Order (PO) allows you to record an order for services and materials from vendors or suppliers 
at a specified price and time. This makes it easier to track purchases and hence prevent unauthorized 
purchases. Purchase Orders mostly have expense items, ultimately paid by a client. 
 
Similar to the time and expense entries, you can submit purchase orders for approval before sending 
them to the suppliers or vendors.  
 
You can create and use purchase orders in the following ways: 
 

 Creating Purchase Orders 
 Creating Purchase Orders from Budgets 
 Cloning Purchase Orders 
 Changing Purchase Orders  
 Deleting Purchase Orders 
 Submitting Purchase Orders 
 Approving Purchase Orders 
 Emailing Purchase Orders 
 Viewing Purchase Order History 
 Viewing Open Purchase Orders 
 Receive Items 

 
 

Creating Purchase Orders 
 

 You can create your purchase order at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Setup 
 
To create a purchase order: 
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1. Open the Purchase Order screen from the Accounting menu (or directly by right clicking in the 
Vendor screen). It automatically opens in the new entry mode. 
 

2.  Select a Vendor ID from the drop-down. You can add a new vendor here on the fly.  
 

 
 

3.  Enter other information. The ‘P.O.No.’ field is auto-generated by BillQuick whenever you create 
a new purchase order. You can specify the PO number format in the Global Settings-Miscellaneous 
screen. 
 

4.  Enter the ‘Ship To’ address where you want to receive the ordered items. Choose from Client 
Address, Client Contact Address, Project Address, or any other address. 
 

5.  Based on the shipping address, select or enter an ID of the client, client contact, or project.  
 

6.  Enter a Date for the purchase order; else select it from the drop-down calendar. BillQuick also 
maintains a ‘Created On’ date for the PO in the grid. 
 

7.  In the Purchase Order grid, enter the service or expense Item requested, number of Units (or 
hours) required and the Project ID for which you placed the order. 
 

8.  BillQuick pre-fills the Description and Rate fields automatically based on the Item chosen. 
However, you can edit it here. The Amount field is calculated as Units or Hours x Rate. 
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 You can convert the purchase order entries into expense or time entries 
from the Vendor Bills screen and then bill a client. BillQuick defaults to the rates 
set in the fee schedules to calculate the purchase order Amount (follows the Rate 
Hierarchy in BillQuick). 

 
9.  When you enter all the required information, click Save and you are done!  

 
Advanced Setup 
 
To add additional information: 
 

1. Set ‘Active’ status for the purchase order. Inactive purchase orders are not displayed in the 
‘Open Purchase Order’ list (unless the ‘Show All’ option is checked there). 
 

2. Select a Payment Term for the purchase order. This is for reference only and does not transfer to 
the Vendor Bills or accounts payable of your accounting package. 
 

 You can base your purchase order on an approved budget. See Create 
Purchase Orders from Budgets below for more. 

 
3. Click Add Project Journal link to record detailed information in a journal. 

 

4. BillQuick allows you to link files and documents to the purchase order by clicking on  Link 
Files option. E.g., you may want to attach the vendor contract or any other document to the 
record. 
 

5. Enter notes related to the PO in the Memo box. Else, press Ctrl + M or click  at the bottom 
to add a memo for each line item. See Memos in the General Features chapter for more information. 
 

6. To save time, you can copy and paste entries in the grid using the Copy-Paste options at the 
bottom. BillQuick activates these options only when you select a row. 
 

7. You may click Tools and select Spell Check to perform a spell check on all the description and 
memo fields. 
 

8. When you are done, click Save and then Close to exit. 
 
 

Creating Purchase Orders from Budgets 
 
You can create purchase orders based on a budget provided you have assigned that budget to the project 
and it contains records against your vendor. You can create purchase orders directly from the Purchase 
Order screen or else from the Budget screen. 
 
To create a new purchase order from a budget: 
 

1. Open the Purchase Order screen from the Accounting menu. 
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2. Select the Vendor for which you want to create a purchase order. 
 

 
 

3. Select the desired budget from the ‘From Budget’ drop-down. BillQuick retrieves its service and 
expense items for the purchase order, but you can edit it here. 
 

 You can also click on the From Budget link on the screen to assign a 
budget to the desired projects. This is useful if you want to base your purchase 
order on a budget not available in the dropdown list.   

 
4. After making the desired modifications, click Save to save the information. 

 
5. When you are done, click Close to exit. 

 
To create a purchase order directly from the Budget screen:  
 

1.  Open the Budget screen. 
 

2.  Select a budget from which you want to create a purchase order. The selected budget should have 
a vendor line item in it. 
 

3.  Click Tools and select Purchase Order. 
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4.  In the ‘Purchase Order from Budget’ dialog, enter the desired Vendor ID, Client ID and Project 
ID. 
 

5.  Click OK to save the purchase order. 
 

6.  When you are done, click Save and then Close to exit. 
 
 

Cloning Purchase Orders 
 
Many purchase orders share attributes and hence, adopting a ‘clone template’ is easier and quicker. It is 
important to determine what is common or same for groups of purchase orders. Sometimes in a 
technology-consulting firm, you need to send purchase orders with same attributes to different vendors. 
Therefore, you can use this clone feature to create many purchase orders quickly. 
 
To clone a purchase order: 
 

1.  Open the Purchase Order screen from the Accounting menu. 
 

2.  Create a unique purchase order for the clone template. (It should be easy to separate clone 
template from actual purchase orders.)  
 

3.  Enter required data along with common attributes to clone. You can use the ‘P.O.No.’ field to 
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describe the template’s key attributes. 
 

4.  Click Save to save the purchase order template. 
 

5.  Next, click Tools and select Clone.  
 

6.  In the Clone Purchase Order dialog, select the clone template from the drop-down list. 
 

 
 

7.  Type a New P.O.No. Enter other required data such as Client ID, Vendor ID, Date, etc. 
 

8.  You can choose not to copy the individual line item (service or expense) memos by checking that 
option at the bottom. 
 

9.  When you are done, click Save and then Close to exit. 
 
 

Changing Purchase Orders  
 
You can change or edit single or multiple fields for a purchase order in BillQuick using the Change option. 
To do so: 
 

1.  Open the Purchase Order screen from the Accounting menu. 
 

2.  Select a record in the grid to edit. Select multiple rows to make batch changes to items. 
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3.  Next, click Tools and select Change. 
 

4.  On the Batch Change screen, enter new values or change options where needed. The adjoining 
checkboxes are automatically marked. 
 

 
 

5.  Click OK. The selected records reflect those changes now. 
 
 

Deleting Purchase Orders 
 
Security permission is required to delete a purchase order. The best plan of action to delete a purchase 
order is: 
 

1.  Open the Purchase Order screen from the Accounting menu. 
 

2.  Select the desired purchase order from the ‘P.O.No.’ drop-down. 
 

3.  Click Delete to delete the entire purchase order. Else, select the rows in the grid that you want 
to delete and click Delete.  
 

4.  If there are items received against the purchase order, it gives a prompt. Click  to 
delete the purchase order. 
 

5. When you are done, click Close to exit. 
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Submitting Purchase Orders 
 
For a company that follows a submit-review-approval process, BillQuick’s built-in workflow makes the 
process easy and fast. Before sending out your purchase orders to a vendor or supplier, you can have it 
routed internally for approval by one or more reviewers or managers. The approver will accordingly 
receive a notification in the Reminders screen or via email. 
 

 Submit-approve feature is available in the BillQuick Enterprise edition 
only. 

 
To submit purchase orders:  
 

1. Open the Purchase Order screen. 
 

2.  Select an existing purchase order or create a new one, as usual.  
 

3. Click Submit to open the Submit-Approve screen.  
 

 
 
4.    Select whom to submit the purchase order. Commonly, you submit purchase orders to a Client 

Manager. You can also submit it to a Specific person or My Manager (your direct supervisor). 
Your BillQuick Supervisor will provide submission instructions. 
 

 You cannot submit a purchase order to a Project Manager because it can 
have multiple projects with different managers. 
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5.  In the Workflow Type, specify the type of submission-whether Billing, Payroll or both. 
 

6.  Enter an unlimited length Memo, if desired. 
 

7.  Click OK and you are done! 
 
 

Approving Purchase Orders 
 
BillQuick automatically routes purchase orders to the persons responsible for reviewing and approving 
them. The next time they log into BillQuick, it reminds them via the Reminders screen or email that 
purchase orders are waiting for review.  
 

 You can prevent anyone from receiving items against unapproved purchase 
orders by specifying that setting in the Global Settings-Rules screen. 

 
To approve submitted purchase orders: 
 

1. Open the Purchase Order screen. 
 
2. Click View Previous POs link and select a submitted purchase order from the P.O.No. 

dropdown. It is indicated by . 
 

3. Review the purchase order details on the grid. If you have appropriate security permissions, you 
can edit them.   
 

4. When ready, click Submit.  
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5. On the Submit-Approve screen, select the Approve option.  
 

6. If you want to send the purchase order to another person for further review (a review chain), 
choose the Submit To option. 
 

7. If you want to reject the purchase order, choose the desired option –Reject or Un-Submit. Click 
OK. 

 

 The Workflow screen enables you to track the entire submit-approve 
process of all the purchase orders.   

 
8. When you are done, click Close to exit  

 
 

Emailing Purchase Orders 
 
BillQuick allows you to email purchase orders to your vendors. When sending the purchase order, the 
vendor’s email address carries from the Vendor profile. The purchase order attaches to the email as a 
PDF document.  
 
To email a purchase order:  
 

1.  Open the Purchase Order screen from the Accounting menu. 
 

2.  Move to the Filters tab and select the desired filters to generate a concise list of purchase orders 
with which you want to work. Click Refresh.  
 

3.  From the ‘P.O.No.’ field, select the purchase order that you intend to email.  
 

4.  Click Email. On the Email screen, a standard message displays in the email body. However, you 
can modify it here. 
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 Mark the checkbox ‘Send Message as Plain Text’, if you want recipients to 
receive the email message without any formatting styles. 

 
5.  You can send the same email to multiple recipients using the Cc field, email addresses separated 

by commas.  
 

6.  Click Spell to spell-check the email before sending it. 
 

7.  When you are done, click Send and then Close to exit. 
 
 

Viewing Purchase Order History 
 
Managing large purchase orders is a challenge for business managers. You can view the complete 
transaction history of items received against purchase orders and other details associated with the vendor 
bills.  
 

 The Transaction History Purchase Order screen is available in the 
BillQuick Enterprise edition only. 

 
To view the Purchase Order History: 
 

1.  Open the Purchase Order screen from the Accounting menu. 
 

2.  Click View Previous POs link and select the desired P.O. No. 
 

3.  Click Tools and select History. It opens the Transaction History Purchase Order screen. 
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It displays the entire history of the purchase orders placed and items received against them. All 
the fields are non-editable. You can view and print this information. 

 
4.  When you are done, click Close to exit. 

 
 

Viewing Open Purchase Orders 
 
After creating and sending purchase orders, you can view all the open orders. To do so: 
 

1.  Choose the Receive Items option from the Accounting menu. The Open Purchase Order screen 
displays.  
 

2.  By default, it shows only the open purchase orders. If you want to view previous purchase 
orders, check the ‘Show All’ option. 
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3.  Select the purchase order that you want to view and then click OK (or double click it) to open 
the Receive Items screen. 
 

 
 

4.  The Receive Items screen gives all the details of the purchase order, the partially received and 
pending items. However, closed (received in full) and inactive items are not displayed. To view all 
records, check the ‘Show All’ option.  
 

5.  When you are done, click Close to exit. 
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Receive Items 
 
When you receive items ordered with a purchase order, you can record them and create a vendor bill 
from that. If you do, it carries to the Expense Log (expense item) or Sheet View (activity) screen. You can 
receive as many as ordered, greater than or less than ordered.  
 

 You can prevent anyone from receiving items against unapproved purchase 
orders by specifying that setting in the Global Settings-More screen. 

 
When receiving items, you can perform the following tasks: 
 

 Receiving Items 
 Emailing Received Items Information 
 Checking Items Received 

 
 

Receiving Items 
 
Whether you receive a full (blue entry) or a partial (black entry) shipment for ordered items, it is 
important to record them as soon as possible. To receive items: 
 

1.  Choose the Receive Items option from the Accounting menu. This will open the ‘Open Purchase 
Order screen.  
 

 
 

2.  Select the desired purchase order and click OK to open the Receive Items screen. All the details 
of the purchase order display.  
 

 You can directly record received items from the Purchase Order screen 
using the Receive option from the Tools dropdown. 
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3.  Select the Receive Date and enter the number of items received (expense units or hours of 
service) in the Received field. Once you receive all the items on a purchase order, BillQuick marks 
the purchase order as ‘Closed’. 
 

4.  If you want to create a vendor bill for received items, remember to check the ‘Create Vendor 
Bill on Save’ option. 
 

5.  Press Ctrl + M or click  at the bottom to open the Memo box. You can enter as much text as 
required for each line item or insert Auto Complete shorthand codes into it. 
 

6.  You may click Tools and select Spell Check to perform a spell check on all the description and 
memo fields. 
 

 As with purchase orders and vendor bills, you can also submit the received 
items for approval. The reviewer will get a reminder for approving these items. 

 
7.  When you are done, click Save and then Close to exit. 

 
 

Emailing Received Items Information 
 
BillQuick allows you to receive items against a specific purchase order. You can email the Receive Items 
information to the vendor as PDF attachments. BillQuick brings forward the vendor’s email address from 
the Vendor profile.  
 
To email: 
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1.  Choose the Receive Items option from the Accounting menu. This will open the ‘Open Purchase 
Order screen.  
 

2.  Select the desired purchase order and click OK to open the Receive Items screen, which displays 
all its details.  
 

3.  Select the Receive Date and enter the desired number of items in the Received field. 
 

4.  Click Email. On the Email screen, a standard message displays in the email body. However, you 
can modify it. 
 

 
 

 Mark the checkbox ‘Send Message as Plain Text’, if you want recipients to 
receive the email message without any formatting styles. 

 
5.  You can send the same email to multiple recipients using the Cc field, email addresses separated 

by commas. E.g., send it to the vendor, client/project manager as well as the client. 
 

6.  Click Spell to spell-check the email before sending it. 
 

7.  When you are done, click Send and then Close to exit. 
 
 

Checking Items Received 
 
Receive Items screen keeps a track of the number of items received against a specific purchase order in 
BillQuick. To check the items received before against a specific purchase order, follow the steps below: 
 

1.   Open the Receive Items screen from the Accounting menu. This will open the Open Purchase 
Order screen. 
 

2.  By default, it shows only the open purchase orders. If you want to view previous purchase 
orders, check the ‘Show All’ option. It will display all the purchase orders generated so far. 
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3.  Select the purchase order whose details you want to view and click OK (or double click it) to 
open the Receive Items screen. 
 

4.  In the Receive Items screen, you can view the items received so far. However, items received in 
full do not display. To view all the entries, check the ‘Show All’ option.  
 

 
 

 The ‘On Hand’ field displays the total number of items received until date 
on the purchase order.  

 
5.  You can select another purchase order from the P.O.Number field to check its details. 

 
6.  When you are done, click Close to exit. 

 
 

Vendor Bills 
 
You can record a new vendor bill or automatically generate it when recording items received against a 
purchase order. When you create a vendor bill, BillQuick automatically creates a corresponding time or 
expense entry for each item on it. You can also create vendor bills by importing un-billed time and 
expense entries recorded by a vendor.  
 
BillQuick charges the services and/or expenses on the vendor bill to a specific project. You can submit 
vendor bills and after approving them, bill them to your client. 
 
You may enter credit card charges in BillQuick as vendor bills. In that case, you need to create vendors 
for your credit card companies. However, credit card receipts are essentially accounts payable (A/P). 
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This section covers the following tasks: 
 

 Creating Vendor Bills from Received Items 
 Creating Vendor Bills 
 Creating Vendor Bills from Time and Expense 
 Batch Changing Vendor Bills 
 Submitting Vendor Bills 
 Approving Vendor Bills 
 Emailing Vendor Bills 

 
 

Creating Vendor Bills from Received Items 
 
You can record a new vendor bill or automatically generate one when recording items fully or partially 
received against a purchase order.  
 
To create a vendor bill from received items: 
 

1.  Select the ‘Receive Items and Create Bill’ option from the Accounting menu. 
 

2.  On the Open Purchase Order screen, select the purchase order against which you want to 
receive items and create a vendor bill. Click OK. 
 

3.  On the Receive Items screen, enter the details for the items received against the purchase order.  
 

 
 

4.  Make sure the ‘Create Vendor Bill on Save’ option is checked. On clicking Save, the number of 
items entered is received against the purchase order and the vendor bill is created. 
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5.  When you are done, click Close to exit the screen. 
 

To view the vendor bill: 
 

1. Open the Vendor Bills screen from the Accounting menu. 
 

2. Select the desired bill by clicking ‘View Previous Bills’ option and choosing it from the Bill No. 
dropdown. 

 

 
 

3. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 

 
4. The vendor bill details display. You can make any changes to it, if needed. (You can also add a 

memo, link a file or create a Project Journal to it) 
 

 Vendor Bill entries are color-coded: black are billable and red entries are 
non-billable. It follows the color-coding for time and expenses as specified in the 
Preferences-Format screen. 

 
5. When you are done, click Save and then Close to exit. 

 

 If you directly access the Vendor Bills screen and select a vendor who has 
purchase orders and received items without a vendor bill associated with them, 
BillQuick prompts you to see these purchase orders without bills. Your vendor 
bill can include these items, if desired. 
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Creating Vendor Bills 
 

 You can create your vendor bill at a basic level with a few mouse-clicks 
or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Setup 
 
To create a vendor bill: 
 

1.  Open the Vendor Bills screen from the Accounting menu (or directly by right clicking in the 
Vendor screen). BillQuick will automatically open it in the new entry mode. 

 
2.  Select the Vendor ID from the drop-down. You can also add a new vendor here on the fly.  

 

 
 

3. Whenever you create a new vendor bill, the Bill No. is auto-generated by BillQuick. You can 
change it here, even after the bill is created. 
 

 BillQuick automatically assigns the bill number counting one unit from the 
value specified in the 'Last Vendor Bill#' in Global Settings-Miscellaneous screen. 

 
4.  Select the Date when you created the vendor bill. By default, BillQuick pre-fills it with the 

current date. 
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5.  Select the date when the vendor bill is due. By default, BillQuick pre-fills the Due Date field with 
the current date. 
 

 If there are some unbilled, approved time and expense entries associated 
with the vendor, BillQuick prompts you to include them in the Vendor Bill. 

 
6.  In the grid, enter the desired Item (activity or expense item received), Units (expense units or 

hours of service) and Project ID to which the bill applies. BillQuick fills the Description, Cost and 
Type fields automatically based on the item chosen.  
 

7.  Check the Rate of the expense or service item of the vendor bill. BillQuick calculates the Amount 
based on the number of Units and Rate associated with the items.  
 

 BillQuick defaults to the cost rate (plus markup in case of expenses) as per 
the rate hierarchy. Since you can convert vendor bills into time or expense 
entries and bill a client, BillQuick uses this cost rate in the time and expense 
screens. You can change these rates there, if desired. 

 
8.  When you enter all the required information, click Save and you are done! 

 
Advanced Setup 
 
To add additional information: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. Optionally, enter a reference number. For example, you may enter a routing number from a 
personal check here. As you add reference numbers, BillQuick retains them for future use. 
 

3. Check ‘Xtra’ to log an activity item as extra. You can do this when services provided by a vendor 
need to be shown separately on an invoice. These are essentially expenses for the firm, which 
pass to the client. 

 
4. You can paste entries in the Vendor Bills grid (maximum of 50 entries at a time) using the Copy 

and Paste options at the bottom. BillQuick activates these options only when you select a row. 
 

5. Click Tools and select Import to import the desired unbilled time and expense entries recorded 
by a vendor in BillQuick. You can use these entries to create vendor bills. 
 

6. Click Tools and select Email to email the vendor bill to the client or any other person as a PDF 
file attachment. 

 
To add extra information to a vendor bill: 

 
1. Type comments or notes for the vendor bill in the Memo field. 

 
2. Click Tools and select Journal to add notes for the vendor bill. 
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3. BillQuick allows you to link files and documents to the vendor bill after saving it. E.g., you may 
want to attach the vendor contract, client contract or any other document to the record. Click 

Link Files or right-click to choose it. 
 

4. To add a memo, press Ctrl + M or click  at the bottom.  You can enter as much text as 
needed or insert Auto Complete shorthand codes into it. 
 

To submit a vendor bill: 
 

1. In the Bill No. dropdown, ‘S’ field indicates the Submit-Approve status of a bill. The status is 
indicated by an icon:  

[blank] Not submitted    Submitted    Forwarded    Approved    Rejected 

 
2. Select it and click Submit to open the Submit-Approve screen. From here, you can submit bills to 

the relevant person. See Submitting Vendor Bills below for details. 
 
To edit a vendor bill: 
 

1. Select one row or multiple rows to be changed. 
 

2. Click Tools and select Change to launch the Batch Change screen. See Batch Changing Vendor Bills 
below for more. 
 

3. You may click Tools and select Spell Check to perform a spell check on all the description and 
memo fields. 
 

4. When you are done, click Close to exit. 
 
 

Creating Vendor Bills from Time and Expenses 
 
You can use Expense Log to enter vendor bills. You can also use the Vendor Bills screen to track vendor 
bills or expenses. When creating a new vendor bill, you can include billed as well as unbilled time and 
expense entries with it. 
 
To create a vendor bill: 
 

1.  Enter time and expenses for the vendor in any time and expense entry screens, as you normally 
do. Submit the entries and get them approved. 
 

2.  Open the Vendor Bills screen from the Accounting menu. 
 

3.  Select a Vendor ID from the drop-down. You can also add a new vendor here on the fly. 
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4.  BillQuick detects approved time and expenses in the system and prompts you to link them to the 

vendor bill. Click  to open the Vendor Time and Expense screen.  
 
Else, click Tools and select Import. On the ‘Vendor Time and Expense’ screen, all the time and 
expense entries for the selected vendor display.   
 

 
 

5.  Check the line items that you want to include in the vendor bill and then click OK. 
 

 BillQuick prevents you from deleting time and expense entries attached to 
a vendor bill. 
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6.  BillQuick adds these items to the vendor bill. It fills the Description, Cost and Type fields 
automatically, but you can edit them here. BillQuick calculates the Amount field based on the 
number of units and cost. 
 

7.  When you are done, click Save and then Close to exit. 
 
If you synchronize data with QuickBooks and the vendor record is already there, you can use Send To 
option to transfer these vendor bills to QuickBooks. They will appear in its Un-Paid Bills report. The 
advantage of recording the vendor bill in BillQuick is the ‘Pay When Paid’ feature. When your client pays 
for the invoice, BillQuick lets you know which vendor bills to pay. 
 
 

Batch Changing Vendor Bills 
 
BillQuick allows you to change a single record or multiple records of Vendor Bills using the Change 
screen.  
 
To make batch changes: 
 

1.  Open the Vendor Bills screen from the Accounting menu. 
 

2.  Select the rows in the grid that need to be changed. Click Tools and select Change. 
 

3.  On the Batch Change screen, enter new values or change options where needed. The adjoining 
checkboxes are automatically marked. 
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4.  Click OK to apply the changes and exit. The selected records reflect the changes in the Vendor 
Bills grid. 
 

5.   When you are done, click Save and then Close to exit. 
 
 

Submitting Vendor Bills 
 
For a company that follows a submit-review-approval process, BillQuick’s built-in workflow makes the 
process easy and fast. Before sending out your vendor bills to a vendor or supplier, or billing it to the 
client, you can have it routed internally for approval by one or more reviewers or managers. When 
submitting a vendor bill, you are not submitting the individual entries but the entire bill. To submit or 
approve individual time and expense entries on a vendor bill, you can do so from their respective screens. 
It is then reflected in the Vendor Bills grid. The approver will accordingly receive a notification in the 
Reminders screen or via email. 
 

 The submit-approve feature is available in the BillQuick Enterprise edition 
only. BillQuick automatically approves the Vendor Bills for Basic and Pro users. 

 
To submit vendor bills:  
 

1. Open the Vendor Bills screen. 
 

2.  Select an existing vendor bill or create a new one, as usual.  
 

3. Click Submit to open the Submit-Approve screen.  
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4.    Select whom to submit the vendor bill. Commonly, you submit vendor bills to a Client Manager. 
You can also submit it to a Specific person or My Manager (your direct supervisor). Your 
BillQuick Supervisor will provide submission instructions.   
 

 You cannot submit a vendor bill to a Project Manager because it can have 
multiple projects with different managers. 

 
5.  In the Workflow Type, specify the type of submission-whether Billing, Payroll or both. 

 
6.  Enter an unlimited length Memo, if desired. 

 
7.  Click OK and you are done! 

 
 

Approving Vendor Bills 
 
BillQuick automatically routes vendor bills to the persons responsible for reviewing and approving them. 
The next time they log into BillQuick, it reminds them via the Reminders screen or email that vendor bills 
are waiting for review. When approving a vendor bill, you are not approving the individual entries but the 
entire bill. To submit or approve individual time and expense entries on a vendor bill, you can do so from 
their respective screens. It is then reflected in the Vendor Bills grid. 
 
To approve submitted vendor bills: 
 

1. Open the Vendor Bills screen. 
 
2. Click View Previous Bills link and select a submitted vendor bill from the Bill No. dropdown. It is 

indicated by . 
 

3. Review the vendor bill details on the grid. If you have appropriate security permissions, you can 
edit them.   
 

4. When ready, click Submit.  
 

5. On the Submit-Approve screen, select the Approve option.  
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6. If you want to send the vendor bill to another person for further review (a review chain), choose 
the Submit To option instead. 
 

7. If you want to reject the vendor bill, choose the desired option –Reject or Un-Submit. Click OK. 
 

 The Workflow screen enables you to track the entire submit-approve 
process of all the vendor bills.   

 
8. When you are done, click Close to exit. 

 
 

Emailing Vendor Bills 
 
You can email vendor bills to your vendors and suppliers. When sending the vendor bill, BillQuick brings 
forward the vendor’s email address from the Vendor profile. The vendor bill attaches to the email as a 
PDF document.  
 
To email a vendor bill: 
 

1.  Open the Vendor Bills screen from the Accounting menu. 
 

2.  To email an existing bill, select the Vendor ID and Bill No. to display the details of vendor bills in 
the grid. 
 

3.  Else, create a new vendor bill by clicking on ‘Create New Bill’ option.  Fill in the required data. 
 

4.  Next, click Tools and select Email.  
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5.  The Email screen displays the standard message (specified in the Preferences-Email Settings or 
Global Settings-Email Settings screen) in the email body. However, you can edit the message 
here. 

 Mark the ‘Send Message as Plain Text’ option if you want recipients to 
receive the email message without any formatting styles. 

 
6.  You can send the same email to multiple recipients by entering additional email addresses in the 

Cc field (email addresses separated by commas).  
 

7.  Click Spell to spell-check the email before sending it. 
 

8. When you are done, click Send and then Close to exit. 
 

 BillQuick includes a Pay When Paid feature. When you apply a payment to 
an invoice that includes a link to a vendor bill, BillQuick prompts you to 
preview/ print it. This helps you schedule payments to your vendors. 

 
 

Chart of Accounts 
 
You may set up a Chart of Accounts in BillQuick or transfer them from your accounting software. These 
accounts are required for the functioning of Accounts Payable module in BillQuick and integration 
purposes. Chart of accounts also display in the Income Account and Expense Account drop-downs in the 
Activity Codes and Expense Codes screens for data integration purposes. 
 
You can also view the Register or Details of any account from the Chart of Accounts screen by clicking 
that option. 
 
 

Creating Chart of Accounts 
 
To create an account: 
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1.  Open the Chart of Accounts screen from the Accounting menu. Previously created or 

transferred accounts display in the grid.  
 

 
 

2.  Click New to create a new account. 
 

3.  Select the Account Type for the new account you are creating. It could be Accounts Receivable, 
Bank, Cost of Goods Sold, Other Income, etc. 
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4.  Enter the Account Name to describe the account. 
 

5.  Enter the Account Number that uniquely identifies the account. It can be letters and/or numbers. 
 

6.  In the ‘Sub Account of’ field, select an existing account for which the new account becomes a 
sub-account. 
 

7.  Enter an Opening Balance amount for the account or sub-account. 
 

8.  Specify the ‘Balance As of’ date for the opening balance. Enter the date or select it from the 
calendar drop-down. 
 

9.  When you are done, click Save and then Close to exit. 
 
 

Accounts Payable 
  
BillQuick offers the ability to handle specific accounts payable tasks such as paying vendor bills, making 
deposits, writing checks, transferring funds, managing account journals and so on. Using the accounts 
payable features in BillQuick, historical accounts can be brought forward from a previous accounting or 
third-party software. It lets you track company expenses and what you owe to vendors or others.  
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To use the accounts payable features, you need to create an A/P account (e.g. Bank account) that 
automatically adds to your Chart of Accounts. BillQuick uses this account to track the money your 
company owes to others. Whenever you pay outstanding bills or write checks, BillQuick records the 
transaction in a register for your A/P account. 
 

 The accounts payable feature is an optional module in BillQuick and needs 
to be purchased separately as BillQuick Basic/Pro/Enterprise Plus. 

 
You can perform the following accounts payable tasks in BillQuick: 
 

 Entering Vendor Credits 
 Paying Vendor Bills 
 Making Deposits 
 Transferring Funds 
 Writing Checks 
 Printing Checks 
 Using Register 
 Making Journal Entries 
 Recording Credit Card Transactions 

 
 

Entering Vendor Credits 
 
If you receive a credit or an advance from a vendor, you must record it in BillQuick. You can apply it 
against an open vendor bill or save it for the next order. BillQuick provides an exclusive Enter Credits 
screen for recording vendor credits. You can also view the previous credit transactions from here. 
 
To enter a credit:  

 
1.  Open the Enter Credits screen from the Accounting menu. 
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2.  On the Expenses tab, select the Vendor ID from the drop-down list. 
 

3.  Next, choose the Date when the credit was given. 
 

4.  In the Reference field, enter the vendor’s credit memo number (if one exists). 
 

5.  Optionally, enter a Memo to record anything specific for this credit transaction. 
 

6.  In the grid, assign an Account and Amount for the credit provided. 
 

7.  Select a Project ID associated with this credit transaction.  
 

8.  When you are done, click Save and then Close to exit. 
 

 When you enter vendor credits, BillQuick debits the accounts payable 
account and credits the expense account by that amount. 

 
 

Paying Vendor Bills 
 
You may have received items from vendors or suppliers and created vendor bills from that. You can also 
create vendor bills from unbilled time and expenses logged by vendors. Depending upon your company 
policy, a reviewer or manager may or may not have to approve these vendor bills before making 
payments.  
 

 Before paying any bills, BillQuick prompts you to create a ‘Bank’ account in 
the Chart of Accounts screen. 

 
To pay your bills: 
 

1.  Open the Pay Bills screen from the Accounting menu.  
 

2.  Select a Vendor ID in the From-To fields.  
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3.  You can also choose to view all bills, specific bill or those due on/before a specific date.  
 

4.  On the Pay Bills tab, all vendor bills meeting your criteria display in the grid. Select the desired bill 
to pay in the grid. 

 
5.  Enter a Pay Amount. (The Pay checkbox is automatically marked.)  

 
6.  Click Discount to take a discount on the bill amount. You need to specify a Discount Account for 

taking a discount. 
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 You can specify either an income account or expense account for the 
discount taken. It depends on how you view this discount – as an income or 
reverse expense. 

 
7.  If you want to take credit against this bill or want to change that amount, click Credit. In the 

‘Discount and Credits’ screen, you can make appropriate changes (or deselect the credit) and 
click OK. 

 

 
 

If you have credits with the vendor, you can apply it to the bill. The amount of credit will appear 
in the Credits Used column. 
 

8.  Next, enter the Payment Method—Check or Credit Card. You can also select the EFT option if 
you are paying the bill via electronic funds transfer. 

 
9.  If you choose to pay by Check, decide whether to print a check or assign a check number to it. If 

you opt for the latter, provide those details in the Assign Check Numbers dialog upon save. 
 

 You can let BillQuick assign check numbers to the payment or assign your 
own number. 

 
10.  Enter or select a Payment Account (checking, saving or credit card account) from which you are 

withdrawing money for this payment. It displays the ending balance of that account. 
 
11.  Enter a Payment Date. BillQuick pre-fills it with the current date (Today) by default but change it 

if you want to predate or postdate it. 
 



Accounting 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 405 

12.  Click Save. It displays a Payment Summary that you can print, if desired. You can also view the 
payments on the Previous Payments tab. 

 
13.  When you are done, click Close to exit. 

 

 When you pay vendor bills, BillQuick debits the A/P account by the total 
payment amount and credits the bank account by that amount. 

 
 

Making Deposits 
 
From time to time, you receive payments from your customers and want to make those deposits into 
your bank account(s). BillQuick lets you do that in a simple and easy way.  
 
By default, BillQuick enters each payment you receive into an account named Undeposited Funds (asset 
account).  Once you have recorded your payments, you are ready to make your deposit by moving the 
money from the Undeposited Funds account into a bank account (or asset account) using the Make 
Deposits screen. You can also record new payments on this screen before making a deposit. 
 

 Legacy users (who upgraded from previous versions of BillQuick to 
BillQuick 2011) will not see their previous payments in the Undeposited Funds 
account or Make Deposits screen. They need to enter their opening balance in 
the Chart of Accounts or reconcile them before proceeding. 

 
You may want to segregate the deposits based on the Pay Method to match it to the way your bank 
records deposits; otherwise, bank reconciliation becomes complicated. Your bank usually records credit 
card deposits separately from a cash/check deposit, even if the date of the deposit is same. 
 
To make a deposit: 

 
1.  Open the Make Deposits screen from the Accounting menu. 

 
2.  In the Deposit To field, select a bank account into which you want to deposit your money or 

payments. It displays the ending balance of that account. 
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3.  Enter or select a Date for the deposit. 
 

4.  If desired, enter a memo related to the deposit you are making. 
 

5.  Click New if you want to record a new payment. At the bottom of the grid, enter the payment 
information such as Depositor ID, Account, Pay Method, Pay Amount, etc. Click Save. 
 

6.  Select the rows whose payments you want to deposit by checking SEL against them. Click Save 
to make the deposit(s). 
 

7.  When you are done, click Close to exit. 
 
 

Transferring Funds 
 
BillQuick allows you to transfer funds between balance sheet accounts such as bank accounts (checking 
and saving). The bottom line of the balance sheet remains the same because BillQuick debits the 
receiving bank account and credits the sending bank account with the same amount. 
 
To transfer funds: 
 

1.  Open the Transfer Funds screen from the Accounting menu. 
 

2.  Enter a Date for the transfer to occur.  
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3.  In the From-To fields, enter the account from which you want to transfer funds (source) and the 
account to which it will transfer (destination). It displays the balances of both accounts. 
 

4.  In the Transfer Amount field, enter the amount that you want to transfer from one account to 
another. 
 

5.  Optionally, you may enter a Memo or a note to record anything specific about the transfer. 
 

6.  When you are done, click Save and then Close to exit. 
 
 

Writing Checks 
 
BillQuick allows you to write checks and make payments to clients, employees or vendors. Some 
companies do not use A/P and hence do not enter vendor bills. They pay bills by writing checks, called 
direct disbursements. Typically, companies use a combination of bills and direct disbursements. They enter 
bills when they receive a physical bill from a vendor in the Vendor Bills screen and pay these bills using 
the Pay Bills screen. They use a direct disbursement and write checks to pay vendors that do not send 
bills (such as rent, delivery charges, petty cash, etc.). You can also write a quick check when you do not 
have the time to enter a bill, pay it and then print a check. 
 
You need to post the check amount against appropriate accounts. If the check is for activity and expense 
items, you have to specify those items. If you have specified the Income/Expense Accounts in the Activity 
Codes and Expense Codes screens, BillQuick will record the transactions against those accounts. 
BillQuick records all the checks you write in a bank account register. 
 
To write a check: 
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1.  Open the Write Checks screen from the Accounting menu. 
 

2.  Select a Bank Account from the dropdown. BillQuick will use this account to write a check. 
 

 
 

3.  The next available check number is already filled in unless the ‘To be printed’ option is checked. 
Accept it or enter a new one in the No. field. 
 

4.  In the ‘Pay to the order of’ field, select the person whom you are paying by check, say a vendor.  
 

 DO NOT use this screen to pay a vendor bill that has been entered in 
your company data file. 

 
5.  BillQuick pre-fills the address from its master profile. However, you can edit it here by clicking 

Address. 
 

6.  Enter the payment amount in figures (say $300). BillQuick auto-fills the amount in words (Three 
Hundred Dollars). 
 

7.  Enter a Memo to keep a record of what the payment was about or to mention anything specific. 
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8.  Check ‘To be printed’ option if you want to print the check later from the Print Checks screen. 
The check also appears in the bank account register with the notation ‘To Print’. 

9. On the Accounts tab, select an Account for posting the check amount. Also, enter a Memo 
(optional) and Amount in the grid.  
 

10. For service or expense items, move to the Items tab. Select an activity or expense Item in the 
grid, and specify its Project (optional), Cost and Quantity. 
 

 If you were paying a vendor bill via a check, you can take a discount on it 
here. Click Discount to reduce your payment amount. 

 
11. To balance the transaction, make sure the total Amount (Accounts tab, Items tab or both) is 

equal to the check amount. Click Save.  
 

12. When you are done, click Close to exit. 
 

 When you write checks, BillQuick debits the expense account and credits 
the bank account by that amount. 

 
 

Printing Checks 
 
You can use the Print Checks screen to print checks that you have created in the Write Checks screen. 
Before you can print, however, you must have a proper vendor name and address. You also have to 
purchase computer checks and set up your printer. 
 
To print a check: 

 
1.  Open the Print Checks screen from the Accounting menu. 

 
2.  Select a Bank Account whose check you are printing. 

 

 
 

3.  The first time you print a check, the First Check Number is 1 but you can change it to match the 
number of the check loaded in your printer. 
 

4.  You can select a Check Style, which should match the check you purchased. It can be a Voucher, 
Standard or Wallet check. 
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5.  On the grid, select the check you want to print by checking the Print box. 
 

6.  Click Alignment to check the layout of the default check form. You can select an item on the 
check and right click to adjust its position and layout. Click Test Print to test your layout. 

 

 
 

7.  When you are ready, and click Print. 
 
 

Using Register 
 
BillQuick allows you to view all account transactions and their details in the Use Register screen. A 
register is available only for balance sheet accounts (e.g., bank, assets, A/R, A/P, etc.) and not for income 
and expense accounts. You can also use an account register to enter transactions (like writing checks, 
paying bills, making deposits, etc.) and maintain accounts (like making adjustments, voiding transactions, 
reconciling bank accounts and so on). 
 

 The Register will vary for different accounts, such as bank, A/R, A/P, etc. 

 
To use a bank register: 
 

1.   Open a register from the Accounting menu by selecting Use Register for the desired account, say 
savings bank account.  

 
2.  You can view all the transactions involving this account. To record a transaction, enter a 

Transaction Date and a transaction Number in the last row. 
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3.  Enter other data—number, name of the Payee, Account assigned to the transaction, amount of 
Payment or Deposit, and optionally, a Transaction Memo. 
 

 Click Simple at the bottom to display the Register in a simpler view; all 
fields display in a single line. 

 
4.  While writing a check or making a deposit, you can split the transaction across different accounts. 

Click Splits and enter the required data.  
 

 You cannot enter or view a split transaction that includes items. Also, you 
cannot use more than one A/R or A/P account in the same transaction. 

 
5.  Click Record to save the transaction. 

 
6.  To modify a transaction, select a row and click Edit Transaction. It takes you to the source 

screen, depending upon the transaction type. 
 

7.  When you are done, click Close to exit. 
 
When you enter vendor bills, BillQuick debits the expense or other specified account and credits the A/P 
account. When you pay vendor bills, BillQuick debits the A/P account and credits the bank account. 
BillQuick allows you to view all accounts payable transactions and their details in the Accounts Payable 
Register. You can view as well as pay vendor bills from this screen. 
 
To use an A/P register: 

 
1.  Open a register from the Accounting menu by selecting Use Register for the desired account, say 
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accounts payable.  
 
2.  You can view all the A/P transactions in the grid. To record a new transaction, enter a Date and 

Number for the bill in a blank row. 
 

 
 

 For vendor bills, BillQuick displays the Type as ‘Bill’. When you pay those 
bills, it pre-fills the Type with ‘BillPay’, and when you apply a credit, it displays 
‘BillCredit’. 

 
3.  Enter other data—name of Vendor, Account assigned to the transaction, Memo, Due Date of bill 

and amount Paid. 
 

 Click Simple at the bottom to display the A/P grid in a simpler view; all 
fields display in a single line. 

 
4.  While paying a bill, you can split the transaction across different accounts. Click Splits and enter 

the required data. 
 

5.  Click Record to save the transaction. 
 

6.  To view the details and change a transaction, select that row and click Edit Transaction. It takes 
you to the source screen, depending upon the transaction type (Write Checks or Vendor Bills). 
 

7.  When you are done, click Close to exit. 
 
When you create invoices, BillQuick debits the A/R account and credits the income and/or sales tax 
account. When you record payments, BillQuick debits the Undeposited Funds or bank account and 
credits the A/R account. BillQuick allows you to view all accounts receivable transactions and their details 
in the Accounts Receivable Register. You can view and edit regular and manual invoices, and client 
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payments here.  
 
To use an A/R register: 

 
1.  Open a register from the Accounting menu by selecting Use Register for the desired account, say 

accounts receivable. 
 

2.  BillQuick displays all the A/R transactions in the grid. To record a new transaction, enter a 
transaction Date and Invoice Number. 

 

 
 

 When you enter invoice details, BillQuick pre-fills the Type with ‘Invoice’ 
or ‘MNLINV’. For payments, it displays ‘Payment’. 

 
3.  Enter other data—Project ID, Item (Service or Expense), Units (number of service hours or 

expense units), Rate per unit, etc. 
 

 Click Simple at the bottom to display the A/R grid in a simpler view; all 
fields display in a single line. You can also choose to view more fields in the grid 

by clicking . 

 
4.  To view the details or change a transaction, select its row and click Edit Transaction. It takes you 

to the source screen, depending upon the transaction type (Manual Invoice, Payment or Invoice 
Review). 
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5.  When you are done, click Close to exit. 
 
 

Making Journal Entries 
 
The General Journal screen allows you to record general journal entries. At the closing of a financial year, 
accountants may use the General Journal to check any discrepancy in the company accounts and make 
adjustments. Typically, only accountants who prefer traditional methods of accounting use a general 
journal.  
 
To make a journal entry: 
 

1.  Open the General Journal screen from the Accounting menu. 
 

2.  Enter a Date for the journal entry. 
 

  
 

3.  The Entry No. is pre-filled but you can change it, if desired. 
 

4.  In the grid, select an Account from your chart of accounts. Enter a Debit or Credit amount for 
that account, depending upon the data you are entering. 
 

5.  You need to associate a Name with the transaction by selecting it from the dropdown. 
 

 For A/R accounts, you have to select a project; for A/P accounts, you have 
to select a vendor; and for all other accounts, you may select a vendor, 
employee or client. 

 
6.  Optionally, enter a Memo to note anything specific about the journal entry. 



Accounting 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 415 

7.  Click Save. You can view the entry in the Previous Entries grid. 
 

8.   To clone an entry, select it on the grid. Click Clone and then Save.  
 

9.  You can make an entry on one date and then reverse it on another date. To reverse the 
debit/credit aspect of an entry, click Reverse and then Save.  
 

 When you clone or reverse an entry, BillQuick creates a memo 
automatically. 

 
10.  When you are done, click Close to exit. 

 
 

Recording Credit Card Transactions 
 
When you use credit cards, you have several options for tracking and paying the credit card bills. You 
may treat credit cards as liability accounts, tracking each transaction against the account as it occurs. 
When the actual bill arrives, you can match the transactions against that and decide about its payment. 
This way, your running balance is tracked against the credit card instead of your Accounts Payable. 
 
The Credit Card screen allows you to record credit card transactions and view previous transactions. It 
lets you record a credit card purchase and issue a refund (return) to clients, employees or vendors. 
Before using this feature, you need to create a Credit Card account in your Chart of Accounts.  
 
You need to post the credit card transactions and expenses against appropriate accounts. If the 
transaction is for service and expense items, you have to specify those items. If you have specified the 
Income/Expense Accounts in the Activity Codes and Expense Codes screens, BillQuick will record the 
transactions against those accounts.  
 
To record a credit card transaction:  

 
1.  Open the Credit Card screen from the Accounting menu. You can also open it from the Pay 

Vendor Bills-Previous Payments screen (if the selected payment is made by a credit card). 
 

2.  Select a Credit Card Account from the dropdown. BillQuick will use this account to record a 
purchase or refund. 
 

3.  Select your option- Purchase/Charge if you are recording a credit card purchase or 
Refund/Credit if you are recording a refund (payment) to the credit card account. 
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4.   For the transaction, enter a No. for it. E.g., receipt number. 
 

5.  Select the date of the credit card transaction. By default, BillQuick uses today’s date. 
 

6.  In the Purchased From field, select the person associated with the credit card transaction, say a 
vendor in case of a purchase or a client in case of a refund. 
 

7.  Enter the transaction amount in figures (say $300). 
 

8.  Enter a Memo to keep a record of what the transaction was about or to mention anything 
specific. 
 

9.  On the Accounts tab, select an Account for posting the credit card transaction. Also, enter a 
Memo (optional) and Amount in the grid.  
 

10.  If you are recording a credit card transaction involving accounts receivable or accounts payable, 
select a Project or Vendor from the dropdown.  
 

 For A/R accounts, you must specify a project.  For A/P, you must select a 
vendor. 

 
11.  If the transaction involves services or expenses, move to the Items tab. Select an activity or 

expense Item in the grid, and specify its Cost, Quantity (units or hours) and Project (optional). 
 

12.  To balance the transaction, make sure the total Amount (Accounts tab, Items tab or both) is 
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equal to the credit card amount. Click Save. 
 

13.  When you are done, click Close to exit. 
 
  

Data Integration 
 
BillQuick generally manages projects, job costs and receivables; tracks time and expenses; generates 
invoices and reports, and manages other practice management information. On the other hand, you can 
use your accounting system for accounting and financial functions such as general ledger, accounts 
payable, banking, payroll and financial reports.  
 
Your day-to-day accounting and financial management tasks become easier when you integrate BillQuick 
with your accounting system. Integrating the two applications eliminates duplicate data entry. Each 
record common to BillQuick and your accounting package shares a unique Link ID that identifies them as 
related. 
 
The following illustration gives an idea about the common breakdown of tasks you should be doing in 
BillQuick and your accounting system. 
 

 
 
BillQuick integrates with the following accounting applications: 
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Application                                             Version 

QuickBooks® Pro, Premier 2002 and later 

QuickBooks® Enterprise 3.0 and later 

QuickBooks® Canada 2004 and later 

QuickBooks® UK 2003 and later 

QuickBooks® Australia 2008 or later 

Peachtree® Complete Accounting,  
Premier Accounting 

2005 and later 

MYOB® Premier Australia 9 and later 

MYOB® Accounting, Accounting Plus 15 and later 

MYOB® Accounting Plus  

 

 You must have security permission in BillQuick to perform the integration 
tasks. The BillQuick Supervisor in your company grants integration (and other) 
rights to users. 

 
The rules set by the developer of your accounting package determine your synchronization options.  
 

Sync Option  QuickBooks Peachtree  MYOB  

Real-Time 
1   

On-Schedule    

On-Demand    
1 It requires QuickBooks 2004 or later. 

 
BillQuick offers the following integration options: 
 

 Integration with QuickBooks 
 Integration with MYOB 
 Integration with Peachtree Accounting 

 

 Download the free BillQuick Integration Guides and BillQuick Conversion 
Guides at www.BillQuick.com/Support.asp.  

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.billquick.com/Support.asp
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Integration with QuickBooks 
 
BillQuick can bi-directionally integrate data with QuickBooks.  

 

BillQuick  
Table Name 

Dataflow QuickBooks  
Table Name 

Activity Codes  Service Item 

Expense Codes  Other Charge Item  

Employee  Employee 

Vendor  Vendor 

Client  Customer 

Project  Job 

Time Entry  Time Tracking 

Expense Log  Bills/Checks 

Invoice  Invoice  

Payment  Payment 

Vendor Bills  Bills 

Chart of Accounts  Chart of Accounts 

Estimate  Estimate 

 To review detailed, field-by-field mapping of data between QuickBooks 
and BillQuick, see BillQuick Help, BillQuick-QuickBooks Integration, Table & 
Field Mapping section. 

 
The table above shows the direction in which data can potentially flow between BillQuick and 
QuickBooks. Whether it flows in one direction or the other (or both) depends on choices made in the 
Integration Settings screen. 
 
BillQuick creates a log that records the events and exceptions involved in data sync with QuickBooks. It 
flags this log file with a date stamp. 
 
 

Integrating Data with QuickBooks 
 

 Before integrating data, create a backup in QuickBooks and BillQuick. 
 

 You can sync your BillQuick data at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
First-Time Integration 
 
To integrate data for the first time: 
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1.  Direct QuickBooks (Edit menu, Preferences, Integrated Applications) to allow data 
communication with BillQuick. Click Properties to grant permission to BillQuick to access your 
QuickBooks database. 

 

 
 

2.  Consider whether you want to send or get data from QuickBooks. It would primarily depend on 
your situation (new/existing user for which application). If you are an existing QuickBooks user 
and a new BillQuick user, it is preferred to get data initially into BillQuick.  
 

3.  Filter what data transfers between the two databases. While most companies choose to apply no 
filters, you can use the Integration Settings screen (Integration menu, QuickBooks) to define your 
sync preferences (Get Settings).  
 

 BillQuick, by default, always connect to the currently open QuickBooks 
company file. If QuickBooks is not running, then it will open the file specified in 
the Integration Settings screen. However, you need to give permission to 
BillQuick to open the desired company file even when QuickBooks is not 
running. 
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4.  After defining your sync settings, click Save and then Close to exit. 
 

5.  Use the Integration menu, QuickBooks to synchronize data. BillQuick starts getting (or sending) 
data and displays the progress.  
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Alternatively, use QuickBooks Integration Wizard for the initial sync procedure to populate the 
BillQuick and QuickBooks database with available data.  
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 If you are not sure about how much to move, you can transfer everything 
into BillQuick and then use its Archive feature to move old clients and projects 
to a secondary archive database. 

 
6.  As a part of data touchup after transfer, review and edit the QuickBooks data transferred into 

BillQuick: 
 

 Update Bill and Cost Rates (Employee screen) 
 Replace ‘FromQuickBooks’ placeholders  automatically created by BillQuick 
 Assign a Manager to all projects (Project screen) 
 Change IDs of employees, projects, activity codes, etc., if needed (Change ID 

Codes screen) 
 

7.  After integrating data, verify the accounts receivable. Compare BillQuick and QuickBooks aging 
(and other) reports. If the data is the same, your integration is successful. If it is not the same, the 
cause could be a journal entry that adjusted A/R or a record that did not transfer. The solution is 
usually making a manual adjustment in BillQuick. 
  
Alternatively, perform a detailed check by opening corresponding screens in both applications 
and manually adjusting data. 

 
Day-to-Day Integration 
 
To integrate data on a day-to-day basis:  
 

1. Consider where you want to save each type of master information and perform which functions 
in BillQuick and QuickBooks. 
 

 BillQuick, by default, always connect to the currently open QuickBooks 
company file. If QuickBooks is not running, then it will open the file specified in 
the Integration Settings screen. However, you need to give permission to 
BillQuick to open the desired company file even when QuickBooks is not 
running. 

 
2. Accordingly, set the day-to-day synchronization options in the Integration Settings screen 

(especially Send Settings). E.g., you would get time entries during initial integration and then 
change it to ‘Do not Get Time Data’ (Get Settings) for day-to-day integration because you will 
enter and manage time in BillQuick. 
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3. QuickBooks associates accounts with all items. Assign default general ledger (G/L) accounts for 
activity (service), expense and invoice items. You can make specific assignments for activity 
codes, expense codes and invoice items at the individual or project level.  
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 You can also assign income and expense accounts to activity codes and 
expense codes on the Activity Codes and Expense Codes screens. 

 
4. Next, assign payroll items to different payroll accounts. You can specify the payroll account for an 

employee or employee group.  
 



Accounting 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 426 

 
 

 If you assign payroll accounts to the Employee Group ‘ALL’, you no longer 
have to go back to Integration Settings screen every time you add a new 
employee in BillQuick. 

 
5. Payroll account can also be assigned to the other items labeled as Flag 1/2/3. For instance, you 

can use these fields in the time entry screens to flag a time entry for double-overtime. 
  

6. Now assign QuickBooks classes to projects, activity and expense items, if required. You can 
assign classes to an item or item group.  
 

7. When you are done, click Save and then Close to exit. 
 

After specifying your sync settings, you are ready to integrate with QuickBooks (primarily send data), 
whether on-demand, in real-time or on-schedule. 
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8. You can 
synchronize data 
using the 
Integration menu, 
QuickBooks (Send 
to/Get from). 
Follow the correct 
sequence while 
transferring each 
type of QuickBooks 
or BillQuick data. 
 
 
 
 
 

Alternatively, send BillQuick records to QuickBooks by clicking Send To in 
various BillQuick screens. Unlink QB Link ID option is available for records 
which you have already synchronized before.  
 

 If you reset or ‘unlink’ the link, BillQuick will treat the record 
as new and add it to the QuickBooks database upon next sync. 

 

 BillQuick identifies the records that have a corresponding record in 

QuickBooks by displaying  in the grids. 
 

9. Check the Real-Time Sync option from the QuickBooks menu if you want BillQuick and 
QuickBooks to synchronize their database in real-time. Else, set a scheduled reminder for 
integration on the Global Settings-Options screen. 
 

 Real-Time sync is a user selection; once selected, it is completely 
automatic. However, you can choose to skip certain data for real-time sync on 
the Integration Settings screen (Send/Get Settings). 

 
10. In case of existing BillQuick and QuickBooks users, it is likely that you will find duplicate records 

in the other application. Use QuickBooks Smart Match (Integration menu, QuickBooks) to match 
similar records or un-match dissimilar records between the two systems. You can view the data 
and manually link and un-link it. 
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11. Check out Sync Reports from the QuickBooks menu to see linked and unlinked data items 
between BillQuick and QuickBooks.  
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 For detailed and complete information on BillQuickQuickBooks 
Integration, please check out BillQuick-QuickBooks-Integration-Guide. Also, see 
the BillQuick 2011 Help. 

 
 

Integration with MYOB 
 
BillQuick can bi-directionally integrate data with MYOB Premier Australia, MYOB Accounting and MYOB 
Accounting Plus.  

 

BillQuick  
Table Name 

Dataflow MYOB  
Table Name 

Activity Codes  Activities List 

Expense Codes  Items Bought** 

Employee  Cards-Employee 

Vendor  Cards-Supplier 

Client  Cards-Customer 

Project  Job 

Time Entry  Activity Slips 

Invoices  Invoices  

Payments  Payments 

Chart of Accounts  Chart of Accounts 

Purchase Orders  Purchase Orders 

** Items that are marked as ‘I sell this’ in MYOB, are marked as Products in BillQuick. 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-QuickBooks-Integration-Guide-2011.pdf
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To review detailed, field-by-field mapping of data between MYOB and BillQuick, see 

BillQuick Help, BillQuick-MYOB Integration, Table & Field Mapping section. 
 
The table above shows the direction in which data can potentially flow between BillQuick and MYOB. 
Whether it flows in one direction or the other (or both) depends on choices made in the Sync Settings 
screen. 
 

 Before integrating, create a backup of your data in MYOB and BillQuick. 
 
 

Integrating Data with MYOB 

 

 You can sync your BillQuick data at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
First-Time Integration 
 
To integrate data for the first time: 
 

1.  You need to grant permission to BillQuick to access your MYOB database. To connect an Add-
On Solution (BillQuick) to your MYOB company file you must update the software license on the 
Company screen (Setup menu, Company Information). See Connection Settings in the detailed 
BillQuickMYOB Integration Guide. 
 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-MYOB-Integration-Guide-2011.pdf
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2.  Consider whether you want to send or get data from MYOB. It would primarily depend on your 
situation (new/existing user for which application). If you are an existing MYOB user and a new 
BillQuick user, it is preferred to get data initially into BillQuick.  

 
3.  Open the Sync Settings screen (Integration menu, MYOB) to define your sync preferences. 

Specify the MYOB data file and other required data to connect to it. 
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4.  Filter what data transfers between the two databases. While most companies choose to apply no 
filters initially, you can set them in the Sync Settings screen (Get Settings), if desired.  
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5.  After defining your sync settings, click Save and then Close to exit.  
 

6.  Use the Integration menu, MYOB to synchronize data. BillQuick starts getting (or sending) data 
and displays the progress.  
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 If you are not sure about how much to move, you can transfer everything 
into BillQuick and then use its Archive feature to move old clients and projects 
to a secondary archive database. 

 
7.  As a part of data touchup after transfer, review and edit the MYOB data transferred into 

BillQuick: 
 

 Update Bill and Cost Rates (Employee screen) 
 Replace ‘FromBQ-MYOBSync’ placeholders  automatically created by BillQuick 
 Assign a Manager to all projects (Project screen) 
 Change IDs of employees, projects, activity codes, etc., if needed (Change ID 

Codes screen) 
 

8.  After integrating data, verify the accounts receivable. Compare BillQuick and MYOB Aging (and 
other) reports. If the data is the same, your integration is successful. If it is not the same, the 
cause could be a journal entry that adjusted A/R or a record that did not transfer. The solution is 
usually making a manual adjustment in BillQuick. 
 
Alternatively, perform a detailed check by opening corresponding screens in both applications 
and manually adjusting data. 
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Day-to-Day Integration 
 
To integrate data on a day-to-day basis:  
 

1.  Consider where you want to save each type of master information and perform which functions 
in BillQuick and MYOB. 

 
2.  Accordingly, set the day-to-day synchronization options in the Sync Settings screen (especially 

Send Settings). E.g., you would get time entries during initial integration, and then change it to 
‘Do not Get Activity Slips’ for day-to-day integration (because you will enter and manage time in 
BillQuick and send it to MYOB). 

 

 
 
3.  MYOB associates accounts to all service, expense and invoice related items. Select the Account 

Assignment tab and assign default general ledger (G/L) accounts to BillQuick items such as 
activities, expense codes, invoices, payments, etc. In addition, you can make assignments for 
invoice line items on a Project or Project Group basis.  
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4.  When you are done, click Save and then Close to exit. 
 

After specifying your sync settings, you are ready to integrate with MYOB (primarily send data), 
whether on-demand or on-schedule. 

 
5.  You can integrate data using the 

Integration menu, MYOB (Send 
to/Get from). Follow the 
correct sequence while 
transferring each type of MYOB 
or BillQuick data. 
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Alternatively, send BillQuick records to MYOB by clicking Send To in 
various BillQuick screens. Unlink MYOB Link ID option is available for 
records which you have already synchronized before.  
 

 If you reset or ‘unlink’ the link, BillQuick will treat the 
record as new and add it to the MYOB database upon next sync. 

 

 BillQuick identifies the records that have a corresponding 

record in MYOB by displaying  in the grids. 
 
6.  Set a schedule reminder for integration on the Global Settings-Options screen. 

 
7.  In case of existing BillQuick and MYOB users, it is likely that you will find duplicate records in the 

other application. Use BillQuickMYOB Smart Match (Integration menu, MYOB) to match 
similar records or un-match dissimilar records between the two systems.  
 

 
 

Smart Match attempts to find matching data (both active as well as inactive) and link them 
automatically. If it fails to find a match, you will be able to match and un-match data manually. 

 

 For detailed and complete information on BillQuick MYOB Integration, 

check out BillQuickMYOB-Integration-Guide. Also, see the BillQuick 2011 
Help.http://www.bqe.com/_pdf/BillQuick-QuickBooks-Integration-Guide-

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-MYOB-Integration-Guide-2011.pdf
http://www.bqe.com/_pdf/BillQuick-QuickBooks-Integration-Guide-2009.pdf
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2009.pdf 

Integration with Peachtree Accounting 
 
BillQuick can bi-directionally integrate data with Peachtree Accounting.  
 

BillQuick  
Table Name 

Dataflow Peachtree  
Table Name 

Activity Code  Inventory Item (Activity) 

Expense Code  Inventory Item (Charge) 

Employee  Employee 

Vendor  Vendor 

Client  Customer 

Project  Job 

Time Entry  Time Ticket 

Expense Log  Expense Ticket 

Invoice  Invoice  
(Sales and Invoicing) 

Payments  Payments (Receipts) 

Chart of Accounts  Chart of Accounts 

Purchase Orders  Purchase Orders 

Vendor Bills  Vendor Bills 

To review detailed, field-by-field mapping of data between Peachtree and BillQuick, see 

BillQuick Help, BillQuick- Peachtree Integration, Table & Field Mapping section. 
 
The table above shows the direction in which data can potentially flow between BillQuick and Peachtree. 
Whether it flows in one direction or the other (or both) depends on choices made in the Sync Settings 
screen. 
 

 Before integrating, create a backup of your data in Peachtree and 
BillQuick. 

 
 

Integrating Data with Peachtree Accounting 

 

 You can sync your BillQuick data at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
First-Time Integration 
 
To integrate data for the first time: 
 

1.  You need to grant permission to BillQuick to access your Peachtree database. Set the security 
level for BillQuick (called a Peachtree Partner) in Peachtree (Options menu, Maintain Global 

http://www.bqe.com/_pdf/BillQuick-QuickBooks-Integration-Guide-2009.pdf
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Options screen). 
 

 
 

2.  Consider whether you want to send or get data from Peachtree. It would primarily depend on 
your situation (new/existing user for which application). If you are an existing Peachtree user and 
a new BillQuick user, it is preferred to get data initially into BillQuick.  

 
3.  Open the Sync Settings screen (Integration menu, Peachtree Accounting) to define your sync 

preferences. Specify your Peachtree Version and Company file to connect to it. 
 

 
 

4.  Filter what data transfers between the two databases. While most companies choose to apply no 
filters initially, you can set them in the Sync Settings screen (Get Settings), if desired.  
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5.  After defining your sync settings, click Save and then Close to exit. 
 

6.  Use the 
Integration 
menu, Peachtree 
Accounting to 
synchronize data. 
BillQuick starts 
getting (or 
sending) data and 
displays the 
progress.  
 

 If you are not 
sure about how 
much to move, 
you can transfer 
everything into 
BillQuick and then 
use its Archive 
feature to move 
old clients and 
projects to a 
secondary archive 
database. 
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7.  As a part of data touchup after transfer, review and edit the Peachtree data transferred into 
BillQuick: 
 

 Update Bill and Cost Rates (Employee screen) 
 Replace ‘FromPeachtree’ placeholders  automatically created by BillQuick 
 Assign a Manager to all projects (Project screen) 
 Change IDs of employees, projects, activity codes, etc., if needed (Change ID 

Codes screen) 
 

8.  After integrating data, verify the accounts receivable. Compare BillQuick and Peachtree aging 
(and other) reports. If the data is the same, your integration is successful. If it is not the same, the 
cause could be a journal entry that adjusted A/R or a record that did not transfer. The solution is 
usually making a manual adjustment in BillQuick. 
 
Alternatively, perform a detailed check by opening corresponding screens in both applications 
and manually adjusting data. 
 

Day-to-Day Integration 
 
To integrate data on a day-to-day basis:  
 

1.  Consider where you want to save each type of master information and perform which functions 
in BillQuick and Peachtree. 

 
2.  Accordingly, set the day-to-day synchronization options in the Sync Settings screen (especially 

Send Settings). E.g., you would get time entries during initial integration, and then change it to 
‘Do not Get Time Entries’ for day-to-day integration (because you will enter and manage time in 
BillQuick and then send to Peachtree). 
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3.  Peachtree associates accounts with all activity (service), expense and invoice related items. Select 
the Accounts tab and assign Default Accounts for BillQuick items such as activities, expense 
codes, invoices, payments, vendor bills and purchase orders. You can make account assignments 
for these items on a Project or Project Group basis. 
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 The G/L account that you select depends on whether your company 
follows a Cash Basis or Accrual Basis of accounting. 

 
4.  If you want to specify G/L and A/R accounts to individual activity or expense items, do so by 

selecting the Activity Accounts and Expense Accounts options on the left. 
 

5.  Next, move to the Payroll Settings tab. Assign a Peachtree pay type from the dropdown to the 
Default Payroll Item in BillQuick. You can specify the payroll settings for an employee or 
employee group. 
 

 
 

 If you assign payroll accounts to the Employee Group ‘ALL’, you no longer 
have to go back to Sync Settings screen every time you add a new employee in 
BillQuick. 

 
6.  Associate BillQuick payroll items to Pay Types in Peachtree. You can select numbers from the 

dropdown to specify the order in which BillQuick payroll items will be listed in Peachtree’s Pay 
Types. For instance, you can assign 1 to Regular Time and number 2 for Overtime. 
 

7.  Click  to save the payroll settings. After defining your sync settings, click Save and then 
Close to exit. 

 
 After specifying your sync settings, you are ready to integrate with Peachtree (primarily send 

data), whether on-demand or on-schedule. 
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8.  You can integrate data using the 
Integration menu, Peachtree 
Accounting (Send to/Get from). 
Follow the correct sequence 
while transferring each type of 
Peachtree or BillQuick data.  
 

 BillQuick identifies the 
records that have a corresponding 
record in Peachtree by displaying 

 in the grids. 
  
9.  Set a schedule reminder for integration on the Global Settings-Options screen. 

 
10.  In case of existing BillQuick and Peachtree users, it is likely that you will find duplicate records in 

the other application. Use Peachtree Smart Match (Integration menu, Peachtree Accounting) to 
match similar records or un-match dissimilar records between the two systems. You can view 
the data and manually link and un-link it. 

 

 
 

 For detailed and complete information on BillQuickPeachtree 
Integration, check out BillQuickPeachtree-Integration-Guide. Also, see the 
BillQuick 2011 Help. 
 

http://bqesoftware.net/media/PDF/BQ/2011/BillQuick-Peachtree-Integration-Guide-2011.pdf
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Billing Overview 
 
Typically, billing managers handle the billing functions in BillQuick, though they may delegate these tasks to 
accountants or project managers. BillQuick allows a lot of flexibility and variety in terms of billing rules, 
methods, payment terms, invoice formats and related decisions. Billing decisions determine what 
information prints on an invoice. As a biller, you need to understand the pre-billing tasks and setup 
decisions before carrying out the actual billing tasks. 
 

 Decisions such as how to bill, what to bill, what to say about the work done and the layout of the 

invoice, begins with the client and project setup (master information).  Reviewers or managers in a 
company must approve time and expenses charged to a project. When ready to bill, accumulated work-in-

progress or  pre-defined billing schedule flows to the Billing Review (or Manual Invoice or wizards). You 
may set projects for automatic billing as well. 
 

 Billing decisions can be made in real-time (on-screen) or through a printed Billing Review report (off-
screen). When creating invoices, billing decisions can range from no-decisions-needed to application of 

retainers, adjustments, exclusion of time and expenses, and marking some entries as billed.  After 
executing decisions, the manager typically reviews and signs off on draft invoices, and then someone 

generates final invoices to  send them to the clients. This billing flow applies to standard invoices as well 

as joint invoices.  After receiving payments and running final reports, the project is completed.  
 

 
 

The billing manager can check out the following checklist to ensure that they take all billing decisions with 
the right information at the right time. 
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Billing 

Area Decision Where to implement 

Pre-Billing Tasks Print or check on-screen memos and project journals 
for billing-related notes and decisions. 

Time and Expense Memos 
Project Journals 

Set up BillQuick Agent for alerts and emails in case of 
delinquent timekeepers. 

Agent, Time Card Monitoring 
Agent, Alerts 

Check reports for approved time and expenses 
(WIP) as well as unapproved entries. 

Reports menu 
Report Center screen 

Invoice Layout Add a logo to invoices. Company-General screen 

Check company name, address, etc. to print on 
invoices. 

Company-General screen 

Typically add the standard text as memos or notes on 
multiple invoices. 

Auto Complete screen 

Hide no-charge (non-billable) entries on detailed 
invoices. 

Global Settings-
Time/Expense screen 

Provide electronic payment option (PayPal/IMS) in 
emailed invoices. 

Global Settings-Merchant 
screen 

Billing Arrangement Define contract type and invoice settings at the 
project level. 

Project-General screen 
Project-Billing screen 

Define billing and invoice settings at the client level. Client-Billing screen 
Client-Detail screen 

Review bill and cost rates of employees, activities and 
expense codes, and special rates in fee schedules. 

Employee screen 
Activity Codes screen 
Expense Codes screen 
Service Fee Schedule 
Expense Fee Schedule 

Determine special bill rates to apply to a project 
when you pre-purchase hours (funds/retainer on 
account). 

Project-Billing screen: 
Delayed SFS 

Negotiate retainage with the client. Project-Billing screen 

Identify who receives the invoice in the client 
organization (billing contact address). 

Client-Detail screen: Main 
Contact 
Project-Billing screen: 
Contact 

Define payment terms to print on invoices. Terms screen 
Client-Billing screen 
Project-Billing screen 

Identify clients and projects to bill in a foreign 
currency and check currency settings. 

Currency Manager screen 
Project-Billing screen 
Client-Billing screen 

All or selective project invoices should be emailed to 
the client. 

Client-Billing screen 
Project-Billing screen 

Set up project for automatic billing on a specified 
frequency. 

Project-Billing: Automatic 
Billing 
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Billing 

Area Decision Where to implement 

 Set up invoices for automatic processing on a 
specified frequency. 

Invoice Review 
Memorize Invoices 

Invoice Formats Assign or change standard/custom invoice formats for 
different billing arrangements or contract types. 

Global Settings-Templates 
Project-Billing screen 
Invoice Review screen 

Set the standard invoice number format for invoices.  
Optionally, define custom invoice numbers for 
projects. 

BillQuick Start-Up Interview  
Global Settings-Miscellaneous 
Project-Billing screen 

Joint Invoices Identify projects for a client or phases of a project to 
bill together. Set the default to joint invoice. 

Client-Billing screen 
Project-Billing screen 

Combine billing records on a single invoice. Billing Review screen 

Retainers Set the standard invoice number format for retainer 
invoices.  

Global Settings-Miscellaneous 

Request project-specific or client-specific retainers 
from the clients 
Create retainer invoices. 

Retainer Management screen 
Project-Billing screen 

Record retainer payments from clients. Payment screen 

Apply project or client retainer payments. Payment screen 
Billing Review 

Set up retainer invoices for automatic processing on a 
specified frequency. 

Retainer Management-
Payment 
Memorize Invoices 

Late Fees  Set interest rate and grace period for all past due 
invoices of all clients 

BillQuick Start-Up Interview 
Global Settings-Options 

Set interest rate and grace period for past due 
invoices related to a project 

Project-Detail screen 

 
 

Billing Methods 
 
BillQuick offers various billing methods and arrangements with flexible options. You can choose the 
method according to your need and situation: 
 

 Fixed or Progressive Billing 
 Hourly Billing 
 Percent Complete Billing 
 Phased Billing 
 Recurring Billing 
 Cost Plus Billing 
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Fixed or Progressive Billing 
 
Progressive flat fee billing occurs when a client is billed a portion of the total contract amount over a 
number of months. Depending on the circumstances, the billed amount may be the same (fixed) or vary in 
each billing cycle. At the end, Bill Final (right-click option) can be used to auto calculate the last Net Bill 
amount. 
 
When the project contract or company policy defines a different billing amount, use a Billing Schedule to 
define billing records. You can create future billing records in it, adding or editing them later. This is also 
useful for milestone billing. (See Creating Billing Schedules below.) 
 
Using the billing record’s Reminder Date in the schedule, BillQuick knows when to remind you to process 
an invoice. The Billing Schedule allows you to enter a bill amount or calculate it as a percent of the contract 
amount. In addition, you can apply a percentage of the project’s retainer to all or part of selected billing 
records. Another option is to include expenses in the bill amount or to bill them in addition to the amount. 
Similarly, you can bill or ‘absorb’ extra time and expense (over-contract amounts). BillQuick also lets you 
add a standard memo to carry to the invoice.  
 
Fixed Fee Invoice 
 
Fixed fee invoice is also called the company’s ‘single service fee invoice’. From the sample below, you can 
gain an understanding of how the billing process requires input from different sources and how the entire 
information fits together.   
 
BillQuick adds the Draft watermark when you choose ‘Process as Draft’ option on the Billing Review 
screen. The watermark disappears when you finalize it in Invoice Review screen. The ‘Paid’ watermark 
prints when the invoice finishes processing. 
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 Name and address carries from the Company screen.  

 The recipient’s name and address carries from (a) the main client contact and client address, or (b) the 
project contact address (prints only if you mark ‘Send Invoice to Contact’).  
 

 Invoice Date defaults to the system date. Companies usually change the invoice to a future date to allow 
for printing and mailing. Aging begins on this date.  
 
BillQuick assigns the next available invoice number on checking the Bill box in the Billing Review screen. In 
this case, a draft invoice number prints in angle brackets.  
 

 The date range carries from the Billing Review screen. The range determines what unbilled, approved 
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time and expenses (work-in-progress) to include in the billing record. As you can see, the date range covers 
any period you want. 
 

 Note that the contract type is Fixed. The company chose to bill by time (rather than by percent 
complete or with a billing schedule).  
 

 The Amount (Net Bill on Billing Review) is Service Amount (Billable on Billing Review) less adjustments 
such as applied discounts, write-up/down, applied retainer, etc. Service Amount is the billable value of the 

approved time entries in the specified date range (see ), including any taxes on individual entries (Tax 1, 
2 or 3 of Activity Codes or in the service fee schedule assigned to the project).  
 

 Approved expenses within the date range defined on the Billing Review screen, which includes taxes on 
individual entries.  
 
You may or may not apply GST to your invoices. Typically, GST equals the calculated Main Service Tax on 
total labor billed plus calculated Main Expense Tax on total expenses billed. You can define MST and MET 
percentages on the Company screen, and as needed, change the rates in Client and Project profiles. 
 

 Payment terms for the invoice. BillQuick first looks at the terms specified in the Project profile, else the 
Client profile. If neither profile contains it, BillQuick prints the default payment term (‘This invoice is due 
upon receipt’). 
 

 Account Summary includes Accounts Receivable (A/R) information – past invoices, payments and 
amount unpaid. Other invoice formats include retainer paid, balance information or aging summary. 
 

 BillQuick supports two memos per invoice. In most invoice formats, the 
first appears near the top of the invoice and the second near the bottom.  

 
Progress Billing 
 
Often you are ready to bill but may not have entered all the time and expenses yet. Typically, you may 
want to send progress invoices to your client and associate your time and expense entries to the invoices 
on a later date. BillQuick allows you to bill now and link (reconcile) the time data on a later date. When you 
do so, BillQuick recalculates any write-up/down for all time entries associated with that invoice. 
 
BillQuick’s progress bill feature lets you release time entries after billing. You could send a progress bill or 
your monthly invoices with the projected value of the work done. Later, you can put the timesheets 
through the submission and approval process, and then associate them with the right un-posted or posted 
invoice. You do not need to mark it as non-billable or reverse invoices or payments. Your job cost and 
profitability information are updated. Moreover, if you need to reprint the invoice, the items you added will 
be there. 
 
To release time entries: 
 

1.   Open the Sheet View screen and select the View By Project option. 
 
2.  Select the Period for which you want to view and release time entries. 
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3.  Select all the relevant time entries and click Tools. Make sure all the selected time entries are 
approved. 
 

4.  Select Change from its dropdown. On the Change screen, check the ‘Set Billed Status Flag to’ 
option and mark it as True. 

 

 
 

5.  To associate the selected time entries it to a previously processed invoice, check the ‘Invoice No 
to’ option and select the relevant invoice from the dropdown. 
 

6.  Keep the Recalculate WUD option checked if you want BillQuick to adjust the write-up/down 
factor for these entries.  
 

7.  Click OK and exit. 
 
 

Hourly Billing 
 
Hourly billing is the most common billing practice across service industries. It involves dynamic generation 
of billing records for projects, bringing together time, expenses, retainer balances, amounts owed and paid, 
and other information. Only approved time and expenses (work-in-progress) are included for the selected 
date range. For Hourly invoices, the invoice amount is the total of the Bill Amount and Charge Amount for 
the billed time and expenses after any adjustments made during the billing process.  
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 Depending on your tax situation, BillQuick applies taxes to individual activity 
codes and/or expense codes (Tax 1, 2, 3) when you record time and expenses.  
BillQuick also applies a second level of tax (Main Service Tax/ Main Expense Tax) 
to the total billed services and expenses. You can choose which taxes to apply.   

 
BillQuick includes many standard hourly invoice templates, presenting services and expenses in a variety of 
summary and detailed formats. 
 
Hourly Invoice 
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     See the previous sample. 
 

 When making billing decisions, you may exclude or write up or down some time entries. The remaining 
entries print and total on the invoice. The invoice lists who worked, how much and on what activity and 
how much the client is charged per hour. 
 

 When timekeepers record time entries, BillQuick inserts the description for chosen the activity. 
Optionally, you can add a memo to a time entry (or expense entry). In some invoice formats, the time and 
expense descriptions and memos print on an invoice. Other formats omit it. You can customize the invoice 
format as needed.  
 

 The Amount (Net Bill on Billing Review) is Service Amount (Billable on Billing Review) less adjustments 
such as applied discounts, write-up/down, applied retainer, etc. Service Amount is the billable value of the 

approved time entries in the specified date range (see ), including any taxes on individual entries (Tax 1, 
2 or 3 of Activity Codes or in the service fee schedule assigned to the project). 
 

 Approved expenses within the date range defined on the Billing Review screen, which includes taxes on 
individual entries.  
 
This section displays the account summary. It informs the client about what the current bill covers and the 
total amount owed. 
 

 Payment terms for the invoice. BillQuick first looks at the terms specified in the Project profile, else the 
Client profile. If neither profile contains it, BillQuick prints the default payment term (‘This invoice is due 
upon receipt’). 
 

 Account Summary includes Accounts Receivable (A/R) information – past invoices, payments and 
amount unpaid. Other invoice formats include retainer paid, balance information or aging summary. 
 
 

Percent Complete Billing 
 
‘Percent Complete’ in BillQuick is the subjective determination of how far along a project is. Throughout 
the life of a project, the manager may update this percent complete value. You can calculate this 
percentage based on the contract amount used or spent and then bill the client accordingly. 
 
You can use percent complete value in two ways in BillQuick: 
 

 To compute the estimated earned value: BillQuick compares it to the actual earned value for the 
project (based on the Amount Spent). A significant difference in these two values indicates that a 
problem is looming. The Earned Value – Estimated report uses the percent complete value. 

 
 To determine how much to bill: Percent complete billing involves the usage of ‘% Complete’ value 

of the project (in Project screen or Billing Review grid) to calculate the net bill amount. 
 
Percent complete billing supports both single project per invoice and joint invoicing. When billing on a 
percent complete basis, BillQuick asks if you want to update the % Complete value in the project profile as 
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well. You have an option to include or exclude the expenses as a part of the contract amount so that 
BillQuick calculates percent complete bill amount accordingly on the project’s Service or Labor Amount. 
 
You can bill phases using percent-complete values from each project phase. For a joint phased percent-
complete billing, BillQuick ‘joins’ the billing records for each phase with unbilled labor and expenses. If 
desired, you can include completed or not-yet-started phases. Billing records for the same client having the 
same code automatically combine on a joint invoice. You can decide to generate a phased percent-
complete joint invoice for each phase on the Project-Billing screen or dynamically during a billing session in 
the Billing Review screen. See Creating Joint Invoices and Creating Percent Complete Invoices below for more. 
 
 

Phased Billing 
 
You may bill one phase or all phases of a project on a joint invoice. It includes completed and not-yet-
started phases. Special phased invoice wizard and formats are available in BillQuick (See Invoice Wizards 
below for more). If you have specified different custom invoice formats for the phases, BillQuick looks for 
the invoice format of the first project in the list. 
 

 Each phase of a project is an independent project record. Thus, you can 
assign different contract types or billing arrangements—hourly, fixed fee, 
percentage, etc. to it. See Project Hierarchy in the Project Management chapter for 
more. 

 

 Whether you are new to BillQuick billing or use it only periodically to 
generate phased invoices, the Phase Invoice Wizard (View menu, Wizards) is 
easier to use. It walks you through the process of creating a joint invoice for 
phased projects. See Invoice Wizards below for more. 
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Joint Phased Percent Complete Invoice 
 

 
 

    See the previous samples. 
 

 Project ID and Phase Description carries from the project phase profile. 
 

 Each phase’s percent of the total project contract amount carries from the project profile.  
 

 Contract (amount) carries from the project phase profile. 
 

 Percent Complete is a decision of the billing manager – accept the % Complete value in the Project 
profile or enter an updated value in the Billing Review screen. 
 

 This is the Service Amount previously billed and carries from accounts receivable for each project 
phase. It illustrates how much of the contract have you already billed to date.  
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 This informs the client of the invoice amount due on Services and Expenses. Amount Due is  

Contract Amount x  Percent Complete -  Services Billed. 
 

 See the previous samples.  
 
 

Recurring Billing 
 
Recurring billing involves pre-setting bill amounts billed to the client on a set frequency such as weekly, 
biweekly, monthly, quarterly, etc. The billed amount is the same regardless of the hours expended. 
BillQuick allows you to reduce the expenses on the recurring bill or to add them to the invoice (in addition 
to the recurring amount).  

 

 Frequency of billing for a project starts from the date of the invoice. Billing 
frequency can also be set for the non-recurring project contracts. 

 
When you select a ‘Recurring’ contract type for a project, BillQuick generates the billing record as per the 
frequency set in Project screen. It does not automatically create an invoice; however, it does remind you 
via Reminders screen that bills need to be processed. If billing does not take place, BillQuick generates a 
recurring billing record for each billing period in Billing Review. If desired, you can allow billing a different 
and higher amount than the specified recurring amount. This happens when the value of time and expenses 
for the project exceeds the recurring amount. 
 
Preferred invoice layouts for recurring bills vary widely. Some prefer a detailed list of time and expenses to 
show the amount of work done, while others prefer a fixed (single fee) invoice with occasional memos. See 
Processing Recurring Invoices below for more. 
 
 

Cost-Plus Billing 

 
If you are an engineering, architectural or other professional services firm that works for federal or state 
agencies, you may have to use Cost Plus contracts. Cost plus billing adds a profit margin or management fee 
to the bill amount. BillQuick supports Cost + Percentage and Cost + Fixed Fee contracts, including their 
invoice templates. You can set special bill rates in the SFS or EFS for the direct costs and set the fixed fee 
or percentage on the Project-General screen. 
 
Cost + Fixed Fee  
 
This contract can be used as a billing arrangement when you want to bill direct costs—time and expense (if 
expenses are a part of contract)—plus a fixed fee (profit) to the client. The total fixed fee is available in the 
Project profile. BillQuick adds a portion of the Fixed Fee to the Net Bill before generating the invoice. 
BillQuick also tracks the fixed fee portion to ensure you do not over-bill. 
 

Fixed Fee Amount = Billable Amount x (Fixed Fee / Contract Amount) 
 
Net Bill= Service Amount + Service Tax + Expense Amount + Expense Tax +  
  Fixed Fee – Discount – Retainer Applied 
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For example: 
Contract Amount = $1000, Fixed Fee Amount = $100, Value of billable time and expenses = $500 
Fixed Fee = 500 x (100/1000) = $50 
  
Cost + Percentage  
 
This contract can be used as a billing arrangement when you want to bill direct costs—time and expense (if 
expenses are a part of contract)—plus a percentage of the costs (profit) to the client. The total fixed fee 
percentage is available in the Project profile. BillQuick adds the profit percentage to the Net Bill before 
generating the invoice until the project is complete.  
 

Fixed Fee Amount = Billable Amount x Fixed Fee %  
 
Net Bill= Service Amount + Service Tax + Expense Amount + Expense Tax +  
  Fixed Fee – Discount – Retainer Applied 

 
For example: 
Contract Amount = $1000, Fixed Fee % = 10, Value of billable time and expenses = $500 
Fixed Fee = 500 x (10/100) = $50 
 

 This is how Billing Review calculates the Fixed Fee Amount. However, you 
can manually override it with a different amount. It will then re-calculate the Net 
Bill Amount. However, if you change the Net Bill manually, it does NOT change 
the Fixed Fee Amount. 

 
 

Payment Terms 
 
Payment terms indicate when you expect to receive a payment from a customer. BillQuick allows you to 
specify and customize payment terms on invoices. In case of forgetful clients or late payments, you can 
charge an interest rate or late fee. These user-defined terms are available in the Project and Client screens and 
applied in the Billing Review screen. 
 
This section covers the following tasks: 
 

 Creating Payment Terms 
 Assigning Payment Terms 

 
 

Creating Payment Terms 
 
To create payment terms: 
 

1. Open the Terms screen from the View menu. 
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2. Click New to add a new payment term. 
 

3. Enter a Term Name, such as Net 30, Net 45 or Net 90. 
 

4. Next, enter the related Grace Days, such as 30 days for Net 30 or 45 for New 45 term. Click on 
the next row to save the term. 
 

5. When you are done, click Close to exit. 
 
 

Assigning Payment Terms 
 
You can assign payment terms to purchase orders and invoices from various screens in BillQuick. You can 
do so in the following ways: 
 

 Purchase Order screen: You can assign payment terms to purchase orders sent to vendors. For 
details, see Purchase Orders in the Accounting chapter. 

 
  Client-Billing screen: Payment terms specified at the client level apply to all the projects of a client. 

For details, see Client Setup in the Master Information Setup chapter. 
 
  Project-Billing screen: Payment terms specified at the project level apply to individual projects 

only. For details, see Project Setup in the Master Information Setup chapter. 
 
The payment terms selected for a project overrides the default terms set at the client level. However, for 
joint invoicing, the payment terms will always pull from the Client profile. E.g., if all projects included on an 
invoice are set to Net 30 at the project level, but Net 60 at the client level, the joint invoice will have Net 
60 as the payment term.  

 
 

Invoice Format 
 
An invoice is a marketing document that nurtures client relationships. It must communicate positive images 
to both new and long-term clients: Quality, Capability, Professionalism and Confidence. BillQuick comes 
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with 150+ standard invoice formats, all designed with Crystal Reports, the de facto standard report writer 
software. 
 
BillQuick lets you customize the invoice format on a project basis. You can customize the invoice number 
and format, and set invoice display attributes per project. For example, if you want to show the account 
summary on some project invoices and hide it on others, you can do so by checking those rules on the 
Project-Detail screen. You can also set these attributes for all projects from the Global Settings-Rules 
screen. 
 

 To customize invoice templates, you can use Crystal Reports 9.0 or later to 
do it yourself, or contact us for Report Customization Service at (310) 602-4020. 
Many of our invoice templates are available for preview at 
www.bqe.com/GenSolutions or you can check out the free BillQuick eBooks for 
billing managers, business managers and project managers. You can also purchase 
the detailed BillQuick Report Book. 

 
BillQuick provides the following invoice format options: 
 

 Choosing Invoice Templates 
 Customizing Invoice Numbers 
 Including Memos on Invoices 

 
 

Choosing Invoice Templates 
 
Standard invoice templates support detail or summary information, individual time and expense 
descriptions and memos, retainers and discounts applied, two invoice memos, employee titles, and value-
added taxes (e.g. GST). In addition, many support a standard graphic logo (Company screen). 
 

 You can set all your invoice templates to show Goods and Services Tax 
(GST) at the project or global level. This option is checked by default for all 
countries other than USA when creating a new database. 

 
Invoice templates are set at the global level but you can change them at the project and invoice level.  
 
To choose a global invoice template: 
 

1. Open the Global Settings screen from the Settings menu or toolbar. 
 

2. Select the Templates option. 
 

http://www.bqe.com/GenSolutions.asp?pageId=Samples
http://www.pagegangster.com/p/VnWkO/
http://www.pagegangster.com/p/4ss47/
http://www.pagegangster.com/p/OLChf/
http://sites.fastspring.com/billquick/product/BillQuick-Report-Book-2011
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3. Click  next to the relevant contract type to open the invoice list.  
 

4. On the Invoice Selection screen, choose the desired invoice template. The sample displays on the 
right. 
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5. Click OK to save the template.  
 

6. Back on the Global Settings screen, click Save and then Close to exit.  
 

 By default, invoices display time and expense entries based on their ‘Created 
On’ dates. 

 
To choose a project invoice template: 
 

1.  Open the Project screen and select a project from the grid for which you want a different invoice 
template. 
 

2.  Click Tools and select Invoice Templates or click Invoice Templates on the Billing tab to open the 
Invoice Selection screen.  
 

3.  You can see the default Assigned Invoice Templates at the top. To change a template, scan the 
Invoices list on the left.  

 

 
 

4.  Choose the desired invoice template and preview the sample on the right. 
 

5.  Click Assign Selected for the relevant invoice type. BillQuick checks that option automatically. For 
Statement, you can click Browse and select any other template. 
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6.  When you are done, click OK to save the template.  
 

7. Back on the Project screen, click Save and then Close to exit.  
 

When the invoice is printed, BillQuick uses the custom template from the Project screen rather than the 
Global Settings template. You can change the invoice template at the last minute in the Invoice Review 
screen without reversing it or changing the project settings. 
 
 

Customizing Invoice Numbers 
 
When setting up BillQuick for the first time, consider whether you want to start with a new number 
structure or use the last invoice number from your old time and billing system. Either way, BillQuick needs 
the last invoice number. By default, it begins numbering invoices with the invoice number defined on Global 
Settings-Miscellaneous screen. You can override this and specify a custom invoice number on the Project-
Billing screen. If a project has phases under it, you are prompted whether to let the immediate phases 
inherit the custom invoice number or not. 
 
If you want to structure the invoice number so that it has static and variable portions, you can define this. 
BillQuick supports automatically incremental invoice numbers of up to 10 characters (including 
punctuation). For example, if you wanted to include the fiscal year in the invoice number structure, you 
have to enter it as static information. The variable will be the incremental part put in curly brackets.  
 

 Custom invoice numbering feature is available in the BillQuick Enterprise 
edition only. 

 
To customize your invoice numbers: 
 

1.   Open the Global Settings screen from the Settings menu or toolbar. 
 

2.   Click the Miscellaneous option on the left. 
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3.  Enter the desired value in the ‘Last Printed Invoice #’ field, e.g., {0000}. The next invoice 
generated will have a number of {0001} and so on. You can add a prefix to it, like INV or FY-2011. 
The prefix will remain static while the number in the curly brackets will be incremented.   
 

4.  Click Save and then Close to exit. 
 
You can also customize invoice numbers at the project level. To do so: 
 

1.  Open the Project screen. 
 

2.  Select a project from the grid to which you want to assign a custom invoice number. Then move to 
its Billing tab 
 

3.  Enter the desired Prefix, Last Invoice Number and Suffix values, e.g., Tax-{1100}-2011. 
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4.  Check the ‘Use Custom Invoice Number’ option to enable this customization for the project. 
 

5.  When you are done, click Save and then Close to exit.  
 

The next invoice generated for this taxation project will have a number of Tax-{1101}-2011.  
 
 

Including Time and Expense Memos on Invoices 
 
BillQuick gives you the option to include time and expense memos on invoices. You can control inclusion of 
memos in two ways: 
 

 Invoice Format: Whether an invoice shows detailed time and expense items with memos depends 
on the invoice format you choose for a project. You have three ways to do this:  
 

1.  Assign a detailed invoice template that includes memos to your project contract type in the 
Global Settings-Templates screen.  
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2.  Assign a detailed invoice template that includes memos to a project in the Project screen, 
using the Templates option. 

3.  Select a detailed invoice template when re-issuing an invoice in the Invoice Review screen, 
using Invoice Template option. 

 
 ‘Memo on Invoices’ Option: By default, every memo carries to a detailed invoice format with 

memos. You can ensure this by checking the ‘Memo on Invoices’ option for each entry in the Sheet 
View or Expense Log screen. (To hold back memos, uncheck the option.) 

 

 
 
 

Rates 

 
BillQuick supports both default bill rates and special bill rates. Employee default rates are part of the 
employee record. You can define special bill rates in a Service Fee Schedule assigned to a project. 
Optionally, you may define bill rates for activity codes. 
 
After negotiating with a client, for instance, project managers would decide whether to charge default 
employee bill rates, activity rates or special fee schedule rates. By defining the rates to use up front, you 
eliminate non-billable administrative hours otherwise spent checking and correcting rate information. This 
can be as simple or as complex as the project requires. For example: 
 

Use default bill and 
cost rates  

Check the rates of each employee that will work on the project to make 
sure the Bill Rate, Pay Rate and Overhead Multiplier are up-to-date. No 
special rates apply. 

Use special bill rates 
and default cost rates 

Create a SFS that defines the special bill rates. You can select individual or 
group of employees/vendors and activities to which special bill rates apply.  

Use activity bill rates Set the activity bill rates in the Activity Codes screen. Next, add it to the 
Rate Hierarchy by marking the ‘Rates from Activity Table’ option on the 
Project-Detail screen. 

Use default, activity 
and special bill and 
cost rates 

Map out the rates on a piece of paper before entering them into BillQuick. 
After completing the map, review it and check for conflicts. Step through 
the rate hierarchy (see below). Finally, setup the rates in BillQuick and test 
them before going live on the project.  

 
This section covers the following tasks related to rates: 
 

 Determining Rates 
 Calculating Ideal Bill Rate 
 Calculating Cost Rates 
 Setting-Up Day Rates 
 Updating Rates 
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Determining Rates 
 
All time entries in BillQuick must have both a bill rate and a cost rate. One of BillQuick’s best features is the 
ability to assign an unlimited number of rates to employees, activities and projects. A manager can 
predetermine these rates, allowing the timekeepers to record their time without any knowledge of the 
rates.  
 
There are three screens in BillQuick where you can define rates: 
 

 Service Fee Schedule: BillQuick assigns bill rates, cost rates and over-time multipliers based 
on a combination of employee-activity and classification.  

 Activity Codes: BillQuick assigns bill rate and a cost rate per activity. 
 Employee: BillQuick assigns default bill rate, cost rate and overtime rate per employee. 

 
BillQuick allows you to set fee schedule rates and specify a classification (title or labor category) for the 
employee. You can have several titles for an employee and may want to set different rates for different 
titles. E.g., an employee may be called a Research Analyst by one agency and a Junior Consultant by 
another. In addition, quite often we end up negotiating a fee structure with our client based on the 
employee’s classification or title. E.g., Senior Designer = $200, Engineer = $150, Draftsperson = $95 and 
Junior Engineer = $125. Therefore, BillQuick lets you specify special rates based on such classification. This 
classification is associated with the relevant time and expense entries, but you can edit it in the respective 
screens.  
 

 Rates by classification feature is available in the BillQuick Pro and Enterprise 
editions only. 

 
The logic used by BillQuick to determine which rate to use is as follows: 
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1. Once you select a project in the time entry screen, BillQuick searches for an associated Service Fee 
Schedule. If you have assigned a SFS to that project and BillQuick finds a matching combination of 
employee and activity there, it applies this Bill Rate and Cost Rate to the time entry.  
 

 In case of multiple matches, BillQuick follows the Priority number as set in 
the SFS screen. This priority number is based on the original sort order of the SFS 
items but can be changed. 

 
Some users want to use the SFS to have both their Bill Rate and Cost Rate default to zero dollars, 
but keep the entry billable. BillQuick lets you specify a $0 rate or null value in a fee schedule if you 
specify that option in Global Settings. In case of $0 rate, BillQuick will apply it to the time entries. In 
case of null value, BillQuick will ignore the SFS and search for the next rate in the rate hierarchy.  
 
If no matching combination is found or if no SFS is assigned to the project, BillQuick proceeds to step 2. 

 
2. BillQuick searches the Project record ‘Rates from Activity Table’ option. If it is checked, BillQuick 

uses the Bill Rate and Cost Rate from the Activity Codes screen. If ‘Rates from Activity Table’ option 
is unchecked, BillQuick proceeds to step 3. 

 
3. BillQuick uses the Bill Rate and Cost Rate from the Employee screen. 

 

 The expenses follow similar rules in determining which unit cost rate to 
apply to an expense entry but it skips step 2. If there is no unit cost rate for the 
expense code in the Expense Codes screen nor an Expense Fee Schedule, 
BillQuick requires you to enter one. 

 
 

Calculating Ideal Bill Rate 
 
Ideal Bill Rate is the rate producing the target profit per hour. Many owners, principals and managers do 
not take into account all the key elements that make up an ideal bill rate. To determine the ideal bill rate, 
you need to know not only the profit margin but also the utilization rate of your employees and their 
overhead multiplier.  
 
The calculations are: 
 
Utilization Rate = (Direct Payroll Cost / Total Project Cost) x 100 
 

For example, if the direct project labor is $10,000 and the total project cost is $14,000, then the 
utilization rate as per the formula is: 
Utilization Rate = (10,000 / 14,000) x 100 = 71.4 % 

 
Now let us calculate the Overhead Multiplier (OHM) as: 
OHM = Total Expenses / Total Payroll Expenses 
 

If the total expenses incurred last year are $1,000,000 and the payroll expenses amounted to $400,000, 
then: 
OHM = 1,000,000 / 400,000 = 2.5 
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 Usually, profitable companies have an OHM between 2.1 to 2.6 (maximum 3.0). 
 
Finally, you can calculate the ideal bill rate as: 
Ideal Bill Rate  = (Pay Rate x OHM x Profit %) / Utilization Rate or 
    = (Bill Rate x Profit %) / Utilization Rate 
     

If the pay rate of the employee is $30 per hour and the profit percentage is 20%, then: 
Ideal Bill Rate = (30 x 2.5 x 1.2) / .714 = $126 per hour 

 
What this means is that if an employee has a pay rate of $30 and bill rate of $100 with 71.4% utilization, 
you should ideally charge the client at $126 to make a 20% profit. 
 
 

Calculating Cost Rates 
 
It is recommended that everyone in your company who draws a paycheck (including principals) should 
enter time in BillQuick so that you have an accurate accounting of the hours (and thus, dollars) invested in 
your business. It may be a bit odd for non-project personnel to do so since BillQuick is ‘project-centric’, 
however, this ensures consistency in the use of a single application to record time. These ‘indirect’ people 
can basically make the same entry (say Project=GEN:Off, Activity Code=clerical) from one day to the 
next and the system will send the time to the appropriate G/L account in your accounting software.   
 
BillQuick requires a bill and cost rate for the employees and vendors working on billable projects. You can 
calculate the cost rate as: 
 
Cost Rate = Pay Rate x Overhead Multiplier 

 
BillQuick applies a Cost Rate to actual hours worked to compute the Cost Amount for a time entry when 
you save it.  BillQuick applies rates as per the rate hierarchy (see above). When you update the OHM, 
BillQuick applies the new cost rate (Pay Rate x new OHM) to all the new time entries for an employee. 
When you create a new budget (that includes optional costs) after updating OHM, it also uses the updated 
cost rate. However, BillQuick does not retroactively update cost amounts for previous time entries or budgets.  
 
To update budgets for new cost rates, you must manually change them. If you need to update cost rates for 
time entries, you can use one of the following options: 
 

 Change feature in the Sheet View screen 
 Update Rates option on the right-click menu in the Sheet View screen 
 QuickUpdate utility (Utilities menu) 

 

 See Updating Rates below for more. 

 
 

Setting-Up Day Rates 
 
A day rate is a set number of hours and amount charged to a client for a task or activity, regardless of the 
actual hours worked in a day. In BillQuick, it is set up using the Bill Rate and Minimum Hours value for an 
activity.  
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 You can also define a day rate on a service fee schedule. 

 
How you report day rate activity on an invoice depends on whether actual time worked is greater or less 
than the stipulated time. When A-Hours (Actual Hours) are greater than the B-Hours (Billing Hours), you 
may want to show the extra hours on the invoice. Conversely, when A-Hours are less than B-Hours, you 
may not want to show this information. 
 
To set up a day rate for your company: 
 

1. Open Activity Codes screen.  
 

2. Click  to open the Field Chooser and check the Minimum Hours and Bill Rate fields. These fields 
now display in the grid.  
 

3. Click New. In the first field, enter a unique Code, Sub and Description. This will make it easy for a 
timekeeper to identify the day-rate activity code in a drop-down list. 

 

 
 

4. In the Minimum Hours field, enter 8 (this day rate is based on a standard 8-hour day). 
 
5. Move to the Bill Rate field. Calculate this rate by dividing the negotiated day rate by Minimum 

Hours. For example, if the day rate is $1,200, then the Bill Rate is $150 per hour (1,200 / 8 = 150). 
 
6. Mark the ‘B’ (Billable) checkbox. Press Tab through the end of the row or click a field in another 

row to save the new record.  
 

7. When you are done, click Close to exit. 
 
When a timekeeper selects the above (day-rate) activity while recording time entries, BillQuick carries its 
Minimum Hours and Bill Rate to the time record. For this, you must check the ‘Rates from Activity 
Table’ rule for the project in the Project-Detail screen. It adjusts the B-Hours to the Minimum Hours 
and applies the activity’s Bill Rate to calculate the Bill Amount. The timekeeper enters his A-Hours (actual 
hours), which calculates the cost of the activity and then saves the time entry. 
 
On the invoice, if A-Hours are greater than B-Hours (Say an 8-hour day-rate activity took 10 hours to 
complete), the extra 2 hours do not print on the invoice. Alternatively, if A-Hours is 6 and B-Hours is 8, 
you do not want to show that it took less time to complete the actual work to a client. 
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When you want to present the extra or free hours on an invoice, split the time entry into two. Enter your 
hours, let BillQuick adjust B-Hours to the minimum, then make sure A-Hours is the same eight hours. 
Next, create a second entry for the same activity and enter 2 in both B-Hours and A-Hours fields, then 
mark the entry as non-billable. This creates a separate item on the invoice and because you marked it as 
non-billable, it prints ‘No Charge’ on the invoice. 
 
A timekeeper with appropriate security permissions can accomplish this task; however, many companies 
delegate this responsibility to a project or billing manager. Thus, while they review time in Sheet View or 
on the Billing Review-Time Details screen, they can look for day-rate activities and determine whether to 
split the time entry into two to show the free hours. 
 
 

Updating Rates 
 
You may need to update or replace rates at any time. For example: 
 

 A revised contract might result in new bill rates 
 At year-end, you would update fee schedule items (or several times per year) for the 

New Year’s rates 
 At year-end, you may convert default employee rates to special fee schedule rates so 

as to easily handle ‘special deals’ offered to clients 
 An employee received a raise  
 The cost of employee benefits or other overhead items changed  
 Higher costs are anticipated for the new year  
 You want to recover profits siphoned by the weak economy over the past few years 
 A new service is being offered 

 
There are various ways of updating rates: 
 

 You can change the bill and cost rates for a single time or expense entry in the time entry or 
expense entry screens (Sheet View, Timer, Expense Log, etc.). BillQuick uses this new rate to 
compute the bill value for the entry. 
 

 If a fee schedule is assigned to a project and you change rates in the assigned fee schedule, the next 
time a timekeeper charges hours or expenses to the project (that find a match in the schedule), 
BillQuick uses the new rate to compute the bill value for the entry. For example, on the first day of 
a new year, you would update SFS rates for a project. From that point forward, BillQuick applies 
the new rates to hours worked on it.  
 
When you modify the pay rate of an employee (say a raise), BillQuick scans the fee schedules to 
check if you used a Pay Rate Multiplier for that employee. If so, it prompts you to update the bill 
rate in those fee schedules. 

 

 However, changing schedule items or updating its rates does not modify 
previously recorded time entries.  

 
 If you need to update bill and cost rates for multiple time or expense entries (batch update), you 

can use the Batch Change feature in the time entry or expense entry screens. You can also use 
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filters to narrow the entries to update. BillQuick updates the rates based on the new values 
specified by you. 
 

 You can update or re-apply bill rates for single or multiple time and expense entries based on the 
current fee schedule rates (or other rates as per the Rate Hierarchy). Use the Update Rates option 
from the right-click menu in the time entry, expense entry or Reviewer screens to do so. You can 
also use filters to narrow the entries to update. 
 

 If you want to apply new bill and cost rates (current fee schedule rates or other rates as per the 
Rate Hierarchy) to multiple time entries at once, use the QuickUpdate utility. This option is useful 
when someone has manually changed the bill and cost rates in the time entry screen and you want 
to reset the earlier rates. You can also use advanced filters to narrow the entries to update. 
 

 All the above options require you to have security permissions to view and 
update bill and cost rate information. 

 
To batch update rates using QuickUpdate: 
 

1. Open the QuickUpdate screen from the Utilities menu. 
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2. Specify Filters to generate a subset of time entries for which you are updating the bill and/or cost 
rates. Select ‘All’ or a range in the From-To fields. 
 

3. Enter new rates for the bill and cost value of time entries in the Set Bill Rate and Set Cost Rate 
fields. Else, skip this to use rates in the current fee schedules or employee records by checking the 
‘Update using current Bill/Cost rates’ options. 
 

4. After specifying the filters and action, click Build to create a list of matching time entries. 
 

5. You can view all the time records whose rates are to be updated by clicking View.  
 

6. When ready, click Update to update the records and then Close to exit. 
 
 

Taxes 

 
BillQuick handles most of the tax rules used in various countries – taxes on time and/or expense entry line 
items, taxes on invoiced labor and expense, and taxes on taxes. BillQuick provides different methods to tax 
services (time entries) and expenses (expense entries). You can specify three different tax rates –Tax1, 
Tax2 and Tax3—per entry. Additionally, you may apply a fourth tax rate (Main Service Tax or Main 
Expense Tax) to the total when invoicing.  
 
At the first level, there are three item taxes, Tax1, Tax2 and Tax3. BillQuick sums the rates and applies the 
total percentage to the time or expense entry’s pre-tax bill amount, then adds the resulting tax to the bill 
amount. You can modify these tax rates during time and expense entry (with the proper security 
permissions).  
 
At the second level, BillQuick uses Main Service Tax (MST) and Main Expense Tax (MET) to tax total 
invoiced labor/services and total invoiced expenses, respectively. You may know them as Value Added Tax 
(VAT) in some countries like UK, Goods and Services Tax (GST) in others like Canada or Harmonized Sales 
Tax (HST). Item taxes are in addition to any Main Tax applied to invoiced activities. 
 
BillQuick also lets you specify how much taxes you paid as part of that expense amount. This Purchase Tax 
is very important for tracking of GST, HST or VAT. It lets you know how much tax the company paid, how 
much tax the company collected from the client and the net balance. E.g., if you paid $110 for lunch with a 
client, this amount includes the VAT or GST of $10. To enter the net amount into BillQuick, you could 
make two separate entries—the pre-tax amount of $100 and the VAT/GST portion of $10. Alternatively, 
you can specify the purchase tax rate for an expense and BillQuick does the math for you. You can run your 
VAT or GST reports that show the total taxes paid by your company and total taxes collected. The Net is 
what you owe to the tax authority. 
 
When generating billing records, Billing Review or Manual Invoice checks MST and MET for the project 
being billed. If BillQuick finds them, it calculates the required tax amount to carry to an invoice. The Tax 1, 
2 and 3 amount is included in the contract amount but the main tax is not. 
 
This section teaches you the following tasks: 
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 Setting-Up Taxes 
 Computing Taxes 

 
 

Setting-Up Taxes 
 
In the United States and many other countries, tax jurisdictions vary in how they tax services and expenses. 
If you wish to tax individual activities and expense items, first determine jurisdiction requirements. You can 
customize tax field labels for your jurisdictions using Custom Labels (e.g., changing MET/MST to GST or 
VAT).  
 

 If the tax authority in your area imposes taxes only on invoiced labor or 
expenses, set up the MST and MET. If the tax authority charges one tax on top of 
another, use both the MST and item tax fields.  

 
You may define MST and MET percentages on the Company screen. Each time you set up a new client, 
BillQuick carries forward those rates to the Client profile. You can edit them as needed. In turn, when you 
set up a new project for a client, MST and MET carry from the Client profile to the Project profile. Again, 
you can edit these rates.  
 
Line item taxes for labor/services are set on the Activity Codes screen. Similar taxes for expenses are set 
on the Expense Codes screen. If you do not charge individual taxes on activities and expenses, you can turn 
off these fields on the Activity Codes, Expense Codes, Time Entry and Expense Log screens. You can also 
do so on a company-wide basis from the Global Settings screen.  
 
When specified in Expense Codes or Expense Log screen, BillQuick subtracts the Purchase Tax from the 
Cost Amount before charging the client. E.g., if you paid a taxi fare of $110 that included 10% GST, you 
can specify this as the Purchase Tax while recording that expense. BillQuick calculates the Charge Amount 
for this expense on the pre-tax Cost Amount. Thus, while the company will reimburse you for $110, it will 
charge the client for $100 plus taxes. 
 

Taxes 

Purchase Tax The rate can be set in the Expense Codes screen. Check ‘Cost 
Includes Purchase Tax’ option and specify it in the Expense Log 
screen. 

Tax 1/2/3 The default rates can be set up in the Global Settings-Options 
screen. Else, you can define these item taxes in the Activity Codes 
and Expense Codes screen. 

Main Service Tax 
Main Expense 
Tax 

You can specify the main tax rates in the Company screen. 
BillQuick carries them to the Client screen but you can override 
them. These rates then carry to the Project screen but you can 
change them also. You can update these rates globally from the 
Global-Settings screen. 

Exempt Item 
Taxes 
 

Individual projects can be exempted from item taxes (Tax 1/2/3) by 
checking this option on the Project-Billing screen. You can exempt 
all projects of a client from these taxes by checking this option on 
the Client-Detail screen. 

MST/MET to Main taxes can exclude item taxes (Tax1/2/3), if desired. You can 
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Exclude Item Tax 
 

directly apply the main taxes to labor/service and expense amount 
on invoices. You can apply these settings at the project level 
(Project-Detail screen) or the client level (Client-Detail screen). 

Ceiling for Taxes You can set a ceiling for MST and MET on the Global Settings-More 
screen. This prevents anyone from applying a rate higher than what 
you specify here. 

 
 

Computing Taxes 
 
Three scenarios illustrate charging taxes for time and expenses. 
 

1. You are charging individual time entries for the same project at different rates. 
2. You are charging all time entries for the same project at the same rate. 
3. You are applying multiple taxes to time entries and the ‘tax is taxed’. 

 

 BillQuick provides you the option to exempt projects from item taxes (Tax 
1/2/3) and main taxes (MST/MET) to exclude item taxes (Tax 1/2/3). 

 
Scenario 1: 
 
You have applied different tax rates to time entries for the same project. Let us assume you have entered 1 
hour for each activity and $100 as Bill Rate for each entry. 
 
Time entry with activity A; Tax 1 = 10 % is charged. 
Time entry with activity B; two taxes are charged, Tax 1= 20% and Tax 2 = 30% 
Time entry with activity C; three taxes are charged, Tax 1 = 10%, Tax 2 = 20% and Tax 3 = 30% 
 
Activity A: 1 hr. x $100 x 1.1 = $110 
Activity B: 1 hr. x $100 x (1.2 + 0.3) = $150 
Activity C: 1 hr. x $100 x (1.1 + 0.2 + 0.3) = $160 
The resulting amount due on the invoice will be $300 service + $120 service tax = $420 
 

 Note that BillQuick taxes each time entry individually. In addition, when 
there is more than one tax, BillQuick sums them before applying to the entry. 

 
Scenario 2: 
 
You have taxed all time entries at a single main tax rate for the same project. Let us assume you have 
entered 3 hours for activity and $100 as the Bill Rate for each entry. 
 
Main Service Tax= 10 % 
Activity: (3 hrs. x $100) x 1.1 = $330 
The resulting amount due on the invoice will be $300 service + $30 main service tax= $330. 
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 The important thing to note here is that BillQuick applies the Main tax after 
computing the total labor amount. If you tax a standard tax rate on all labor and 
expense, enter it as the Main Service Tax in Company screen. BillQuick brings 
forward these values when creating new clients and subsequent projects. 

 
Scenario 3: 
 
You have applied multiple taxes to time entries and the ‘tax is taxed’ for the same project. Let us combine 
scenario 1 and 2. The individual time entries are taxed based on the activity (Scenario 1) and then that total 
amount is taxed (Scenario 2). 
 
Activity A: 1 hr. x $100 x 1.1 = $110 
Activity B: 1 hr. x $100 x (1.2 + 0.3) = $150 
Activity C: 1 hr. x $100 x (1.1 + 0.2 + 0.3) = $160 
The resulting amount due on the invoice will be $300 service + $120 service tax = $420 
 
Total Service + 10% MST: $420 x 1.1 = $462 
The resulting total amount due on the invoice will be $462. 
 

 Similarly, these scenarios apply to expense entries made in Expense Log. 

 
 

Retainage 
 
Retainage refers to the holding back of a portion of invoice payments by clients until they sign off on a 
project. This is most common in the construction industry, but also found in any project-oriented company. 
The client pays the total or accumulated retainage amount later — when the project is over or until he 
verifies the quality and completeness of a project. 
 
BillQuick allows you to set a retainage percentage and a maximum retainage amount in the Project –Billing 
screen (See Creating Project Profile in Master Information Setup chapter for steps). When an invoice is 
generated in the Billing Review or Manual Invoice screen, BillQuick computes the retainage amount that 
will be unpaid by the client until the agreed date. In addition, you can specify a maximum amount that a 
client can retain on a given project. 
 
E.g., if you set a retainage of 5% and maximum retainage amount is $2000 on a project, BillQuick calculate 
this 5% on every invoice (billable amount) until the accumulated retainage reaches $2000. You can see the 
Retainage Amount to Date on the Billing Review screen. Once it reaches this maximum limit, full invoice 
amount is due from the client.  
 
In case of retainage, BillQuick computes the invoice amount as: 
 
Amount Due = Services Billed + Expenses Billed + Taxes – Applied Retainer – Discount – Retainage 
 
Hence, if the total bill amount is $1000 and calculated Retainage is $50, the invoice sent to the client will 
display the bill amount prior to applying the retainage (say $1000) and then the Amount Due after retainage 
(say $1000 - $50 = $950). 
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Currency Manager 
 
Your operations may take place in multiple locations, say, United States with clients in Canada, Mexico and 
China. With different countries and foreign currencies, billing can get confusing. 
 
Currency Manager in BillQuick converts bill and expense amounts from your home currency to the local 
currency of the client (or project) when you generate an invoice. BillQuick applies the exchange rate as of 
the date when it generates an invoice. It automatically identifies your home currency from the Windows 
operating system.  
 
You can specify the local currency for clients or projects in their respective profiles. A currency selected for 
a client applies to all projects of that client, but when selected for a project, it applies only to that project. 
The only time you will see a foreign currency is on the invoices and when recording payments. Values and 
amount on your BillQuick reports always appear in your home currency.  
 
 

Assigning Currencies 
 
To assign a currency: 
 

1. Open the desired screen: Client-Billing screen or Project-Billing screen. 
 

2. Select a local currency from the dropdown in the Currency field. To add a new local currency, 
select <Add New>. 
 

3. On the Currency Manager screen, click New. 
 

4. You can enter a new Currency for a country along with the Current Multiplier and Symbol. 
BillQuick does not consider changes in rates unless you made the changes in the Multiplier field. It 
handles currency conversion automatically using this multiplier.  
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5. Update the conversion multipliers by getting the latest exchange rates from the web link at the top. 
You can specify the URL for this in the Global Settings-More screen (e.g., Yahoo currency 
converter).  
 

6. Define a preferred Decimal Character for your currency and a Separator Character, if required. 
 

7. When you are done, click Close to exit. 
 
 

Billing Schedules 
 
A billing schedule represents a decision to bill projects for a specified amount at a future date. While you 
can define a billing schedule for any contract type, you would most commonly use it for fixed-type 
contracts. You can also create billing schedule for projects with milestone billing, wherein the project 
manager makes the billing decision rather than the billing manager. Architects and engineers make payment 
schedules based on milestones achieved while working on projects. 
 
Depending on your needs, you can define billing records for the entire life of a project, or only for the initial 
period of work. You can add, edit or delete billing records any time before generating an invoice in Manual 
Invoice or Billing Review screen.  

http://finance.yahoo.com/currency-converter
http://finance.yahoo.com/currency-converter
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 You cannot create a billing schedule for a Recurring, Recurring with Cap and 
Recurring + Expenses contract types. 

 
 

Creating Billing Schedules 
 

 You can set up your billing schedule at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Setup 
 
To create a billing schedule:  
 

1.  Open the Project screen and select a project from the grid. 
 

2.  On the General tab, enter a value in the Contract Amount field. Click Save. 
 

3.  To open the Billing Schedule screen, click  next to the Contract Type field. The Project ID and 
related data is pre-filled. 
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4.  Enter an Amount for the invoice before a retainer amount (if any) is applied. Else, use the % 
Contract Amount to calculate the bill amount automatically.  
 

5.  Press Tab or click in the next field. BillQuick automatically inserts 1 in the Bill # field. 
 

 Net Bill amount for the invoice is auto-calculated (Bill Amount – Retainer). 
Net Bill on a Billing Schedule is not the same as a project’s Net Bill on the Billing 

Review screen. 
 

6.  In the Reminder Date field, enter or select a date from the drop-down calendar. On the specified 
date, BillQuick reminds you to generate an invoice from the scheduled billing record. 
 

 To inform the project or billing managers about scheduled billings via the 
Reminders screen, you must mark ‘Load Reminder on Startup’ option in 
Preferences screen. 

 
7.  Press Tab through the end of the row or click the next row to save the billing record. 

 
Advanced Setup 
 
To add additional information: 
 

1. Apply a part of the project retainer to the billing record (if available) in the Retainer field. 
Alternatively, specify a % Retainer.   

 
2. Press Tab. Notice that the Net Bill (Amount - Retainer) is auto-calculated for you. 

 
3. Mark the ‘Exp’ field if you want to charge expenses against the Contract Amount on the invoice. 

Unchecked, expenses are billed in addition to the Contract Amount. 
 
4. Mark the ‘Ext’ field if you want to charge time entries flagged ‘Xtra’ against the Contract Amount 

on the invoice. Unchecked, these entries are billed in addition to the Contract Amount. 
 
5. Enter any important Notes, and if desired, mark the ‘Show Notes on Invoice’ option. 

 
6. Click Move Up or Move Down to move the selected unbilled record one-step up or down in the 

Billing Schedule grid. You may do so if you want to change the billing order of these records. 
 

 You cannot move an unbilled record above the billed record. 

 
7. When you are done, click Close to exit. 

 

 Check out BillQuick Training at www.bqe.com/Services.asp for a standard or 
custom training course for Billing Managers. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

http://www.bqe.com/Services.asp?pageId=Training
mailto:BQ-Ideas@bqe.com
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Overview 
 
Once you have completed the pre-billing tasks and made the initial billing decisions, you are ready for 
actual billing. The billing managers may handle the billing tasks themselves or delegate them to 
accountants or admin staff. 
 
You can accomplish billing in the following ways:  
 

 Invoice Wizards 
 Automatic Billing 
 Billing Review 
 Manual Invoice 

 
 

Invoice Wizards 
 
When you are new to BillQuick’s billing features or use it only periodically to generate percent complete 
invoices for the company, you can use Invoice Wizard and Phased Invoice Wizard to make billing easier 
and faster. These wizards are accessible through the View menu and Sidebar.  
 
The Phase Invoice Wizard walks you through the process of creating a joint invoice for phased projects. 
You need to specify a billing period for which you want to include approved time and expenses to relieve 
with the invoice. BillQuick calculates Net Bill Amount as a percent of the contract amount or you can 
apply a discount and/or a retainer to reduce it. You can then preview, print, email and create a PDF of 
the invoice from the Invoice Review screen.  
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The Invoice Wizard scans projects due for billing (with approved time and expense entries), projects with 
a billing schedule, fixed fee or projects with recurring contract types. If there are no approved time and 
expenses to bill, you can create a manual invoice. Then, the wizard steps you through creating a draft or 
final invoice, and if you want, print a Billing Review Report to review offline. 
 

 
 
 

Automatic Billing 
 
BillQuick simplifies and automates the billing process by allowing you to define an auto-billing schedule at 
the project level. Once you set up a billing schedule and frequency for the desired project(s), BillQuick 
memorizes these settings and creates an entry in the Memorized Invoices screen. It releases the 
associated time and expense automatically and does the write-up and write-down as needed. 
 
Automatic billing follows all the business rules built into BillQuick. It knows when the last invoice went 
out for a project and how much approved work-in-progress you have for it. It knows when the next 
invoice is due for a fixed fee project. If the project has a billing schedule, BillQuick generates the invoice 
accordingly. It also applies the rates correctly and automatically to hourly projects, releasing associated 
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time and expenses automatically. If a fixed fee or HNTE contract type is involved, BillQuick knows not to 
bill more than the contract amount. It knows whether expenses are part of the contract or on top of it. It 
knows when to write-up/down time to match the net bill amount. In addition, it knows which invoice 
template to apply.  
 

 Automatic billing feature is available in BillQuick Pro and Enterprise 
editions only. 

 
To set up automatic billing for a project: 
 

1.  Open the Project screen and select a project from the grid. 
 

2.  Move to the Billing tab and click Automatic Billing. 
 

3.  In the Project Auto Bill Settings screen, enter the schedule settings, including the Frequency for 
generating invoices.  

 

 
 

4.  Check ‘Process as Draft’ if you want to generate a draft invoice automatically but finalize it 
manually in the Invoice Review screen. 
 

5.  You may choose to repeat the billing for a specific number of times (Repeat), specific date range 
(Start and End Date) or forever (Never Expires).  
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6.  You can choose whether someone will process the project invoices, or BillQuick will process 
them automatically and just inform someone about it. In any case, select the ID of that person 
from the dropdown.  
 

7.  Optionally, you can enter an unlimited length memo for the invoices.  
 

8.  When you are done, click Save and then Close to exit. 
 
 

Billing Review 
 
Billing Review is an important screen where you can implement billing decisions and process invoices. 
Whichever billing method you choose, all billing information flows to Billing Review. It lets you generate 
invoices by client, project, manager, contract type and by whatever billing period you wish.    
 
A billing record summarizes approved time and expenses within the date range you define, and brings 
forward other useful information like retainers, billable amounts, taxes, etc.). BillQuick generates it based 
on the three key business rules:  
 

 For projects with a Fixed Fee, Hourly, Hourly Not To Exceed, Percentage or Cost Plus contract 
type, there must be one or more time or expense entries charged to and approved for the 
contract that has not yet been billed. Exception: If a project has the ‘Always Show in Billing 
Review’ rule set (Project-Detail screen), then regardless of the Contract Type, a billing record 
will be included on the Billing Review screen. 
 

 For projects with Recurring, Recurring with Cap or Recurring + Expenses contract type, a billing 
record is generated, whether there are time or expenses charged to and approved for the 
project or not. In essence, the recurring contract type pre-defines the billing record based on the 
recurring frequency chosen (Project-Billing screen). You also have an option in the Billing Review 
screen to allow billing the maximum amount for recurring contract types. When this option is 
checked, BillQuick recommends the larger amount for billing. 
 

 For a project with any contract type (other than Recurring) having a billing schedule assigned, its 
billing records transfer to the Billing Review screen. You predefine the billing record and the 
Reminder Date in Billing Schedule, which determines when it displays in the Billing Review 
screen. 

 
When you process a billing record into an invoice, the associated time and expenses are ‘relieved’ 
(marked billed and given the invoice number for cross-reference). BillQuick allows concurrent billing 
wherein multiple users do their billing simultaneously. However, it locks those time and expense entries 
that show up in the Time/Expense Details screen. Another user will not see any invoice related to those 
entries until the first user releases them. You can also process multiple invoices for the same project by 
defining different dates (billing period). 
 
Billing Review allows you to perform the following billing tasks: 
 

 Customizing Billing Review Grid 
 Printing Pre-Billing Reports 
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 Creating Invoices 
 Adjusting Net Bill Amount 
 Batch Billing 
 Creating Percent Complete Invoices 
 Processing Recurring Invoices 
 Joint Invoices 
 Creating Invoices from Billing Schedule 
 Creating Invoices for Negative Time 
 Write-Up/Down 
 Applying Discounts 
 Viewing Time and Expense Details 
 Excluding Time Entries for Billing 
 Adding Memos to Invoices 
 Creating Billing Journals 

 
 

Customizing Billing Review Grid 
 
It is a good management practice to determine what information you want when making billing decisions. 
BillQuick provides you the option to choose the fields, and thus information, you want to view and hide 
those you do not deal with. For example, do you collect taxes on labor or expenses? If yes, turn on the 
tax fields. Do you want the client, project name and contract amount in the grid as reference 
information? Do you need to see retainer amounts available? Do you group your joint invoices by PO 
number? Then turn on those fields in the grid. 
  
To customize the fields (columns) in the Billing Review grid: 
 

1. Open the Billing Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu.  
 

3. Click the relevant checkboxes for the columns you want to turn on. The grid dynamically adapts 
to your preferences.  
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4. Now, review the sequence of columns in the grid. Is it more logical for you to put the Bill 
checkbox between the historical information and the current billing information? Do you prefer 
reference information grouped together on the left or right side of the grid? If you regularly 
generate percent complete invoices, perhaps placing the % Complete column closer to the 
Discount, Retainer and Net Bill columns would be more intuitive.  

 
5. To rearrange columns, position the mouse cursor on the column header, and then drag it left or 

right to the desired position. The column header moves with your mouse. Repeat this procedure 
as needed.  

 
6. Next, determine how you want to sort billing records in the grid. If you have PO# for a group of 

projects or want to bill by project’s Due Date, click on the column header to sort (once for 
ascending order, twice for descending order).  

 
7. You can also sort by multiple columns. After clicking on the first column to sort it the way you 

want, press Shift while clicking on the next column. Repeat this for as many columns as needed 
to sort the billing records in the order you prefer. 

 

 For more on customizing grids, see Grids in the General Features chapter. 
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Printing Pre-Billing Reports 
 
You can review billing information and print pre-billing reports in BillQuick. Some billing managers use it 
to speed-up the billing process. Others record billing decisions on the report and hand it off to the 
administrative staff to complete billing.  
 
To print reports: 
 

1.  Open the Billing Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2.  Set the filters and click Refresh to view the billing records for that project. 
 

2.  Before processing the bill, select a record and click Print to print a billing report. 
 
3.  The ‘Select a Report’ dialog lets you select 

the desired in-context report. Preview 
the report (you can also print, email or 
export it).  
 

4.  Else, mark the ‘B’ (bill) box for the 
selected record. 
 

5.  Then click Process and choose ‘Process 
Final and Print’ option. This lets you first 
process the invoice and then print it. 

 
Pre-billings reports commonly used by project or 
billing managers include: 
 

 Work in Progress (WIP)  Project Investment Reconciliation (WIP + AR) 
 Earned Value – 

Calculated and Estimated 
 Project Profitability (Summary/Detail) 
 Unapproved Time and Expense 

 Billing Review Report 
 Project Contract Billed 

 Percentage Billed 

 

 You can print all billing reports from the Report Center screen (Reports 
menu). 

 
 

Creating Invoices 
 
Other than the billing wizards and Manual Invoice screen, you can make billing decisions and create 
invoices from Billing Review. You can display as much or as little detail as you want on your invoices to 
the clients. BillQuick allows concurrent billing wherein multiple people can bill at the same time.  
 

 You can create your invoice at a basic level with a few mouse-clicks or 
at an advanced level with all the details. Please read the desired sections. 
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Basic Billing 
 
To generate invoices in Billing Review: 
 

1. Open the Billing Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2. Using the View by drop-down, select Project. You can also select other options. 
 

 
 

3. Using the Project From/To fields, select relevant projects (range) from the drop-down lists. 
 

4. In the Period field, select your billing period. If required, enter the date (today’s date is the 
default).  
 

5. After setting the filters, click Refresh. BillQuick displays all billing records that meet your criteria. 
Review all entries before continuing.  
 

6. The Net Bill is the amount to bill on the invoice. You can adjust it by applying a discount, retainer 
on account or write-up/down. Alternatively, you can manually adjust it to any desired value.  
 

 Depending on the contract type of the project, the Net Bill amount may 
be the total of time and expenses charged to the project, a fixed fee amount, a 
scheduled bill amount, a recurring amount or a percent complete computation. 
You can change its label in the Custom Labels screen. 

 
7. BillQuick automatically inserts the Invoice Date (based on system date) when you are generate 
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billing records. However, you can edit it.  
 

 BillQuick bases invoice aging and late fees on the invoice date. To allow 
time for company processing and mailing, it is common practice to advance it by 

several days. 
 

8. To process a billing record into an invoice, check the B (bill) box. BillQuick assigns Invoice # 
when you do so. Though it is preferred not to edit the invoice number, you can do so. 
 

9. When you are ready, click Process and select the Process Final option. If you want to produce a 
draft invoice for now, click ‘Process as Draft’ option. Alternatively, select ‘Process Final and Print’ 
option to create invoices and immediately print them. The selected billing records disappear and 
move to the Invoice Review screen. You are done! 

 
Advanced Billing 
 
To use additional options: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 

 
2. Enter a Minimum Amt (bill amount) for a billing record, if desired. If the bill amount is less than 

this, BillQuick does not display it. The default Minimum Bill Amount carries from Global Settings-
Miscellaneous screen. 

 

 BillQuick ignores the minimum amount when processing billing records 
from a Billing Schedule or for a project with a recurring billing arrangement. 

 
3. Click Add to open a list of projects without current activity to include in Billing Review. You can 

include complete or not-yet-started phases on a joint invoice by checking those projects and 
clicking Done.  
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After adding the project, click Refresh to view the recently added projects. 
 

4. If you are using a Billing Schedule for billing, select ‘Use Billing Schedule Reminder Date’ from the 
Options drop-down. (See Creating Invoices from Billing Schedule below.) 
 

5. For a joint invoice, enter an identifier in the ‘J’ field. (See Creating Joint Invoices below for more.) 
You can also drag and drop billing records on the grid to assign them automatically a joint invoice 
identifier.  
 

6. For cost-plus contracts, Fixed Fee amount is auto-calculated. However, you can change it 
manually.  
 

7. To bill on a project’s percent complete basis, select Use Percent Complete option from the 
Options drop-down. (See Creating Percent Complete Invoices below for more.) 
 

8. If you want to write-up or write down time entries, highlight that billing record. Click Tools and 
select Write-Up. (See Writing Up and Down below for details.) 
 

9. MST applies to labor or service billed on an invoice and MET applies to expenses billed. The rates 
carry from the Company, Client or Project profile, but you can edit them here. 
 

10. To apply a discount, enter a dollar amount or a percent (of the net bill amount). (See Applying 
Discounts below.) 
 

11. Retainer reduces the net bill amount carried to the invoice after taxes. Enter a dollar amount or a 
percent (of the retainer balance).  
 



Billing 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 492 

 You must use the entire Project Retainer Available before applying the 

Client Retainer Available to billing records. 
 

12. If you regularly apply retainers to bills, select ‘Auto Apply Retainers’ from the Options drop-
down menu. This automatically applies the available retainers to highlighted billing records.  
 

 BillQuick applies the Project Retainer to the Net Bill until the project 
retainer or the net bill is zero. If the net bill is greater than zero and there is a 
Client Retainer available, it is applied until the client retainer is zero or the net 
bill is zero. 

 
13. Accept or enter the Retainage amount for the project, if applicable. BillQuick reduces the final bill 

amount accordingly. (See Retainage in the Billing Basics chapter for details.) 
 

14. If you need to run a quick calculation, select Calculator from the Options drop-down menu. 
 

15. Click Tools and select Spell Check to perform a global spell check on the time and expense data, 
descriptions and memos for all billing records in the grid. 

 
To add or view billing information: 
 

1. To add or view billing journal notes, click in the Journal field. Else, click Tools and select Journal 
to do so. See Creating Billing Journals below for more. 
 

2. Click Tools and select Memo to open the Memo Pad and add up to two memos to an invoice. 
(See Adding Memos to Invoices below for more.) 
 

3. Click Details and select the Billing Details option from the drop-down menu. You can scan billing 
details here. 
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4. To drill down to individual time and expense entries for a billing record, select the row and click 
Details. 
 

5. To review time details of a billing record, select Time Details to open the Time Entry Details 
screen. 
 

6. Repeat this procedure for Expense Details, if required. (See Viewing Time and Expense Details 
below for more.) 

 
To change or edit billing records: 
 

1. Select the billing record(s) that need to be changed. 
 

2. Click Tools and select Change to open the Billing Review Change screen. 
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3. Enter new data to replace the current values of selected records and then click Apply to apply 
these changes.  
 

4. When you are done, click Close to exit. 
 
You can preview, print and finalize your invoices in the Invoice Review screen. 
 
 

Adjusting Net Bill Amount 
 
In Billing Review, the net bill amount carries to the invoice. When generating a billing record, the net bill 
amount calculates depending upon  
 

 contract type of the project 
 assignment of a billing schedule 
 whether a ‘cap’ or maximum amount is part of the billing arrangement 

 

Contract Type                              Net Bill Amount 

Hourly Billable1 + Expenses2 

Adjusted Net Bill Amount 

Hourly with Billing Schedule Schedule Bill Amount (including expenses) 

Schedule Bill Amount + Expenses2 

Adjusted Net Bill Amount 

Fixed Billable1 + Expenses2 (up to the Contract Amount) 

Adjusted Net Bill Amount 

Fixed with Billing Schedule Schedule Bill Amount (including expenses) 

Schedule Bill Amount + Expenses2 

Recurring Recurring Bill Amount 

Recurring + Expense Recurring Bill Amount + Expenses 
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Recurring with Cap Recurring Bill Amount (up to the Contract Amount) 

Percentage Percent of Contract Amount 

Cost + Percentage Net Bill Amount + Percentage3  

Adjusted Net Bill Amount 

Cost + Fixed Fee Net Bill Amount + Fee4  (up to the Fixed Fee)     

Adjusted Net Bill Amount 
1 Sum of Bill Amounts for time entries included in the billing record. 
2 Sum of Charge Amounts for expense entries included in the billing record. 
3 Percent x Billable Amount 
4 Ratio of Contract Amount / Fixed Fee 

 
You can make the following adjustments to the Net Bill amount:  
 

1. Exclude time entries and expenses you do not want to bill. Select Time Details or Expense 
Details option from the Details drop-down and use the Exclude option.  
 

2. Edit time and expenses as needed. Click Edit from the Time Details or Expense Details screen.  
 

3. Write up or write down time entries. Click Tools and select Write-Up on the Billing Review 
screen. 
 

4. Apply Discount to reduce the net bill amount. You can enter a dollar amount or a percent (of 
the net bill amount) in the Discount field in the Billing Review grid. 

 
5. Use Auto-Apply Retainers to reduce the net bill amount. BillQuick stops applying retainers when 

they are exhausted or the net bill amount is zero. 
 
6. Apply Retainer to reduce the net bill amount. Enter a dollar amount or a percent (of the 

available retainer) in the Retainer field in the Billing Review grid. You must exhaust the project 
retainer balance before you can apply a client retainer to a billing record. 

 
7. Edit the Net Bill Amount directly to increase or reduce the bill amount carried to the invoice. 

 

 Discounts and retainers can apply to any contract type; they simply reduce 
the net bill amount. When you apply discounts and retainers, BillQuick includes 
this information on the invoice. 

 
 

Batch Billing 
 
Most of the billing records generated in a billing cycle are billed as-is. These records may be projects with 
hourly, recurring, fixed fee or other contract type. Since they require no billing decisions—no 
adjustments, no exclusions, no editing—batch billing is the fastest way to create invoices. Processing and 
printing of invoices in one simple step. 
 
To batch bill many billing records:  
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1. Open the Billing Review screen. 
 

2.  Click  to open the Field Chooser window and turn on the Contract Type column. 
 

 
 

3.  Enter the criteria in the key fields to generate the billing records with which you want to work. 
Then, click Refresh.  

 
4. In the grid, click the Contract Type column header once to sort the records by it.  
 
5. Select the billing records that do not require special billing decisions. Typically, Fixed and Recurring 

project contracts fall into this category. 
 

6. Click ‘Bill Sel’ to check the B (bill) box in the selected rows. 
 

7. Click Print to print a billing report or click Process and choose the desired processing option 
from its dropdown. The processed billing records appear as invoices in the Invoice Review 
screen. 
 

8.  When done, click Close to exit. 
 
 

Creating Percent Complete Invoices 
 
A percent complete invoice uses the ‘% Complete’ value of the project (in Project screen or Billing 
Review grid) to calculate the net bill amount. BillQuick automatically calculates this value based on the 
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contract amount and bills the client accordingly. Percent complete billing supports both single project per 
invoice and joint invoicing. 
 

 You can create a Percent Complete invoice only when a project has a 
Contract Amount, with neither a billing schedule nor a recurring contract type 
assigned. 

 
To create a Percent-Complete invoice:  
 

1.   Open the Billing Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2.   Click  to open the Field Chooser window and turn on Contract Type, Contract Amount, Due 
Date, % Complete, Amount Billed and Service Amount fields. These are the most common 
columns used by managers when making percent complete billing decisions.  
 

 
 

3.    Click Options and select Use Percent Complete option from the dropdown button. This turns 
on the automatic calculation of Net Bill based on the project’s percentage of completion. 
 

 Billing Review ignores the Use Percent Complete option if the % 
Complete value of the project is blank or zero. 

   
4.  Using the filters above the grid, enter the desired View by, Period and other data. Click Refresh. 

BillQuick displays all billing records that meet your criteria.   
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5.    Find the billing record that you want to bill on a percent complete basis. Move to its % 
Complete column.  
 

6.  The current value carries from the Project profile. Accept the value or enter a new value and 
then press Tab to move on. (You can enter a dollar value by inserting the $ symbol and let BillQuick 
reverse calculate the percentage.) 
 

7.  BillQuick recalculates the net bill amount and prompts you to accept or reject that value. Click 

 to re-calculate the Net Bill based on % Complete. 
 
8.  Click the B (bill) checkbox for each row you want to invoice. 
 
9.  Click ‘Process as Draft’ option to generate a draft invoice, Process Final to generate a final 

invoice, or ‘Process Final and Print’ from the Process drop-down button to generate and print a 
final invoice. BillQuick removes those billing records from the grid. 
 

10.  When you are done, click Close to exit. 
 
BillQuick includes invoice templates that print percent complete information. 
 
 

Processing Recurring Invoices 
 
You can process billing records for projects with ‘Recurring’ contract type. To do so: 
 

1. Open the Project screen and select the desired project from the grid. 
 

2. On the General tab, check whether its Contract Type is ‘Recurring’ and then move to the Billing 
tab. 
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3. In the Billing section, specify the Recurring Bill Amount and Frequency. Accordingly, BillQuick will 
generate billing records for this project in the Billing Review screen. 
 

 Frequency of billing for a project starts from the date of the invoice. 

 
4. Click Save and then Close to exit. 

 
5. Now, open the Billing Review screen and select the above project for billing.  

 
6. Set the filters and click Refresh to view the billing records for that project.  

 
7. Billing records will appear as per the schedule set in the Project screen. The Net Bill amount is 

the amount set as the Recurring Bill Amount. Check the ‘B’ (bill) column.  
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8. If desired, click Options and select ‘Bill Maximum for Recurring Contract Types’ to allow billing a 
different and higher amount than the specified recurring amount. This happens when the value of 
time and expenses for the project exceeds the recurring amount. 
 

9. When ready, click Process and then click Process Final to generate a final invoice. The record will 
disappear from here and appear as invoice in the Invoice Review screen. 
 

10. When you are done, click Close to exit. 
 
 

Joint Invoices 
 
You can make a billing decision to generate a joint (combined or consolidated) invoice before billing 
clients or as part of the billing process.  
 
For joint invoicing, BillQuick groups the projects based on a common client. In case of projects with 
phases, it groups the phases based on a common parent project. E.g., if ‘Send as Joint Invoice’ option is 
checked for three phases of a project and two phases of another project having a common client, Billing 
Review does not join all five phases into a single joint invoice. It considers the parent project for each 
phase and joins them accordingly. 
 

 Combine all projects (all the time) for a client – On the Client-Billing screen, mark the 
option ‘Default to Joint Invoice’. BillQuick automatically assigns a unique ‘J’ code to 
billing records for these projects. 

 Combine selected projects – On the Project-Billing screen, mark ‘Send as Joint Invoice’ in 
each project record you want on the joint invoice. BillQuick creates a unique ‘J’ code 
when you generate billing records.  

 Combine as a billing decision – On Billing Review, enter a unique code into the ‘J’ column 
of each billing record you want to combine onto a single invoice. You can also drag and 
drop billing records on the grid to assign them automatically a joint invoice identifier. 

 

BillQuick separates the joint invoices of merged projects into individual 
invoices. See Merging Project for more information. 
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Creating Joint Invoices 

 
 To generate a joint invoice: 
 

1.  In the Billing Review screen, choose View by: Client.  
 
2.  In the Client From drop-down, select the client for which you want to generate a joint invoice. 

Since the Client ID for joint projects must be identical, select the same client in the To field as 
well. 

 
3.  Enter the billing Period and Period From-To, if relevant.  When you have set all the filters, click 

Refresh. 
 
4.  Review all records displayed in the grid and decide which projects you want to join. 

 

 
 

5.  Enter the same letter or number in the ‘J’ column of all such records. For example, enter the 
letter ‘j’ in the J column next to those project records. You can also drag and drop billing records 
on the grid to assign them automatically a joint invoice identifier. 

 

 For automatic joint invoicing, BillQuick joins the projects based on a 
common client; however, in case of project phases, it joins them based on a 
common parent project. 

 
6.  To process these billing records, mark each by checking the ‘B’ (bill) column. 
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7.  Click Process and then choose Process Final option from the dropdown button to generate a 
final invoice. The records will disappear here and appear as joint invoice in the Invoice Review 
screen. 
 

8.  When you are done, click Close to exit. 
 
 

Creating Invoices from Billing Schedule 
 
After creating and attaching a billing schedule to a project, you can bill the client on the scheduled date 
for the scheduled amount. To do so: 
 

1. Open the Billing Review screen. 
 
2. Select View by Project and choose the Project for which you have created a billing schedule. 

Click Refresh. 
 

 
 

3. Billing Review displays the details of the attached billing schedule provided you have recorded any 
time or expense entry in that billing period.  
 
Alternatively, click Options and select ‘Use Billing Schedule Reminder Date’. Billing Review 
displays the billing schedule details based on its Reminder Date. 
 

4. Select the billing records in the grid and mark its ‘B’ (bill) box. 
 



Billing 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 503 

5. To process the invoice, click Process and then choose ‘Process as Draft’ or ‘Process Final’ option. 
The billing records disappear from Billing Review and appear as invoices in the Invoice Review 
screen. 
 

6. When you are done, click Close to exit. 
 
 

Creating Invoices for Negative Time 
 
You may have recorded a negative time entry and would like to create an invoice that includes it. 
BillQuick handles such situations as well. 
 
To create invoices for negative time: 
 

1.  Open the Billing Review screen and filter the project you would like to bill. 
 

2.  Click Add. Find your project in the list and mark that checkbox. If the box is already checked, then 
uncheck and recheck it.  
 

 
 

3.  Click Done and then back on the Billing Review screen, click Refresh. 
 
4.  You should now see the project listed with a negative Net Bill amount. Invoice this project as 

usual. 
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Write-Up/Down 
 
When billing a client, a billing manager may recognize the company was more efficient than normal 
because of investment in new technology and staff training. Conversely, a billing manager may recognize 
that employees were less efficient because of some issues. Alternatively, the decision-maker may look at 
the service delivered and decide its value is greater for the client than the calculated bill amount. 
Whatever the reason, you can adjust the Net Bill amount of the invoices by writing up or writing down 
the value of time entries. Write-up/down affects the bill rate and not the cost rate. 
 
BillQuick generate a write-up/down automatically on the fixed project contracts because actual billing 
differs from the time and expense value. In case of other contract types, it is a conscious billing decision 
taken by the billing manager or accountant.  
 
You can write up or down time records in three ways.  
 

Change Time  
Entries 

Using the Write-Up/Down feature on Billing Review, you can 
adjust time entries by a percentage or an amount. 

Change the 
Net Bill 
Amount 

By entering a new value for Net Bill on Billing Review, you 
generate a write-up (a higher value) or write-down (lower value). 
To maintain the correct Bill Amount value for the entries, the 
Billing Hours (B-Hours) display on the invoice as adjusted but the 
Bill Rate does not change. 
When time entries are associated with a Manual Invoice, 
BillQuick compares their billable value to the Service Amount and 
generates a write-up or write-down accordingly. 

Time Entry 
Change 

Before billing, the Time Entry Change panel includes the option 
to write-up or down time entries. 

 
This section covers the following WUD tasks: 
 

 Writing Up or Down 
 Resetting Write-Up/Down 

 
 

Writing Up or Down 
 
To write up or down time entries:  
 

1. Open any time entry screen, say Sheet View. 
 

2. Select the time entry(s) in the grid for which you want to write-up or write-down value. Check 
its WUD value in the grid (if not visible, select it from the Field Chooser). 
 



Billing 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 505 

 
 

3. Click Tools and select Change to enter the new Write-up/Down value.  
 

4. Click OK to apply the change and close that screen. 
 

Back on the time entry screen, you can see the modified value reflected in the WUD column for the 
selected entry(s). 

 
Alternatively, you can write up and down entries in the following way: 
 

1. Open the Billing Review screen and select the desired billing record. 
 

2. Click Tools and select Write-Up to open the Write-Up/Write-Down screen. 
 

3. You may filter time entries by Employee, Group or Activity. Click Apply to apply the filter to the 
time entry list. 
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4. Select the entries you want to adjust and specify the Percentage or Amount option for the write-
up or write-down.  
 

5. Enter a positive value to write up the entries or a negative value to write them down. Click 
Update.   
 

6. When you are done, click Apply and then Close to exit.  
 

Back on the Billing Review screen, you can see the modified value and the new Net Bill. After creating 
the invoice, you can view the write-up/down value for each adjusted entry on the Sheet View screen. 
(Turn on the WUD column.)  
 

 While reversing an invoice, BillQuick also reverses WUD if you generated 
the write-up/down in the Billing Review screen. This does not happen if you 
generated it from the Write-Up/Down screen. 

 
 

Resetting Write-Up/Down 
 
If you have generated a write-up or a write-down on an invoice but need to set it back to the original 
amount, you can reset that in BillQuick.  
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To reset the write-up/down: 
 

1.  Select your project in the Billing Review screen. 
 

2.  Click Tools and select Write-Up to open the Write-Up/Write-Down screen. 
 

 
 

3.  Select all the time entries that you wrote up or down previously. 
 

4.  Set the Write-Up/Down percentage to 0 and click Update. 
 

5.  When you are done, click Apply and then Close to exit.  
 

6.  Back on the Billing Review screen, click Refresh. Your invoice should now be set to the original 
amount. 

 
 

Applying Discounts 
 
Discount refers to reduction in the usual bill or invoice amount. In BillQuick, you can apply a discount to 
an invoice prior to processing it. You can do it in the Billing Review, Manual Invoice and invoice wizard 
screens. 
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 The discount reduces the final invoice amount after taxes. It does not 
reduce the tax amount of service or expense. However, you can change this 
setting in Global Settings-More screen. Proper security permission is required to 
apply a discount. 

 
To apply a discount: 
 

1. Open the Billing Review screen.  
 

2. Enter the required data in the key fields and set the usual filters for the billing records.  
 

 
 

3. Click Refresh. Review the billing records displayed in the grid.  
 

4. Enter a dollar amount or percentage in the Discount column of the desired record(s). For 
example, enter 90 to reduce the net bill by $90 or enter 5% (including the percent sign) to 
reduce the net bill by 5%. 
 

 BillQuick reduces the Net Bill amount by whatever amount you enter 
here. It converts the percentage value automatically to the dollar amount.  

 
5. To process the billing record(s), check its ‘B’ (bill) column.  

 
6. Click Process and select Process Final to generate a final invoice. The record(s) disappear here 

and appear as invoice(s) in the Invoice Review screen. 
 

7. When you are done, click Close to exit. 
 
 

Viewing Time and Expense Details 
 
To execute billing decisions about time and expenses, you can drill down into time and expense details in 
the Billing Review or Manual Invoice screen prior to invoicing. You must have appropriate security 
permissions to view and edit time and expense details. 
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 By default, invoices display time and expense entries based on their 
‘Created On’ dates. 

 
To view details: 
 

1. Open the Billing Review screen. 
 

2. Enter required data in the key fields and set appropriate filters for viewing the billing records. 
Click Refresh. 
 

3. Select the billing record in the grid whose details you want to view. 
 

4. Click Details. To review time details, select Time Details option. 
 

5. In the Time Entry Details screen, the details of the labor amount display. If you do not want to 
bill all the time entries, you can choose them and mark Exclude against them. See Excluding Time 
Entries below for more. 
 

 
 

6. You can also mark an entry as billed to write off the item or reduce its value to zero. You are not 
charging the client for it, but your reports show the cost of each item. 
 

 ‘Mark Billed’ time (displayed in blue) does not link to the invoices. This 
decision can be reversed or undone using Mark Unbilled. At times, you may bill 
$5000 to a client with $3000 worth of billable time. Later, some issue can make 
you work on the same project without charging the client anything extra. You 
can then mark the existing time entries as ‘Mark Billed’. These entries are non-
editable until they are marked as unbilled. 
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7. You can check or uncheck the ‘Billable’ option to mark the entry as billable or non-billable. 
 

8. You can also edit time descriptions, B-Hours, bill rates and memos. Highlight the row in the Time 
Details grid and click Edit. 
 

9. When you have edited and reviewed the time details, click Close to exit.  
 

The same procedure applies to the Expense Details. BillQuick reflects these changes in the billing 
records. 
 
 

Excluding Time Entries for Billing 
 
There may be instances where you want to hold or not bill specific time entries on an invoice. In 
BillQuick, you can exclude these time entries to bill them later. Exclusion is for a single session only. If 
you close the Billing Review screen and open it again, the excluded time entries will reappear next time.  
 
To exclude time entries on your invoice: 
 

1.  Open the Billing Review screen and set your filters to show the project for which you wish to 
hold time. 
 

2.  Select the project. Click Details and select Time Details. 
 
3.  On the Time Entry Details screen, check the Exclude column corresponding to the time entries 

you wish to hold from the current invoice you are trying to process. 
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4.  Once done, click Close.  
 
Back on the Billing Review screen, your services column will reflect the changes made above. 
Process this invoice as usual. 

 

 BillQuick places the excluded time entries back into work-in-progress for 
future billing. To ensure these excluded entries are included in your next billing 
cycle, set the ‘From’ Date older than the date on these time entries. 

 
 

Adding Memos to Invoices 
 
You can add project or billing related information to the invoices in the form of a memo. BillQuick allows 
you to add two memos to an invoice. For example, in one memo an IT firm may type, “Windows Server 
and Internet Information Server configurations handled by the new IT staff reduced the projected cost. 
These savings are reflected in the final bill.” and “Thank you for your business. We look forward to satisfying 
your technology needs in the future.” in the second memo. 
 
To add memos: 
 

1. In the Billing Review screen, select a billing record.  
 

2. Click Tools and select Memo to open the Memo Pad. 
 

3. Type the desired notes in the First Memo and/or Second Memo.  
 

 
 

4. When you are done, click and then Close to exit. 
 

Optionally, you can add or modify an invoice memo in the Invoice Review screen. To do so: 
 

1. Open the Invoice Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2. Select the filters for viewing the desired invoices and click Refresh. 
 



Billing 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 512 

3. Choose your invoice in the grid. Click Tools and select Memo. 
 

4. In the Memo Pad, modify an existing memo or type new notes.  
 

5. When you are done, click Save and then Close to exit. 
 
 

Creating Billing Journals 
 
Besides the project journal, you can also create journals for invoices, payments, etc. You can enter 
Project Journals of different types through their respective screens, such as Billing Review, Invoice 
Review, Payment, and so on. For example, to enter a journal for a particular billing record, you should 
add the journal through the Billing Review screen. 
 
To create a billing-related journal: 
 

1. Open the Billing Review screen from the Billing menu.  
 

2. Display the Journal field using the  Field Chooser from the grid or Edit menu.  
 

3. Select the desired billing record for which you have to record a journal. Click in the Journal field 
to launch the Add Journal Note screen. 
 
Else, click Tools and select Add Journal option. 

 

 
 

4. Enter your Journal Note. The ‘Billing Review’ Journal Category is pre-selected.  
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5. When you are done, click Save and then Close to exit. 
 

 You can create a journal in the Invoice Review and Manual Invoice screens 
and use it to track journal entries related to invoices. See Project Journals in the 
Project Management chapter for more. 

 
 

Manual Invoices 
 
The Manual Invoice screen mimics a paper invoice while providing time and effort-saving features. While 
you are creating most of the invoices using Billing Review, there are situations when Manual Invoice is a 
better option. For example: 
 

 When you need to create a quick invoice from an estimate, budget or ‘% Done’ for each 
activity or expense 

 When there are no significant services associated with the product, such as reselling of 
software, hardware, etc. 

 When you want to create a quick invoice based on service and/or expense items 
 When you want to enter historical invoices (summary or detail) from a previous time and 

billing system 
 When there are no time or expense entries charged to a project 
 When you have to create a quick invoice from a Billing Schedule 

 
Manual Invoice is not limited to these situations. If you want, you can create a manual invoice for many 
other purposes. Manual Invoice supports many billing options as in Billing Review including MET and MST 
(GST or VAT) level taxes in addition to the item level taxes, cost plus billing, retainers, discounts, 
retainage, etc. 
 
You can create manual invoices in the following ways: 
 

 Creating Manual Invoices 
 Creating Manual Invoices from Estimates 

 
 

Creating Manual Invoices 
 

 You can create your manual invoice at a basic level with a few mouse-
clicks or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Billing 
 
To create and process a manual invoice:  

 
1. Open the Manual Invoice screen from the Billing menu, toolbar, Sidebar or navigator. 

 
2.  Select a Project ID from the drop-down list. The related Billing Address is automatically displayed 
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(click link to edit). 
 

 
 

3.  BillQuick automatically assigns the invoice number to it. If you want to edit it, click the field and 
enter another number. (BillQuick does not allow duplicate invoice numbers.) 
 

4. In the Invoice Date field, enter the month, day and four-digit year or select a date from the drop-
down calendar. The date defaults to today (the system date in your computer). 

 
5. Enter an activity or expense Item from the dropdown list in the grid. BillQuick automatically 

displays the item’s Description. You may edit it, if desired (it will be spell-checked as you type). 
 
6.  Accept or change the values for Units (hours or expense units) and Rate. It automatically 

calculates the Amount. 
 
Note the ‘Total’ fields below. All calculations are done in real-time. 

 
7. When ready, you can process, preview or print the invoice by clicking Print or Process. You are 

done! 
 
Advanced Billing 
 
To use additional options for billing: 
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1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. You can base a manual invoice on an estimate, a budget, a previous invoice, unbilled time and 

expenses and billing schedule. To do so, click  to open the Build Options. 
 

 
 

3. Select the relevant option in the Load From section. Relevant data pre-fills the grid. 
 

4. When ‘Show % Done’ option is turned on, you can enter the percentage of work completed for 
each activity and expense item. BillQuick uses this percent to calculate the line item total. 
 

5. The Tax % is brought forward from the Activity Codes or Expense Codes screen if any of the 
taxes (Tax 1+Tax 2+ Tax 3) apply. However, you can edit or enter it here. BillQuick then 
calculates the Total amount for each line item. 
 

6. If desired, add a miscellaneous charge to the invoice in the Misc Amount field below. Similarly, 
you can apply a Discount or Retainer to the invoice.  
 

 The discount reduces the final invoice amount after taxes. It does not 
reduce the tax amount of service or expense. However, you can change these 
setting in Global Settings-More screen. Proper security permission is required to 
apply a discount before or after taxes. 
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7. Enter a MST or an MET if relevant.  
 

8. If the client has paid all or part of the invoice prior to preparing this manual invoice, click the Paid 
Today field and enter that amount. 
 
You can specify payment attributes in the Payment Detail dialog such as Pay Method, Reference, 
Memo, Date, etc. when you enter the amount paid. 

 

 
 

9. Accept or enter the Retainage amount for the project, if applicable. BillQuick reduces the final bill 
amount accordingly. (See Retainage in the Billing Basics chapter for details.) 
 

 SubTotal is the sum of item amounts. Tax is the sum of item taxes. Fixed 
Fee is the value specified in the Project profile for Cost Plus contracts. Total is 
the addition of SubTotal, Tax, Fixed Fee and Misc Amount minus Discount and 
Retainer. The Amount Due is the net of Total, Paid Today and Retainage. 

 

10. Click  at the bottom to open the Memo box and add unlimited length memo to the invoice. 
(See Memos in the General Features chapter for details.) 
 

11. You may add journal notes to the invoice by clicking Tools and selecting Add Journal. See Project 
Journal for more information. 
 

12. Click Tools and select Spell to perform a global spell check on the time and expense data, 
descriptions and memo of the current invoice. 
 

13. To view and edit associated time and expenses, click Time Details or Expense Details. 
 

14. When you are done, click Close to exit the Manual Invoice screen 
 

 You can memorize manual invoices from the Invoice Review screen. See 
Memorized Invoices in the Accounts Receivable chapter for more. 
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Creating Manual Invoices from Estimates 
 
Creating a manual invoice is similar to filling out a paper invoice, except it is more flexible. You can charge 
a project with estimate details. You can edit various fields, apply taxes and add a miscellaneous amount to 
the invoice, if desired. 
 
To create and process a manual invoice from an estimate:  

 
1. Open the Manual Invoice screen from the Billing menu, toolbar, Sidebar or navigator. 
 
2. Select a Project ID from the drop-down list.  

 

 
 

3. In the Invoice Date field, enter the month, day and four-digit year or select a date from the drop-
down calendar. The date defaults to today (the system date in your computer). 

  
4. BillQuick automatically assigns the invoice number. If you want to edit it, click the field and enter 

another number. (BillQuick does not allow duplicate invoice numbers.) 
 

5. In the Build Options section, select the desired Estimate from the drop-down list. Review or edit 
the estimate details displayed in the grid.  

    
6. Click the ‘% Done’ field for the activity item. Enter a value to indicate how much work you have 
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done.    
  
7. Next, enter the %Done for the expense items to indicate how much of the estimated expenses 

have been used up. BillQuick indicates the expense items by the Exp checkmark.  
 

BillQuick calculates the Total amount for each line item.  
 

8. If the client has pre-paid all or part of the invoice, click the Paid Today field and enter an amount. 
Note the Total fields below. All calculations are done in real-time. 
 

9. You can process, preview or print the invoice by clicking Print or Process. When you are done, 
click Close to exit. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

mailto:BQ-Ideas@bqe.com
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Overview 
 
When you create invoices, BillQuick debits the accounts receivable (A/R) account and credits the income 
and/or sales tax account. When you record payments, BillQuick debits the Undeposited Funds or bank 
account and credits the A/R account. BillQuick allows you to view all accounts receivable transactions and 
their details in the accounts receivable Register. You can view invoice and payment information here and 
edit these transactions.  
 
You can also track and manage your receivables by using various aging and A/R reports in BillQuick. 
 
 

Invoice Review 
 
Once you have created invoices, you can preview, print, email, generate a PDF document, reverse, edit 
memos, calculate late fees and post invoices from the Invoice Review screen. It contains everything you 
need to manage current, historical and draft invoices. 
 
BillQuick also supports electronic invoices commonly used in European nations. See Electronic Invoices for 
more. 
 
You can perform the following tasks in Invoice Review: 
 

 Reviewing Invoices 
 Changing Invoice Templates 
 Reversing or Deleting Invoices 
 Draft Invoices 
 Electronic Invoices 
 Submit-Approve Invoices 
 Finalizing Invoices 
 Emailing Invoices 
 Saving Invoices as PDFs 
 Memorized Invoices 
 Interest and Late Fees 

 
 

Reviewing Invoices 
 

 You can review and finalize your invoice at a basic level with a few 
mouse-clicks or at an advanced level with all the details. Please read the 
desired sections. 

 
Basic Review 
 
To review your invoices: 
 

1. Open the Invoice Review screen from the Billing menu, toolbar, Sidebar or navigator. 



Accounts Receivable 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 521 

2. You can specify various Filters in the top section of the screen using  for selective viewing of 
invoices—Invoice #, Project, Client, Manager, Group, etc.  
 

 
 

3. In addition, you may choose an Invoice Status like Open, Posted, Draft Invoice, etc. to view 
selective invoices only. Click Refresh. 
 

4. In the grid, edit the Invoice # or Date if required. Late fees, receivables aging, and statements 
use this date for processing. 
 

5. After reviewing your invoices, finalize them by clicking the desired option: 
 

 Email to email the invoice as a PDF attachment (See Emailing Invoices below.) 
 Tools and select PDF to save the invoice as a PDF (See Saving Invoices as PDFs below.) 
 Preview to preview the selected invoice in the viewer. You can also double-click on the 

row to preview an invoice. 
 Print to print the invoices (BillQuick prompts you to flag the invoice(s) as posted.) 

 

 In the Client and Project profiles, you can set BillQuick to email project 
invoices to a client. When you click Print here, BillQuick automatically emails 
the invoices as PDF attachments. 

 

 You are done! 
 
Advanced Review 
 
To use additional options: 
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1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 
 

2. Click on More tab to apply more filters for selective viewing of invoices. 
 

 
 

3. To display the draft invoices, mark the ‘Draft Invoice’ checkbox and then click Refresh. The draft 
invoices will appear in <> brackets. 
 

4. Click ‘Create Late Fee Invoices’ to calculate late fee on the outstanding invoice balance. This 
creates a late fee invoice based on the date specified in the ‘Calculate Late Fee Up To’ field. (See 
Interest and Late Fee below for details.) 
 

5. Click in the ‘Invoice Template’ field on the grid to change the invoice template temporarily when 
reissuing an invoice to a client or when reviewing various invoice layouts with live data. (See 
Changing Invoice Templates below for more.) 
 

6. You can spell check your invoice by right clicking on one or more selected rows. 
 

7. BillQuick allows you to attach files with the invoices by clicking Tools and selecting Link Files. 
E.g., you may want to attach reports, bills, receipts or any other document to the invoice.  
 

 You can use the Link Files option to link a new file to the invoice or select 
an existing file. The existing attachments displays in a tree-node structure with 
the project at the top. 

 
8. Click Details to view the details of the selected invoice. From here, you can also review the Time 

Details and Expense Details associated with it by clicking those buttons. 
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9. Click Reverse or Void to reverse (delete) or void an invoice. (See Reversing Invoices below for 
more.) 
 

10. You can apply a credit to an invoice by clicking Credit Memo link. It launches the Credit Memo 
screen with the selected invoice pre-filled. 
 

To add a memo: 
 

1. Select an invoice on the grid. Click Tools and select Memo to open the Memo Pad. 
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2. Edit the existing memo (from Billing Review) or enter new notes in the First Memo and/or 
Second Memo.  
 

 When editing or adding a memo for joint invoices, you can choose a 
project from the dropdown and assign separate memos to each. 

 
3. When you are done, click Save and then Close. 

 
4. To view or add an invoice-related journal note, hover your mouse over the Journal field in the 

grid and click . 
 

 You can add a journal note to the joint invoices. 

 
To submit invoices: 
 

1. On the grid, ‘S’ field indicates the Submit-Approve status of an invoice. The status is indicated by 
an icon:  
 

[blank] Not submitted    Submitted    Forwarded    Approved    Rejected 
 

2. Select invoices to submit. 
 

3. Click Submit. It opens the Submit-Approve screen from where you can submit them to the 
desired person. See Submit-Approve below for details. 

 
To view time and expense details: 
 

1. Select the desired invoice(s) in the grid. Click Tools and select Edit. 
 

2. In the Invoice Time Entry and Expense Log Details screen, make the desired edits to the entries 
(limited editing). 
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3. You can re-sequence the items into the order you want on a detailed invoice. You can change the 
sequence by clicking Up or Down and moving the row accordingly. 
 

 By default, invoices display time and expense entries based on their 
‘Created On’ dates. 

 
4. When you are done, click Save and then Close to exit. 

 
 

Changing Invoice Templates 
 
At times, clients request another copy of an invoice. You can reprint or resend any invoice in BillQuick via 
email. In addition, when a client asks for more or less detail, or simply the same invoice information in a 
different format, you can reissue the invoice directly from Invoice Review. You can do this without 
reversing the invoice or changing its project settings. This option is faster and easier than printing a 
report.  
 
To reissue an invoice in a different format:  
 

1. From the Invoice Review screen, click  and turn on the Invoice Template column. 
 

2. When you hover your mouse over this field, BillQuick displays . Click it to open the Invoice 
Selection screen.  

 



Accounts Receivable 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 526 

 
 

3. Select the invoice format you want, and then click OK.  
 

4. Back on the Invoice Review screen, highlight the row and click Preview, Print or Email. 
 

5. When you are done, click Close to exit. 
 
 

Reversing or Deleting Invoices 
 
You can process invoices in the Billing Review or Manual Invoice screen. Once processed, you can review 
and finalize them in the Invoice Review screen. However, BillQuick prevents you from reversing an 
invoice if it has late fee invoices linked to it. 
 

 If your Global Settings option is set for voiding invoices on deletion, the 
Reverse button changes to Void instead. On clicking it, BillQuick retains a copy 
of the voided invoice in the database. 

 
To modify a processed invoice: 
 

1. Open the Invoice Review screen from the Billing menu, toolbar, Sidebar or navigator. 
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2. Apply Filters available on the top panel of the screen for selective viewing of invoices. Click 
Refresh. 
 

 
 

3. Review the invoices and select the one to modify or reverse. 
 

4. Click Reverse to reverse or delete the invoice. Reversing an invoice cancels your billing decisions 
and puts the time and expenses back into work in progress for later billing. 
 

5. The selected invoice disappears from the grid.  You can view the reversed invoice in the Billing 
Review screen and re-process it after modifications. (If you missed deleting any associated 
payments, BillQuick displays a message.) 
 

6. When you are done, click Close to exit. 
 

 While reversing an invoice, BillQuick also reverses WUD if you have 
generated the write-up/down in the Billing Review screen. This will not happen 
if you have generated it from the Write-Up/Down screen. 

 
 

Draft Invoices 
 
BillQuick does not add a draft invoice to the receivables of a company until you finalize it. During the 
review and approval process, the invoice can be reversed, additional billing decisions made, and 
processed again as a draft invoice (or a final invoice) until you are satisfied with its content. BillQuick also 
memorizes and generates draft invoices automatically for specific projects, which you can then finalize 
here. 
 



Accounts Receivable 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 528 

 You cannot create a late fee invoice for a draft invoice. 

 
 

Finalizing Draft Invoices 

 
To process a draft invoice:  
 

1. Open the Billing Review screen. 
 

2. Select View by Project and then select the desired projects in the From/To fields.  
 

 
 

3. Select the desired Period and then click Refresh.  
 

4. Various billing records appear in the grid. Mark the ‘B’ (bill) box for the desired projects.  
 

5. Click Process and select ‘Process as Draft’. BillQuick removes the billing record from the grid 
and creates a draft invoice.  
 

6. Click Close to exit the Billing Review screen. 
 
To finalize a draft invoice: 
 

1. Open the Invoice Review screen from Billing menu, toolbar, Sidebar or navigator. 
 



Accounts Receivable 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 529 

2. Click  and select the Filters you want to apply. Click Refresh. 
 

 
 

3. All the invoices meeting your criteria appear in the grid. Now select the ‘Draft Invoice’ checkbox 
above the grid. Again, click Refresh. 
 

4. The draft invoice(s) appears. Notice the angle brackets <>around the invoice number. Also, 
notice that a new Process Invoice button appears at the top. This appears only when draft invoices 
display in the grid.  
 

5. You can print the draft invoice by clicking Print or review it on-screen. A DRAFT watermark 
appears on all pages of a draft invoice.  
 

6. If the draft invoice needs substantial changes, click Reverse, modify the billing record, and then 
re-process it. 
 

7. To finalize the draft invoice, click Preview. After checking it out, click Process Invoice. The 
invoice row disappears because it is no longer a draft invoice.  
 

8. Deselect the ‘Draft Invoice’ checkbox. Click Refresh. The finalized invoice displays in the grid 
with other invoices.  
 

9. You can print or email the invoice to the client. When you are done, click Close to exit. 
 
 

Electronic Invoices 
 
Some companies prefer electronic invoicing, especially in Europe. It involves delivery of invoices 
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electronically via the Internet or formalized EDI relationship between the buyer and supplier. With 
tools like Vendor and Supplier Portals, virtually any company can accept electronic invoices from their 
vendors and suppliers without having to implement costly and complicated systems. It provides benefits 
to both buying companies (paper and expense reductions) and supplying companies (elimination of mail 
float and lower billing costs). 
 
BillQuick supports electronic invoices using both the Finnish Reference Number and Structured 
Creditor Reference. Depending upon your preference, you can specify a reference calculation method 
in Global Settings.  
 

 Support for electronic invoicing is available in the BillQuick Enterprise 
edition only. 

 
The Finnish Reference Number is generated using an invoice number and a check digit (minimum 4 digits 
+ 1 check digit and maximum 19 digits + 1 check digit). BillQuick calculates it automatically using a 
method called Multiplier 137. The 137 Method ensures the delivery of invoices electronically to its 
intended recipient with these numbers printed on the invoices. The reference number is very 
important to make online electronic invoicing between accounting and banking systems possible. The 
invoicing company’s reference number identifies the invoice sent to the client. Payments furnished with a 
reference number are transferred to the payee’s account reserved for payments with a reference 
number. The check digit makes sure that the payments in the bank and invoices in the accounting 
systems can be connected with each other automatically.  
 
On the other hand, the Structured Creditor Reference is a new international business standard based 
on ISO 11649, popularly used by the European Union. The Creditor Reference number is generated as 
an alphanumeric string with RF as a prefix and two check digits (RF + 2 check digits + 21 digits 
maximum). BillQuick generates it automatically using the invoice number. This RF Creditor Reference 
method ensures the delivery of invoices electronically to its intended recipient with these unique 
references printed on the invoices. The invoicing company adds the RF Creditor Reference to its 
invoices. When a client pays the invoice, he/she writes this RF Creditor Reference instead of the invoice 
number in its message or payment ledger. When the company receives that payment, it can 
automatically match the remittance information to its accounts receivable system.  
 
To enable electronic invoicing: 
 

1. Open the Global Settings screen and select its Options panel. 
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2. In the Reference Calculation Method field, choose either 137 Method or RF Creditor Reference. 
It assigns a unique number to invoices. 
 

3. Check ‘Show Reference Number on Invoices’ if you want to display the reference numbers on 
invoices. 
 

4. Click Save and then Close to exit. 
 

When you review and finalize invoices in the Invoice Review screen, you will see the Reference No and 
RFNumber generated for them on the grid.  
 
 

Submit-Approve Invoices 
 
BillQuick workflow also supports submittal and approval process for invoices besides the time and 
expenses. You can submit invoices, including draft invoices, to project managers, principals or billing 
managers for approval prior to sending them to clients. 
 
For a company that follows a submit-review-approval process, BillQuick’s built-in workflow makes the 
process easy and fast. It enables you to follow company policy and submit invoices to a client manager, 
project manager, employee manager or a specific person. Once submitted, BillQuick notifies the manager 
or reviewer concerned about those invoices via Reminders or email.  
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A chain of reviewers can check invoice before a final reviewer approves them. You can track all these 
events and take action on them in the Workflow screen. Then you can send the approved invoices to the 
client for payment.   
 

 The submit-approve feature is available in the BillQuick Enterprise edition 
only. 

 
This section covers the following tasks: 
 

 Submitting Invoices 
 Notifying Managers 
 Approving Invoices 

 
 

Submitting Invoices 
 
To submit invoices:  
 

1. Open the Invoice Review screen. You can specify various Filters in the top section of the screen 

using  for selective viewing of invoices—Invoice #, Project, Client, Manager, etc. 
 

2.  Select the invoices in the grid that you want to submit to a particular reviewer. BillQuick will 
submit all the selected rows to the same person.  
 

3. Click Submit to open the Submit-Approve screen.  
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4.    Select whom to submit the entries. You may submit invoices to a Project Manager (or a billing 

manager), Specific person or My Manager (your direct supervisor). Your BillQuick Supervisor 
will provide submission instructions.   
 

5.  In the Workflow Type, specify the type of submission-whether Billing, Payroll or both. 
 

6.  Optionally, enter a Memo for the submitted invoices. 
 

7.  Click OK and you are done! 
 
 

Notifying Managers 
 
Reviewers and managers need to leverage their time, whether they are in or out of the office. Rather 
than remembering to check for submitted invoices on the Company Navigator or Reminders screen, 
BillQuick notifies managers proactively by email when someone submits invoices for their approval. 
 
The Workflow event tracking system allows you to track the flow path of the entire submit-approve 
process and take the desired action on events. It gives you the status of all submitted invoices –all in one 
screen. From here, reviewers and managers can check the details of the event, action taken and status. 
Besides the submitted and approved items, you can reference the rejected, forwarded and un-submitted 
items from this screen.  
 
To notify a manager: 
 

1.  Log in to BillQuick as a reviewer and open the Preferences screen from the Settings menu. 
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2.  On the Notification and Reminders panel, check ‘Email me when Invoices are sent to me for 

Approval’.  
 
3.  When your ‘email received’ indicator flashes, you can immediately log into BillQuick or Web 

Suite — in the office or on the road — and review, reject or approve invoices.  
 

 

Approving Invoices 
 
BillQuick automatically routes invoices to the person responsible for reviewing and approving them. The 
next time a reviewer logs into BillQuick, it will remind him or her via the Reminders screen, Workflow 
section of the Company Navigator or email that invoices are waiting for review.  
 
To approve submitted invoices: 
 

1.  Open your Reminders screen. Double click on any invoice awaiting approval and it opens in the 
Invoice Review screen. Else, directly open the Invoice Review screen. 

 
2. On the Invoice Review screen, check invoice amount, date, memo and other information as 

required. If you have appropriate security permissions, you can edit associated time and expense 
details.  

3.  Select the invoices to be approved and click Approve. Else, click Submit to open the Submit-
Approve screen and approve invoiced from there. 

 

 
 

4.  If you want to send the invoices to another person for further review (a review chain), or you 
want to reject one or more invoices, choose the desired (Submit To or Reject) option. 
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 When you reject invoices, you have the option of sending a message to the 
users. They will receive it the next time they log into BillQuick. 

 
5.  When you are done, click OK. 

 

 You can track all these submission-approval events in the Workflow screen 
and approve all invoices from there. 

 
 

Finalizing Invoices 
 
To finalize an invoice: 
 

1. Open the Invoice Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2. In the Filters section, set the desired filters using . Then click Refresh.  
 

 
 

3. All invoices meeting the filters display in the grid. Select the invoice to finalize. 
 

4. Click Print to produce a hard copy of the invoice or Preview to preview it. Invoice Review is 
intelligent enough to see there is a contact listed for the selected project and change the address to 
that.  

 

 In BillQuick Enterprise edition, you can print invoice attachments 
automatically when printing an invoice. 
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5. Else, click Tools and select PDF to convert the invoice to the Portable Document Format. See 
Saving Invoices as PDFs below for more. 
 

6. If you generate invoices for internal purposes and do not distribute them to clients, you can click 
Post. This marks the selected invoices as ‘posted’. 
 

7. Click Email to email the invoice (and any linked files) to a client, manager or any other person. 
See Emailing Invoices below for more. 
 

8. Right-click on a manual invoice and select Memorize Invoice to memorize it for future billing. See 
Memorizing Invoices below for more. 
 

9. When you are done, click Close to exit. 
 
 

Emailing Invoices 
 
BillQuick allows you to specify the default settings for emailing invoices to clients (on Client-Billing screen 
and Project-Billing screen). If neither profile is set for emailing invoices, you can do so from the Invoice 
Review screen. You can email any invoice – paid, unpaid, new, old, and draft and attach additional 
documents to it. While emailing invoices, BillQuick also allows you to email the linked files or attachments 
automatically.  
 
On the Invoice Review grid, you can see if an invoice was sent to the contact or client via email and the 
date it was last emailed. This helps to avoid duplicate emails. 
 

 With the global Email feature, you can send emails from BillQuick using any 
of the email programs like AOL, Gmail, MSN, etc. Specify your SMTP Server 
(Outgoing mail server) settings in Preferences or Global Settings screen and 
have BillQuick bypass Outlook when sending email. 

 
To email an invoice: 
 

1. Open the Invoice Review screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2. In the Filters section, set the desired filters using . Then click Refresh.  
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3. All the invoices meeting the filters display in the grid. Select the invoice(s) to email. You can see if 
an invoice was sent via email and the date it was last emailed by displaying those fields from the Field 
Chooser. 
 

4. Click Email. You have the option to send the invoice as a PDF to a Client, Client Manager, 
Project Manager or any other person(s).  
 

 Use the ‘Send without preview’ option to send the email without 
previewing it, provided you have specified the email address(es) of the 
recipient(s). 

 
5. If you have files linked to an invoice, BillQuick prompts you whether to email the linked files 

automatically. 
 

 BillQuick scans the Client, Project, Time and Expense data and presents 
the existing attached files to you. E.g., if your employee attached a lunch receipt 
when recording his/her expense, it will be available without you having to search 
for it. 

 

 This feature is available in the BillQuick Enterprise edition only. 
 

6. In the Email screen, a default message displays (from the Preferences-Email Settings or Global 
Settings-Email Settings screen). You can edit it, if desired.  
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7. You can also change the default Subject and Attachment name here (if specified in the Global 
Settings-Email Settings screen). 
 

8. Access the BillQuick Address Book from the Email window, if required. 
 

9. Perform a spell-check of the email by clicking Spell. 
 

10. When you are done, click Send and then Close to exit.  
 
 

Saving Invoices as PDFs 
 
Invoices can be stored as PDF files in a user-defined location. You can save invoices as PDFs in the 
Retainer Management screen for the retainer invoices and in the Invoice Review screen for the regular 
invoices.  
 
The PDF button option creates separate PDFs for each invoice. On the other hand, previewing invoices 
in a group and then exporting them as PDF creates a single PDF including all invoices. This could be 
useful while sending invoices to a principal or partner for approval or review.  
 
To do so: 
 

1. Open the Invoice Review screen. 
 

2. After applying filters, click Refresh. 
 

3. Select the desired invoice from the grid. 
 

4. Click Tools and select PDF. BillQuick creates the invoice PDF and automatically saves it in the 
default folder location (specified in Global Settings-Folders or Preferences-Folders screen). 
 

5. When you are done, click Close to exit. 
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Memorized Invoices 
 
Billing has never been so easy. Most of the businesses that use fixed-contract types will find the 
memorized invoice feature extremely useful. You can memorize manual invoices and retainer invoices, 
and schedule them for automatic processing on a user-defined frequency. After specifying a recurring 
frequency and other settings for your invoices, you can set the workflow to notify the right person to 
make the decision whether to process the new invoice. Better still, you can set it for automatic 
processing. BillQuick then notifies you about these future billings via BillQuick Messages or reminders. 
 
When you set a project for automatic billing in the Project screen, it creates an entry in the Memorized 
Invoices screen. 
 
This section teaches you the following tasks: 
 

 Memorizing Invoices 
 Processing Memorized Invoices 

 
 

Memorizing Invoices 
 
To memorize invoices: 
 

1. Open the Invoice Review screen from the Billing menu and select a manual invoice to memorize. 
You may create and process a new one for this purpose in the Manual Invoice screen. 
 

2. Right-click and select Memorize Invoice from the menu. It opens the Memorize Invoice screen 
with the invoice number and amount pre-selected. You can also access it from the preview window 
while previewing a manual invoice. 
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3. Type a Name for the memorized invoice. Enter a detailed Description as well. 
 

4. Enter the desired Schedule Settings, including the Repeat frequency. E.g., you may select Weekly 
to generate memorized invoices each week or on a monthly basis. 
 

 The schedule you set can go on forever, repeat a set number of times, or 
begin and end on specific dates. 

 
5. In the Notify Settings section, specify who has to process the memorized invoices by selecting 

that ID from the dropdown. Else, set it for automatic processing. 
 

 In case of automatic processing, you can specify whom to notify about it 
via email. 
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6. Assigning an invoice number is automatic. Select whether to use the next sequential invoice 
number available in BillQuick or specify a custom number. 
 

7. It is a good idea to Release Time or Release Expenses with the memorized manual invoice by 
checking the appropriate option.  
 

 By doing so, time and expenses (WIP) are associated with an invoice, 
enabling you to keep track of bookkeeping, realization, profitability and gross 
margins. The invoice may or may not print the time and expense details. It 
depends on the invoice format selected for the contract type or specifically for 
the project. 

 
8. Check ‘Use Memo on Invoices’ option if you want to display this memo on the memorized 

invoice. 
 

 If available, BillQuick does not carry forward the Manual Invoice memo to 
the Memorize Invoice screen. When the above option is checked, it replaces the 
existing manual invoice memo to print on the invoice. 

 
9. When you are done, click Save and then Close to exit. 

 
 

Processing Memorized Invoices 
 
Once you have memorized manual invoices (or retainer invoices) from the Invoice Review screen, on 
receiving the appropriate message or email you can view and process them. 
 
If you have memorized a manual invoice, say for $5000, and opt to release time and expenses with it, the 
services and expenses total might be more or less than the scheduled invoice amount. In such a case, you 
can process the memorized invoice for the scheduled amount but BillQuick will generate a write-down 
or write-up against the time records (service amount). Say, 
 
Services = $4850 
Expenses = $550 
Total Services + Expenses = $4850 + 550 = $5400 
Bill Amount = $5000 
 
However, the difference between the Bill Amount and Total Amount ($5400 - 5000 = $400) will result 
in a write-down of $400 or 8.25% from the service amount (400/4850 x 100 = - 8.25%).  
 
To process memorized invoices: 
 

1. Open the Memorized Invoices screen from the Billing menu (BillQuick will prompt you with this 
screen if the memorized invoices are due for processing). 

 
2. Select a memorized invoice on the grid to view its schedule details. Make changes, if desired. 
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3. Click  at the bottom to open the Memo box and add unlimited length memo to the 
memorized invoice. (See Memos in the General Features chapter for details.) 
 

4. Click View Invoices to view all the memorized invoices that are due for processing.  
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5. When ready, check the B box and click Process to generate an invoice.  
 

6. When you are done, click Close to exit. 
 
 

Interest and Late Fees  
 
At times, you may include a late fee or finance charge on your invoices. In such cases, you will receive a 
payment for the invoice amount plus that late fee amount. Typically, companies calculate late fee or 
finance charges on the last invoice and the clients pay it with the last payment. In some cases, companies 
prefer to calculate late fee on each outstanding invoice and clients have to pay it each time.  
 
In BillQuick, you can calculate late fee on the outstanding balance or invoice amount based on a specified 
date. For example, if you bill a client for $5000 and he makes a $2500 payment within the payment term, 
but is late for the second payment of $2,500, BillQuick will calculate the late fee on the outstanding 
balance of $2500 and not the entire principal amount of $5000. It takes into account payments applied to 
invoices and late fees before calculating the new late fee on the unpaid balance.  
 

 Late fee invoices print on selected invoices formats and statements. These 
age like any other invoice and print on aging reports. You can write off all or 
part of a late fee invoice and apply payment to it. 

 
When you create a late fee invoice in the Invoice Review screen, BillQuick generates a manual invoice 
internally with an invoice number same as that of the actual invoice but with ‘LF’ appended to it. The first 
late fee invoice will have the same invoice number but with a prefix of LF, and any subsequent late fee 
invoices will have initials LF1, LF2 and so on. You can view regular invoices as well as associated late fee 
invoices. 
 
You can define the late fee settings or interest rates at the company level or the individual level. Based on 
these settings, BillQuick calculates late fee when you create a late fee invoice in the Invoice Review 
screen. You can also change its label in the Custom Labels screen. 
 

 You can transfer separate late fee invoices and corresponding payments 
from BillQuick to your accounting software. Check out the detailed Integration 
Guides for more information. 

 
This section covers the following tasks: 
 

 Setting-Up Late Fees 
 Calculating Late Fees 
 Charging Late Fees 

 
 

Setting-Up Late Fees 
 
You can define late fee settings in the following ways: 
 

http://www.bqe.com/Support.asp?pageId=Documents
http://www.bqe.com/Support.asp?pageId=Documents
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 Global Settings-Options screen: If all projects for all the clients should have the same late fee 
settings, then specify them at the global level. For more, see Settings and Preferences in the 
Company Management chapter. 
 

 Client-Billing screen: If all projects of a client carry the same payment terms, then set them up at 
the client level before creating project profiles. For more, see Client Setup in the Master 
Information Setup chapter. 
 

 Project-Detail screen: If only selective projects should incur a charge for overdue invoices or if you 
want to override the client setting for a particular project, enter the settings in the Project 
profile. For more, see Project Setup in the Master Information Setup chapter. 

 
For all joint invoicing, the Payment Terms will always pull from the Client profile. E.g., if all projects 
included on an invoice are set to Net 30 at the project level but Net 60 at the client level, the joint 
invoice will have Net 60 as the payment term. 
 
 

Calculating Late Fees 
 
You should use the late fee option on Invoice Review before you print statements or run reports on 
which you want up-to-date late fee amounts.  
 

 You cannot create a late fee invoice on a draft invoice. 
 
To calculate late fee: 
 

1.   In the Invoice Review screen, select the desired invoice (except draft) from the grid. 
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2.  Enter the date up to which you want to calculate late fees. Type it or choose the date from the 
drop-down calendar. 
 

3.  Click ‘Create Late Fee Invoices’ to calculate late fee on the outstanding balance and generate a 
late fee invoice. 
 

4.  BillQuick prompts you to review the invoice. Check the Late Fee invoice filter and click Refresh. 
 

5.  The late fee invoice displays on the grid. You can process it as usual. 
 
 

Charging Late Fees 
 
The method to calculate late fees on past due invoices incorporates the new approach of date stamping 
the late fee amount. BillQuick calculates the late fee based on the date you choose in the Invoice Review 
screen for the outstanding balance or invoice amount. You can record the late fee payments separately in 
the Payment screen and then view several reports, such as Account Transaction report and Cash 
Receipts Journal. 
 
The following example clarifies the process: 
 
January 1, 2011: You generate an invoice #1005 for $1000 for Project A. The project is set to charge 1.5 
% interest per month on past due invoices. The grace period is set to 45 days. 
 
February 15, 2011: This is the 45th day since the invoice was generated and therefore within the grace 
period. User opens the Invoice Review screen and brings up invoice #1005. You calculate the late fee for 
this invoice by setting the ‘Late Fee Up To’ date to February 15, 2011 and clicking ‘Create Late Fee 
Invoices’. This results in zero late fee since it is within the 45-day grace period. Therefore, total owed on 
invoice #1005 = $1000 
 
February 16, 2011: This is the 46th day since the user generated the invoice. User opens the Invoice 
Review screen and brings up the invoice #1005. You calculate the late fee for this invoice by setting the 
‘Late Fee Up To’ date to February 16, 2011 and clicking ‘Create Late Fee Invoices’. This results in a late 
fee of $23 ([$1000 x 1.5 x 46] / [100 x 30]). Therefore, total owed on invoice #1005 = $1000 and on 
LF-1005 = $23. 
 
July 20, 2011: This is the 200th day since the user generated the invoice. You open the Invoice Review 
screen and bring up the invoice #1005. You calculate the late fee for this invoice by setting the ‘Late Fee 
Up To’ date to July 20, 2011 and clicking ‘Create Late Fee Invoices’. This results in a late fee of $100 
([$1000 x 1.5 x 200] / [100 x 30]). Therefore, total owed on invoice #1005 = $1000 and on LF-1005 = 
$100. 
 
July 31, 2011: Client makes a total payment of $800 after receiving the July 20 statement. The payment is 
applied as:  
 

$700 towards principal = Invoice # 1005 
$100 towards late fee = Invoice # LF-1005 

 
August 19, 2011: You get ready to generate a new invoice statement. This is the 230th day since the user 
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generated the first invoice. You open the Invoice Review screen and bring up the invoice #1005. You 
calculate the late fee for this invoice by setting the ‘Late Fee Up To’ date to August 19, 2011 and clicking 
‘Create Late Fee Invoices’. Considering the payment made on July 31, the late fee amount would be:  
 
Late Fee = ($1000 x 1.5 x 230) / (100 x 30) - $100 = $15 
Therefore, total owed on invoice #1005 = $300 and on LF-1005 = $15. 
 

 It is better for the client to pay off the late fee invoice before paying the 
original invoice amount (principal amount). 

 
 

Payments 
 
Tracking invoices to full payment is a critical task. Prompt receipt and recording of payments results in 
the most up-to-date information, driving cash flow and other management decisions as well as affecting 
billing decisions. Through the Payment screen, you can record a variety of payments and apply it to one 
invoice or multiple invoices (manually or automatically). Real-time access to secure online payment 
services is available. 
 
This section teaches you the following tasks: 
 

 Recording Payments 
 Deleting Payments 
 Handling Bounced Checks 
 Printing Payment Reports 
 Credit Card Payments 
 Credit Memos 

 
 

Recording Payments 
 
BillQuick allows you to record various types of payments– checks, cash, debit, credit memos, retainer 
receipts, electronic funds transfer and so on – and apply them to unpaid invoices. You can apply 
payments to regular invoices, electronic invoices as well as late fee invoices. 
 

 You can record your payment at a basic level with a few mouse-clicks 
or at an advanced level with all the details. Please read the desired 
sections. 

 
Basic Entry 
 
To enter payments: 
 

1. Open the Payment screen from the Billing menu, toolbar, Sidebar or navigator. You can also 
open it directly from the Client screen using the right-click menu.  
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2. Select the mode by which you want to see unpaid invoices – View By: Client (all project 
invoices), Project (single project invoice), Invoice (single invoice) or Reference No (electronic 
invoice). For now, select the View by Client option and choose the desired Client ID in the next 
field. 
 

 
 

3. Select the desired Project ID (optional) and Date of payment (you may accept today’s date or 
change the payment date).  
 

4. Select the Pay Method, say Check.  
 

 Credits and write-offs reduce the outstanding balance of an invoice. Debit 
entry increases an invoice balance. 

 
5. Enter the total amount of payment in the Amount field. You can apply this payment to multiple 

invoices.  
 

6. Determine which invoices should receive the payment. To apply the payment (oldest to newest 
invoice) automatically, check the Auto Apply option.  
 

7. To apply the payment manually to individual rows, enter the Amt Applied value and check the 
Apply box to the left of each invoice in the grid. BillQuick automatically updates the Balance due 
for the listed invoices as you apply the payment.  
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8. Click Save. BillQuick prompts you to save any unapplied amount remaining at the end of a 
session as a ‘retainer’. You are done! 

 If you are in the View by: Client mode, the excess amount is saved as a 
client retainer. In the View by: Project mode, BillQuick saves it as a project 
retainer. 

 
Advanced Entry 
 
To enter additional information: 
 

1. Click  Field Chooser at the top of the grid to display all the columns in the grid. Alternatively, 
choose this option from the Edit menu. 

 

 When the ‘Show Active Only’ checkbox is marked, the drop-down list 
includes only active client and project records. 

 
2. If required, enter or select a Reference number or a Memo for tracking the payment. 

 
3. Check ‘Apply as Retainer’ option if you want to flag the payment amount as a retainer.  

 

 The amount becomes a client retainer when you are in View By: Client 
mode, and a project retainer when you are in View By: Project mode. See 
Retainers below for more. 

 

4. In the grid, click in the  Journal field to add notes about collections and payment related 
matters. Alternatively, add extra notes at the bottom by clicking Tools and selecting Client 
Notes. 
 

5. Click Print to preview and print a cash receipt or client payment report. 
 

6. When you are done, click Close to exit. 
 

 BillQuick includes a Pay When Paid feature. When you apply a payment to 
an invoice that includes a link to a vendor bill, you can preview/print it with the 
breakdown for the vendor. This helps you schedule payments to your vendors. 

 
 

Deleting Payments 
 
You can delete payments in BillQuick in the following way: 
 

1.  Open the Payment screen from the Billing menu, toolbar, navigator or Sidebar. 
 

2.  Select the desired View by, Client ID and/or Project ID from the drop-downs. 
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3.  Choose the payment to delete from the Previous Payments drop-down. 
 

4.  Click Delete. BillQuick prompts you to confirm the deletion. Select  to delete the 
invoice. 
 

5. When you are done, click Save and then Close to exit. 
 
At times, you may delete payments because you have to delete associated projects and clients. In such 
cases, you can delete master information only after deleting the associated payments. To do so: 
 

1. Open the Client screen and list all the projects of the client. 
 

2. Next, open the Project screen. Determine what you have recorded against each project by 
reviewing the Project-Account screen. (Note the values pointing to time, expense, invoice and 
payments.) 
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 ‘Services x Billable’ shows there are time entries on file. ‘Expenses x 
Billable’ shows there are expense entries. ‘Total Amount Billed’ shows there is 
invoice activity and ‘Total Amount Paid’ shows there are payment records. 

 
3. Open the Payment screen from the Billing menu, toolbar, Sidebar or navigator. 

 
4. Select View By: Project, then select your project. 
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5. Next, move to the Previous Payment field and select a previous payment. The corresponding 
invoice and payment details display in the grid.  
 

6. Click Delete. When you are done, click Close to exit. 
 
 

Handling Bounced Checks 
 
Clients may make payments on the invoices via checks. At times, client may have insufficient funds in the 
account and hence you have a bounced/returned check and want to record that in BillQuick. There are 
several ways to handle that. 
 
To handle a bounced-check payment or insufficient funds: 
 

1.   Open the Payment screen and record a regular payment for the amount that has bounced.  
 

 If you have already recorded this payment, select it in the Previous 
Payments field and simply Void or Delete it. 

 
2.  Next, enter a payment of the same Amount to counter the first payment. 
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3.  Select Debit as the Pay Method and uncheck ‘Hide Paid Invoices’ to see the previously paid 
invoice. 
 

4.  Now, check Apply in the grid against that invoice. The outstanding invoice amount increases by 
that amount. 
 
Alternatively, you can enter this payment using the NSF (Not Sufficient Funds) option. It behaves 
exactly as a Debit type of payment.  
 

 Auto Apply option is not available for Debit and NSF payments. 

 
5.  When you are done, click Save and then Close to exit. 

 
 

Printing Payment Reports 
 
You can print reports related to payments from the Report Center or Reports menu. You can also print 
in-context reports from the Payment screen, including cash receipt, client payment detail, etc.  
 
To print a payment report: 
 

1. Open the Payment screen.  
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2. Select the desired View by mode and Client/Project ID from the dropdowns.  
 

3. Record a payment or view a previous payment. 
 

4. Click Print and choose the desired 
payment report in the ‘Select a Report’ 
dialog.  
 

5. You can Preview or directly Print a report 
from here. 
 

 
 
 
 
Alternatively: 
 

1. Select the desired report from the Reports menu, 
Payments category. 

 
2. On the Report Filters screen, apply the desired 

Date/Other filters and Options for selective viewing of 
information. 

 
3. Click Preview or Print to view your report. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

Credit Card Payments 
  
You can record and process credit card payments securely from within BillQuick. You can transfer credit 
card payments into BillQuick or embed an email link into invoices that lets a client make an online credit 
card payment. 
 
This section covers the following tasks related to credit transactions: 
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 Setting Credit Card Options 
 Processing Credit Card Payments 
 Downloading Payments 

 
 

Setting Credit Card Options 
 
Before processing credit card payments, you need to establish a merchant account. To specify credit card 
settings: 
 

1. Open the Global Settings screen from the Settings menu or toolbar. 
 

2. Select the Merchant option on the left. 
 

 
 

3. Choose the desired service provider –PayPal or Innovative Merchant Solutions. 
 

4. Enter the Account Email, ID and Password that you will get on registering with PayPal or 
Innovative Solutions. 
 

5. Choose desired currency for the transactions.  
 

6. Next, check the option to include the electronic payment link on the invoices. This is a good 
option if the client does not want to share his credit card information directly with your 
company. 
 

7. When you are done, click Save and then Close to exit. 
 
These settings apply to all transactions that you make using BillQuick’s credit card processing feature. 
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When you email an invoice to a client, they can simply click on the link and make a payment.  
 

 
 

Part of the information on the credit card payment web page is pre-filled. Your client only needs to add 
required information (marked with an *). 
 
 

Processing Credit Card Payments 
 
BillQuick allows you to receive and process payments from your clients using the credit card. This saves 
time and is very convenient for you and your clients. 
 
To receive credit card payments from your clients: 
 

1. Open the Payment screen from the Billing menu, toolbar, Sidebar or navigator. 
 

2. Select the desired View by, Client ID and/or Project ID option. 
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3. Enter the payment amount in the Amount field and select Credit Card as the Pay Method. 
 

4. Click Process Credit Card option. The Credit Card Processing screen opens with the Card 
Holder Information (client) pre-filled.  
 
Alternately, you can select Process Credit Cards from the Billing menu and manually enter the 
Client Holder Information. 
 

 
 

5. Next, enter the Credit Card Information (Card Type, Dates, etc.). Enter the full set of numbers 
in the Card Number field. Do not type spaces or dashes.  
 

6. Enter the three-digit Verification Code on the back of the credit card. For American Express, this 
is a four-digit code on the front of the card.  
 

7. Now enter the Amount to charge to the credit card.  
 

8. Click Process. The payment is processed and the status of the transaction displays in a message. 
 

9. Click Close to exit. 
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 You can view the payments received using the credit card in the Download 
Payment screen. See Downloading Payments below for details. 

 
 

Downloading Payments 
 
Download Payments screen lets you pull in credit card payments from clients into BillQuick. To do so: 
 

1.  Open the Download Credit Card Payments screen from the Billing menu. 
 

2.  Filter the payments you want to view for a date range by selecting the From-To dates.  
 

 
 

3.  Filter the payments based on the status of credit card payments. The Status drop-down list 
includes Success, Pending, Bad Card and Problem.  
 

4.  After reviewing the items, click Transfer to move them into BillQuick as payments. 
 

5.  When you are done, click Close to exit. 
 
 

Credit Memos 
 
You can create credit memos for a ‘Credit’ type of payment recorded against an invoice. You can use it 
to inform clients that you have reduced their outstanding balance.   
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Creating Credit Memos 

 
To create a credit memo: 
 

1.  Open the Credit Memo screen from the Billing menu. (You can also open it from the Invoice 
Review screen.) 

 
2.  Select a Client from the drop-down list (whose memo you want to create). 
 

 
 
3. Select the Project ID for the client against whom you are recording the payment. 
 
4. Next, enter the payment Date and Amount. 
 
5. Optionally, enter a Memo, Reference number or unlimited length Description related to the 

credit memo. 
 
6.  Apply the credit amount to the invoice(s) by manually entering the Amt Applied in the grid. Else, 

use the Auto Apply option to apply the amount automatically to the listed invoices. 
 

7.  Click Save. Else, click Print to preview or print the credit memo. 
 

8.  When you are done, click Close to exit. 
 

 You can record a credit memo from the Payment screen as well. When 
you select the ‘Credit’ payment method, BillQuick asks if you want to print a 
Credit Memo after saving the payment. 
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Accounts Receivable 
 
An invoice sent to a client for work done and with an amount due is a receivable. Slow receivables reduce 
profits, funds available for needed or desirable capital expenditures and resource improvements, and 
increase the costs of doing business. Thus, it is important to manage receivables and track individual 
invoices for timely collections. In addition, it is a good practice to include a ‘Stop Work’ clause in your 
contracts to safeguard your interests. Projects will be profitable only if the client pays you on time for the 
work done. 
 
BillQuick contains many tools to help you track and analyze receivables and work-in-progress with at-a-
glance Dashboard information, reports, billing-related memos, journals and collections conversations. 
Client investment is a good indicator of your accounts receivable.  
 
 Client Investment = Unpaid Invoices + Work-in-Progress – Retainer 
 
When the client investment is too high, you need to remind the client for payments. You can obtain this 
information from the Investment Summary (WIP + A/R) or A/R Reconciliation reports.  
 
The aging reports in BillQuick include client sections that list aged project invoices. Client contact details 
and the project manager display prominently. You can print aging reports using one or more ranges as 
filters: 
 

 Invoice numbers 
 Transaction dates 
 Clients 
 Projects 
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If you need an aging summary, such formats are also available. You can drill-down to the details while 
previewing the report. In addition, you can identify payment deficiencies and other receivable information 
from other A/R reports such as Client Snapshot with AR Aging, Billings Summary by Month, Cash 
Receipts, Statements, Collections, etc. See Report and Invoice Samples in the Appendix chapter. 
 
BillQuick displays the invoices that are past due and their total bill amount on the Reminders, Dashboard 
and Company Navigator. You can then drill down to the past due items or print a report. You can track 
your receivables, cash flow and other critical information using the Dashboard. See Dashboard in the 
Project Management chapter for details. 
 
 

Writing-Off Accounts Receivable 
 
At times, you may have to write-off all or part of an invoice because of bad debt, non-payment of 
outstanding amount or any other reason where you know accounts receivable will not be collected. In 
such a case, BillQuick lets you write off an invoice amount. 
 
To generate a write-off: 
 

1.  Open the Payment screen and select the relevant client/project with an outstanding balance. 
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2.  In the Pay Method field, select the Write-Off option. 
 

3.  Enter the Amount you want to write off. 
 
4.  In the grid, check Apply next to the invoice that you would like to write off. 

 
5.  When you are done, click Save and then Close to exit. 

 

 If you synchronize with QuickBooks, a write-off will transfer as a credit or 
discount. 

 

 Check out BillQuick Training at www.bqe.com/Services.asp for a standard 
or custom training course for Billing Managers. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 
 

http://www.bqe.com/Services.asp
mailto:BQ-Ideas@bqe.com
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Retainers 
 
In BillQuick, you can have two types of retainers—client retainers and project retainers. BillQuick 
recognizes a retainer and makes it available for application only after you record it in the Payment 
screen. Whether BillQuick classifies the amount that you receive as a client retainer or a project retainer 
depends on how you record it. Typically, you would apply a retainer toward the end of a project on the 
final invoice. Most of the industries, especially architectural and engineering, consider it as a security 
deposit, used at the end of a contract. 
 
BillQuick saves overpayments and other unapplied amounts—funds on account—as client retainers.  
 
Retainer Management maintains a complete history of all retainer activity, including retainer invoices, 
receipts, and application to invoices. Retainer information is also available in-context throughout 
BillQuick, including client records, project records, Billing Review, Manual Invoice, Payments and various 
reports. 
 

 BillQuick does not allow retainers for a Main project. It distributes retainer 
and contract amount to its phases and segments using ‘% of Total Project’ for 
each (on the Project-Detail screen). You can manually distribute the retainer 
amount to phases or generate a retainer invoice for them. 

 
 

Retainer Situations 
 
You may be having clients who pre-bill for all their work or offer pre-paid services. Typically, they use 
fixed fee contract types involving monthly, quarterly or annual billing. In other words, there are no time 
or expense entries when they issue invoices.  
 
You can handle this situation in three ways: 
 

 Set up a billing schedule for each contract. You can specify the bill amount and reminder date for 
the billing to take place, irrespective of the time and expense entries made. 
 

 Set the project as ‘Recurring’ and specify the recurring amount and frequency on the Project, 
Billing tab. Once a project is set as recurring type, it will show up in the Billing Review 
irrespective of whether you have recorded any time or expense against the project. 

 
 Send the client a retainer invoice at the beginning of every month and then internally create a 

regular invoice at the end of the month for the same amount and apply the retainer received. 
This will result in a zero dollar invoice, which you will not email to the client. However, the time 
and expense entries will link correctly, giving you the correct realization rates and accurate write-
up/write-down values.  

 
This section covers the following retainer topics: 
 

 Retainer Invoices 
 Retainer Payments 
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Retainer Invoices 
 
You can create retainer invoices from the Project screen as well as the Retainer Management screen.  
 
Select the tasks to perform: 
 

 Creating Retainer Invoices 
 Adding Memos to Retainer Invoices 
 Emailing Retainer Invoices 
 Memorizing Retainer Invoices 

 
 

Creating Retainer Invoices 
 
To create a retainer invoice: 
 

1. Open the Retainer Management screen from the Billing menu. 
 

2. Select the desired client in the grid. On the Summary tab, click Create Retainer Invoice.  
 

 
 

3. On the Retainer Invoice screen, select the Project for which you want to produce a retainer invoice. 
The default Client Address displays; however, you can change it by clicking on the Change Client 
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Address link.  
 

 Alternatively, you can check the ‘Create Retainer Invoice for a Project 
Group’ option and select a Project Group instead. 

 
4. Next, enter the Retainer Amount and Date of the invoice. 
 
5. Optionally, add a description. Depending on the invoice format chosen, you can print this text on 

the retainer invoice. To save time, use Auto Complete shorthand codes.  
 
6. Click Process to create the retainer invoice.  
 
7. To preview or print a retainer invoice, click Print. 

 
8. When you are done, click Close to exit.  

 
Alternatively, you can create a retainer invoice from the Project screen. To do so: 
 

1. Open the Project screen. 
 

2. Select a project in the grid for which you want to produce a retainer invoice. Move to the Billing 
tab.  
 

3. In the Retainer section at the bottom, enter a Retainer Amount to request from the client. Click 

 to create and preview the retainer invoice. 
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4. Choose the desired invoice type and then click Preview.  
 

5. From the preview window, you can print, email or export the retainer invoice.  
 

 You can memorize retainer invoices with user-defined frequency. See 
Memorizing Retainer Invoices below for more. 

 
 

Adding Memos to Retainer Invoices 
 
You can add relevant notes by attaching memos to the retainer invoices. To do so: 
 

1. Open the Retainer Management screen from the Billing menu. 
 

2. Select a client in the grid and on the Summary tab, click Create Retainer Invoice. 
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3. On the Retainer Invoice screen, select the Project for which you want to produce a retainer 
invoice. 
 

 
 

4. Create a retainer invoice by entering the required data.  
 

5. Type the desired memo or notes in the Description box. You can format the text, insert date-

time stamp to it using  and also spell-check it using . 
 

6. When you are done, click Process. The retainer invoice now has a memo attached to it. 
 
Alternatively, you can add a memo in the Retainer Management screen. To do so: 

 
1. Click on the Payment tab of the Retainer Management screen. 

 

2. Select the desired retainer (Billed) from the grid and then click Memo. 
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3. Enter unlimited length text memo or notes in the Memo Pad. You can format the text, insert 

date-time stamp to it using  and also spell-check it using . 
 

4. When you are done, click Save and then Close to exit. 
 

 

Emailing Retainer Invoices 
 
You can email the retainer invoices to the clients in the following way: 
 

1.  Open the Retainer Invoice screen from the Retainer Management or Project screen. 
 

2.  Processed invoices display in the Previous Retainer Management grid. Select the one that you 
intend to email. 
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3.  Next, click Email. Choose the desired invoice type and then click Preview. 
 

4.  In the Email screen, a default message displays (from the Preferences-Email Settings or Global 
Settings-Email Settings screen). Edit the body of the email message, if desired.  

 

 
 

5.  You can change the default Subject as well as the Attachment name (from the Global Settings-
Email Settings screen). 
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6.  Perform a spell-check of the email by clicking Spell. 
 

7.  Click Send and then Close to exit.   
 
Alternately, you can email retainer invoices from the Retainer Management screen. To do so: 
   

1. Click on the Payment tab of the Retainer Management screen. Select the desired retainer invoice 
(Billed). 
 

 
 

2. Click Email. Choose the desired invoice type and then click OK. 
 
3. In the Email screen, a default message displays (from the Preferences-Email Settings or Global 

Settings-Email Settings screen). Edit the body of the email message, if desired. 
 

4. Mark the ‘Send Message as Plain Text’ option if you want recipients to receive 
the email message without any formatting styles. 

 

 BillQuick carries forward the email address of a client from the Client 
profile. You can also send the email to multiple recipients, using the Cc field 
(email addresses separated by commas).  

 
5. When you are done, click Send and then Close to exit. 

 
BillQuick creates a PDF invoice and sends it to the client on the specified email address.  
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Memorizing Retainer Invoices 
 
You can memorize retainer invoices (and manual invoices) and schedule them for automatic processing 
on a user-defined frequency. You can specify a recurring frequency and other settings for your retainer 
invoices. You can set the workflow to notify the right person to make the decision whether to process 
the new invoice, or set it for automatic processing. BillQuick then notifies you about these future billings 
via BillQuick Messages or reminders. 
 
To memorize retainer invoices: 
 

1. Open the Retainer Management screen from the Billing menu and select the desired client or 
project in the grid. 
 

2. Click its Payment tab. Select a retainer invoice (Billed) to memorize.  
 

3. Click Memorize to open the Memorize Invoice screen with the invoice pre-selected. You can also 
access it from the preview window while previewing a retainer invoice. 
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4. Type a Name for the memorized invoice. Enter a detailed Description as well. 
 

5. Enter the desired Schedule Settings, including the Repeat frequency. E.g., you may select Monthly 
to generate memorized retainer invoices after every month. 
 

6. In the Notify Settings section, specify who has to process the memorized retainer invoice by 
selecting that ID from the dropdown. Else, set it for automatic processing. 
 

 In case of automatic processing, you can specify whom to notify about it 
via BillQuick Messages. 

 
7. Assigning an invoice number is automatic. Select whether to use the next sequential invoice 

number available in BillQuick or a custom number. 
 

8. Enter a Memo, if required. You can choose to display the memo on retainer invoices by checking 
that option. 
 

9. When you are done, click Save and then Close to exit. 
 

 Once you have memorized the retainer invoices, on receiving the 
appropriate notifications you can view and process them. See Processing 
Memorized Invoices in the Accounts Receivable chapter for more information.  

 
 

Retainer Payments 
 
You can record retainer receipts or payments in BillQuick, whether client retainers or project retainers. 
BillQuick differentiates a client retainer from a project retainer by the way you record it. For a client 
retainer, you select only a Client ID. For a project retainer, you select only a Project ID or both Client ID 
and Project ID.  
 
This section explains various tasks related to retainer payments: 
 

 Recording Retainer Payments 
 Deleting Retainers 
 Applying Retainer to Invoices 
 Converting Project Retainers to Client Retainers 
 Refunding Unused Retainers 

 
 

Recording Retainer Payments 

 
To record a project retainer payment: 
 

1. Open the Payment screen. 
 
2. Select View By: Client and a Client ID from the drop-down list. (You can also choose View By: 
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Project, then select the desired Project ID.) 
 

 
 
3. Enter the Date of the payment or select one from the drop-down calendar. 
 
4. Select the Pay Method from the drop-down list, say Check. 
 
5. Check the ‘Apply as Retainer’ box. This directs BillQuick to process the receipt as a retainer 

payment and add it to the Project Retainer balance. 
 
6. Now enter the Amount of the retainer.  

 
7. Click Save to record the payment. When you are done, click Close to exit. 

 

 If you mistakenly record a retainer receipt to a project or client, 
delete it and re-enter the payment. 

 
 

Deleting Retainers 
 
You can delete retainers in two ways. 
 
To delete a retainer from the Retainer Management screen: 
 

1.  Open the Retainer Management screen from the Billing menu or toolbar. 
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2.  Select a client in the grid and move to its Payment tab. 
 

 
 

3.  Select the desired retainer payment from the grid and then click Delete. 
 

4.  BillQuick prompts you to confirm the deletion. Select  to delete the invoice. 
 

5.  When you are done, click Close to exit. 
 
To delete a retainer payment from the Payment screen: 
 

1.  Open the Payment screen and select View by Client or Project, as desired.  
 

2.  Select the Project or Client ID whose retainer payment you want to delete. 
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3.  In the Previous Payments drop-down list, select your retainer payment with an invoice number 0. 
 

4.  You will see the retainer payment details on the screen (grayed out). Click Delete. 
 

5.  When you are done, click Save and then Close to exit. 
 
 

Applying Retainers to Invoices 
 
After sending retainer invoices to clients and receiving the retainer payments, you can apply them to 
invoices in several ways: 
 

 On billing records in the Billing Review screen 
 On manual invoices in the Manual Invoice screen 
 On billing records in the Billing Schedule screen 
 On outstanding invoices (A/R) in the Payment screen 

 
Billing Review 
 
When executing billing decisions in the Billing Review screen, you can apply project and client retainers to 
billing records. To do so:   
 

1. Open the Billing Review screen. 
 

2. Select the desired options in the View by and From/To fields to view the billing records in the 
grid. 
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3. To view retainer available, click  Field Chooser and turn on all the retainer fields.  
 

4. When Client and/or Project Retainer are available, enter a dollar amount in the Retainer field. 
You can also enter a percent value (with % sign). 
 
Else, select Auto Apply Retainer option from the Options drop-down. BillQuick applies available 
retainer balances until exhausted or Net Bill is zero. 

 
5. When you are done, click Process to process the invoice and click Close to exit. 

 

 If a project retainer and a client retainer exist, you must apply the entire 
project retainer before you apply the client retainer.  

 
Manual Invoice 
 
To apply a retainer to a manual invoice: 
 

1. Open the Manual Invoice screen from the Billing menu, toolbar, Sidebar or navigator.  
 

2. Select the desired Project ID. 
 

3. Check the Project Retainer at the bottom of the screen. If available, apply a portion of it to the 
invoice in the Retainer field.  
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If project retainer is zero, check the Client Retainer. If available, apply a portion of it to the 
invoice in the Retainer field. BillQuick reduces the Total amount of the invoice by that amount.  

 
4. When you are done, click Process and then Close to exit. 

 
Billing Schedule 
 
When defining a billing schedule, you can apply all or a portion of the project retainer to future invoices. 
To do so: 
 

1. Open the Billing Schedule screen. 
 

2. Select the desired Project ID and create billing records for it. 
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3. Next, check the Retainer Amount above the grid and, if available, apply it in the Retainer field. 
 

Alternatively, enter a percent value in the % Ret field. BillQuick calculates and inserts the amount 
in the Retainer field.  
 
BillQuick reduces the Net Bill by that amount. It carries forward these billing records to the 
Billing Review screen for processing. 

 
4. When you are done, click Close to exit. 

 
Payment 
 
To apply retainer payments to outstanding invoices: 
 

1. Open the Payment screen. 
 

2. Choose the desired View by and Client ID/Project ID. 
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3. Enter the required data, as you normally would, but choose ‘Use Retainer’ as the Pay Method.  
 

4. Check the Client Retainer Available and Project Retainer Available fields. If retainer is available, 
enter the Amount to apply. 
 

5. Check ‘Auto Apply’ option to apply the retainer amount automatically to outstanding invoices. 
 

6. When you are done, click Save and then Close to exit. 
 
 

Converting Project Retainers to Client Retainers 
 
You may want to move a project retainer to the client level. Converting project retainer to client retainer 
is a two-step process: 
 
To remove the available project retainer: 
 

1.   Open the Payment screen. 
 

2.  Select the desired project with the retainer from the Project ID drop-down. 
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3.  Check ‘Apply as Retainer’ to record this as a negative retainer payment. 
  

4.  In the Amount field, enter a negative amount equal to your project retainer available. 
 

5.  When you are done, click Save. 
 
To apply the project retainer to the client: 
 

1.  On the Payment screen, select the desired client from the Client ID drop-down. 
 

2.  In the Amount field, enter the same project retainer amount that you removed earlier. 
 

3.  Check ‘Apply as Retainer’. 
 

4.  When you are done, click Save and then Close to exit. 
 

 In a similar way, you can move a project retainer to another project or 
convert a client retainer to a project retainer. 

 
 

Refunding Unused Retainers 
 
There are situations when a retainer balance remains after a project is complete and the client receives 
the final bill. This situation comes up in law firms, accounting firms, architectural firms, engineering and IT 
companies. The company can return or refund this unused retainer to the client or save it as a negative 
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retainer equaling the unused retainer balance.  
 
To refund unused retainers:  
 

1.  Open the Payment screen from the Billing menu, toolbar, Sidebar or navigator.  
 

2.  Choose View by: Project or Client (if it is a client retainer) and select a Client ID.  
 

 
 

3.  In the Date field, accept the payment date (defaults to today) or change it. 
 

4.  Next, select the type of payment in the Pay Method. It defaults to Check. 
 

5.  Enter the Amount of retainer payment that you are returning to the client as a negative value (for 
e.g. to return $1000 retainer amount, enter -1000. 
 

6.  Check the ‘Apply as Retainer’ option. 
 

7.  Click Save. The Client/Project Retainer Available reduces by that amount.  
 

8.  When you are done, click Close to exit. 
 

 If integrating with your accounting software, this negative payment will 
NOT transfer over. You must reduce the ‘BQUnearnedRetainer’ amount using 
a credit memo or reduce this amount directly from the QuickBooks retainer 
account. You also need to issue a refund check to the client from QuickBooks. 
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Reports 
 
Reports contain important and useful information for the company, especially the executives such as 
owners, principals, partners and managers. BillQuick offers a variety of standard, memorized and custom 
reports, more than 400 reports categorized for your convenience. There are also reports corresponding 
to the charts and graphs that display on the navigators and the Dashboard. See Report and Invoice Samples 
in the Appendix chapter. 
 
You can make reports dealing with critical data more secure by assigning report-level security to the user 
besides the modular security. You get an amazing power to run reports specific to any group, date or 
other parameter. 
 
BillQuick lets you memorize reports and tag your favorite reports. You can find and view all reports in 
the Report Center. BillQuick filters and adjusts the reports in the Reports menu and Report Center 
automatically based on your report permissions.  
 

 You can customize and create new BillQuick reports using Crystal Reports 
9.0 or later. Alternatively, you can request a quote from the BillQuick Reports 
Team. You can also buy the detailed BillQuick Report Book. It contains sample 
reports and lists all reports by category with descriptions for easy identification. 
Contact BillQuick Sales at (310) 602-4020 for more information. 

 
Besides the reports, you can also access collection letters and statements from the Reports menu. 
Collection letters are editable Word templates that you can customize to your company preference. 
 
This section covers the following reporting tasks: 
 

 Generating Reports 
 Generating In-Context Reports 
 Report Filters 
 Modifying Reports 
 Previewing and Printing Reports 
 Exporting Reports as PDFs 
 Memorizing Reports 
 Adding Custom Reports 
 Report Automation 

 
 

Generating Reports 
 
In BillQuick, you can generate reports in many ways: Reports menu, Report Center screen or any 
BillQuick screen (in-context reports). You can filter any of the pre-defined reports according to your 
requirements, including filter by ‘Group’. BillQuick cuts the wait time with the background report 
generation. You can get back to work while BillQuick compiles and generates your report.  
 
To view or print a report: 
 

http://sites.fastspring.com/billquick/product/BillQuick-Report-Book-2011
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1. Select a report from the Reports menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. It opens the Report Filters screen where you can apply 
filters to view specific data only. 
 

 



Report Management 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 585 

3. Enter or select the desired Date Filters, Other Filters, Group Filters or Options by selecting a 
range of items from the drop-down lists or discrete items in Select Items dropdown. 
 

4. Once you have applied the filters, click Preview to view the report or Print to print it directly. 
From the preview window, you can print, export or email the report. 
  

Alternatively, you can view and generate reports from the Report Center screen. To do so: 
 

1.  Select Report Center from the Reports menu.  
 

2.  Open the Standard report list. Check ‘Legacy View’ at the bottom if you want to view the report list 
as per the traditional categorization of reports. 

 

 
 

You can click Browse (active in Legacy View only) to open a navigation dialog to select the path to 
an alternative folder containing other BillQuick report templates. 

 

3.  Open the desired report category by clicking  next to it and then select a report.  
 

Alternatively, you can search for a specific report by typing that name in the box at the top and 
clicking . 

 

 A brief Report Description displays for the selected report on the Filters 
tab. You can view a sample preview and full location (path) of the selected 
report on the More tab. 

 
4.  On the Filters tab, check ‘Use Archive Database’ option to include archived data in the reports. 
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5.  Apply Date Filters by selecting the desired Filter By options such as Transaction Date, Time 
Entry Date, Invoice Date, etc. 
 

6.  In the next field, select a range such as All Dates, This Week/Month/Quarter/Year to Date, etc. 
and appropriate dates in the From-To fields. 
 

7.  You can select AND or OR option to narrow or broaden the search when using multiple Date or 
Other filters. Click Tools and select Show Operators to show/hide these AND/OR options. 
 

 If you specify a range of employee IDs AND a range of project IDs, only 
that data which match both filters will be included in a report. Thus, the report 
will contain fewer records. In contrast, OR retrieves records that match one or 
both filters, resulting in more records for the report. 

 

8.  Apply Other Filters by selecting a Filter By option (Activity, Client, Employee, Project, Payment, 
Time and so on) and then a range of items in the From-To fields. You may also select discrete 
items in the Select Items dropdowns. 

 

 Other Filters available on the Report Center screen also include custom 
fields from master information records associated with the report, e.g., Client 
Custom 1, Client Custom 2, Project Custom 1, etc. 

 
9.  Similarly, you can specify Group Filters (such as Employee Group, Client Group, etc.) and then 

select the appropriate From-To range.  
 

10.  Move to the More tab. You can see a Sample Preview of your report. If this is not what you 
want, selected another from a list of Similar Reports. 
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11.  If required, enter a Custom Query String as a specific filter by clicking . Check ‘Append to (E) 
Query’ option to apply it. 
 

12.  Click Print or Preview. From the preview window, you can print, export or email the report. 
 

13.  On the button panel, click Favorites to tag the current report as your favorite. All your favorite 
reports will display in the Reports menu, Favorite Reports dropdown. 
 

14.  If you applied filters to the report and want to save the settings, click Memorize. See Memorizing 
Reports below for more. 
 

15.  When you are done, click Close to exit. 
 
 

Generating In-Context Reports 
 
You can access in-context reports from almost all the screens in BillQuick. For example, if you are using 
the Payment screen, you can access payment reports from that screen directly. Similarly, if you are in the 
Employee screen, you can generate employee reports from there. 
 
To generate an in-context report: 
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1.  Open the desired screen in BillQuick, say Project.  
 

2.  To preview or print any project-related 
report, click Print. It displays a ‘Select a 
Report’ dialog. 
 

3.  Select the desired report from the list.  
 

4.  Click Preview. From the preview 
window, you can print, export or email 
the report. 
 

5.  When you are done, click Close to exit. 
 
 
 
 
 

 Data included in the in-context report is limited to what is in the grid. 
Thus, how you filter data in the screens will determine the information included 
on the report.  

 
 

Report Filters 
 
Report filters limit the number of records or data displayed in the report. You can filter any of the pre-
defined reports according to your requirements, including filter by ‘Group’. You can apply the group 
filters to the custom reports as well. This gives you an amazing power to run reports specific to any 
group you may have created. You can set filters for reports in the Report Filters as well as Report Center 
screen.  
 
For example, if you make activities or expenses billable to a project, the Project Time and Expense 
Report initially shows unbilled costs for all projects and for all dates. This is too much information if all 
you want to see is last year’s unbilled costs to one of the projects. You can use the Date and Projects 
Filters to print last year’s Project Time and Expense report for a particular project. Similarly, if you want 
to view a report for employees with IDs ranging from A through M, you must select that range in the 
Report Filters screen.  
 
 

Applying Report Filters  

 
To apply filters to a report: 
 

1.  Open the Report Filters screen by clicking on any report in the Reports menu. 
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2.  Click on the desired filter option, like Date Filters. Then select the item from its drop-down – All 
Dates, Today’s Date, This Year to Date, etc.  
 

3.  Enter the dates in the From-To fields or select them from the drop-down calendar. 
 

4.  Depending upon the selected report, you may specify Other Filters (such as Projects, Clients, 
Employees, Payment Types, etc.) or Group Filters (Project Groups, Client Groups, etc.). You can 
select the All option, a range in the From-To fields or discrete items in the Select Items field.  
 

5.  In addition, you can check various Options for filtering the report further—Active Only, Billable 
Only, Approved Only, etc.  
 

 For some billing reports, you can choose to print a log file for late fee 
invoices only. This is useful for those who want to know how much late fee they 
billed and what they collected against that.  

 
6.  Check ‘Use Archive Database’ if you want to include the archived data on the reports. 

 
7.  After selecting the desired filters, click Preview or Print. From the preview window, you can 

print, export or email the report. 
 

8.  Click Cancel to close the screen. 
 

 You can right-click on the Report Filters screen to access the Reports 
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menu and directly select the desired report to be viewed. 

 
 

Modifying Reports 
 
You can view a report (invoice and statement as well) by clicking Preview in any screen. From the 
preview window, you can sort data, suppress items, customize font style, size and color of the report, 
besides print, email or export it. Customization choices can be ad hoc (on the fly, one-time), or you can 
save the new settings as a standard for future copies of the report. 
 

 All the common email and modify features are available on the right-click 
menu. 

 

 
 

 Click  Modify Item Font to select the text that you want to edit in terms of font size, 
style and effects. 

 Click  Modify All Fonts to modify the entire report’s font- the font size, style and 
effects. 

 Click  Modify Item to open the Modify Report screen, which allows you to edit 
selected report items and fields. You can modify item visibility, apply border and other 
effects, and change the text, format, size and position of the item. E.g., you may want to 
suppress items like ‘Hours’ or ‘Cost’ in a report. 

 Sort the items on the report by selecting the field/column heading by which to sort the 

report. Then click  Sort Ascending or  Sort Descending as needed. 

 Click  to save the modified report as a new report. You can access this modified 
report from the Report Center screen under the Custom or Saved Reports (Legacy 
View) category.  

 Click  to memorize the previewed report. You can assign a new name and report 
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group to it and save it under the Memorized Reports category in the Reports menu (and 
Report Center).  

 You can customize the size of the logo in the preview window. Resizing is done 

proportionally using the  Modify Item option. 
 
 

Previewing and Printing Reports 
 
You can view a report (invoice and statement as well) by clicking Preview in any screen. You can see the 
full path of the report or invoice at the top.  
 
From the preview window, you may: 
 

 
 

 Click  Export option to export a report to another format and save it to a folder. 
Formats include PDF, Word and Excel. 

 Click  Print setup to choose printer options, properties, print range and copies to 
print. 

 Click  to refresh the data displayed on the report. 

 Jump to a section of the report using  Toggle Group Tree or click  Find to search 
for any text in the report.  

 Scroll page-by-page through the report using   or Page Up/Down keys. You can also 
use the keyboard arrows to scroll vertically and horizontally on a page. 

 Click  to change the zoom level from 400% to 25%, plus Whole Page, Page Width 
and a custom setting. The report viewer remembers the zoom level upon exit. 

 Click  to email the report as a PDF, Word or Excel file. You can accept the standard 
message (from the Preferences-Email Settings screen) or add a new message. You can also 
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change the default Subject and Attachment name of the email (from the Global Settings-
Email Settings screen). 

 Click  to choose paper, orientation and margin settings for the printed reports. 

 Click   to enable or disable the drill-down feature. When enabled, you can click on an 
item or section and view its details. E.g., in the Aging Summary report, you can drill 
down from client to projects; projects into phases.  
You can also make changes to the sub-reports embedded in the main report. E.g., if you 
want to suppress one element of the Account Summary shown at the bottom of your 
invoice, you can now accomplish that by drilling into the Account Summary section and 
suppressing it. 

 Click to tag the report as your favorite. It appears instantly in your Favorite Reports 
list in the Reports menu and Report Center for easy and fast selection. This setting is 
user-specific. 

 

 Besides the reports, you have these options available for statements and 
invoices as well.  

 
 

Saving Reports as PDFs 
 
Invoices as well as reports can be stored as PDF files. To do so: 
 

1.  Open a report from any BillQuick screen, Reports menu or Report Center screen. 
 

2. To export the report as a PDF, click  in the preview window. 
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3.  In the Export dialog, enter a file name for this report and save it as a PDF. Click Save.  
 
BillQuick creates and saves the PDF report at the specified location or in the client files at the 
default PDF Folder location (specified in the Preferences-Folder screen). 

 

4.  You can also click  to email the report as a PDF. 
 

5.  When you are done, close the preview window. 
 
 

Memorizing Reports 
 
Many mangers and staff review the same report or a set of reports. You may apply filters or modify a 
report to suit your needs. It is a good practice to memorize a modified or regularly viewed report to save 
time and for quick access. For example, you may memorize a profit report or a staff utilization report to 
show the previous month’s information. 
 
You can memorize a report from the Report Center screen or preview window, and then run it directly 
from the Reports menu. The Memorize Report option allows you to categorize your memorized report 
on the Reports menu the way you prefer. E.g., you may memorize the utilization and profitability reports 
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for employees for the current year and then put them in the Staff Performance report group. The 
memorized reports are database-specific. 
 

1.  Open the Report Center from the Reports menu. 
 

2.  Select the desired report from the list on the Standard tab. 
 

3.  Apply the desired Date Filters. For this example, let us assume managers want to view employee 
report based on the date they were hired. So choose All Dates. 
 

4.  In the Other Filters section, select Employee Manager or Project Manager from the drop-down 
list. You can memorize the performance report for one of the employee managers. 
 

5.  Click Memorize to create a new memorized report.  
 

6.  In the Memorize Report screen, enter a descriptive Name for the report.  
 

 
   

7.  Check ‘Save in Report Group’ option and enter the group in which you want this memorized 
report saved. 
 

8.  When you are done, click OK. 
 

9. You can see the new report listed on the Memorized tab of Report Center as well as on the 
Reports menu (under Memorized Reports). You or the project manager can now run the 
profitability report anytime.  
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Adding Custom Reports 
 
BillQuick lets you manage and keep track of your custom reports that your company uses frequently. You 
can also set security for these reports using Report Level Security and apply group filters on them. 
 
To add a custom report: 
 

1.  Open the Custom Report List screen from the Reports menu. 
 

2.  Enter a name for the custom report in the Report Name field. 
 

 

 
 

3.   Click on the Report File field and browse for a custom report by clicking . BillQuick adds your 
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report to this list. 
 

4.  You can change the Group Name (Custom by default) and specify an Industry and Description for 
the custom report. 
 

5.  When you are done, click Close to exit. 
 

 You can also modify an existing BillQuick report in the preview window 
and save it. You can access it from the Report Center screen under the Custom 
category. 

 
 

Report Automation  
 
Typically, executives and decision makers follow a standard pattern when it comes to reviewing 
information. Contract spent and budget comparisons may be daily or weekly reports. Job costs, work in 
progress and unpaid invoices may be biweekly. After monthly billing, managers check profitability, work-
in-hand and analysis reports.  
 
BillQuick Agent is an add-on module that schedules BillQuick reports (or other reports created with Crystal 
Reports) to be generated and delivered on any frequency to an email address (as a PDF attachment) or 
postal address (as a printed document). 
 
 

Automating Reports with Agent 

 
To generate reports automatically: 
 

1.  Open the Agent application from the BillQuick Add-Ons menu (opens only if you have purchased 
it). 

 
2.  Click Reports to open the Reports Scheduler screen. Move to the Database Options tab. 

 
3.  Select the relevant Database Type- BillQuick Standard, SQL Server or any other. 

 
4.  Accordingly, enter the Name, Password, etc. of the BillQuick database. Click Apply. 

 
5.  The BillQuick Reports folder is loaded. Select the relevant Report File Name from the list. 

 
6.  If desired, move to the Report Filters tab and apply the desired filters. 
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7.  Click on the ‘Scheduling and Auto Run Settings’ tab. In the Process section, specify the processing 
date and frequency.  

 
8.  Specify the Email preferences for delivering the scheduled report. You can view and edit the text 

of the email. 
9.  To save these settings as a memorized report, click New, Save or Save As on the button panel. 

 
10. Click Preview or Print to view the report. 

 
11.  When you are done, click Close to exit BillQuick Agent. Your BillQuick reports will be 

automatically processed and distributed. 
 

 The Agent Workflow Automation tool is available separately. Contact 
BillQuick Sales at (310) 602-4020 for more information.  

 
 

Statements 
 
You can view and print statements from the Invoice Review, Report Center and Statements screens. 

 

http://www.bqe.com/ProductOverview.asp?prodId=AG
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BillQuick defines the default statement templates for each contract type on the Global Settings-
Templates screen. You can change it there or specify an alternative statement format for a project in the 
Project screen. 
 
 

Printing Statements 
 
BillQuick gives you the ability to print statements for clients even if they have no invoices for a particular 
month. However, as an exception you can choose to ‘Exclude Clients with Billing Between’ specified 
From-To dates. 
 

 As in case of invoices, statements in BillQuick are intelligent enough to see 
there is a contact listed for a project and change the address to the contact’s 
address. 

 
To preview or print a statement: 
 

1. Open the Invoice Review screen and select an invoice from the grid.  
 

2. Click Tools and select Print Statements. 
 

3. The statement displays in a preview window. From here, you can export, email or print it. 
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Alternately, you can print statements directly from the Statements screen. To do so: 
 

1.  Open the Statements screen from the Billing menu. 
 

2.  Set the Invoice Date Filter to preview statements for a specific date or all dates. 
 

 
 

3.  Specify the Statement Type, whether Project or Client statement. ‘Other Type’ provides various 
alternatives to choose from—Outstanding Invoices by Project, Client Statement by Project- Full 
Details, etc.  
 
Alternatively, click Add to browse for a custom statement and load it. 
 

4.  If desired, select Other/Additional Filter Options for further selective viewing. You may choose 
to view information by groups or discrete items, status and so on. 
 

5.  Click Preview if you want to view the statement. Else, directly print the statement by clicking 
Print. 
 

6.  When you are done, click Close to exit. 
 

 To customize invoice templates, you can use Crystal Reports 9.0 or later to 
do it yourself, or contact us for Report Customization Service at (310) 602-
4020. Many of our invoice templates are available for preview at 
www.bqe.com/GenSolutions or you can check out the free BillQuick eBooks for 
billing managers, business managers and project managers. You can also 
purchase the detailed BillQuick Report Book. 

 

 Was this information helpful? Please email your comments, suggestions and 
ideas about BillQuick and this User Guide to BQ-Ideas@bqe.com. 

http://www.bqe.com/GenSolutions.asp?pageId=Samples
http://www.pagegangster.com/p/VnWkO/
http://www.pagegangster.com/p/4ss47/
http://www.pagegangster.com/p/OLChf/
http://sites.fastspring.com/billquick/product/BillQuick-Report-Book-2011
mailto:BQ-Ideas@bqe.com
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Report and Invoice Samples 
 
This section displays the following samples: 
 

 Profitability: Gross Margin 
 Project Management: Budget Comparison 
 Analysis: WIP by Project 
 Time & Expense: Time & Expense Detail 
 Accounts Receivables: Statement Details 
 Analysis: Staff Performance 
 Retainer Management: Retainer Invoice 
 Hourly Invoice 

 

 To customize invoice templates, you can use Crystal Reports 9.0 or later to 
do it yourself, or contact us for Report Customization Service at (310) 602-
4020. Many of our invoice templates are available for preview at 
www.bqe.com/GenSolutions or you can check out the free BillQuick eBooks for 
billing managers, business managers and project managers. You can also 
purchase the detailed BillQuick Report Book. 

 

http://www.bqe.com/GenSolutions.asp?pageId=Samples
http://www.pagegangster.com/p/VnWkO/
http://www.pagegangster.com/p/4ss47/
http://www.pagegangster.com/p/OLChf/
http://sites.fastspring.com/billquick/product/BillQuick-Report-Book-2011
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Gross Margin 
 

 



Appendix 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 603 

Budget Comparison 
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Work-in-Progress 
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Time & Expense Detail 
 

 
 

Statement Details 
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Staff Performance 
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Retainer Invoice 
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Hourly Invoice 
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Glossary 
 
Activity Codes are time-based billable and 
non-billable actions charged to projects. It 
represents a task or service performed by an 
employee or a vendor on a project. 
 
Accounts Payable is a record of the 
outstanding bills to be paid. It is a liability for the 
business. 
 
Accounts Receivable: When your customers 
owe you money for the goods or services 
delivered to them. The sum of all accounts 
receivable becomes an asset for the company. 
Anytime you make a sale, the unpaid amount 
adds to the A/R balance. 
 
Actual Hours is the time taken to complete a 
task. Using this value, BillQuick calculates the 
cost of the time expended on a task (Cost 
Amount = Hours x Cost Rate). 
 
Add-Ons enhance BillQuick by providing 
additional functionality and features. They 
require separate purchase and installation.   
 
Aging is the number of days between invoicing 
a client and a specific date, usually today. You 
can age from the due date or transaction date. 
An aging report shows who owes how much 
and how long the invoice has been out.  
 
Agent is a BillQuick add-on module that 
automates administrative, reports and 
management workflow. It monitors and notifies 
you of delinquent time cards; schedules and 
delivers reports; and provides alerts in 
exception situations. 
 
Approve is the authorization of time and 
expenses for billing. BillQuick’s workflow 
feature notifies the designated reviewer of 
submitted entries waiting for approval. Entries 
can be auto-approved as you record them. 
 
 
Archive is a collection of client, project and 

related information packaged together for 
backup, to transport to some other location. 
BillQuick deletes the archived data from your 
database and moves to an archive file. 
 
Arrears are unpaid debts. It may be a cause for 
bringing a project to a standstill until you update 
the amount owed (in arrears). 
 
Assign means to associate one item with 
another. Through defined associations, Web 
Suite automates some tasks. You can assign 
projects, activity codes and expense codes to 
employees. Similarly, you can assign employees, 
activity codes and expense codes to projects. 
Budgets, estimates and fee schedules can be 
assigned to projects. 
 
Auto Complete feature allows you to type 
shorthand codes, which expand to the 
predefined longhand descriptions as you type 
on. 
 
Backup is an exact copy of your company’s data 
file, providing an alternate and complete 
database if your computer fails, your hard disk 
crashes or you accidentally erase information 
from the working database. 
 
Billable Hours (B-Hours) is the time billed to a 
client. By default, it is the same as Actual Hours, 
but you can change it. BillQuick it to calculate 
the bill value of each time entry (Bill Amount = 
B-Hours x Bill Rate). 
 
Billable Expenses are expenses charged or 
billed to a client by your company. They may be 
incurred by employees or vendors on a 
project(s), for which the company will be 
reimbursed (via an itemized invoice) by the 
client. 
  
Billing Schedule allows you to define and 
schedule billing records for later processing. You 
can attach a billing schedule to projects having 
fixed-type contracts. 
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Bill Rate is the default hourly rate that you 
charge a client for an employee’s time. BillQuick 
uses the Bill Rate to calculate the Bill Amount 
(Billing Hours x Bill Rate) for each time entry. 
 
BillQuick Supervisor is a ‘go to’ person in a 
company –company manager or administrator—
who is responsible for the planning and 
management of BillQuick.  This person typically 
assigns security permissions to users and often 
ensures that all users complete time, expenses, 
billing and other tasks on time.  
 
Budget allows the assignment of expected 
revenues and costs on a project and tracks them 
against actual amounts. It is usually an internal 
document, exclusive to one project or assigned 
to multiple similar projects. 
 
Chart of Accounts is a list of accounts that 
summarize your transactions. It is a list of your 
assets, liability, equity, income, expense, etc.  
 
Class is used by QuickBooks to classify 
transactions involving jobs, service and expense 
items. BillQuick translates its use of classes into 
QuickBooks’ classification system. 
 
Clone is a tool for creating duplicate records 
with similar information and attributes like those 
of the existing clients, employees, projects, etc. 
Cloning does not alter the source record. 
 
Closed Invoice is an invoice with a zero or 
negative balance. Also called a ‘paid’ or ‘paid-in-
full’ invoice. 
 
Comp Time is the extra time that you log to a 
project beyond the standard hours. It is banked 
time in hours that you can use in future. If you 
do not mark the extra time as compensation 
time, it can be marked as overtime. 
 
Contract Amount is the maximum amount 
agreed for a project. In BillQuick, you cannot 
exceed a contract amount for a fixed-type 
project, except by billable transactions marked 
‘Xtra’. 
 

Contract Type refers to the nature of a formal 
or informal agreement regarding the project 
performed for a client. You can also refer to it as 
a billing arrangement or project type. 
 
Control Hours are the hours specified in a time 
entry screen that control the time entered per 
session. The number in the Control Hours field 
should match the total number of B-Hours 
(billing hours) entered in one session. 
 
Cost Rate is the most common rate that an 
employee costs the company for per hour of 
work. It is calculated as Cost Rate = Pay Rate x 
Overhead Multiplier. BillQuick uses the Cost 
Rate to calculate the Cost Amount (Actual 
Hours x Cost Rate) for each time entry. 
 
Credit Memo informs clients that their 
outstanding balance with a company is reduced. 
You can create credit memos for a ‘Credit’ type 
of payment recorded against an invoice. 
 
Crystal Reports is the de facto standard report 
writer, a product of Business Objects. You can 
use it to create new report templates or modify 
existing ones in BillQuick. 
 
Custom Labels allow you to choose lexicon 
and technical jargon that is familiar to your 
organization and business. It applies to screen 
captions, field labels and masks.  
 
Dashboard is a control area displaying the key 
performance metrics of a business. It contains a 
series of widgets or mini-applications that 
extract information from your company 
database and present it in the best format on 
panels. 
 
Delayed SFS is an additional service fee 
schedule used for special bill rates when services 
are pre-sold. It works in conjunction with the 
regular SFS but on a trigger type and value. 
 
Draft Invoice is a preliminary invoice created 
for internal review by managers and/or 
principals. Draft invoices are not receivables.  
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Employee is a person hired by a company to 
work on various projects and tasks. An 
employee may be working part-time or full-time 
but is necessarily on the payroll of a company. 
 
Estimate is a draft or a description of work 
proposed in terms of activities to perform and 
expenses to incur. 
 
Expense Codes represent expense or charge 
items incurred by employees or vendors on 
various projects. They may be billable, non-
billable or reimbursable. 
 
Extra Time is the time worked on a project 
beyond that specified in the contract (Xtra).  
 
Fee Schedule 
SFS enables you to assign multiple bill rates for 
various combinations of employee-activity. 
EFS enables you to set multiple expense rates 
for various combinations of employee-expense.  
 
Filter is a value or range of values used to 
restrict records displayed in a grid or included in 
a report. 
 
Fixed Contracts are billing arrangements with 
fixed contract amount agreed upon by the client 
and your company. You can bill the contract in 
full, by the hour or in incremental flat amounts. 
 
Flags are indicators used to denote any special 
attribute of entries as specified in the BillQuick 
database. 
 
General Ledger (G/L) is where all your 
account information – sales, purchase, 
inventory, cash flow, etc. – is recorded and 
available. All the financial statements (income 
statement, balance sheet, etc.) are drawn from 
the G/L only. 
 
General Journal is a record of transactions 
where the total amount in the Debit column 
equals the total amount in the Credit column. 
Each amount is assigned to an account. 
 
Grid consists of rows and columns used to 

display records from a database. Each row is a 
record, and each column represents a field 
within the record. A grid looks like a 
spreadsheet or table. 
   
Hourly Contracts have no specific contract 
amount. Although BillQuick allows you to bill 
any amount you wish, hourly contracts typically 
involve billing based on time and expense entries 
recorded for the project.  
 
Hourly Not to Exceed is a fixed type of a 
contract based on a contract amount agreed 
upon by the client and company. It involves 
automatic checking of time and expense entry 
so that it does not push the project total over 
the contract amount.  
 
Joint Invoice is a consolidated or combined 
type of an invoice where you can group 
together phased projects or separate projects 
with the same client on a single invoice for billing 
purposes.   
 
LEDES (Legal Electronic Data Exchange 
Standard) is a standard file format used by the 
legal industry for the electronic exchange of 
information. It codifies a uniform data output 
from legal time-and-billing systems for export to 
e-billing systems. 
 
License is a privilege to use BillQuick and its 
add-on modules within the company that 
purchased it and within the limitations of the 
license agreement. The license key contains the 
user count or number of user licenses 
purchased by a company. It is also known as 
‘Named Seat License’. 
 
License Key is a code (sequence of letters and 
numbers) provided by BQE Software when the 
software is purchased. The encrypted 
information in the key includes the company 
name and number of authorized users. 
 
Main project is the highest level in the hierarchy 
of project phases. It is a parent project with one 
or more phases under it. You cannot record any 
time or expense entries against a main project. 
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Marketing is a contract type assigned to 
projects not yet secured while you make efforts 
to pursue it. You can record non-billable time 
and expense entries for it.  
 
Markup is a percentage value used to increase 
the cost rate. It determines the percentage by 
which BillQuick will increase the cost of the 
expense to determine the charge amount. You 
can even enter a negative markup to reduce 
charge amount. 
  
MDI is an acronym for Multiple Document 
Interface. When enabled, you can enter multiple 
windows within the main BillQuick window. 
Non-MDI option puts all sub-windows separate 
from each other. 
 
Navigator is a role-based graphical workflow 
presentation of BillQuick functions with one-
click access. It also contains shortcut links to 
recently used reports and online resources.  
 
Non-MDI setting allows each window opened 
in BillQuick to be independent and to be moved 
anywhere on the Windows Desktop. You can 
drag non-MDI windows to a second or third 
monitor connected to a PC.  
 
On-Demand Sync allows you to transfer all 
updated data or just one record at a time, 
whenever you want. You can do it from the 
menu or directly from the screens. 
 
On-Schedule Sync means BillQuick reminds 
you to synchronize on the schedule you choose. 
The schedule may be daily, weekly or when you 
start up or exit BillQuick. 
 
On the fly indicates doing something on the run 
or in a hurry. In BillQuick, you can use <Add 
New> in a drop-down list to add a new master 
record (client, employee, etc.). After saving the 
record, you can immediately continue what you 
were doing.  
 
Open Invoice is an invoice with a positive 
balance (not paid in full). 
 

Overhead is a contract type used for work 
done on projects that track company overheads 
and administrative costs. It is non-billable and 
may include meetings, office maintenance, 
birthday parties, holidays, sick time, vacations, 
etc.   
 
Overhead Multiplier is combined with the Pay 
Rate of an employee to calculate a Cost Rate 
(Cost Rate = Pay Rate x Multiplier). It increases 
the cost rates for benefits and other costs 
attributed to an employee.  
 
Overtime is the time recorded to a project 
exceeding the daily or weekly Standard Hours, if 
the time has not been marked as Comp time. 
 
Overtime Bill Rate is an optional rate charged 
for time beyond standard daily or weekly hours. 
BillQuick uses the Overtime Bill Rate to 
calculate the Bill Amount (Billing Hours x OT Bill 
Rate) for each overtime entry. 
 
Pay Rate is the hourly rate paid to an 
employee. For a salaried employee, it is 
calculated as total salary divided by hours 
worked per year (2,080 hours). 
 
Percentage is a contract type based upon a 
certain percentage of cost or settlement 
amount. 
 
Phase is a subgroup of services (child project) 
provided as part of a larger group of services 
called a project (parent project). Typically, a 
phase can be broken down into segments and 
segments into sub-segments. This forms the 
project hierarchy. 
 
Posting refers to process involving distribution 
of an invoice to a client by mail, email or by 
hand. When you print or email it, BillQuick 
automatically marks the invoice as ‘posted’.  
 
Project is the scope of work contracted by a 
client. In some companies, all the work done for 
a client is defined as a single project or it may be 
broken down into phases, segments and sub-
segments. 



Appendix 

 
BillQuick User Guide 2011.3                                                                                                                                                        Page 613 

Project Control feature enables you to assign 
specific activities, expenses and employees to 
projects. Only assigned items can charge time 
and expenses to a project. 
 
Purchase Order is a commercial document 
issued by a company to a vendor, indicating the 
type, quantity and price for products or services 
ordered from a seller. It records an order for 
services and materials from vendors or suppliers 
at a specified price and time. 
   
Real-Time Sync means data transfers to and 
from BillQuick when you update a record in 
either BillQuick or your accounting application. 
It is completely automatic and requires no action 
on your part. 
 
Recurring is a contract type used if you have to 
bill a fixed amount after a specified number of 
days, irrespective of the time spent on a project. 
 
Recurring with Cap is a contract type used if 
you have to bill a fixed amount after a specified 
number of days, and the total consideration for 
the project has a ceiling. 
 
Register is a record of all activity that affects an 
account's balance. You can use your account 
registers to enter transactions and maintain 
accounts.  
 
Reimbursable Expenses are expenses 
reimbursed by the company to its employees 
and vendors. They may be charged or billed to 
the client later or via vendor bills. 
 
Reminder is a built-in message system that 
displays user-defined notes based on your 
computer’s system date. 
 
Retainage is a portion of the Net Bill amount 
that is unpaid or retained by a client for any 
project. The client pays this amount later or 
when the project is completed.  
 
Retainer is a payment that you receive in 
advance for performing work on a project. This 
money creates a liability because you owe the 

service to the client. 
Client Retainer is an advance payment received 
from a client and is available for all the projects 
of that client.  
Project Retainer is an advance payment 
received from a client but is available for a 
particular project only. 
 
Retainer Invoice is a request of prepayment 
for services. It is not a receivable of the 
company but rather a liability when received. 
 
Security Profile is a predefined security 
template that determines the security 
permissions of users. Usually, security profiles 
are role-based, e.g. Manager Level Access, Time 
& Expense Only, etc.  
 
SQL String is a series of commands written in 
Structured Query Language, a language used by 
most of the major databases.  
 
Statement is a periodic account summary sent 
by a company to customers who have account 
transactions during the billing period. It 
summarizes invoices, adjustments and 
payments.  
 
Tabbed MDI setting allows windows and 
screens opened within BillQuick to display with 
a tab. Each tabbed window expands the height 
and width of the BillQuick desktop. 
 
Template is a model or format for something. 
In BillQuick, it is combination of fields, fonts, 
rules (lines), and other objects applied in Crystal 
Reports Writer to represent invoices and 
reports. Additionally, a security template refers 
to the combined permissions saved under a 
name using the Security Profile screen. 
 
Upgrade is a software version that contains 
significantly more new features, reports, 
functionality, and perhaps new user interface 
elements. The main version number is also 
changed. 
 
User is an employee or vendor of a company 
who is authorized to access and work with 
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BillQuick. A license is required for each person 
to be an authorized user of BillQuick. 
 
Vendors can be subcontractors, suppliers, 
consultants, agents or brokers. They offer 
valuable products, materials, skills or services to 
a company. They can be contract employees but 
are not on the payroll of your company. 
 
Vendor Bill is an invoice received for products 
and services that a company purchases from an 
outside party. It lists the quantity of service or 
expense items received from a vendor or 
supplier. 
 
Void Invoice is an invoice archived for backup, 
which may be reviewed later by managers. Void 
invoices remain in the database but are not 

editable. 
 
Wizard is a special form of user assistance that 
automates a task through a dialogue with you. 
BillQuick wizards help you to accomplish tasks 
that can be complex for the first time users and 
require experience. 
 
Work-In-Progress in BillQuick essentially 
represents the billable, approved, unbilled time 
and expense entries or their value. 
 
Xtra means the time or expense entry is in 
addition to the contract amount. This item is an 
exception to the Automatic Evaluation rule and 
BillQuick does not evaluate extra items. 

 

 Your feedback helps us plan and improve BillQuick releases and associated 
documentation. Please email your comments, suggestions and ideas about 
BillQuick and this User Guide to BQ-Ideas@bqe.com. 

mailto:BQ-Ideas@bqe.com
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